
Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

En esta guía se describe la configuración y el funcionamiento de ILME-FR7 / ILME-FR7K Interchangeable Lens Digital
Camera.

Consulte este manual y las instrucciones de funcionamiento para los dispositivos relacionados según lo necesite.

Introducción

Aplicaciones de uso típicas

Configuración del sistema

Control de una sola unidad con el control remoto infrarrojo suministrado

Control de una sola unidad con una tablet u ordenador

Control de una sola unidad con un controlador remoto externo

Control de varias unidades con un controlador remoto externo

Ubicación y función de los componentes

Vista frontal

Vista trasera

Bloque de conectores

Vista lateral

Vista superior

Vista inferior

Soporte del objetivo

Ubicación y función de las piezas del control remoto infrarrojo (suministrado)

Pantalla de la Aplicación Web

Descripción general de la pantalla de la Aplicación Web

Estructura del área común de las pantallas

Estructura de la pantalla de operación en directo

Estructura de la pantalla de operación de reproducción

Estructura de la pantalla de ajustes
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Preparación

Menú de la cámara

Visualización de la pantalla de la cámara

Montaje de la unidad

Montaje en vertical en un lugar fijo

Montaje en vertical en un lugar alto y fijo

Montaje en techo

Acoplar/extraer un objetivo

Precauciones a la hora de acoplar/retirar un objetivo

Comprobación de los interruptores del objetivo

Precauciones al utilizar un objetivo con zoom

Acople de un objetivo

Extracción de un objetivo

Conexión de los cables

Conexión de la unidad a un dispositivo de red a través de una conexión por cable

Conexión de una fuente de alimentación

Utilización de la alimentación por CA

Utilización de la alimentación de PoE++

Restablecimiento del giro/inclinación

Configuración antes de la filmación

Inicialización de la unidad con la aplicación web

Acceso a la Aplicación Web desde un explorador web

Inicialización de la unidad

Configuración del funcionamiento básico

Preparación de tarjetas de memoria

Tarjetas de memoria compatibles

Introducción de las tarjetas de memoria

Extracción de una tarjeta de memoria
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Filmación

Formateo (inicialización) de tarjetas de memoria

Comprobación del tiempo de grabación restante

Restablecimiento de tarjetas de memoria

Funcionamiento básico

Iniciar/detener grabación

Intercambio de tarjetas de memoria

Comprobación del audio

Especificación de los datos de tiempo

Revisión de la grabación (Rec Review)

Ajuste del encuadre

Pantalla de ajuste del encuadre

Ajuste de la dirección de filmación

Ajuste de la dirección de filmación mediante la Aplicación Web

Ajuste de la velocidad del giro/inclinación

Ajuste de la aceleración del giro/inclinación

Ajuste de la dirección de filmación mediante el control remoto infrarrojo suministrado

Ajuste del zoom

Ajuste del tipo de zoom

Ajuste del zoom mediante la Aplicación Web

Ajuste de la velocidad de funcionamiento del zoom

Ajuste del zoom mediante el control remoto infrarrojo suministrado

Guardado/restauración de la posición de giro/inclinación/zoom de la cámara (posición preajustada)

Calibración de un objetivo de montura E

Almacenamiento/restablecimiento de la posición de giro/inclinación, la posición del zoom y el ajuste de enfoque con la Aplicación
Web

Cambio de nombre de las posiciones preajustadas mediante la Aplicación Web

Sustitución de una posición preajustada almacenada por una posición nueva mediante la Aplicación Web

Eliminación de una posición preajustada almacenada mediante la Aplicación Web

Sincronización de las operaciones de giro/inclinación y zoom/enfoque al restaurar una posición preajustada
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Cambio de la velocidad de transición (giro-inclinación/zoom/enfoque) al restaurar una posición preajustada

Almacenamiento/restablecimiento de la posición de giro/inclinación y del zoom mediante el control remoto infrarrojo suministrado

Grabación/reproducción de operaciones de encuadre de cámara (rastreo de PTZ)

Grabación de operaciones de encuadre de la cámara mediante la Aplicación Web

Reproducción de operaciones de encuadre de la cámara mediante la Aplicación Web

Eliminación de operaciones de encuadre grabadas por la cámara mediante la Aplicación Web

Grabación de las operaciones de encuadre de la cámara con el control remoto infrarrojo suministrado

Reproducción de las operaciones de encuadre de la cámara con el control remoto infrarrojo suministrado

Ajuste del enfoque

Pantalla de ajuste del enfoque

Ajuste manual del enfoque (Manual Focus)

Ajuste manual mediante la Aplicación Web

Ajuste manual mediante el control remoto infrarrojo suministrado

Enfoque mediante la especificación de una posición de enfoque (Spot Focus)

Uso del enfoque automático de forma temporal (Push Auto Focus (AF))

Uso de Enfoque automático de una sola toma (Push Auto Focus (AF-S))

Ajuste automático del enfoque (Auto Focus)

Ajuste automático mediante la Aplicación Web

Ajuste automático a través del control remoto infrarrojo suministrado

Especificación de la posición/área de enfoque automático (Focus Area)

Cambio del área de enfoque rápidamente (Focus Setting)

Desplazamiento del marco del área de enfoque mediante el funcionamiento táctil (área de enfoque táctil)

Ajuste del funcionamiento del enfoque automático (velocidad de transición AF, sensibilidad de desplazamiento del sujeto AF)

Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación Web

Enfoque manual durante el enfoque automático mediante el control remoto infrarrojo proporcionado

Uso temporal del enfoque manual durante el enfoque automático (Push Manual Focus)

Seguimiento usando detección de caras y ojos (Face/Eye Detection AF)

Seguimiento de un sujeto especificado (Realtime Tracking AF)

Ajuste del brillo
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Funciones útiles

Pantalla de ajuste del brillo

Ajuste de la sensibilidad base

Establecimiento del nivel deseado para el ajuste de brillo automático

Ajuste del diafragma

Ajuste automático del diafragma

Ajuste manual del diafragma

Ajuste de la ganancia

Ajuste automático de la ganancia

Ajuste manual de la ganancia

Ajuste del obturador

Ajuste automático del obturador

Ajuste manual del obturador

Ajuste del nivel de luz (filtro ND)

Acerca del filtro ND

Ajuste en el modo predeterminado

Ajuste automático en el modo variable

Ajuste manual en el modo variable

Ajuste de colores naturales (balance de blancos)

Pantalla de ajuste del balance de blancos

Ajuste automático del balance de blancos

Ajuste manual del balance de blancos

Utilización del balance automático de blancos

Configuración del audio que se va a grabar

Pantalla de configuración de audio

Selección del dispositivo de entrada de audio

Ajuste automático del nivel de grabación de audio

Ajuste manual del nivel de grabación de audio

Funcionamiento del menú directo
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Botones asignables

Movimiento a cámara lenta y rápida

Grabación de vídeo de manera intermitente (Interval Rec)

Grabación de imágenes en memoria intermedia (Picture Cache Rec)

Grabación en la tarjetas de memoria A y B simultáneamente (2-slot Simul Rec)

Monitor de señal de vídeo

Marcas de clip

Breathing Compensation

Grabación de proxy

Descripción general de la grabación de proxy

Grabación de un proxy

Filmación con el aspecto deseado

Descripción general del aspecto

Selección del aspecto

Importación del aspecto básico deseado

Personalización del aspecto

Guardar un aspecto

Eliminación de un aspecto básico

Filmación con ajuste del aspecto en posproducción

Filmación con ajuste del aspecto en posproducción

Aplicación de una LUT a la transmisión y a la salida de HDMI

Cambio de una LUT

Cambio de la distribución de las áreas oscuras e iluminadas en la imagen grabada

Grabación RAW

Grabación de vídeo RAW

Grabación de vídeo RAW en modo Slow & Quick Motion

Ajuste del bokeh (función de control del bokeh)

Activación/desactivación de la función de control del bokeh
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Funciones de red

Pantalla de imágenes en miniatura

Menú de la cámara y ajustes detallados

Ajuste del grado de bokeh

Guardar y cargar datos de configuración

Descripción general del proceso para guardar y cargar datos de configuración

Guardar un archivo ALL

Cargar un archivo ALL

Transferencia de archivos

Acerca de la transferencia de archivos

Registro de un destino de transferencia de archivo

Selección de un archivo y carga

Carga de un archivo proxy en una tarjeta de memoria desde la pantalla de imágenes en miniatura

Carga de un archivo original en una tarjeta de memoria desde la pantalla de imágenes en miniatura

Comprobación del estado de transferencia de archivos

Carga mediante FTP segura

Configuración de la transmisión

Acerca de la transmisión

Configuración del formato de transmisión

Configuración del códec de vídeo para la transmisión

Configuración del códec de audio para la transmisión

Iniciar/detener transmisión

Pantalla de imágenes en miniatura

Reproducción de clips y otras operaciones de clips

Reproducción de clips grabados

Operaciones en clips grabados

Configuración del menú de cámara

Funcionamiento del menú de la cámara

Funcionamiento del menú de la cámara
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Introducción de una cadena de caracteres

Menú User

User

Menú Edit User

Edit User

Menú Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Menú Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Menú Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Menú Pan-Tilt

P/T Acceleration

Menú TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Menú Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Menú Audio
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Audio Input

Audio Output

Menú Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Menú Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menú Network

Wired LAN

File Transfer

Menú Maintenance

Language

Clock Set

Hours Meter

Ajustes y valores predeterminados del menú Shooting

Ajustes y valores predeterminados de ISO/Gain
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Menú web y ajustes detallados

Ajustes y valores predeterminados de AGC Limit

Ajustes de calidad de imagen guardados para cada modo de filmación

Configuración del menú web

Operaciones del menú web

Menú Shooting

Focus

Menú Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Menú Paint/Look

Base Look

Menú Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Menú Monitoring

Output Format

Output Display

Menú Audio

Audio Input
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Audio Output

Menú Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Menú Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 a 3

SSL

Referer Check

Brute Force Attack Protection

Menú Stream

Stream

Video Stream

Audio Stream

Menú Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Conexión de dispositivos externos

Apéndice

Service

EULA

Software

Conexión de dispositivos de grabación y monitores externos

Conexión de un RCP/MSU (opcional)

Conexión con un RCP/MSU

Conexión de uno a uno entre la unidad y un RCP

Uso de la unidad en un entorno multicámara con una MSU/software de control remoto de la cámara

Lista de funciones compatibles

Funcionamiento con un controlador remoto RM-IP500 (opcional)

Acerca del funcionamiento con un controlador remoto RM-IP500 (opcional)

Conexión de un controlador remoto RM-IP500

Sincronización con un dispositivo externo

Acerca de la sincronización con un dispositivo externo

Sincronización de la fase de la señal de vídeo (Genlock)

Bloqueo del código de tiempo en otros dispositivos

Conexión de un micrófono externo o un dispositivo de audio externo

Gestión/edición de clips con un ordenador

Emisión de una señal de fibra óptica

Conexión de una señal de registro

Emisión de datos de seguimiento (free-d)

Conexión de un controlador del objetivo

Ajuste del zoom mediante un controlador del objetivo

Precauciones de uso

Limitaciones y formatos de salida

Resolución de problemas

Advertencias de funcionamiento
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5-041-957-43(1) Copyright 2022 Sony Corporation

Lista de elementos del menú

Elementos guardados de posición preajustada

Diagramas de bloques

Actualización del software del objetivo de montura E

Colocación de la tapa del botón de liberación del objetivo

Licencias

Especificaciones

Marcas comerciales
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Configuración del sistema

Esta unidad puede combinarse con dispositivos periféricos para crear distintas configuraciones del sistema.

Objetivo de montura E1.

Adaptador de montura A LA-EA3 LA-EA42.

Control remoto infrarrojo (suministrado)3.

Tarjetas de memoria CFexpress Tipo A/tarjetas de memoria SDXC4.

Lector de tarjetas CFexpress Tipo A/lector de tarjetas SD5.

Micrófono de ECM-680S, ECM-678*, ECM-674*6.
Se requiere un cable adaptador XLR EC-0.5X3F5M de 3 contactos → 5 contactos.*

Adaptador de CA (suministrado)7.

Monitor de vídeo8.

Controlador remoto RM-IP5009.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Control de una sola unidad con el control remoto infrarrojo suministrado

Es posible controlar una sola unidad de manera remota con el control remoto infrarrojo.

 Señal de vídeo
 Flujo de la señal

5-041-957-43(1) Copyright 2022 Sony Corporation

Control remoto infrarrojo (suministrado)1.

Monitor de vídeo2.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Control de una sola unidad con una tablet u ordenador

Es posible conectar una tablet u ordenador a la unidad y controlar la unidad a través de un explorador web.

 Señal de vídeo
 Señal de control remoto

  Flujo de la señal

5-041-957-43(1) Copyright 2022 Sony Corporation

Monitor de vídeo1.

Tablet2.

Ordenador3.

Punto de acceso4.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Control de una sola unidad con un controlador remoto externo

Es posible controlar la unidad de manera remota con un controlador remoto.

 Señal de vídeo
 Señal de control remoto

  Flujo de la señal

5-041-957-43(1) Copyright 2022 Sony Corporation

Monitor de vídeo1.

Controlador remoto RM-IP5002.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Control de varias unidades con un controlador remoto externo

Es posible controlar hasta 100 unidades de manera remota con un solo controlador remoto.

 Señal de vídeo
 Señal de control remoto
 Señal de contacto/registro

  Flujo de la señal

5-041-957-43(1) Copyright 2022 Sony Corporation

Monitor de vídeo1.

Conmutador de vídeo2.

Concentrador Ethernet3.

Controlador remoto RM-IP5004.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista frontal

En este tema se describe la ubicación y la función de las piezas de la parte frontal de la unidad.

Sugerencia

Esta descripción se refiere a la ilustración de la unidad sin el objetivo colocado.

Cabezal de la cámara

Nota

No someta el cabezal de la cámara a impactos fuertes.

1.

Lámpara indicadora/indicador de grabación
Cuando el dispositivo está configurado como indicador de grabación, la lámpara se ilumina en color rojo cuando se
está grabando en una tarjeta de memoria. La lámpara parpadea cuando el espacio libre restante del soporte de
grabación es bajo o si se produce un error.

2.
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Para obtener más detalles, consulte “Advertencias de funcionamiento”.

Cuando el dispositivo está configurado como luz indicadora de registro, la lámpara se ilumina en color rojo o en
verde en función de la señal de registro externa.

Para obtener más detalles, consulte “Conexión de una señal de registro”.
Sensor de imagen

Nota

No tocar directamente con las manos.

3.

Botón de liberación del objetivo
Púlselo para retirar el objetivo.

Para obtener más información, consulte “Extracción de un objetivo”.

4.

Contactos de señal del objetivo

Nota

No tocar directamente con las manos.

5.

Indicador POWER6.

Indicador NETWORK
El estado de la unidad se indica mediante la combinación del color y el estado de iluminación (iluminado, parpadeo y
no iluminado) que muestran los indicadores POWER y NETWORK.

7.

Indicador
POWER

Indicador
NETWORK Estado de la unidad

Iluminado en
verde*1

Iluminado en
verde

Encendido (conectado a la red)

No iluminado Encendido (no conectado a la red)

Intermitente en
verde

No iluminado Proceso de encendido en progreso

Iluminado en
naranja

No iluminado Fuente de alimentación en estado de espera

Intermitente en
amarillo

No iluminado Actualización del software en progreso

Parpadeo lento
en naranja*2

Parpadeo lento
en verde*2

La unidad no funciona con normalidad. Para obtener más información,
consulte el registro del sistema. Si el problema continúa incluso tras haber
puesto la unidad en el modo de espera o haberla apagado y encendido,
póngase en contacto con el servicio de asistencia técnica de Sony.

Parpadeo
rápido en
naranja*3

Parpadeo
rápido en
verde*3

Se ha producido una avería en la unidad. Póngase en contacto con el
representante del servicio de asistencia de Sony.

Parpadea en verde cuando se recibe una orden del control remoto infrarrojo suministrado.*1

Parpadeo lento: parpadea una vez por segundo.*2

Parpadeo rápido: parpadea cuatro veces por segundo.*3
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Tema relacionado

Advertencias de funcionamiento

Conexión de una señal de registro

Extracción de un objetivo

5-041-957-43(1) Copyright 2022 Sony Corporation

Sensor de control remoto infrarrojo
Recibe la señal de control desde el control remoto infrarrojo suministrado.

8.

Entrada de aire

Nota

No obstaculice el flujo de aire. Si lo hace, podría provocar una avería.

9.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista trasera

En este tema se describe la ubicación y la función de las piezas de la parte trasera de la unidad.

Tema relacionado

Vista lateral

5-041-957-43(1) Copyright 2022 Sony Corporation

Palanca de bloqueo del cabezal de la cámara
Bloquea el movimiento hacia delante/atrás del cabezal de la cámara.

Nota

Colóquela siempre en la posición de bloqueo cuando no cambie el objetivo.

Cuando transporte la unidad, retire siempre el objetivo y colóquelo en la posición de bloqueo.

Apague la alimentación de la unidad y bloquee el cabezal de la cámara horizontalmente con la palanca de bloqueo de
giro/inclinación antes de poner en funcionamiento la palanca de bloqueo para evitar que se pellizque los dedos y sufra
lesiones. Para obtener más detalles sobre la palanca de bloqueo de giro/inclinación, consulte “Palanca de bloqueo de
giro/inclinación” en “Vista lateral.”

1.

Base deslizante2.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bloque de conectores

En este tema se describe la ubicación y la función de las piezas del bloque de conectores de la unidad.

Conexión  (a tierra)
Establezca una conexión a tierra mediante la conexión al terminal de tierra de una toma de corriente o barra de
puesta a tierra.

1.

Conector DC IN (toma de CC estándar)
Conéctelo a un adaptador de CA.

Nota

No utilice ningún adaptador de CA salvo el suministrado. Si conecta otro adaptador, podría provocarse un incendio o una
avería.

2.

Conector  LAN (red) (RJ-45)
Conecte un cable de red (categoría 5e o superior) para la comunicación de red y el suministro de alimentación
PoE++*.

Estado de visualización del LED de velocidad
Indica la velocidad de la conexión de la red.

3.

PoE++: Power over Ethernet Plus Plus. De conformidad con IEEE802.3bt (tipo 4, clase 8). Para obtener más información acerca de la
conexión, consulte las instrucciones de funcionamiento del dispositivo de la fuente de alimentación.

*
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Estado de visualización del LED ACT/de enlace
Indica el estado de la conexión de la red.

Nota

Cuando conecte este producto a Internet, conéctelo mediante un sistema con función de protección como, por ejemplo, un
router o un firewall. Si se conecta sin dicha protección, pueden producirse problemas de seguridad.

Pantalla Velocidad de conexión

No iluminado
Conexión de 10 Mbps

Conexión de 100 Mbps

Iluminado en naranja Conexión de 1000 Mbps

Pantalla Estado de conexión

 No iluminado No hay enlace

Intermitente en verde Enlace establecido; datos activos

Iluminado en verde Enlace activo

Conector TC IN
Introduce una señal externa de códigos de tiempo de referencia.

Para obtener más detalles, consulte “Bloqueo del código de tiempo en otros dispositivos”.

4.

Conector HDMI
Emite el vídeo desde la unidad como una señal HDMI.

Para obtener más información, consulte “Conector HDMI (conector tipo A)” en “Conexión de dispositivos de
grabación y monitores externos”.

5.

Tornillo de montaje de la placa de retención del cable HDMI
Para evitar la extracción del cable HDMI, coloque la placa de retención del cable HDMI suministrada con la ayuda
del tornillo de montaje proporcionado (M2.6×6) y acople el cable HDMI con una cinta o brida disponible en el
mercado.

Para obtener más información acerca de cómo colocar la placa de retención del cable HDMI, consulte “Conexión
de los cables”.

6.

Conector OPTION
Utilícelo para conectar una señal de registro desde un dispositivo externo o un controlador del objetivo.

Para obtener más detalles, consulte “Conexión de una señal de registro” y “Conexión de un controlador del
objetivo”.

7.

Abrazadera de cables
Utilícela para fijar el cable del adaptador de CA.

8.

Interruptor RESET
Presiónelo durante al menos 5 segundos con la punta de un bolígrafo o similar para restablecer los ajustes de la
unidad a sus valores predeterminados de fábrica.
Es posible restablecer solo los ajustes de conexión de red o todos los ajustes con el interruptor SETUP 1.

9.

Conector de salida OPTICAL10.
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Emite una señal SDI convertida a formato óptico cuando se conecta un módulo SFP+ (opcional).

Para obtener más detalles, consulte “Emisión de una señal de fibra óptica”.
Interruptores SETUP

Permiten configurar los siguientes ajustes:
Interruptor 1: define qué ajustes se restablecen al pulsar el interruptor RESET.

Interruptor 2: establece si la fuente de alimentación de +48 V (alimentación fantasma) está encendida/apagada
cuando se conecta el dispositivo de entrada de audio. El ajuste se aplica de inmediato.
Esta función se activa cuando [Audio] > [Audio Input] > [AUDIO IN Select] se establece en [MIC] en el menú de la
cámara.

Nota

Si establece el interruptor 2 en la posición ON y conecta un micrófono que no sea compatible con fuentes de +48 V, es
posible que el dispositivo conectado sufra daños. Compruebe el ajuste antes de conectar el dispositivo.

Interruptor 3: activa/desactiva la comunicación VISCA over IP. Los ajustes se aplican cuando la cámara está
encendida.
Establézcalo en la posición ON para utilizar la unidad cuando se conecta a un controlador remoto (RM-IP500).

Nota

Si la contraseña del administrador no se ha configurado, la comunicación VISCA over IP estará desactivada,
independientemente del ajuste del interruptor. Para obtener más información acerca de la configuración de la contraseña del
administrador, consulte “Inicialización de la unidad”.

11.

Ajuste Descripción

OFF
(predeterminado)

Restablece solo los ajustes de conexión de red. Se restablecerán los ajustes de red y de
seguridad, así como la información del usuario (nombre de usuario y contraseña).

ON Restablece todos los ajustes a los valores predeterminados de fábrica.

Ajuste Descripción

OFF
(predeterminado)

No se suministra la alimentación de +48 V (fuente de alimentación fantasma). Configure este
ajuste cuando utilice un dispositivo de audio externo (por ejemplo, un mezclador), un
micrófono dinámico o un micrófono con batería integrada.

ON
Se suministra alimentación de +48 V (fuente de alimentación fantasma) a un micrófono
compatible con alimentación fantasma conectado al conector AUDIO IN (CH-1 o CH-2).

Ajuste Descripción

OFF (predeterminado) No responderá a los comandos de VISCA over IP.

ON Acepta los comandos de VISCA over IP.
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Tema relacionado

Bloqueo del código de tiempo en otros dispositivos

Conexión de dispositivos de grabación y monitores externos

Conexión de los cables

Conexión de una señal de registro

Conexión de un controlador del objetivo

Emisión de una señal de fibra óptica

Inicialización de la unidad

Sincronización de la fase de la señal de vídeo (Genlock)

Conexión de un micrófono externo o un dispositivo de audio externo

5-041-957-43(1) Copyright 2022 Sony Corporation

Interruptor 4: cambia la velocidad de las operaciones de giro/inclinación enviadas desde el control remoto infrarrojo.
El ajuste se aplica de inmediato.

Ajuste Descripción

OFF (predeterminado) Funciona a velocidad normal.

ON Funciona a máxima velocidad.

Conector SDI OUT
Emite el vídeo desde la unidad como una señal 12G/6G/3G/HD-SDI.
La unidad también se puede configurar para la salida de señal RAW.

Para obtener más detalles, consulte “Conector SDI OUT (tipo BNC)” en “Conexión de dispositivos de grabación y
monitores externos”.

12.

 Sensor de control remoto infrarrojo (trasero)
Sensor de infrarrojos para el control remoto infrarrojo suministrado.

13.

Salida del ventilador/aire
Emite calor desde dentro de la unidad.

Nota

No cubra la salida de aire. Si lo hace, podría provocar una avería.

Tenga en cuenta que la zona situada cerca de la salida de aire podría calentarse.

14.

Conector GENLOCK
Utilícelo para la entrada de una señal de sincronización externa.

Para obtener más detalles, consulte “Sincronización de la fase de la señal de vídeo (Genlock)”.

15.

Conector AUDIO IN (conector de 5 pines tipo XLR)
Utilícelo para la entrada de la señal desde un dispositivo de audio o micrófono externo.
Funciona como conector AUDIO IN CH-1 o AUDIO IN CH-2.

Para obtener más detalles, consulte “Conexión de un micrófono externo o un dispositivo de audio externo”.

16.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista lateral

En este tema se describe la ubicación y la función de las piezas de la parte lateral de la unidad.

Sugerencia

Esta descripción se refiere a la ilustración de la unidad sin el objetivo colocado.

Palanca de bloqueo de giro/inclinación
Bloquea el mecanismo de giro/inclinación de la unidad. Utilícela en los siguientes casos.

Cuando transporte o embale la unidad.
Cuando acople o extraiga un objetivo. Para obtener más información, consulte “Acople de un objetivo” o
“Extracción de un objetivo”.
Cuando utilice un objetivo que no admita la operación de giro/inclinación (por ejemplo, los objetivos Sony
SEL100400GM/SEL200600G/SEL400F28GM/SEL600F40GM).
Cuando transporte la unidad, retire siempre el objetivo y colóquelo en la posición de bloqueo.

1.
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Tema relacionado

Acople de un objetivo

Extracción de un objetivo

Introducción de las tarjetas de memoria

Acceso a la Aplicación Web desde un explorador web

5-041-957-43(1) Copyright 2022 Sony Corporation

Sugerencia

Es posible fijar el movimiento de giro/inclinación en los siguientes ángulos.

Base deslizante2.

Orificios de tornillos para dispositivos externos (4 lugares)
Para tornillos M3 de hasta 6 mm de longitud.

Nota

No utilice tornillos de más de 6 mm. Si lo hace, podría provocar una avería.

3.

Indicador de acceso A4.

Indicador de acceso B
El indicador se ilumina o parpadea cuando el soporte de grabación está insertado.

Para obtener más detalles, consulte “Introducción de las tarjetas de memoria”.

5.

Ranura de la tarjeta CFexpress Tipo A/SD (A)6.

Ranura de la tarjeta CFexpress Tipo A/SD (B)
Utilícela para insertar el soporte de grabación.

Para obtener más detalles, consulte “Introducción de las tarjetas de memoria”.

7.

Código QR para la conexión de red
Utilícelo para configurar los ajustes iniciales.

Para obtener más detalles, consulte “Acceso a la Aplicación Web desde un explorador web”.

8.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista superior

En este tema se describe la ubicación y la función de las piezas de la parte superior de la unidad.

Sugerencia

Esta descripción se refiere a la ilustración de la unidad sin el objetivo colocado.

5-041-957-43(1) Copyright 2022 Sony Corporation

Orificios de tornillos para dispositivos externos (2 lugares)
Compatibles con tornillos 1/4-20 UNC para trípode.
Longitud máxima de 6 mm.

1.

ɸ (marca de la cámara)
La marca de la cámara está situada en el mismo plano que el sensor de imagen.
Para medir la distancia entre la unidad y el sujeto de forma precisa, utilice esta marca de la cámara como punto de
referencia.

2.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista inferior

En este tema se describe la ubicación y la función de las piezas de la parte inferior de la unidad.

Sugerencia

Esta descripción se refiere a la ilustración de la unidad sin el objetivo colocado.

Orificios para tornillos de montaje en el soporte de techo (6 lugares, 5,5 mm de profundidad de roscado
efectiva)
Cuando monte la unidad en el techo o en una estantería colocada a gran altura, coloque el soporte para el cuerpo
(opcional) en la base de la unidad insertando los seis tornillos para montaje en el soporte para el cuerpo en sus
correspondientes orificios.

Para obtener más información acerca del montaje, consulte “Montaje en vertical en un lugar alto y fijo” y “Montaje
en techo”.

1.

Tornillos de montaje en trípode (2 lugares)2.
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Tema relacionado

Montaje en vertical en un lugar alto y fijo

Montaje en techo

5-041-957-43(1) Copyright 2022 Sony Corporation

Se utilizan cuando se monta la unidad en un trípode para cámaras (opcional, tornillos 1/4-20 UNC de hasta 5,5 mm
de longitud).

Nota

No utilice tornillos de más de 5,5 mm. Si lo hace, podría provocar una avería.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Soporte del objetivo

En este tema se describe la ubicación y la función de las piezas del soporte del objetivo de la unidad.

Sugerencia

Esta descripción se refiere a la ilustración de la unidad sin el objetivo colocado.

Varilla del soporte del objetivo (2)
Sujeta el objetivo.
También se puede utilizar para montar accesorios de varilla generales de Ø15.

1.
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Unidad de soporte del objetivo
El soporte del objetivo puede deslizarse hacia delante/atrás según el tipo y luego fijarse.

2.

Tornillo de acoplamiento del pedestal del soporte del objetivo
Colóquelo en el pedestal del soporte del objetivo. Es posible ajustar el tornillo hacia arriba/hacia abajo para que
coincida con el altura del pedestal del soporte del objetivo.

3.

Palanca de sujeción de la varilla de soporte del objetivo (2 lugares)
Fija la posición hacia delante/hacia atrás de la unidad de soporte del objetivo.

4.

Palanca de sujeción del tornillo de acoplamiento del pedestal del soporte del objetivo
Fija la posición vertical del tornillo de acoplamiento del pedestal del soporte del objetivo.

Sugerencia

Si una palanca de sujeción está en una posición que dificulta el giro, libérela y gírela hasta colocarla en un ángulo que facilite
el funcionamiento. Una vez esté en la posición deseada, ciérrela.

A: Palanca de sujeción del tornillo de acoplamiento del pedestal del soporte del objetivo
B: Palanca de sujeción de la varilla de soporte del objetivo

Nota

Para evitar que la unidad de soporte del objetivo interfiera en la operación de giro/inclinación, muévala hacia arriba cuando
no la esté usando (contra el cabezal de la cámara) y mueva el tornillo de acoplamiento del pedestal del soporte del objetivo
hasta su posición más alta (lo más cerca posible del objetivo).

5.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ubicación y función de las piezas del control remoto infrarrojo (suministrado)

En este tema se describe la ubicación y la función de las piezas del control remoto infrarrojo (suministrado).

Botón REC● (START/STOP de grabación)
Púlselo para iniciar o detener la grabación.

1.

Botón MENU
Púlselo para mostrar u ocultar el menú de la cámara.

2.

Botones de control de la GUI
Púlselos para realizar operaciones en el menú de la cámara y en los diálogos de los mensajes que incluyen botones,
así como para otras funciones de visualización de la pantalla.

3.

Botón CANC./BACK
Púlselo para cancelar un ajuste o para volver a la pantalla anterior del menú de la cámara de la unidad.

4.
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Batería del control remoto infrarrojo

El control remoto infrarrojo necesita dos baterías AA (LR6).
Introduzca las baterías en el control remoto infrarrojo tal y como se muestra en el siguiente diagrama.

Botones de control de giro e inclinación
Pulse los botones de las flechas para controlar el giro/inclinación de la cámara. Pulse el botón HOME para que la
orientación de la cámara vuelva a estar hacia delante.

5.

Botones de control de posición preajustada
Mantenga pulsado el botón PRESET y pulse uno de los botones del 1 al 3 para almacenar la dirección de la cámara,
el zoom y el estado de ajuste del enfoque en el botón del número pulsado.
Pulse uno de los botones con un número con los ajustes guardados para recuperar el estado guardado.

6.

Botones de control de enfoque
Utilícelos para ajustar el enfoque.
Para ajustar el enfoque automáticamente, pulse el botón AF.
Para ajustar el enfoque manualmente, pulse el botón MF y, a continuación, pulse el botón F (lejos) para enfocar a los
sujetos que están lejos o el botón N (cerca) para enfocar a los sujetos que están cerca.

7.

Botones asignables del 1 al 3
Ejecuta las funciones asignadas a cada uno de los botones asignables a través del menú de la cámara.
Si asigna la función [Direct Menu] a un botón asignable, podrá ajustar la exposición, el balance de blancos y otros
ajustes con los botones de control de la GUI.

Para obtener más información acerca de la asignación con el menú de la cámara, consulte “Botones asignables”.

Para obtener más información acerca del menú directo, consulte “Funcionamiento del menú directo”.

8.

Botón  (encendido)
Púlselo para encender la unidad o para cambiar la fuente de alimentación al estado de espera.

9.

Botón THUMBNAIL
Muestra la pantalla de imágenes en miniatura en la que se visualizan los clips grabados en la tarjeta de memoria de
la unidad.

Para obtener más información acerca de la pantalla de imágenes en miniatura, consulte “Pantalla de imágenes
en miniatura”.

Puede seleccionar clips y controlar su reproducción en la pantalla de imágenes en miniatura a través de los botones
de control de la GUI.

Para obtener más información acerca de cómo seleccionar clips y controlar su reproducción, consulte
“Reproducción de clips grabados” y “Operaciones en clips grabados”.

10.

Botón SLOT SEL (selección de ranura de tarjeta de memoria (A)/(B))
Si introduce dos tarjetas de memoria, pulse este botón para cambiar la tarjeta de memoria en la que desea grabar.
Pulse este botón cuando la pantalla de imágenes en miniatura se esté mostrando para cambiar entre las tarjetas de
memoria que desee visualizar.

11.

Botón P/T RESET (restablecimiento de giro/inclinación)
Restablece las funciones de giro/inclinación. Pulse este botón cuando las luces indicadora POWER y NETWORK
estén parpadeando simultáneamente o cuando se muestre el botón [Execute Pan-Tilt Reset] en el panel de control
de encuadre en la Aplicación Web.

12.

Botones de control del zoom
Para acercar la imagen, pulse el botón T (telefoto).
Para alejar la imagen, pulse el botón W (gran angular).

13.
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Nota

Utilice únicamente baterías alcalinas o de manganeso; si no lo hace, podrían romperse.

Deseche las baterías usadas de acuerdo con las leyes y normativas de su país o región.

Tema relacionado

Botones asignables

Funcionamiento del menú directo

Pantalla de imágenes en miniatura

Reproducción de clips grabados

Operaciones en clips grabados

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Descripción general de la pantalla de la Aplicación Web

Si conecta una tablet u ordenador, podrá efectuar las funciones de giro/inclinación y zoom, así como grabar, reproducir
vídeos grabados y configurar la unidad a través de un explorador web (de aquí en adelante, llamaremos a esta función
“Aplicación Web”).

Para obtener más detalles sobre cómo iniciar la Aplicación Web, consulte “Acceso a la Aplicación Web desde un
explorador web”.

Nota

La Aplicación Web no admite la salida de audio de la cámara.

Cuando se abre la Aplicación Web, aparece la siguiente pantalla de operación en directo.

Pantalla de operación en directo

Para obtener más detalles sobre la pantalla de operación en directo, consulte “Estructura de la pantalla de operación
en directo”.
Los botones e iconos que comparten la pantalla de operación en directo y la pantalla de operación de reproducción
se muestran en la parte superior de la pantalla.
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Para obtener más detalles sobre el área común de las pantallas, consulte “Estructura del área común de las
pantallas”.
Para cambiar entre las pantallas, pulse las pestañas de cambio de pantalla en el área común.

Pantalla de operación de reproducción

Pulse la pestaña [Playback] para mostrar la pantalla de operación de reproducción.

Para obtener más detalles sobre la pantalla de operación de reproducción, consulte “Estructura de la pantalla de
operación de reproducción”.

Pantalla de ajustes

Pulse la pestaña [Settings] para visualizar la pantalla de ajustes (de aquí en adelante, el “menú web”).
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Nota

En el menú web, los ajustes no se aplicarán hasta que pulse el botón [OK]. Si modifica los ajustes de una página que contiene
un botón [OK], asegúrese de pulsar dicho botón [OK].

Para obtener más detalles sobre la pantalla de ajustes, consulte “Estructura de la pantalla de ajustes”.
En esta Guía de Ayuda, la pantalla de ajustes de la Aplicación Web se denomina “menú web”.

Tema relacionado
Acceso a la Aplicación Web desde un explorador web

Estructura de la pantalla de operación en directo

Estructura del área común de las pantallas

Estructura de la pantalla de operación de reproducción

Estructura de la pantalla de ajustes

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Estructura del área común de las pantallas

En este tema se describe la estructura del área común de las pantallas.

Nombre de la cámara
Muestra el nombre de la cámara.
Para cambiar el nombre, vaya a [Network] > [Camera Name] en el menú web.
El color de fondo cambia en función de la señal de registro externa.

1.

Interruptor de alimentación
Si la unidad está encendida, se muestra [Power ON]. Pulse el interruptor y seleccione [Power Standby] para definir la
fuente de alimentación de la unidad en el estado de espera.
Si se muestra [Power Standby], pulse el interruptor y seleccione [Power ON] para activar la fuente de alimentación
de la unidad.

2.

Pestañas de cambio de la pantalla de operación
Pulse una pestaña para mostrar la pantalla de operación correspondiente.
Pestaña [Live]: muestra la pantalla de operación en directo.
Pestaña [Playback]: muestra la pantalla de operación de reproducción.
Pestaña [Settings]: muestra la pantalla de ajustes (menú web).

3.

Señal de notificaciones
Cuando llega un mensaje, la indicación cambia como se muestra a continuación.

 (Notificaciones activadas)
Tome las medidas necesarias según el mensaje mostrado en el panel de imagen de la cámara.

Nota

Los mensajes no se muestran si la opción [Monitoring] > [Output Display] > [HDMI/Stream] está definida en [Off] en el menú
web. Para comprobar el contenido de los mensajes, ajústela en [On].

4.

Botón  (estado de la cámara)
Pulse este botón para visualizar la información de la señal de la imagen de salida/imagen grabada en la cámara y el
estado de controlador (opción) del objetivo en otra pantalla.

5.
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Cuando se produce una notificación relacionada con el controlador (opción) del objetivo, la indicación cambia como
se muestra a continuación.

Interruptor de bloqueo de la operación en pantalla
 (Desbloqueo de la operación): sitúe el interruptor a la izquierda para controlar las operaciones de la pantalla

de operación en directo y de la pantalla de operación de reproducción.
 (Bloqueo de la operación): sitúe el interruptor a la derecha para bloquear las operaciones de la pantalla de

operación en directo y de la pantalla de operación de reproducción y evitar así fallos accidentales en la operación.

6.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Estructura de la pantalla de operación en directo

En este tema se describe la estructura de la pantalla de operación en directo.

Panel de control de la posición preajustada
Muestra la posición registrada de un ajuste preestablecido con una imagen en miniatura. Pulse dos veces en la
imagen en miniatura para volver a la posición almacenada en el ajuste preestablecido.

Para obtener más detalles sobre la posición preajustada, consulte “Almacenamiento/restablecimiento de la
posición de giro/inclinación, la posición del zoom y el ajuste de enfoque con la Aplicación Web”.
Para obtener más información sobre el rastreo de PTZ, consulte “Grabación de operaciones de encuadre de la
cámara mediante la Aplicación Web”.

1.

Panel de imagen de la cámara
Muestra la imagen actual de la cámara y el estado de la unidad.
Muestra la misma imagen que la salida HDMI.
El siguiente estado se muestra encima de la imagen. Además, se muestra un marco rojo o un marco verde alrededor
de la imagen en función de la señal de registro externa recibida.

2.
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Botón [Display]
Pulse este botón para mostrar la información de la cámara en la imagen.
Púlselo de nuevo mientras se muestra la información de la cámara para ocultarla.

Además de los marcadores, algunos mensajes e indicadores relacionados con el enfoque automático se muestran
según el estado y no pueden ocultarse pulsando el botón [Display].

Para obtener más detalles acerca de la información sobre la cámara mostrada, consulte “Visualización de la
pantalla de la cámara”.

N.º Pantalla Descripción

2-
1

Indicador de modo de enfoque
Consulte “Indicador de modo de enfoque” en “Visualización de la
pantalla de la cámara”.

2-
2

Modo de grabación, ranura A/B,
indicador de intervalo de grabación
Interval Rec

Consulte “Modo de grabación, ranura A/B, indicador de intervalo
de grabación Interval Rec” en “Visualización de la pantalla de la
cámara”.

2-
3

Indicador de estado de la transmisión
Se muestra durante la transmisión (solo cuando la opción [Stream
Setting] está definida en [RTMP] o [SRT-Caller]).

2-
4

Indicador de estado de funcionamiento
de la salida RAW

Muestra el estado de salida de la señal RAW. Para obtener más
información acerca de RAW, consulte “Grabación de vídeo RAW”.

2-
5

Indicador de capacidad restante de los
soportes

Consulte “Indicador de capacidad restante de los soportes” en
“Visualización de la pantalla de la cámara”.

2-
6

Indicador de posición del zoom

Consulte “Indicador de posición del zoom” en “Visualización de la
pantalla de la cámara”.
Cuando un controlador del objetivo (opcional) está conectado, se
muestra . Si se produce un error en el controlador del objetivo
(opcional), se muestra .

2-
7

Indicador de modo AE/nivel AE
Consulte “Indicador de modo AE/nivel AE” en “Visualización de la
pantalla de la cámara”.
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Botón de detención de AF de seguimiento en tiempo real
Pulse este botón para detener el seguimiento de un sujeto.

Para obtener más información, consulte “Seguimiento de un sujeto especificado (Realtime Tracking AF)”.
Botón START/STOP de grabación
Pulse este botón para comenzar a grabar. Durante la grabación, el botón START/STOP de grabación se ilumina en
color rojo.
Púlselo durante la grabación para dejar de grabar.
Puede definir el interruptor Hold en el estado Hold para evitar el funcionamiento incorrecto del botón START/STOP
de grabación.

3.

Panel de configuración básica de la cámara
Muestra los ajustes para las funciones básicas necesarias para los botones de filmación. Pulse un botón para
visualizar la pantalla de configuración correspondiente a cada una de las funciones en el panel de ajuste de la
configuración básica de la cámara siguiente (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Para obtener más información, consulte la descripción de cada una de las funciones.

4.

Función Referencia

FPS “Movimiento a cámara lenta y rápida”

ISO/Gain
“Ajuste de la sensibilidad base”, “Ajuste automático de la ganancia” y “Ajuste manual de la
ganancia” en “Ajuste de la ganancia”

Exposure
Index

“Ajuste de la sensibilidad base” y “Cambio de la distribución de las áreas oscuras e iluminadas en
la imagen grabada”

Shutter “Ajuste automático del obturador” y “Ajuste manual del obturador” en “Ajuste del obturador”

Iris “Ajuste automático del diafragma” y “Ajuste manual del diafragma” en “Ajuste del diafragma”

ND Filter “Acerca del filtro ND” en “Ajuste del nivel de luz (filtro ND)”

Scene File “Descripción general del aspecto” y otros temas en “Filmación con el aspecto deseado”
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Función Referencia

Base
Look/LUT

“Filmación con ajuste del aspecto en posproducción”

White
Balance

“Pantalla de ajuste del balance de blancos”

Panel de ajuste de la configuración básica de la cámara/botones asignables
Muestra los botones asignables durante el funcionamiento normal. Pulse los botones del panel de configuración
básica de la cámara (elemento 4) para mostrar los elementos de configuración correspondientes. Pulse el botón [X]
o el botón del panel de configuración de la cámara de nuevo para volver a la pantalla de botones asignables.

Para obtener más información acerca de los botones asignables, consulte “Botones asignables”.
Para obtener más información acerca del panel de ajuste de la configuración básica de la cámara, consulte la
descripción de cada una de las funciones.

5.

Panel de control encuadre/panel de control de la GUI
Cambie entre el panel de control de encuadre y el panel de control de la GUI con las pestañas que aparecen en la
parte superior.
Puede pulsar el botón  (cerrar) en la parte superior derecha de la pantalla para ocultar el panel de control y evitar
operaciones accidentales. Si el panel de control no se muestra, pulse el botón  (abrir) para mostrarlo.
Ajuste el encuadre en el panel de control de encuadre. Pulse la pestaña  (Giro/inclinación/zoom) para
mostrar el panel de control de encuadre.

Para obtener más detalles acerca del funcionamiento, consulte “Ajuste del encuadre”.

Sugerencia

La parte de la palanca de mando del panel de control de encuadre se muestra tal y como aparece a continuación cuando la
operación de giro/inclinación está desactivada y cuando es necesaria su inicialización.

Cuando la operación de giro/inclinación se ha bloqueado con la palanca de bloqueo de giro/inclinación

6.
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Cuando la operación de giro/inclinación no se ha inicializado

Cuando es necesario restablecer la operación de giro/inclinación

Cuando la operación de giro/inclinación está deshabilitada

Si la operación de giro/inclinación no se ha inicializado y debe restablecerse, puede acceder rápidamente al botón 
(restablecimiento del giro/inclinación) del panel de control de la cámara si pulsa el mensaje que se muestra debajo de la
palanca de mando.

Utilice el panel de control de la GUI para controlar el menú de la cámara, la reproducción de clips y otras funciones.
Pulse la pestaña  (GUI de la cámara) para mostrar el panel de control de la GUI.
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Para obtener más información acerca del funcionamiento, consulte “Funcionamiento del menú de la cámara” y
“Reproducción de clips grabados”.

Panel de control de la cámara
Utilícelo para configurar las funciones necesarias para controlar la cámara.
Cambie entre las pantallas que se mostrarán con las pestañas que aparecen en la parte superior.
Puede pulsar el botón  (cerrar) en la parte superior derecha de la pantalla para ocultar el panel de control y evitar
operaciones accidentales. Si el panel de control no se muestra, pulse el botón  (abrir) para mostrarlo.

Para obtener más información, consulte la descripción de cada una de las funciones.

Pestaña  (Main)
Muestra los elementos de configuración de las funciones que se utilizan con frecuencia.
Para cambiar las funciones de los controles deslizantes superior e inferior, pulse el botón [▼] y seleccione un valor
de la lista mostrada. Es posible seleccionar las siguientes funciones.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Pestaña  (Focus)
Muestra los elementos de configuración relacionados con el enfoque.

7.

Se visualiza según los ajustes del menú.*
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 Pestaña  (Audio)

Muestra los elementos de configuración relacionados con el audio.

Pestaña  (Stream)
Muestra los elementos de configuración relacionados con la transmisión.
Los elementos mostrados variarán en función de la configuración de formato de la transmisión.
Si esta opción está definida en [RTMP] o [SRT-Caller], es posible iniciar/detener la transmisión en esta pantalla.

Para obtener más detalles, consulte “Acerca de la transmisión” y otros temas en “Configuración de la
transmisión”.
Se muestra un mensaje de error si se produce un fallo en la conexión. Para obtener más detalles acerca del
mensaje de error, consulte “Advertencias de funcionamiento”.
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Tema relacionado

Almacenamiento/restablecimiento de la posición de giro/inclinación, la posición del zoom y el ajuste de enfoque con
la Aplicación Web

Grabación de operaciones de encuadre de la cámara mediante la Aplicación Web

Visualización de la pantalla de la cámara

Grabación de vídeo RAW

Seguimiento de un sujeto especificado (Realtime Tracking AF)

Pestaña  (Others)
Muestra los elementos de configuración relacionados con otras funciones.

Al pulsar el botón [Full Screen Display] se abre una pestaña nueva en el explorador web y se muestra la imagen del
panel de imagen de la cámara a pantalla completa.
Solo se muestra la imagen; AF por toque y otras funciones no están disponibles.

Nota

La pantalla de operación en directo en la pestaña original sigue funcionando. Se recomienda cerrar la pestaña para reducir el
número de conexiones simultáneas si no necesita hacer ninguna operación.

Pulse el botón  (Inicializar controlador del objetivo) para inicializar el controlador del objetivo (opción
de terceros). Este botón solo se activa cuando [Technical] > [Lens Controller] > [Zoom] > [Setting] se establece en
[On] en el menú web.
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Movimiento a cámara lenta y rápida

Ajuste de la sensibilidad base

Ajuste automático de la ganancia

Ajuste manual de la ganancia

Cambio de la distribución de las áreas oscuras e iluminadas en la imagen grabada

Ajuste automático del obturador

Ajuste manual del obturador

Ajuste automático del diafragma

Ajuste manual del diafragma

Acerca del filtro ND

Descripción general del aspecto

Filmación con ajuste del aspecto en posproducción

Pantalla de ajuste del balance de blancos

Botones asignables

Reproducción de clips grabados

Funcionamiento del menú de la cámara

Acerca de la transmisión

Advertencias de funcionamiento

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Estructura de la pantalla de operación de reproducción

En este tema se describe la estructura de la pantalla de operación de reproducción.

Panel de imagen de la cámara
Muestra la imagen en reproducción y su información. Cuando la reproducción se detiene, aparece la pantalla de la
imagen de la cámara.

1.
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1-1 Fecha y hora de filmación
1-2 Indicador de estado de reproducción
1-3 Indicador de formato de reproducción (tamaño de imagen)
1-4 Indicador de formato de reproducción (códec)
1-5 Visualización del nombre del clip
1-6 Número del clip/número total de clips
1-7 Visualización del nombre de LUT
1-8 Indicador de estado de la transmisión
1-9 Indicador de formato de reproducción (velocidad de fotogramas y método de exploración)
1-10 Indicador de aspecto de grabación

Panel de control de reproducción

Muestra los botones del control de reproducción.

Botón [Display]
Púlselo para cambiar entre las imágenes visualizadas en la pantalla.
Botón [Thumbnail]
Muestra en el panel de imagen de la cámara los clips grabados en la tarjeta de memoria en forma de miniaturas.

2.

Botón Función

Botón  (reproducir/pausar) Reproduce un clip. Durante la reproducción, pausa el clip.

Botón  (avance rápido), botón 
(rebobinado rápido)

Reproduce un clip a alta velocidad. Cuando se pulsa este botón, la
velocidad de reproducción cambia en tres pasos.

Botón  (siguiente), botón 
(anterior)

Salta al inicio del clip o al clip anterior/siguiente.

Botón  (detener) Detiene la reproducción.
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Tema relacionado
Pantalla de imágenes en miniatura

Botones asignables

Reproducción de clips grabados

5-041-957-43(1) Copyright 2022 Sony Corporation

Si pulsa el botón [Thumbnail] mientras está visualizando la pantalla de imágenes en miniatura, se cerrará la pantalla
de imágenes en miniatura y volverá a la imagen de la cámara.

Para obtener más información acerca de la pantalla de imágenes en miniatura, consulte “Pantalla de imágenes
en miniatura”.

Botón [Slot Select]
Cambia entre los soportes de reproducción objetivo.

Botones asignables
Muestra los botones asignables asignados a las funciones de la unidad.

Para obtener más información acerca de los botones asignables, consulte “Botones asignables”.

3.

Panel de control de la GUI
Utilice el panel de control de la GUI para controlar el menú de la cámara, la reproducción de clips y otras funciones.

Para obtener más información acerca del funcionamiento, consulte “Funcionamiento del menú de la cámara” y
“Reproducción de clips grabados”.

4.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Estructura de la pantalla de ajustes

Utilice la pantalla de ajustes para configurar los distintos elementos de configuración de la unidad, incluidos los ajustes
iniciales, los ajustes de red y los ajustes de filmación/reproducción a través del menú web.

Nota

En el menú web, por lo general, los ajustes no se aplicarán hasta que pulse el botón [OK]. Si modifica los ajustes de una página
que contiene un botón [OK], asegúrese de pulsar dicho botón [OK].

Para obtener más detalles sobre la pantalla de ajustes, consulte “Menú web y ajustes detallados”.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Menú de la cámara

Pulse el botón [Menu] en el panel de control de la GUI de la pantalla de operación en directo o la pantalla de operación
de reproducción para mostrar el menú de la cámara en el panel de imagen de la cámara.

Puede configurar los ajustes necesarios para filmar y reproducir con el menú de la cámara.
Pulse el botón [Menu] mientras se muestra el menú de la cámara para ocultarlo.
El menú de la cámara se controla con el panel de control de la GUI.

Para obtener más detalles sobre el menú de la cámara, consulte “Menú de la cámara y ajustes detallados”.

Nota

Cuando [Monitoring] > [Output Display] > [HDMI/Stream] se ha definido en Off en el menú web (desactivando la superposición de
información en la visualización de la pantalla), el menú de la cámara ya no se muestra en el panel de imagen de la cámara. Sin
embargo, debe tener en cuenta que las operaciones de menú en el panel de control de la GUI continúan estando activadas. Para
evitar operaciones accidentales, procure no realizar operaciones de menú con el panel de control de la GUI cuando
[HDMI/Stream] esté definido en Off.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Visualización de la pantalla de la cámara

Puede mostrar el estado y los ajustes de la unidad superpuestos en la imagen de salida desde la cámara. Es posible
definir las salidas para las que se habilita la visualización de la pantalla en [Monitoring] > [Output Display] en el menú
web.
Puede mostrar/ocultar la información con el botón [Display]. Aunque esté oculta, aparecerá mientras se realizan
operaciones en el menú directo.
Puede mostrar/ocultar elementos individuales con [Monitoring] > [Display On/Off] en el menú de la cámara.

Información mostrada en la pantalla durante la filmación

Indicador de carga/indicador de archivos restantes

Para obtener más información acerca de la transferencia de archivos, consulte “Acerca de la transferencia de
archivos” y otros temas en “Transferencia de archivos”.

1.

Indicador de área de enfoque
Muestra el área de enfoque para el enfoque automático.

Para obtener más información acerca del enfoque automático, consulte “Ajuste automático mediante la
Aplicación Web” y otros temas en “Ajuste automático del enfoque (Auto Focus)”.

2.

Modo de grabación, ranura A/B, indicador de intervalo de grabación Interval Rec

Para obtener más información acerca de Interval Rec, consulte “Grabación de vídeo de manera intermitente
(Interval Rec)”.

3.

Pantalla Significado

●Rec Grabación

Stby Grabación en espera
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Indicador de profundidad de campo4.

Indicador de modo de escaneado de la cámara
Se muestra una marca  (discrepancia) si hay una discrepancia entre el tamaño del círculo de la imagen del
objetivo y el ajuste del modo de escaneado de la cámara del tamaño de imagen efectivo.
Cuando Imager Scan Mode está ajustado en FF, aparece una marca “C” en los modos con un ángulo de visión más
reducido (recortado).
El recorte se produce en los siguientes modos:

Cuando el formato de grabación es 3840×2160 y la velocidad de fotogramas de S&Q Motion es 100 fps o 120 fps
Cuando [Codec] está ajustado en RAW o RAW & XAVC-I y el formato de salida RAW es 3840×2160
Para obtener más información acerca del modo de escaneado de la cámara, consulte “Ajuste del modo de
escaneado de la cámara” en “Configuración del funcionamiento básico”.

5.

Indicador de estado de funcionamiento de la salida RAW
Muestra el estado de salida de la señal RAW.

Para obtener más información acerca de RAW, consulte “Grabación de vídeo RAW”.

6.

Indicador de la velocidad de fotogramas a cámara lenta y rápida

Para obtener más información acerca del movimiento a cámara lenta y rápida, consulte “Movimiento a cámara
lenta y rápida”.

7.

Indicador de posición del enfoque

Muestra la posición del enfoque.

8.

Indicador de modo de enfoque

AF de detección de caras/ojos

Para obtener información detallada acerca del AF de detección de caras/ojos, consulte “Seguimiento usando
detección de caras y ojos (Face/Eye Detection AF)”.

9.

Pantalla Significado

Focus Hold Modo Focus Hold

MF Modo MF

AF Modo AF

 (Modo AF de seguimiento en tiempo real) Modo AF de seguimiento en tiempo real

Pantalla Significado

 (AF de detección de caras/ojos) Indica que el AF de detección de caras/ojos está activo

 (AF solo de caras/ojos) Indica que el AF solo de caras/ojos está activo

 (cara de seguimiento guardada) Indica que se ha guardado una cara de seguimiento

 (AF pausado) Indica que el AF se ha pausado*

Aparece cuando no hay una cara de seguimiento guardada y no se detecta una cara, o cuando hay una cara de seguimiento guardada y no
se detecta la cara objetivo del seguimiento.

*
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Indicador de posición del zoom
Muestra la posición del zoom en el rango de 0 (gran angular) a 99 (telefoto) (si se acopla un objetivo compatible con
la pantalla de posición de zoom).
Es posible cambiar el indicador a una visualización de barras o visualización de distancia focal a través del ajuste
[Technical] > [Lens] > [Zoom Position Display] del menú de la cámara.
Los siguientes elementos se añaden a la pantalla cuando Clear Image Zoom está activado.

Para obtener más información acerca del zoom, consulte “Ajuste del tipo de zoom” y otros temas en “Ajuste del
zoom”.

10.

Pantalla Significado

 (Clear Image Zoom está activado) Clear Image Zoom está activado

Valor de ampliación Cuando se utiliza Clear Image Zoom

Indicador de modo de estabilización de la imagen11.

Indicador de estado de Rec Control de salida SDI/HDMI
Muestra el estado de salida de la señal de control REC.

Para obtener más información, consulte “Conexión de dispositivos de grabación y monitores externos”.

12.

Indicador de enfoque

Para obtener más detalles, consulte “Uso de Enfoque automático de una sola toma (Push Auto Focus (AF-S))” en
“Ajuste del enfoque”.

13.

Indicador de capacidad restante de los soportes
Si la tarjeta de memoria está protegida contra escritura, aparece un icono  (protegida).

14.

Indicador de modo de balance de blancos15.

Pantalla Significado

 (ATW) Modo Auto

 (ATW Hold) Modo Auto pausado

W:P Modo predeterminado

W:A Modo de Memoria A

Indicador de bloqueo de código de tiempo externo/pantalla de datos sobre el tiempo
Muestra “EXT-LK” cuando está bloqueado con el código de tiempo de un dispositivo externo.

Para obtener más información acerca del código de tiempo, consulte “Especificación de los datos de tiempo”.

16.

Indicador del filtro ND17.

Pantalla Significado

 (A) Modo Auto

 (B) Modo de control del bokeh
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Para obtener más información acerca de los filtros ND, consulte “Ajuste del nivel de luz (filtro ND)”.
Para obtener más información acerca del control del bokeh, consulte “Ajuste del bokeh (función de control del
bokeh)”.

Indicador de archivos de escena

Para obtener detalles sobre los archivos de escena, consulte “Descripción general del aspecto” y otros temas en
“Filmación con el aspecto deseado”.

18.

Indicador de diafragma
Muestra la posición del diafragma (valor F) (si se acopla un objetivo compatible con la pantalla de configuración del
diafragma).

Para obtener más detalles acerca del diafragma, consulte “Ajuste automático del diafragma” y “Ajuste manual del
diafragma”.

19.

Indicador del advertencia del nivel de vídeo20.

Indicador de ganancia
Muestra el valor EI cuando está en el modo Cine EI/Cine EI Quick.

Para obtener más detalles sobre la ganancia, consulte “Ajuste automático de la ganancia” y “Ajuste manual de la
ganancia”.
Para obtener más información acerca del modo Cine EI/Cine EI Quick, consulte “Ajuste del modo de filmación”
en “Configuración del funcionamiento básico”.

21.

Pantalla Significado

 (A) Modo Auto

L Modo L predeterminado

 (Modo de ajuste temporal) Modo de ajuste temporal

 (B) Modo de control del bokeh

Visualización del nombre del clip
Muestra el nombre del clip que se está grabando o se grabará a continuación.
Si parpadea, hay una discrepancia entre el último clip del soporte de grabación y los ajustes [Camera ID] o [Reel
Number]. Para obtener más información, consulte la descripción [Clip Name Format] > [Auto Naming].

22.

Indicador de obturación

Para obtener más detalles acerca del obturador, consulte “Ajuste automático del obturador” y “Ajuste manual del
obturador”.

23.

Indicador de modo AE/nivel AE

Para obtener más detalles sobre la exposición automática (AE), consulte “Establecimiento del nivel deseado para
el ajuste de brillo automático”.

24.

Indicador de nivel de burbuja
Muestra el nivel horizontal en intervalos de ±1° hasta ±15°.

25.

Medidor del nivel de audio
Muestra el nivel de audio de cada canal.

26.

Monitor de señal de vídeo27.
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Información mostrada en la pantalla durante la reproducción

La siguiente información se superpone sobre la imagen reproducida.

Muestra una forma de onda, un vectorscopio y un histograma.
La línea naranja indica el valor establecido del marcador de nivel de brillo.
En los modos de filmación Log, el tipo de LUT del objetivo del monitor se muestra encima de la pantalla.

Para obtener más información, consulte “Monitor de señal de vídeo”.
Para obtener más información acerca de los modos de filmación Log, consulte “Ajuste del modo de filmación” en
“Configuración del funcionamiento básico”.

Indicador Base Sensitivity/indicador Base ISO
En el modo Custom, muestra la sensibilidad base establecida a través del botón [ISO/Gain / Exposure Index] en el
panel de configuración básica de la cámara o en [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] en el menú de la
cámara.
En los modos de filmación Log, muestra la sensibilidad Base ISO establecida a través del botón [ISO/Gain /
Exposure Index] en el panel de configuración básica de la cámara o en [Shooting] > [ISO/Gain/EI] > [Base ISO] en el
menú de la cámara.

Para obtener más información acerca de la sensibilidad base, consulte “Selección de la sensibilidad base”.
Para obtener más información acerca de los modos de filmación Log, consulte “Ajuste del modo de filmación” en
“Configuración del funcionamiento básico”.

28.

Indicador de aspecto de supervisión
En los modos de filmación Log, se muestra el ajuste de LUT.

Para obtener más información acerca del ajuste de LUT, consulte “Filmación con ajuste del aspecto en
posproducción” y temas relacionados.
Para obtener más información acerca de los modos de filmación Log, consulte “Ajuste del modo de filmación” en
“Configuración del funcionamiento básico”.

29.

Indicador de aspecto básico/aspecto de grabación
Muestra el ajuste de Base Look.
En los modos de filmación Log, se muestra la señal de vídeo para grabar en las tarjetas de memoria.

Para obtener más información acerca del aspecto básico, consulte “Descripción general del aspecto” en
“Filmación con el aspecto deseado”.
Para obtener más información acerca de los modos de filmación Log, consulte “Ajuste del modo de filmación” en
“Configuración del funcionamiento básico”.

30.

Indicador de estado de proxy31.

Indicador de formato de grabación (códec)
Muestra el nombre del formato de grabación en las tarjetas de memoria.
Defina el formato de grabación (códec) en [Project] > [Rec Format] > [Codec] en el menú web o en el menú de la
cámara.

32.

Indicador de formato de grabación (velocidad de fotogramas y método de exploración)33.

Indicador de formato de grabación (tamaño de imagen)
Muestra el tamaño de imagen para grabaciones en las tarjetas de memoria.
Defina el formato de grabación (tamaño de imagen) en [Project] > [Rec Format] > [Codec] en el menú web o en el
menú de la cámara.

34.

Indicador de registro
Muestra un marco rojo o un marco verde alrededor de la imagen en función de la señal de registro externa recibida.

35.
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Tema relacionado

Acerca de la transferencia de archivos

Ajuste automático mediante la Aplicación Web

Grabación de vídeo de manera intermitente (Interval Rec)

Configuración del funcionamiento básico

Grabación de vídeo RAW

Movimiento a cámara lenta y rápida

Indicador de carga/indicador de archivos restantes1.

Número del clip2.

Indicador de estado de reproducción3.

Indicador de formato de reproducción (velocidad de fotogramas y método de exploración)4.

Indicador de formato de reproducción (tamaño de imagen)5.

Indicador de formato de reproducción (códec)6.

Indicador de soporte
Si la tarjeta de memoria está protegida contra escritura, aparece un icono  (protegida).

7.

Visualización de datos de tiempo8.

Visualización del nombre del clip9.

Indicador de la pantalla asistida de gamma10.

Medidor del nivel de audio
Muestra el nivel de reproducción de audio.

11.

Indicador de aspecto básico/aspecto de grabación12.

Indicador de registro13.

63



Seguimiento usando detección de caras y ojos (Face/Eye Detection AF)

Ajuste del tipo de zoom

Conexión de dispositivos de grabación y monitores externos

Uso de Enfoque automático de una sola toma (Push Auto Focus (AF-S))

Especificación de los datos de tiempo

Descripción general del aspecto

Ajuste automático del diafragma

Ajuste manual del diafragma

Ajuste automático de la ganancia

Ajuste manual de la ganancia

Ajuste automático del obturador

Ajuste manual del obturador

Establecimiento del nivel deseado para el ajuste de brillo automático

Monitor de señal de vídeo

Filmación con ajuste del aspecto en posproducción

Clip Name Format

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaje en vertical en un lugar fijo

En este tema se describe cómo montar la unidad sobre una mesa o trípode.

Nota acerca de la instalación
Para proteger el objetivo y el bloque de conectores del objetivo de la unidad, mantenga la tapa y la cubierta de la
unidad unidos hasta que fije el objetivo.
Para evitar fallos en el objetivo, no sujete las piezas del objetivo mientras está en funcionamiento.
Para evitar fallos en la unidad, no sujete el cabezal de la cámara mientras está en funcionamiento.

Compruebe el espacio de montaje.

Montaje en una mesa
Monte la unidad sobre una superficie plana teniendo en cuenta el espacio necesario para girar el objetivo y para el
cableado de la parte posterior de la unidad.

Nota

Móntela sobre un lugar estable que no reciba vibraciones. Los entornos que podrían recibir vibraciones pueden provocar
vibraciones en la imagen.

Si necesita montar la unidad sobre una superficie inclinada, manténgala a ±15° de la línea horizontal y tome las medidas
necesarias para evitar que caiga.

Montaje en un trípode
Fije el trípode en el orificio para el tornillo de montaje en trípode que encontrará en la parte inferior.
Utilice un tornillo para montaje en trípode que sobresalga de la superficie de montaje la cantidad que se indica a
continuación y apriételo con un destornillador de mano.

A: Tornillos de montaje en trípode 1/4-20 UNC, ISO 1222 (6,35 mm)

1
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A continuación, acople el objetivo. Consulte “Acople de un objetivo,” teniendo en cuenta la información de “Precauciones
a la hora de acoplar/retirar un objetivo,” “Comprobación de los interruptores del objetivo” y “Precauciones al utilizar un
objetivo con zoom”.

Tema relacionado

Precauciones a la hora de acoplar/retirar un objetivo

Comprobación de los interruptores del objetivo

Precauciones al utilizar un objetivo con zoom

Acople de un objetivo

5-041-957-43(1) Copyright 2022 Sony Corporation

B: Saliente (de 4,5 mm a 5,5 mm)

No utilice los tornillos para trípode para montar la unidad en un lugar alto.

Nota

Elija un trípode que no tenga peligro de volcar al girar el objetivo.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaje en vertical en un lugar alto y fijo

En este tema se describe el procedimiento para montar la unidad en posición vertical en un lugar alto con la ayuda del
soporte de techo (CIB-PCM1 (opcional)).

Para montar la unidad en un lugar alto, consulte a un contratista profesional.
Cuando monte la unidad en un lugar alto, asegúrese de que la superficie y los materiales de montaje (excepto los
accesorios) soportan 200 kg o más, y monte la unidad tal y como se describe en la Guía de Ayuda. Si el montaje no
es lo suficientemente resistente, la unidad podría caerse y provocar lesiones graves.
Fije el cable metálico para evitar la caídas al soporte de techo CIB-PCM1 suministrado (opcional) para evitar la caída
de la unidad.
Si la unidad se monta en un lugar alto, compruebe una vez al año que el montaje no se ha aflojado. Acorte el
intervalo de inspección de acuerdo con las condiciones de uso.

Nota acerca de la instalación
Para proteger el objetivo y el bloque de conectores del objetivo de la unidad, mantenga la tapa del objetivo y la
cubierta colocadas hasta que fije el objetivo.
Para evitar fallos en el objetivo, no sujete las piezas del objetivo mientras está en funcionamiento.
Para evitar fallos en la unidad, no sujete el cabezal de la cámara mientras está en funcionamiento.

Compruebe el espacio y los accesorios para el montaje en un lugar alto.

Kit de soporte de techo CIB-PCM1 (opcional)
Antes de comenzar, compruebe que dispone de las siguientes piezas.

Soporte para el cuerpo (1)
Soporte de techo (1)
Tapa del botón de liberación del objetivo (1)
Cable metálico para evitar la caída (1)
Tornillos +PSW M3×8 (9)
Tornillo de acero inoxidable +PSW M4×8 para cable metálico para evitar la caída (1)

1
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Nota

El cable metálico para evitar la caída se ha diseñado para sujetar la unidad cuando se encuentra suspendida. No le aplique
ninguna carga que no sea la de la unidad.

Espacio de montaje
Consulte el siguiente dibujo cuando determine la dirección y la ubicación de montaje, teniendo en cuenta el espacio
necesario para girar el objetivo y para el cableado de la parte posterior de la unidad.

A: Rango de movimiento del cabezal de la cámara (p. ej. SEL70200GM2 (con SEL20TC acoplado): Ø370)
B: Soporte de techo (orificio en el lateral de la superficie de montaje (Ø150))
C: Orificio de alineación de montaje

Nota

Móntela sobre un lugar estable que no reciba vibraciones. Los entornos que podrían recibir vibraciones pueden provocar
vibraciones en la imagen.

Si necesita montar la unidad sobre una superficie inclinada, manténgala a ±15° de la línea horizontal y tome las medidas
necesarias para evitar que caiga.

Mueva la palanca de bloqueo de giro/inclinación a la posición LOCK para bloquear el giro/inclinación del
cabezal de la cámara.

2
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Nota

Si el giro/inclinación del cabezal de la cámara no se bloquea cuando la palanca de bloqueo está en la posición LOCK,
mueva manualmente el cabezal de la cámara hasta que encaje.

Fije el soporte para el cuerpo en la parte inferior de la unidad con los seis tornillos suministrados (M3×8).3
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Utilice los tornillos suministrados. El uso de tornillos distintos a los suministrados podría dañar el interior de la
unidad.

Coloque el cable metálico para evitar la caída en el soporte para el cuerpo.4
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A: Cable metálico suministrado 
B: Tornillo Phillips suministrado (M4×8)
C: Presilla metálica para el cable metálico

Utilice el tornillo suministrado. El uso de un tornillo distinto al suministrado podría reducir la efectividad de la función
del cable metálico.

Coloque el soporte de techo en la superficie donde montará la unidad; por ejemplo, en una estantería.5
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A: Pared 
B: Marca △ (dirección de la cámara hacia delante)
C: Orificio para los cables de conexión
D: Estantería u otra superficie de montaje

Coloque el cable metálico para evitar la caída en un punto cerca de la superficie de montaje.

Utilice un tornillo con cabeza de hexágono interior M5 (3/16 pulg.) (opcional) y fíjelo en un objeto cerca de la
estantería o superficie en la que se colocará el soporte de techo.

6
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A: Cable metálico 
B: Tornillo con cabeza de hexágono interior (M5, 3/16 pulg.)

Haga coincidir el orificio del tornillo 〇 de la parte delantera del soporte para el cuerpo con el orificio ◇ del
soporte de techo, inserte la unidad y gírela en el sentido de las agujas del reloj para fijar temporalmente el
soporte para el cuerpo en el soporte de techo.

7

73



A: Orificio 〇
B: Orificio ◇

Fije el soporte para el cuerpo y el soporte de techo con los tres tornillos de bloqueo de rotación
suministrados (M3×8).

8
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A continuación, acople el objetivo. Consulte “Acople de un objetivo,” teniendo en cuenta la información de “Precauciones
a la hora de acoplar/retirar un objetivo,” “Comprobación de los interruptores del objetivo” y “Precauciones al utilizar un
objetivo con zoom”.

Nota

Tras acoplar un objetivo, compruebe que está bien colocado.
El objetivo no dispone de protección contra caídas. Sony no asume ninguna responsabilidad por los objetivos que caigan de la
unidad.

Tema relacionado
Precauciones a la hora de acoplar/retirar un objetivo

Comprobación de los interruptores del objetivo

Precauciones al utilizar un objetivo con zoom

Acople de un objetivo

Compruebe el estado del montaje.

En concreto, compruebe los siguientes elementos. 

Los tornillos de montaje están bien colocados.
El cable metálico para evitar la caída está bien colocado y no está retorcido.
La unidad se ha montado de manera nivelada (sin inclinación ni bamboleo).
La unidad no gira libremente cuando se rota.

9
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaje en techo

En este tema se describe el procedimiento para montar la unidad en el techo con la ayuda del soporte de techo (CIB-
PCM1 (opcional)).

Para montar la unidad en el techo, consulte a un contratista profesional.
Cuando monte la unidad en un techo, asegúrese de que la superficie y los materiales de montaje (excepto los
accesorios) soportan 200 kg o más, y monte la unidad tal y como se describe en la Guía de Ayuda. Si el montaje no
es lo suficientemente resistente, la unidad podría caerse y provocar lesiones graves.
Fije el cable metálico para evitar la caídas al soporte de techo CIB-PCM1 suministrado (opcional) para evitar la caída
de la unidad.
Si la unidad se monta en el techo, compruebe una vez al año que el montaje no se ha aflojado. Acorte el intervalo de
inspección de acuerdo con las condiciones de uso.

Nota acerca de la instalación
Para proteger el objetivo y el bloque de conectores del objetivo de la unidad, mantenga la tapa del objetivo y la
cubierta colocadas hasta que fije el objetivo.
Para evitar fallos en el objetivo, no sujete las piezas del objetivo mientras está en funcionamiento.
Para evitar fallos en la unidad, no sujete el cabezal de la cámara mientras está en funcionamiento.

Compruebe el espacio y los accesorios para el montaje en el techo.

Kit de soporte de techo CIB-PCM1 (opcional)
Antes de comenzar, compruebe que dispone de las siguientes piezas.

Soporte para el cuerpo (1)
Soporte de techo (1)
Tapa del botón de liberación del objetivo (1)
Cable metálico para evitar la caída (1)
Tornillos +PSW M3×8 (9)
Tornillo de acero inoxidable +PSW M4×8 para cable metálico para evitar la caída (1)

1
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Nota

El cable metálico para evitar la caída se ha diseñado para sujetar la unidad cuando se encuentra suspendida. No le aplique
ninguna carga que no sea la de la unidad.

Espacio de montaje
Consulte el siguiente dibujo cuando determine la dirección y la ubicación de montaje, teniendo en cuenta el espacio
necesario para girar el objetivo y para el cableado de la parte posterior de la unidad.

A: Rango de movimiento del cabezal de la cámara (p. ej. SEL70200GM2 (con SEL20TC acoplado): Ø370)
B: Soporte de techo (orificio en el lateral del techo (Ø150))
C: Orificio de alineación de montaje

Nota

Realice el montaje en un techo (por ejemplo, de hormigón) que sea lo suficientemente resistente.

Para montar la unidad en un techo que no sea lo suficientemente resistente, refuércelo lo suficiente.

Móntela sobre un lugar estable que no reciba vibraciones. Los entornos que podrían recibir vibraciones pueden provocar
vibraciones en la imagen.

Si necesita montar la unidad sobre una superficie inclinada, manténgala a ±15° de la línea horizontal y tome las medidas
necesarias para evitar que caiga.

El lado opuesto al orificio △ en el soporte de techo es la dirección de filmación (lado frontal de la cámara).

Mueva la palanca de bloqueo de giro/inclinación a la posición UNLOCK para desbloquear el giro/inclinación
y gire el cabezal de la cámara 180° en la dirección de inclinación.

2

Mueva la palanca de bloqueo de giro/inclinación a la posición LOCK para bloquear el giro/inclinación del
cabezal de la cámara.

3
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Cabezal de la cámara girado 180°

Nota

Si el giro/inclinación del cabezal de la cámara no se bloquea cuando la palanca de bloqueo está en la posición LOCK,
mueva manualmente el cabezal de la cámara hasta que encaje.

Fije el soporte para el cuerpo en la parte inferior de la unidad con los seis tornillos suministrados (M3×8).4
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Utilice los tornillos suministrados. El uso de tornillos distintos a los suministrados podría dañar el interior de la
unidad.

Fije el soporte de techo en una placa de montaje (opcional) y, a continuación, fije la placa en el techo.5
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A: Soporte de techo
B: Techo
C: Placa de montaje
D: Orificio ◇
Coloque el soporte de acuerdo con la orientación del soporte de techo.
Tenga en cuenta que cuando se monta en el techo, la parte delantera de la cámara se encuentra en el lado
opuesto del soporte de techo en comparación con un montaje vertical normal. Para efectuar correctamente el
montaje, consulte el diagrama en el que se indica la orientación de montaje.

A: Parte delantera para el montaje vertical (orientación del orificio △)
B: Parte delantera para el montaje en techo

Nota

El cliente es el responsable del material de la superficie de montaje.

Coloque el cable metálico para evitar la caída en el techo.6
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A: Soporte de techo
B: Tornillo con cabeza de hexágono interior (M5, 3/16 pulg.)
C: Cable metálico (suministrado)
D: Placa de montaje
E: Techo

Pase el cable metálico para evitar la caída por el orificio situado en la parte central del soporte de techo y
únalo al soporte para el cuerpo.

Pase el cable metálico para evitar la caída por la presilla metálica del cable metálico del soporte para el cuerpo y
fíjelo de manera segura al soporte con el tornillo de acero inoxidable suministrado (M4×8).

A: Cable metálico suministrado
B: Tornillo Phillips suministrado (M4×8)
C: Presilla metálica para el cable metálico

7
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Utilice el tornillo suministrado. El uso de un tornillo distinto al suministrado podría reducir la efectividad de la función
del cable metálico.

Nota

Se recomienda que una persona sujete la unidad tal y como se muestra en el siguiente diagrama mientras otra la monta.

No sujete el cabezal de la cámara ni el soporte del objetivo mientras monta la unidad. Existe riesgo de daños o lesiones si
la unidad se cae.

Durante el cableado, lleve cuidado de que los cables y conectores eléctricos no se cortocircuiten con el cable metálico para
evitar la caída.

La montura admite una masa suspendida de hasta 8,8 kg (incluido el objetivo). Para evitar la caída de la unidad, no supere
la masa máxima prevista.

Haga coincidir el orificio del tornillo (A) del soporte para el cuerpo con el orificio ◇ (B) del soporte de
techo, inserte la unidad y gírela unos 60 grados en el sentido de las agujas del reloj hasta que el orificio del
tornillo (A) y el orificio del tornillo (C) coincidan.

8
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A: Orificio para el tornillo en el soporte para el cuerpo
A: Orificio para el tornillo en el soporte de techo (orificio ◇)
C: Orificio para el tornillo
D: Techo
E: Placa de montaje

Fije el soporte para el cuerpo y el soporte de techo con los tres tornillos de bloqueo de rotación
suministrados (M3×8).

9
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A continuación, acople el objetivo. Consulte “Acople de un objetivo,” teniendo en cuenta la información de “Precauciones
a la hora de acoplar/retirar un objetivo,” “Comprobación de los interruptores del objetivo” y “Precauciones al utilizar un
objetivo con zoom”.

Nota

Para controlar correctamente el giro/inclinación cuando la unidad está montada en el techo, defina [Pan-Tilt] > [Direction] >
[Ceiling] en [On] en el menú web.

Tras acoplar un objetivo, compruebe que está bien colocado.
El objetivo no dispone de protección contra caídas. Sony no asume ninguna responsabilidad por los objetivos que caigan de la
unidad.

Tema relacionado

Compruebe el estado del montaje.

En concreto, compruebe los siguientes elementos.

Los tornillos de montaje están bien colocados.
El cable metálico para evitar la caída está bien colocado y no está retorcido.
La unidad se ha montado de manera nivelada (sin inclinación ni bamboleo).
La unidad no gira libremente cuando se rota.

10
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Precauciones a la hora de acoplar/retirar un objetivo

Comprobación de los interruptores del objetivo

Precauciones al utilizar un objetivo con zoom

Acople de un objetivo

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Precauciones a la hora de acoplar/retirar un objetivo

No deje el objetivo orientado directamente al sol. La luz directa del sol puede penetrar a través del objetivo, enfocarse en
la unidad y provocar un incendio.

Nota

Acople o retire el objetivo mientras la unidad esté apagada.

Los objetivos son componentes de precisión. No coloque los objetivos sobre una superficie dejando la montura de estos
orientada hacia abajo. Acople la tapa de la montura del objetivo suministrada.

Sugerencia

Para obtener más información acerca de los objetivos compatibles con la unidad, póngase en contacto con el servicio de
asistencia técnica de Sony.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Comprobación de los interruptores del objetivo

En función del tipo de objetivo, las siguientes comprobaciones y ajustes son necesarios.

Para un objetivo con un interruptor de modo de enfoque

Ajuste el interruptor en AF/MF o AF.
Si el interruptor se ajusta en MF o Full MF, el enfoque solo se puede ajustar usando el anillo del objetivo.

Nota

Cuando se usa un objetivo con montura A, el ajuste manual de una unidad de control remoto puede no estar disponible.

Para un objetivo con un interruptor de zoom

Ajuste el interruptor en SERVO.
Si el interruptor se ajusta en MANUAL, el zoom solo se puede ajustar usando el anillo del zoom. El control del zoom
desde la unidad no tiene ningún efecto.

Para un objetivo con un interruptor Auto Iris

Ajuste el interruptor en AUTO.
Si no se ajusta en AUTO, el diafragma solo se puede ajustar usando el anillo del objetivo. El funcionamiento del
diafragma desde la unidad no tiene ningún efecto.

Para un objetivo con un interruptor de estabilización de imagen

Ajuste el interruptor en OFF.
Si el interruptor se ajusta en ON, es posible que se produzca un comportamiento inesperado durante la operación de
giro/inclinación.

SELP28135G

A: Mueva el anillo de enfoque a la posición delantera (modo AF/MF).
B: Ajuste el interruptor de ZOOM en la posición SERVO.
C: Ajuste el anillo del diafragma en “A” y el interruptor IRIS LOCK en la posición LOCK.
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D: Ajuste el interruptor del estabilizador de imagen en OFF.

5-041-957-43(1) Copyright 2022 Sony Corporation

89



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Precauciones al utilizar un objetivo con zoom

Cuando se utiliza un objetivo con zoom distinto a un objetivo con zoom motorizado, la posición del zoom puede cambiar
en función del entorno de montaje. Fije el anillo del zoom en su posición con cinta según su finalidad de uso.

Cinta de plástico: 471 BLA 50 o equivalente

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Acople de un objetivo

En este tema se describe cómo acoplar un objetivo de montura E o un objetivo de montura A.

Nota

No transporte la unidad con el objetivo aún acoplado.

Cuando se usa un objetivo con montura A, el diafragma se establece manualmente y el enfoque se establece en MF.

Mueva la palanca de bloqueo de giro/inclinación a la posición LOCK para bloquear el giro/inclinación del
cabezal de la cámara.

Nota

Si el giro/inclinación del cabezal de la cámara no se bloquea cuando la palanca de bloqueo está en la posición LOCK,
mueva manualmente el cabezal de la cámara hasta que encaje.

1

Gire la palanca de sujeción del tornillo de acoplamiento del pedestal del soporte del objetivo en sentido
contrario a las agujas del reloj para aflojar el bloqueo; a continuación, mueva el tornillo de acoplamiento
del pedestal del soporte del objetivo a una posición que no interfiera con el objetivo.

2
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A: Correcto
A: Incorrecto

Gire la palanca de bloqueo del cabezal de la cámara en la dirección de la flecha para desbloquear el cabezal
de la cámara.

Nota

Hasta que el cabezal de la cámara vuelva a bloquearse, existe riesgo de que se mueva por su propio peso. Sujete el
cabezal de la cámara con la mano mientras realiza la tarea.

3

Deslice el cabezal de la cámara a su posición más delantera.4
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Gire la palanca de bloqueo del cabezal de la cámara en la dirección de la flecha para bloquear el cabezal de
la cámara.

Nota

Compruebe que la palanca de bloqueo del cabezal de la cámara no entre en contacto con otras piezas para evitar interferir
con la operación de inclinación.

5

Retire la tapa y la cubierta de la unidad y el objetivo.6

Alinee la marca de la montura del objetivo (blanca) con la unidad, introduzca con cuidado el objetivo en el
cabezal de la cámara y, a continuación, gire el objetivo hacia la derecha hasta que encaje en la posición
bloqueada.

A: Marcas de la montura (blancas)

Nota

Para utilizar un objetivo de montura A, acople un adaptador de montura de objetivos (opcional) a la unidad y, a
continuación, acople el objetivo de montura A.

7

Gire la palanca de bloqueo del cabezal de la cámara en la dirección de la flecha para desbloquear el cabezal
de la cámara.

8
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Nota

Hasta que el cabezal de la cámara vuelva a bloquearse, existe riesgo de que se mueva por su propio peso. Sujete el
cabezal de la cámara con la mano mientras realiza la tarea.

Mantenga el equilibrio del cabezal de la cámara hacia adelante y hacia atrás de manera que la base
deslizante quede en horizontal.

Si utiliza uno de los siguientes objetivos, podrá equilibrar más o menos la unidad y el objetivo fijándose en la
báscula de la base deslizante.

9

Posición de la báscula Nombre del objetivo

0,5 SEL70200GM (con SEL20TC acoplado)

1,7 SEL70200GM

2,0 SEL70200GM2 (con SEL20TC acoplado)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Nota

Utilice la báscula de la base deslizante como referencia para conseguir un equilibrio aproximado.

Mientras acople el objetivo, efectúe los ajustes necesarios para equilibrar la unidad de modo que no se incline hacia
adelante ni hacia atrás.

Equilibre la unidad sobre una superficie horizontal.

Retire la unidad de soporte del objetivo al usar el SELC1635G.

Posición de la báscula Nombre del objetivo

5,0 o superior SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Gire la palanca de bloqueo del cabezal de la cámara en la dirección de la flecha para bloquear el cabezal de
la cámara.

Nota

Compruebe que la palanca de bloqueo del cabezal de la cámara no entre en contacto con otras piezas para evitar interferir
con la operación de inclinación.
Método de confirmación: deslice el bloqueo de giro/inclinación a la posición UNLOCK, gire el bloque de la cámara a mano
de forma que mire hacia arriba y confirme visualmente que no esté en contacto con otras piezas. Si hay contacto, vuelva a
girar la palanca de bloqueo del cabezal de la cámara en la dirección de la flecha.

10

Gire las palancas de sujeción del soporte del objetivo en el sentido contrario a las agujas del reloj para
aflojar la unidad de soporte del objetivo.

11
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A: Palanca de sujeción de la varilla de soporte del objetivo (2 lugares)
B: Unidad de soporte del objetivo

Mueva la unidad de soporte del objetivo de modo que el pedestal del soporte del objetivo esté alineado con
el tornillo de acoplamiento del pedestal del soporte del objetivo; a continuación, gire el tornillo en el
sentido de las agujas del reloj para fijar el pedestal del soporte del objetivo.

Nota

Asegúrese de que el pedestal del soporte del objetivo está perpendicular al tornillo de acoplamiento del pedestal del
soporte del objetivo y, a continuación, apriételo.

12

Gire la palanca de sujeción del tornillo de acoplamiento del pedestal del soporte del objetivo en el sentido
de las agujas del reloj para bloquear el tornillo de acoplamiento del pedestal del soporte del objetivo.

A: Tornillo de acoplamiento del pedestal del soporte del objetivo
B: Orificio para el tornillo de acoplamiento
C: Palanca de sujeción del tornillo de acoplamiento del pedestal del soporte del objetivo

Sugerencia

Si una palanca de sujeción está en una posición que dificulta el giro, libérela y gírela hasta colocarla en un ángulo que
facilite el funcionamiento. Una vez esté en la posición deseada, ciérrela.

13

96



Tema relacionado
Calibración de un objetivo de montura E

5-041-957-43(1) Copyright 2022 Sony Corporation

A: Palanca de sujeción del tornillo de acoplamiento del pedestal del soporte del objetivo
B: Palanca de sujeción de la varilla de soporte del objetivo

Gire las dos palancas de sujeción de la varilla del soporte del objetivo en el sentido de las agujas del reloj
para fijar la unidad de soporte del objetivo.

14

Compruebe que ambas palancas están apretadas y no están flojas, que el objetivo está bien acoplado y
que los interruptores del objetivo se han configurado correctamente.

Si una palanca está suelta o si el objetivo no se ha acoplado correctamente, el objetivo podría caerse y sufrir
daños.
Cuando utilice un objetivo con zoom motorizado con montura E, el objetivo también debe calibrarse por
separado para restablecer de manera precisa las posiciones del zoom almacenadas en la cámara como
posiciones preajustadas. Para obtener más detalles, consulte “Calibración de un objetivo de montura E”.

15
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Extracción de un objetivo

Para extraer un objetivo, siga los pasos del procedimiento de acople de un objetivo a la inversa.

Nota

Sujete el objetivo con firmeza para impedir que caiga.

Si no se acopla otro objetivo inmediatamente, coloque siempre la tapa del cuerpo.

Tema relacionado

Acople de un objetivo

5-041-957-43(1) Copyright 2022 Sony Corporation

Compruebe que el giro/inclinación está bloqueado.1

Gire la palanca de sujeción del tornillo de acoplamiento del pedestal del soporte del objetivo en el sentido
contrario a las agujas del reloj para aflojar el bloqueo.

2

Retire el tornillo de acoplamiento del pedestal del soporte del objetivo de la unidad de soporte del objetivo
y muévalo a una posición que no interfiera con el objetivo.

3

Desbloquee el cabezal de la cámara y deslícelo a su posición más delantera.

Para obtener más información, consulte los pasos del 3 al 5 de “Acople de un objetivo”.

4

Mantenga presionado el botón de liberación del objetivo y gire el objetivo en el sentido contrario a las
agujas del reloj mientras lo sujeta.

5

Con las marcas de la montura (blancas) de la cámara y del objetivo alineadas, extraiga el objetivo hacia
delante.

6
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Conexión de los cables

En este tema se describen las conexiones de los cables.

5-041-957-43(1) Copyright 2022 Sony Corporation

Conecte los cables necesarios en los conectores del panel trasero.

Para evitar la extracción del cable HDMI, retire el tornillo de montaje de la placa de retención del cable HDMI
(M2.6×6, negro) del bloque de conectores y acople la placa de retención del cable HDMI suministrada con el
tornillo de montaje. Fije el cable HDMI a la placa de retención del cable HDMI con una cinta o brida disponible en el
mercado.

A: Tornillo de montaje de la placa de retención del cable HDMI (M2.6×6, negro)
B: Cinta o brida disponible en el mercado
C: Placa de retención del cable HDMI (suministrada)

1
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Conexión de la unidad a un dispositivo de red a través de una conexión por cable

En este tema se describe cómo conectar la unidad a un dispositivo de red a través de una conexión por cable.

5-041-957-43(1) Copyright 2022 Sony Corporation

Conecte la unidad al dispositivo de red (como un punto de acceso Wi-Fi o un concentrador) utilizando un
cable LAN de categoría 5e o superior.

1
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Utilización de la alimentación por CA

En este tema se describe el procedimiento para alimentar la unidad a través de CA.

Mueva la palanca de bloqueo de giro/inclinación a la posición LOCK para bloquear el giro/inclinación del
cabezal de la cámara.

1

Conecte el adaptador de CA (suministrado) al conector DC IN de la unidad y, a continuación, conecte el
cable de alimentación (suministrado) a una fuente de alimentación de CA.

A: Conector DC IN
B: Cable de alimentación
C: Adaptador de CA

2

Si desea evitar que el cable se desconecte, fije el cable del adaptador de CA con la abrazadera para cables.

Abra la abrazadera para cables, pase el cable por la abrazadera tal y como se muestra a continuación y cierre la
abrazadera.

3
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Nota

No utilice ningún adaptador de CA ni cable de alimentación salvo los suministrados con la unidad. Si conecta otro adaptador o
cable de alimentación, podría provocarse un incendio o una avería.

No conecte ni utilice un adaptador de CA en espacios reducidos, como por ejemplo, entre una pared y un mueble.

No provoque un cortocircuito en las piezas metálicas del enchufe del adaptador de CA. Si lo hace, podría provocar una avería.

A: Abrazadera de cables
B: Cierre de la abrazadera para cables
C: Cable del adaptador de CA

Compruebe que el indicador POWER situado en la parte delantera de la unidad pasa de parpadear en verde
a mostrarse en verde fijo y que el inicio ha finalizado.

Si la unidad se ha iniciado con normalidad y se ha conectado a la red, el indicador NETWORK se iluminará en
verde.

Si utiliza un objetivo que no admite la operación de giro/inclinación, bloquee la palanca de bloqueo de
giro/inclinación y omita los pasos que se indican a continuación. Para obtener más información acerca de los
objetivos compatibles con el giro/inclinación, póngase en contacto con su distribuidor o con el servicio de
asistencia técnica de Sony.

4

Mueva la palanca de bloqueo de giro/inclinación a la posición UNLOCK para desbloquear el giro/inclinación
del cabezal de la cámara.

5

Restablezca el giro/la inclinación.

Para obtener más detalles, consulte “Restablecimiento del giro/inclinación”.

6
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Conecte el adaptador de CA a la fuente de alimentación de CA más cercana. Si se produce algún problema durante el uso,
desconecte inmediatamente el cable de alimentación de la fuente de alimentación de CA.

Cuando vaya a desconectar el adaptador de CA de la unidad, sujete el enchufe y sáquelo recto. Si tira del cable, podría producir
un fallo de funcionamiento.

Tema relacionado

Restablecimiento del giro/inclinación

5-041-957-43(1) Copyright 2022 Sony Corporation
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Utilización de la alimentación de PoE++

Cuando la unidad se conecta a un dispositivo de suministro de alimentación compatible con PoE++, la alimentación se
suministra a la unidad a través de un cable de red disponible en el mercado.
Este método permite que se suministre alimentación a la unidad sin necesidad de cables de la fuente de alimentación en
entornos en los que no hay toma de corriente de alimentación cerca de la ubicación de montaje.

Mueva la palanca de bloqueo de giro/inclinación a la posición LOCK para bloquear el giro/inclinación del
cabezal de la cámara.

1

Conecte la unidad y un dispositivo de suministro de alimentación compatible con PoE++ mediante un cable
de red disponible en el mercado.

A: Cable de red
B: Dispositivo de suministro de alimentación compatible con PoE++

2

Compruebe que el indicador POWER situado en la parte delantera de la unidad pasa de parpadear en verde
a mostrarse en verde fijo y que el inicio ha finalizado.

Si la unidad se ha iniciado con normalidad y se ha conectado a la red, el indicador NETWORK se iluminará en
verde.

3
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Nota

Esta unidad es conforme con IEEE802.3bt tipo 4, clase 8. Para obtener más información acerca de los dispositivos de suministro
de alimentación PoE++ compatibles, póngase en contacto con su distribuidor o con el servicio de asistencia técnica de Sony.

Esta unidad es conforme con la autenticación de software (LLDP), aunque es posible que sea necesario configurar los
dispositivos de red (compatibles con IEEE802.3bt).

No utilice un adaptador de CA si utiliza el suministro de alimentación PoE+ con la autenticación de software (LLDP) activada.

Si se conectan al mismo tiempo un adaptador de CA y el dispositivo de suministro de alimentación PoE++, la alimentación se
suministrará a través del adaptador de CA.

Si la alimentación se suministra a través de PoE++, utilice un cable de red de categoría 5e o superior.

Espere unos 10 segundos tras volver a encender la unidad cuando reciba alimentación a través de PoE++.

Cuando utilice el suministro de alimentación PoE++, conecte a tierra el terminal de tierra.

Cuando establezca la conexión a través del suministro de alimentación PoE++, no pase los cables en el exterior.

Tema relacionado
Restablecimiento del giro/inclinación

5-041-957-43(1) Copyright 2022 Sony Corporation

Nota

Si la alimentación se suministra a través de PoE++, durante el intervalo se efectúa una autenticación inicial hasta que el
inicio ha finalizado.

Si utiliza un objetivo que no admite la operación de giro/inclinación, bloquee la palanca de bloqueo de giro/inclinación y
omita los pasos que se indican a continuación. Para obtener más información acerca de los objetivos compatibles con el
giro/inclinación, póngase en contacto con su distribuidor o con el servicio de asistencia técnica de Sony.

Mueva la palanca de bloqueo de giro/inclinación a la posición UNLOCK para desbloquear el giro/inclinación
del cabezal de la cámara.

4

Restablezca el giro/la inclinación.

Para obtener más detalles, consulte “Restablecimiento del giro/inclinación”.

5

105



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Restablecimiento del giro/inclinación

Es posible restablecer el giro/inclinación cuando, por ejemplo, se sustituye el objetivo. Para ello, siga el procedimiento
que se indica a continuación.

5-041-957-43(1) Copyright 2022 Sony Corporation

Mueva la palanca de bloqueo de giro/inclinación a la posición UNLOCK y compruebe que el giro/inclinación
del cabezal de la cámara se ha desbloqueado.

1

Ejecute la función de restablecimiento del giro/inclinación.

Es posible ejecutar el restablecimiento del giro/inclinación a través del control remoto infrarrojo, la Aplicación Web o
el controlador remoto RM-IP500 (opcional).

Operación con el control remoto infrarrojo: pulse el botón P/T RESET.
Operación con la Aplicación Web: pulse el botón  (restablecimiento del giro/inclinación) que encontrará
en la pestaña  (Others) del panel de control de la cámara, en la pantalla de operación en directo.
Operación con el RM-IP500: consulte las instrucciones de funcionamiento del RM-IP500.

Nota

Al ejecutar el restablecimiento del giro/inclinación, el objetivo y el cabezal de la cámara se giran. Antes de la ejecución,
compruebe que el objetivo no está obstruido.

La unidad dispone de una función que limita el rango de giro/inclinación, pero esta función se desactiva cuando se
enciende la unidad o se ejecuta el restablecimiento de giro/inclinación.

Sugerencia

Una vez ha finalizado el restablecimiento del giro/inclinación, la unidad vuelve a la posición previa a la ejecución.

2
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Acceso a la Aplicación Web desde un explorador web

Si conecta la unidad a una tablet u ordenador, podrá controlar y configurar la unidad a través de un explorador web.

Compruebe si la tablet o el ordenador admiten las operaciones de la Aplicación Web.

Nota

Si no se dispone del entorno necesario, o en función del uso que se haga de la tablet o del ordenador, es posible que la
visualización de vídeo en un explorador web se vea negativamente afectada.

La Aplicación Web de esta unidad utiliza JavaScript. Si utiliza un software antivirus en su tablet/ordenador, es posible que
la página web no se muestre correctamente.

1

Elemento Requisito

Pantalla
Se recomiendan 1080×810 píxeles o más
Tamaño de la pantalla de la tablet: se recomiendan al
menos 10 pulgadas

Explorador web y SO
compatibles

Windows

SO Windows 10 o posterior

Explorador
web

Google Chrome

Mac

SO macOS 10.15 o posterior

Explorador
web

Google Chrome
Safari

iPad

SO iPadOS 15 o posterior

Explorador
web

Google Chrome
Safari

Android

SO Android 12 o posterior

Explorador
web

Google Chrome

Compruebe que la unidad, tablet/ordenador y dispositivos periféricos están encendidos.2

Compruebe que la unidad y la tablet o el ordenador están conectados a través de Wi-Fi o mediante una
conexión de área local LAN por cable.

3

Conéctese a la unidad desde el explorador web de su tablet u ordenador.

Conexión con un código QR
Escanee el código QR impreso en la tapadera lateral de la unidad utilizando la cámara de la tablet.

4
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Nota

Si el número de puerto HTTP se ha cambiado desde un valor de 80, escriba “http://dirección IP de la unidad:número de puerto”
en la barra de dirección.

Cuando se conecte a través de un código QR o mediante la introducción de la URL en la barra de dirección de un explorador

web, utilice un dispositivo compatible con mDNS*.

Sugerencia

Después podrá acceder rápidamente a la unidad a través de la función de marcador del explorador web.

5-041-957-43(1) Copyright 2022 Sony Corporation

Abra el vínculo que se muestra en la tablet.
El explorador web de la tablet se abre y muestra la pantalla de la Aplicación Web de la unidad.

Conexión mediante la introducción de una URL en la barra de dirección de un explorador web
Abra un explorador web en su tablet u ordenador y escriba la URL impresa en la tapadera lateral de la unidad.
El explorador web debería mostrar la pantalla de la Aplicación Web de la unidad.

Conexión mediante la introducción de la dirección IP de la unidad en la barra de dirección de un explorador
web
Abra un explorador web en su tablet u ordenador y escriba “http://dirección IP de la unidad” en la barra de
dirección.
El explorador web debería mostrar la pantalla de la Aplicación Web de la unidad.

mDNS: protocolo de comunicación utilizado para determinar la dirección IP a partir de un nombre de host en una red local.*
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Inicialización de la unidad

Cuando utilice la unidad por primera vez, asegúrese de configurarla siguiendo el procedimiento que se indica a
continuación.

Sugerencia

Si la batería de reserva se descarga por completo, tendrá que realizar la configuración inicial de nuevo.

Conéctese a la unidad desde una tablet u ordenador e inicie la Aplicación Web.

Cuando utilice la unidad por primera vez, el sistema le pedirá que introduzca un nombre de usuario y una
contraseña en el explorador web. Introduzca los siguientes ajustes.

Nombre de usuario: admin
Contraseña: (en blanco)

Siga las instrucciones que aparecen en pantalla para efectuar la configuración inicial.

1

Introduzca el nombre de usuario y la contraseña de administrador (Administrator) y pulse el botón [OK].

1: Introduzca el nombre de usuario del administrador.
2: Establezca la contraseña del administrador.
3: Introduzca la misma contraseña de nuevo para confirmar.

Nota

Los siguientes caracteres pueden utilizarse en el nombre de usuario y la contraseña. La contraseña debe incluir, al menos,
una letra mayúscula, una letra minúscula y un número, y debe tener entre 8 y 64 caracteres.

Caracteres alfanuméricos

2
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Se mostrará la pantalla en directo para capturar operaciones. Continúe con la configuración del funcionamiento básico
de la unidad en función del modo de funcionamiento.

Sugerencia

Símbolos (!$%`*+-./<=>?@[]^_{|}~)

El explorador web se recargará y le pedirá introducir el nombre de usuario y la contraseña.

Introduzca el nombre de usuario y la contraseña configurados en el paso 2.

Aparecerá la pantalla de configuración de idioma y reloj.

3

Especifique los siguientes elementos y pulse el botón [OK].

[Language]
Seleccione el idioma de debe utilizarse en la Aplicación Web y la pantalla de la cámara. Cambiar el idioma hará
que cambie el idioma de visualización de la Aplicación Web.
[Date & Time Format]
Seleccione el formato de visualización de la fecha y la hora en las siguientes opciones.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
“yyyy” indica el año, “mm” indica el mes, “dd” indica el día, “hh” indica la hora, “mm” indica los minutos y “ss” indica
los segundos, respectivamente.
[12 h/24 h]
Seleccione [12 h] (sistema horario de 12 horas) o [24 h] (sistema horario de 24 horas) para la visualización de la
hora.
[Time Setting]
Seleccione el método para configurar la fecha/hora.
[Synchronize with PC]: defina la sincronización con la fecha/hora del ordenador o tablet.
[Manual setting]: se establecen los valores manualmente. Si selecciona este método, se mostrarán los campos
para la introducción de la fecha y la hora.
[Time Zone]
Seleccione la zona horaria.

4

110



En algunos casos, como cuando se utiliza la unidad con una tablet como par, puede ser más fácil utilizar una dirección IP fija
para la unidad.

Para establecer una dirección IP fija, desactive primero [Network] > [Wired LAN] > [IPv4] > [DHCP] (interruptor deslizante en la
posición izquierda) en el menú web.

Aparecen los elementos de configuración relacionados con una dirección IP fija. Configure los elementos y, después, pulse el
botón [OK] de la pantalla.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Configuración del funcionamiento básico

En este tema se describe cómo configurar la unidad para las funciones básicas.

Ajuste del modo de filmación

Puede seleccionar el modo de filmación de la unidad para que coincida con el flujo de trabajo.

Modo Custom: crea imágenes de forma flexible durante la filmación.
Modos de filmación Log: graba contenido S-Log.

Modo Flexible ISO: los ajustes de exposición se establecen mediante ajustes del valor ISO en función de la
escena que se esté fotografiando.
Modo Cine EI/modo Cine EI Quick: utilizar la unidad de forma similar a una cámara de cine (sin crear imágenes
por completo al disparar), con metraje revelado en postproducción.

En el modo Cine EI Quick, se selecciona automáticamente una sensibilidad base adecuada para el ajuste del índice de
exposición.
Cambie el modo de filmación con [Project] > [Base Setting] > [Shooting Mode] en el menú web o en el menú de la
cámara.

Modo Custom
Puede seleccionar el estándar de vídeo.
Cámbielo con [Project] > [Base Setting] > [Target Display] en el menú web o en el menú de la cámara.

[SDR(BT.709)]: filmación según el estándar de emisión HD
[HDR(HLG)]: filmación según el estándar de emisión 4K de última generación

Para obtener más detalles, consulte “Descripción general del aspecto” y otros temas en “Filmación con el aspecto
deseado”.

Modos de filmación Log
(modo Flexible ISO/modo Cine EI/modo Cine EI Quick)
En los modos de filmación Log, se selecciona la gama de colores base para las señales grabadas y las señales de
salida. La gama de colores seleccionada aquí es la gama de colores de la salida de vídeo cuando los ajustes de [LUT
On/Off] se establecen en [MLUT Off].
Puede cambiar la gama de color con [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] en el menú de la cámara.

[S-Gamut3.Cine/SLog3]: gama de colores fácil de ajustar para el cine digital (DCI-P3).
[S-Gamut3/SLog3]: amplia gama de colores de Sony que cubre el espacio de color ITU-R BT.2020.

Para obtener más información, consulte “Filmación con ajuste del aspecto en posproducción”.
 
Las funciones admitidas en cada modo de disparo se indican en la tabla siguiente.
●: Compatible, –: No compatible

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –
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Sugerencia

En los modos Cine EI Quick y Cine EI, la filmación se produce con una sensibilidad ISO base sin utilizar la ganancia para
maximizar el rendimiento del sensor de imagen. El brillo se ajusta utilizando la iluminación y el filtro ND para ajustar la cantidad
de luz que llega al sensor de imagen.

Ajuste de la frecuencia del sistema

Cámbielo con [Project] > [Rec Format] > [Frequency] en el menú web o en el menú de la cámara. La unidad puede
reiniciarse automáticamente después de cambiar, dependiendo del valor seleccionado.

Nota

No puede cambiar la frecuencia del sistema durante una grabación o una reproducción.

Ajuste del modo de escaneado de la cámara

Puede establecer el tamaño efectivo de la imagen y la resolución del sensor de imagen.
Cámbielo con [Project] > [Rec Format] > [Imager Scan Mode] en el menú web o en el menú de la cámara.
[FF]: tamaño de fotograma completo.
[S35]: tamaño Super 35mm.

Nota

No puede cambiar el modo de escaneado de la cámara durante una grabación o una reproducción.

Cuando se ajusta a S35, el formato de vídeo está restringido a 1920×1080.

Ajuste del códec

Puede configurar el códec para la grabación.
Cámbielo con [Project] > [Rec Format] > [Codec] en el menú web o en el menú de la cámara.

Nota

No puede cambiar el códec durante una grabación o una reproducción.

Ajuste del formato de vídeo

Puede configurar el formato de vídeo para la grabación y el formato de salida para la salida desde la cámara.

Custom Flexible ISO Cine EI Cine EI Quick

Base Sensitivity ● – – –

Base ISO – ● ● ● (vinculado a EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(excepto Base Look)

● – – –
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Cambie el formato de vídeo para la grabación con [Project] > [Rec Format] > [Video Format] en el menú web o en el
menú de la cámara.
Para cambiar el formato de salida de los conectores de los conectores SDI OUT y HDMI OUT, vaya a [Monitoring] >
[Output Format] en el menú web o en el menú de la cámara.

Nota

No puede cambiar el formato de vídeo durante una grabación o una reproducción.

Se pueden aplicar restricciones a la señal de los conectores SDI OUT y HDMI OUT, según la configuración del formato de vídeo.

Tema relacionado

Descripción general del aspecto

Filmación con ajuste del aspecto en posproducción

5-041-957-43(1) Copyright 2022 Sony Corporation
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Tarjetas de memoria compatibles

La unidad graba audio y vídeo en tarjetas de memoria CFexpress Tipo A o en tarjetas de memoria SDXC (ambas
disponibles por separado) insertadas en las ranuras para tarjetas. Las tarjetas de memoria también se utilizan para
grabar proxy.

Tarjetas de memoria CFexpress Tipo A

Utilice las tarjetas de memoria CFexpress Tipo A de Sony* indicadas en “Soportes de grabación recomendados” en la
unidad.
Para obtener más información sobre las operaciones con soportes de otros fabricantes, consulte las instrucciones de
funcionamiento de dichos soportes o la información del fabricante.

Tarjetas de memoria SDXC

Utilice las tarjetas de memoria SDXC* indicadas en “Soportes de grabación recomendados” en la unidad.

Soportes de grabación recomendados

Las condiciones de funcionamiento garantizadas variarán según los ajustes de Rec Format y Recording.

CFexpress Tipo A
Compatible con VPG400
Compatible con todos los formatos de grabación de la unidad.

SDXC
Compatible cuando se cumplen las condiciones indicadas en la siguiente tabla. “●” indica que la operación se ha
verificado y “–” indica que la operación no está garantizada.

RAW Out & XAVC-I, 4096×2160 Clase 300, modo Normal

RAW Out & XAVC-I, 3840×2160 Clase 300, modo Normal

En esta Guía de Ayuda se denominan “tarjetas CFexpress”.*

En esta Guía de Ayuda se denominan “tarjetas SD”.*

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 Clase 300, S&Q (60 fps o menos)

RAW Out & XAVC-I, 3840×2160 Clase 300, S&Q (100 fps, 120 fps)
Soporte verificado no disponible.

XAVC-I, 4096×2160 Clase 300, modo Normal

XAVC-I, 4096×2160 Clase 300, S&Q (60 fps o menos)

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 3840×2160 Clase 300, modo Normal

XAVC-I, 3840×2160 Clase 300, S&Q (60 fps o menos)

XAVC-I, 3840×2160 Clase 300, S&Q (100 fps, 120 fps)
Soporte verificado no disponible.

XAVC-I, 1920×1080 Clase 100, modo Normal

XAVC-I, 1920×1080 Clase 100, S&Q (60 fps o menos)

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

24P – – – – – – ●

23.98P – – – – – – ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Clase 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Clase 100, S&Q (150 fps, 180 fps)
Soporte verificado no disponible.

XAVC-I, 1920×1080 Clase 100, S&Q (200 fps, 240 fps)
Soporte verificado no disponible.

XAVC-L, 3840×2160 420, modo Normal

XAVC-L, 3840×2160 420, S&Q (60 fps o menos)

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, modo Normal

XAVC-L, 1920×1080 HD50, S&Q (60 fps o menos)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, modo Normal

XAVC-L, 1920×1080 HD35, S&Q (60 fps o menos)

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-957-43(1) Copyright 2022 Sony Corporation

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frecuencia del sistema Clase 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Introducción de las tarjetas de memoria

En este tema se describen las precauciones a tener en cuenta cuando se introducen las tarjetas de memoria.

Abra la tapa de soportes de la sección de la ranura para tarjetas.1

Introduzca una tarjeta de memoria.

En las tarjetas CFexpress, la etiqueta mira hacia arriba.

Nota

En una unidad montada en el techo, la etiqueta mira hacia abajo.

En las tarjetas SD, la etiqueta mira hacia abajo.

Nota

En una unidad montada en el techo, la etiqueta mira hacia arriba.

El indicador de acceso se iluminará en rojo y, a continuación, cambiará a verde si la tarjeta se puede utilizar.

2
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Nota

La tarjeta de memoria, la ranura de la tarjeta de memoria y los datos de imagen de la tarjeta de memoria pueden resultar
dañados si la tarjeta se introduce a la fuerza en la ranura en la orientación incorrecta.

Cuando grabe en los soportes utilizando ambas ranuras de tarjeta CFexpress Tipo A/SD, la A y la B, inserte los soportes en las
dos ranuras que se recomiendan para su funcionamiento con el formato que desea grabar.

5-041-957-43(1) Copyright 2022 Sony Corporation

Nota

Si el indicador de acceso parpadea continuamente en color rojo y no cambia a verde, apague temporalmente la unidad,
retire la tarjeta de memoria e insértela de nuevo.

Cierre la tapa de soportes.3
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Extracción de una tarjeta de memoria

Abra la tapa de soportes de la sección de la ranura para tarjetas y presione ligeramente la tarjeta de memoria para
extraerla.

Nota

Si la unidad está apagada o si se extrae la tarjeta de memoria mientras se está accediendo a esta, no se podrá garantizar la
integridad de los datos de la tarjeta. Es posible que se pierdan todos los datos grabados en la tarjeta. Asegúrese de que el
indicador de acceso esté siempre iluminado en color verde o apagado antes de apagar la unidad o extraer la tarjeta de memoria.

Cuando extraiga una tarjeta de memoria inmediatamente después de finalizar una grabación, es posible que la tarjeta de
memoria esté caliente, pero esto no significa que haya un problema.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Formateo (inicialización) de tarjetas de memoria

Si se introduce una tarjeta de memoria sin formatear o formateada con especificaciones diferentes, aparecerá en el
panel de imagen de la cámara el mensaje “Media Needs to be Formatted”.
Formatee la tarjeta mediante el siguiente procedimiento.

Nota

Al formatear una tarjeta de memoria se borran todos los datos, incluidos los archivos de configuración y los datos de vídeos
grabados.

Es posible que aparezcan mensajes durante la ejecución dependiendo de la duración del proceso de formateo.

Si el formateo no se completa correctamente
Las tarjetas de memoria no compatibles con la unidad no se podrán formatear.
Se mostrará un mensaje de advertencia. Siga las instrucciones para sustituir la tarjeta por una tarjeta de memoria
compatible.

Para utilizar una tarjeta formateada con la unidad en la ranura de otro dispositivo
En primer lugar, realice una copia de seguridad de la tarjeta y, a continuación, vuelva a formatear la tarjeta en el
dispositivo que se va a utilizar.

5-041-957-43(1) Copyright 2022 Sony Corporation

Establezca [TC/Media] > [Format Media] en el menú de la cámara.1

Seleccione Media(A) (ranura A) o Media(B) (ranura B) y, a continuación, seleccione el método de formateo
(Full Format o Quick Format).

Aparecerá un mensaje de confirmación.
[Full Format]: inicia el soporte por completo, incluida la información acerca de la gestión de datos y la región de
datos.
[Quick Format]: inicia solo la información acerca de la gestión de datos del soporte.

2

Seleccione [Execute].

Se mostrará un mensaje durante el formateo y el indicador de acceso se iluminará en rojo.
Cuando termine el formateo, aparecerá un mensaje de finalización.

3
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Comprobación del tiempo de grabación restante

Durante la filmación (grabación/en espera), puede comprobar la capacidad restante de la tarjeta de memoria en cada
ranura mediante los indicadores de los soportes de las ranuras A/B restantes en el panel de imagen de la cámara.
El tiempo de grabación restante se calcula a partir de la capacidad restante de los soportes en cada ranura y del formato
de grabación actual (velocidad de bits de grabación), y se mostrará en minutos.

Tiempo de cambio de tarjetas de memoria
Cuando el tiempo de grabación restante total en las dos tarjetas de memoria es inferior a 5 minutos, aparece el mensaje
“Media Near Full” y la lámpara indicadora/indicador de grabación comienza a parpadear para advertirle.
Introduzca algún soporte que disponga de espacio.
Si continúa grabando hasta que el tiempo restante de grabación total llegue a cero, el mensaje cambiará a “Media Full” y
la grabación se detendrá.

Nota

En una tarjeta de memoria se pueden grabar hasta 600 clips aproximadamente.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Restablecimiento de tarjetas de memoria

Si, por alguna razón, se produjera un error en una tarjeta de memoria, esta debe restablecerse antes de usarla.
Si carga una tarjeta de memoria que necesite restablecerse, aparecerá un mensaje en el panel de imagen de la cámara
en el que se le preguntará si desea restablecerla.

Para restablecer una tarjeta
Seleccione [Execute] mediante los botones de flecha del panel de control de GUI y pulse el botón [Set].
Se mostrará un mensaje y el estado de avance (%) durante el formateo y el indicador de acceso se iluminará en rojo.
Cuando termine el restablecimiento, aparecerá un mensaje de finalización.

Si falla el restablecimiento
No se pueden restablecer las tarjetas de memoria donde se haya producido un error. Se mostrará un mensaje de
advertencia. Siga las instrucciones para sustituir la tarjeta de memoria.
Las tarjetas de memoria en las que se haya producido un error pueden volver a usarse si se vuelven a formatear.
Algunos clips pueden restablecerse, pero otros no. Los clips restablecidos pueden reproducirse con normalidad.

Nota

Asegúrese de utilizar esta unidad para restablecer los soportes grabados con ella.

Es posible que los soportes grabados con un dispositivo que no sea esta unidad o con una unidad de versión diferente (incluso
del mismo modelo) no se restablezcan mediante esta unidad.

Los clips de menos de 2 segundos no se pueden restablecer.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Iniciar/detener grabación

En este tema se describe cómo iniciar y detener una grabación.

Acople los dispositivos necesarios y compruebe que se suministra la alimentación necesaria a la unidad y
a los dispositivos periféricos.

1

Introduzca las tarjetas de memoria.2

Compruebe el estado de alimentación de la unidad en la parte superior izquierda de la pantalla de la
Aplicación Web.

Si la fuente de alimentación está encendida
Si la unidad está encendida, se muestra [Power ON] en el interruptor de alimentación, en la parte superior de la
pantalla de la Aplicación Web.

El indicador POWER se ilumina en la parte delantera de la unidad y la imagen de la cámara aparece en la pantalla
de operación en directo de la Aplicación Web.

Nota

Si no se ha configurado la contraseña del administrador, se mostrará una pantalla solicitándole que configure la
contraseña. Consulte “Inicialización de la unidad”.

Si la fuente de alimentación está en estado de espera
Si la fuente de alimentación de la unidad está en estado de espera, se muestra [Power Standby] en el interruptor
de alimentación de la Aplicación Web.

En este estado, pulse el interruptor de alimentación y seleccione [Power ON]. La unidad se enciende, el indicador
POWER se ilumina en verde en la parte delantera de la unidad y la imagen de la cámara aparece en la pantalla de
operación en directo de la Aplicación Web.

3
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Para cambiar la fuente de alimentación de la unidad al estado de espera
Pulse el interruptor de alimentación de la Aplicación Web y seleccione [Power Standby] para definir la fuente de
alimentación de la unidad en el estado de espera.

Sugerencia

También puede establecer la fuente de alimentación en el estado de espera a través del botón de alimentación del control remoto
infrarrojo suministrado.

Sugerencia

También puede controlar la unidad con el botón de alimentación del control remoto infrarrojo suministrado.

Pulse el botón START/STOP de grabación.

La grabación comienza y la lámpara indicadora/indicador de grabación (2 lugares) de la unidad se ilumina.
Durante la grabación, el botón START/STOP de grabación se ilumina. Además, se muestra un icono del soporte de
grabación objetivo y [●Rec].

4

Para detener la grabación, pulse el botón START/STOP de grabación de nuevo.

La grabación se detiene y la lámpara indicadora/indicador de grabación (2 lugares) de la unidad se apaga.
Durante el estado de espera de la grabación, el botón START/STOP de grabación no se ilumina. Además, se
muestra un icono del soporte de grabación objetivo y [Stby].

Sugerencia

También puede iniciar/detener la grabación con el botón START/STOP de grabación en el control remoto infrarrojo.

5
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Tema relacionado
Inicialización de la unidad

5-041-957-43(1) Copyright 2022 Sony Corporation
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Intercambio de tarjetas de memoria

Si introduce dos tarjetas de memoria, pulse el botón [Slot Select] del panel de control de reproducción de la Aplicación
Web para intercambiar las tarjetas de memoria.

Sugerencia

También puede pulsar el botón SLOT SEL (selección de ranura de tarjeta de memoria (A)/(B)) en el control remoto infrarrojo para
intercambiar las tarjetas de memoria.

Acerca de la grabación continua

Al grabar, la unidad cambia automáticamente a la segunda tarjeta de memoria justo antes de que la capacidad restante
en la primera tarjeta se reduzca a cero (grabación continua). Puede continuar grabando de forma continua al cambiar de
tarjeta de memoria si sustituye la tarjeta de memoria llena por una nueva.

Nota

No se pueden intercambiar las tarjetas de memoria durante el modo de reproducción. Además, la reproducción continua de un
soporte de duración de un clip en la ranura A y B no es compatible.

Acerca de los datos grabados

Al dejar de grabar, el vídeo, el audio, y los datos que los acompañan desde el principio hasta el final de la grabación se
guardan como un solo “clip” en una tarjeta de memoria.

Nombre del clip de los datos grabados

A todos los clips grabados con esta unidad se les asignará un nombre automáticamente a través de [TC/Media] > [Clip
Name Format] en el menú de la cámara.

Duración máxima de clip

Hasta 6 horas por clip.
La duración máxima de una grabación continua es la misma que la duración máxima de un clip. Si el tiempo de
grabación supera la duración máxima de un clip, se crea un clip nuevo automáticamente y continúa la grabación. El
nuevo clip aparece como un clip separado en la pantalla de imágenes en miniatura.
Se graban varios clips sucesivamente durante la grabación continua, pero la grabación se detendrá de manera
automática transcurridas unas 24 horas.

Nota

No extraiga una tarjeta de memoria mientras se esté grabando en ella. Cambie solo las tarjetas de memoria en las ranuras cuyo
indicador de acceso esté apagado.

Cuando la capacidad restante de la tarjeta de memoria en la que se está grabando es inferior a un minuto y en la otra ranura se
ha insertado otra tarjeta de memoria en la que se puede grabar, aparecerá el mensaje “Will Switch Slots Soon”. El mensaje
desaparecerá después de cambiar las ranuras de tarjeta de memoria.

Es posible que la grabación continua no funcione si la grabación comienza cuando la capacidad restante de la tarjeta de
memoria es inferior a un minuto. Para una grabación continua correcta, compruebe que la capacidad restante de la tarjeta de
memoria es superior a un minuto antes de comenzar a grabar.

Los vídeos creados con la función de grabación continua de la unidad no se pueden reproducir sin interrupciones en la unidad.
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Para combinar los vídeos creados con la función de grabación continua de la unidad, utilice el software “Catalyst Browse”.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Comprobación del audio

El audio se emite a través de los conectores SDI y HDMI de la unidad. Seleccione la combinación de canales de audio
que se emiten desde el conector HDMI a través de [Audio] > [Audio Output] > [HDMI/Stream Output CH] en el menú de
la cámara.
CH1/CH2: combinación de CH1 y CH2
CH3/CH4: combinación de CH3 y CH4
Cuando supervise el audio en la Aplicación Web, utilice el medidor del nivel de audio de la parte inferior derecha de la
imagen de la cámara.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Especificación de los datos de tiempo

En este tema se describe cómo establecer los datos de tiempo.

Ajuste del código de tiempo

Defina el código de tiempo para la grabación en [TC/Media] > [Timecode], en el menú de cámara.

Ajuste de los bits del usuario

Puede añadir un número hexadecimal de 8 dígitos a la imagen grabada como bits de usuario. También puede establecer
los bits del usuario a la hora actual. Se define a través de [TC/Media] > [Users Bit] en el menú de la cámara.

Visualización de los datos de tiempo

Defina el código de tiempo que se mostrará en [TC/Media] > [TC Display] > [Display Select], en el menú de cámara.
Si pulsa un botón asignable con la opción [DURATION/TC/U-BIT] asignada, cambiará la visualización entre código de
tiempo, los bits de usuario y la duración de forma consecutiva.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Revisión de la grabación (Rec Review)

Puede revisar el último clip grabado en la pantalla (revisión de grabación).

Nota

Rec Review no es compatible si el formato de vídeo se cambia después de grabar un clip.

Ajuste del punto de inicio de Rec Review

Puede establecer el punto de inicio de la reproducción en uno de los siguientes mediante [Technical] > [Rec Review] en
el menú de la cámara.

Últimos 3 segundos del clip
Últimos 10 segundos del clip
Inicio del clip

Sugerencia

Si desea revisar un clip específico después de grabar varios clips, presione el botón [Thumbnail] para mostrar la pantalla de
miniaturas y seleccione el clip para comenzar la reproducción.

También puede pulsar el botón THUMBNAIL en el control remoto infrarrojo para mostrar la pantalla de imágenes en miniatura.

Método Rec Review

Asigne primero la función Rec Review a uno de los botones asignables en el panel de ajuste de la configuración básica.

Para obtener más información acerca de la asignación, consulte “Botones asignables” en “Funciones útiles”.

Detenga la grabación y, a continuación, pulse un botón asignable asignado con la función Rec Review para comenzar la
reproducción del clip anteriormente grabado.

135



El clip se reproduce hasta el final, Rec Review finaliza y la unidad vuelve al modo Stby (en espera).

Para detener Rec Review
Presione un botón asignable con Rec Review asignado o pulse el botón [Cancel/Back].
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Sugerencia

Puede pulsar el botón [Cancel/Back] en el control remoto infrarrojo para detener la función Rec Review.

Tema relacionado

Botones asignables

5-041-957-43(1) Copyright 2022 Sony Corporation
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Pantalla de ajuste del encuadre

El encuadre se ajusta mediante los siguientes elementos de la pantalla de operación en directo.

Nota

En función de la dirección de la cámara, la distancia focal del objetivo y la posición del zoom, es posible que parte de la unidad o
de los cables conectados al bloque de conectores esté visible. Antes de filmar, compruebe el campo de visión para el objetivo y
la distancia focal que está usando. También puede controlar el rango de giro/inclinación mediante [Pan-Tilt] > [P/T Range Limit]
en el menú web. Cuando la unidad se activa o se ejecuta el restablecimiento de giro/inclinación, este ajuste de límite de rango se
ignora. Para obtener más detalles, consulte [Pan-Tilt] > [P/T Range Limit] en el menú web.

Sugerencia

También puede controlar el encuadre con el control remoto infrarrojo suministrado.

5-041-957-43(1) Copyright 2022 Sony Corporation

Panel de control de la posición preajustada1.

Pestaña  (Main) / pestaña  (Others)2.

Panel de control de encuadre3.
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Ajuste de la dirección de filmación mediante la Aplicación Web

El movimiento horizontal de la cámara se denomina giro y el vertical, inclinación.
Puede ajustar la dirección de filmación a través de las operaciones de giro/inclinación.

Sugerencia

Si la opción [Execute Pan-Tilt Reset] se muestra debajo de la palanca de mando, significa que se ha producido una incoherencia
en la información de origen del control de giro/inclinación de la unidad. Ejecute la función de restablecimiento del giro/inclinación
para actualizar la información de origen. Para obtener más detalles, consulte “Restablecimiento del giro/inclinación”.

Para orientar la cámara de nuevo hacia adelante
Pulse el botón  (restablecer giro/inclinación) en la pestaña  (Others) en el panel de control de la cámara.

Nota

En función de la dirección de la cámara, la distancia focal del objetivo y la posición del zoom, es posible que parte de la unidad o
de los cables conectados al bloque de conectores esté visible. Antes de filmar, compruebe el campo de visión para el objetivo y
la distancia focal que está usando. También puede controlar el rango de giro/inclinación mediante [Pan-Tilt] > [P/T Range Limit]
en el menú web. Cuando la unidad se activa o se ejecuta el restablecimiento de giro/inclinación, este ajuste de límite de rango se
ignora. Para obtener más detalles, consulte [Pan-Tilt] > [P/T Range Limit] en el menú web.

Tema relacionado

Restablecimiento del giro/inclinación

Pulse la pestaña  (Giro/inclinación/zoom) en el panel de control de encuadre para mostrar la
palanca de mando.

1

Arrastre el centro de la palanca de mando en la dirección que desee visualizar mientras controla el panel de
imagen de la cámara.

La dirección y la velocidad de la cámara cambian en respuesta a la orientación de arrastre y el nivel.
Puede ajustar la inclinación/giro de manera más precisa si pulsa las zonas periféricas de la palanca de mando.

2
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Ajuste de la velocidad del giro/inclinación

Para modificar la velocidad de funcionamiento del giro/inclinación con el control deslizante [Pan-Tilt Speed] del panel de
control de la cámara, utilice la palanca de mando del panel de control de encuadre.

Nota

Si hay alguna pared u obstáculo dentro del rango de movimiento de la cámara, tenga cuidado de no golpear la cámara o el
objetivo durante la operación de giro/inclinación.

La aceleración del giro/inclinación depende de las características físicas como el equilibrio del peso del objetivo. Puede cambiar
el ajuste de la aceleración con [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] en el menú web o en el menú de la cámara.

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse la pestaña  (Main) en el panel de control de la cámara.1

Seleccione el control deslizante [Pan-Tilt Speed] de la lista.

Si el control deslizante [Pan-Tilt Speed] no se muestra, seleccione uno de los dos botones de selección de
funciones del control deslizante para mostrarlo.

2

Mueva la perilla del control deslizante hacia la izquierda o hacia la derecha.

Si mueve la perilla hacia la izquierda, la velocidad de funcionamiento disminuirá y, si la mueve hacia la derecha,
aumentará.

3
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Ajuste de la aceleración del giro/inclinación

Puede establecer la operación de aceleración en nueve gradaciones a través de [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] en el menú web o en el menú de la cámara. Aumente el valor para que los cambios de velocidad sean más
rápidos o disminúyalo para unos cambios de velocidad más graduales.
Para una mayor capacidad de respuesta cuando se utiliza el giro/inclinación, seleccione un valor en el intervalo de 7 a 9.
Para una mayor precisión en la posición al inicio/finalización del movimiento en una posición preajustada, se recomienda
un valor en el intervalo de 1 a 6.

Para obtener más detalles sobre la posición preajustada, consulte “Almacenamiento/restablecimiento de la posición
de giro/inclinación y zoom”.

Nota

Si el valor establecido es alto, es posible que la función no funcione correctamente si se acopla un objetivo pesado. Compruebe
el funcionamiento antes del uso real.

Relación entre el ajuste [Ramp Curve] y la operación de giro/inclinación

Cuando se utiliza el giro/inclinación

Cuando se recupera una posición preajustada
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Ajuste de la dirección de filmación mediante el control remoto infrarrojo suministrado

Puede ajustar la dirección de filmación mediante los botones de la operación de giro/inclinación del control remoto
infrarrojo suministrado.

Para orientar la cámara de nuevo hacia adelante
Pulse el botón HOME.

Nota

En función de la dirección de la cámara, la distancia focal del objetivo y la posición del zoom, es posible que parte de la unidad o
de los cables conectados al bloque de conectores esté visible. Antes de filmar, compruebe el campo de visión para el objetivo y
la distancia focal que está usando. También puede controlar el rango de giro/inclinación mediante [Pan-Tilt] > [P/T Range Limit]
en el menú web. Cuando la unidad se activa o se ejecuta el restablecimiento de giro/inclinación, este ajuste de límite de rango se
ignora. Para obtener más detalles, consulte [Pan-Tilt] > [P/T Range Limit] en el menú web.

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse los botones de las flechas para controlar el giro/inclinación.

Pulse el botón de flecha de la dirección que desee visualizar mientras controla la imagen de la cámara.
Para desplazarse una distancia corta, pulse brevemente el botón de la flecha.
Para desplazarse una distancia larga, mantenga pulsado el botón de la flecha.
Para moverse diagonalmente, mantenga pulsado el botón  (flecha hacia arriba) o  (flecha hacia abajo) y
pulse el botón  (flecha hacia la izquierda) o  (flecha hacia la derecha).

1
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Ajuste del tipo de zoom

Ajuste el tipo de zoom con [Technical] > [Zoom] > [Zoom Type] en el menú de la cámara.
El tipo de zoom variará en función del tipo de objetivo acoplado.

Nota

Clear Imagen Zoom no está disponible en los siguientes casos:

Cuando el ajuste [Shooting] > [S&Q Motion] > [Setting] está definido en On y el ajuste [Frame Rate] del menú de la cámara es
superior a 60 fps
Cuando [Project] > [Rec Format] > [Codec] en el menú de la cámara está establecido en [RAW] o en una opción que incluye
RAW

Cuando se utiliza el interruptor de selección SERVO/MANUAL de un objetivo, la ampliación de Clear Image Zoom se restablece
en 1×.

AF-S no es compatible durante Clear Image Zoom.

Clear Image Zoom

La unidad cuenta con una función de zoom que utiliza un procesamiento de la señal de la imagen llamado Clear Image
Zoom. Cuando Clear Image Zoom está activado, se admite el zoom incluso para los objetivos de focal fija. También se
puede utilizar para ampliar el rango más allá del rango óptico de un objetivo con zoom motorizado.
La relación de zoom máxima con Clear Image Zoom varía en función de la resolución de grabación.

Para la resolución de grabación QFHD/4K: 1,5×
Para la resolución de grabación HD: 2×

5-041-957-43(1) Copyright 2022 Sony Corporation

Tipo de objetivo acoplado
Ajuste [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Objetivo de focal fija/objetivo con
zoom manual

No se admite el funcionamiento del
zoom.

Se admite Clear Image Zoom.

Objetivo con zoom motorizado Solo se admite el zoom óptico.
Se admiten el zoom óptico y Clear
Image Zoom.
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Ajuste del zoom mediante la Aplicación Web

Es posible ajustar el zoom de la unidad mediante el zoom óptico o de Clear Image Zoom. En este tema se describe
cómo realizar ajustes mediante la Aplicación Web. Para obtener más información acerca de Clear Image Zoom, consulte
“Ajuste del tipo de zoom”.

Nota

En función de la dirección de la cámara, la distancia focal del objetivo y la posición del zoom, es posible que parte de la unidad o
de los cables conectados al bloque de conectores esté visible. Antes de filmar, compruebe el campo de visión para el objetivo y
la distancia focal que está usando. También puede controlar el rango de giro/inclinación mediante [Pan-Tilt] > [P/T Range Limit]
en el menú web. Cuando la unidad se activa o se ejecuta el restablecimiento de giro/inclinación, este ajuste de límite de rango se
ignora. Para obtener más detalles, consulte [Pan-Tilt] > [P/T Range Limit] en el menú web.

La velocidad de zoom real y la precisión variarán dependiendo del objetivo. Compruebe el funcionamiento antes del uso.

Sugerencia

Puede controlar el zoom de un objetivo de zoom manual utilizando un controlador del objetivo (opcional) que sea compatible con
esta unidad. Para obtener más detalles, consulte “Ajuste del zoom mediante un controlador del objetivo” y “Ajuste del zoom
mediante un controlador del objetivo”.

Tema relacionado

Ajuste del tipo de zoom

Conexión de un controlador del objetivo

Ajuste del zoom mediante un controlador del objetivo

Pulse la pestaña  (Giro/inclinación/zoom) en el panel de control del encuadre para mostrar el panel
de control de giro/inclinación.

1

Deslice la perilla del control deslizante [Zoom] en la dirección [T] (telefoto) o [W] (gran angular) para ajustar
el zoom.

La velocidad de zoom varía con el movimiento del control deslizante.

2
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Ajuste de la velocidad de funcionamiento del zoom

Para modificar la velocidad de funcionamiento del zoom con el control deslizante [Zoom] del panel de control de
encuadre, utilice el control deslizante [Zoom Speed] del panel de control de la cámara.

Nota

La velocidad de zoom real y la precisión variarán dependiendo del objetivo. Compruebe el funcionamiento antes del uso.
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Pulse la pestaña  (Main) en el panel de control de la cámara.1

Seleccione el control deslizante [Zoom Speed] de la lista.

Si el control deslizante [Zoom Speed] no se muestra, seleccione uno de los dos botones de selección de funciones
del control deslizante para mostrarlo.

 

2

Mueva la perilla del control deslizante [Zoom Speed] hacia la izquierda o hacia la derecha.

Si mueve la perilla hacia la izquierda, la velocidad de funcionamiento disminuirá y, si la mueve hacia la derecha,
aumentará.

3
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Ajuste del zoom mediante el control remoto infrarrojo suministrado

Es posible ajustar el zoom de la unidad mediante el zoom óptico o de Clear Image Zoom. En este tema se describe
cómo realizar ajustes mediante el control remoto infrarrojo suministrado. Para obtener más información acerca de Clear
Image Zoom, consulte “Ajuste del tipo de zoom”.

Nota

En función de la dirección de la cámara, la distancia focal del objetivo y la posición del zoom, es posible que parte de la unidad o
de los cables conectados al bloque de conectores esté visible. Antes de filmar, compruebe el campo de visión para el objetivo y
la distancia focal que está usando. También puede controlar el rango de giro/inclinación mediante [Pan-Tilt] > [P/T Range Limit]
en el menú web. Cuando la unidad se activa o se ejecuta el restablecimiento de giro/inclinación, este ajuste de límite de rango se
ignora. Para obtener más detalles, consulte [Pan-Tilt] > [P/T Range Limit] en el menú web.

Sugerencia

Puede controlar el zoom de un objetivo de zoom manual utilizando un controlador del objetivo (opcional) que sea compatible con
esta unidad. Para obtener más detalles, consulte “Ajuste del zoom mediante un controlador del objetivo” y “Ajuste del zoom
mediante un controlador del objetivo”.

Tema relacionado

Ajuste del tipo de zoom

Conexión de un controlador del objetivo

Ajuste del zoom mediante un controlador del objetivo

5-041-957-43(1) Copyright 2022 Sony Corporation

Para ajustar el zoom, pulse el botón del zoom.

Pulse el botón T (telefoto) o W (gran angular) mientras controla la pantalla para ajustar el zoom.
Para acercar la imagen, pulse el botón T.
Para alejar la imagen, pulse el botón W.

1
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Calibración de un objetivo de montura E

La calibración corrige las diferencias en la posición del zoom debido a las diferencias de objetivos individuales al utilizar
un objetivo con zoom motorizado de montura E.
Para calcular la posición del zoom de manera precisa, calibre el objetivo para corregir las diferencias individuales del
objetivo siguiendo el procedimiento que se describe a continuación.

Datos de calibración
Es posible almacenar los datos de calibración de hasta cinco objetivos en la unidad. Los datos más antiguos se
sobrescribirán cuando se calibre el objetivo número 6 y posteriores.
Para comprobar si los datos de calibración del objetivo acoplado están disponibles, pulse el botón  (Estado de la
cámara) del área común de la Aplicación Web y seleccione [Lens] > [Calibration Data].

5-041-957-43(1) Copyright 2022 Sony Corporation

Si el objetivo dispone de un interruptor SERVO/MANUAL, establézcalo en la posición SERVO.

Nota

El objetivo no podrá recibir instrucciones de zoom desde la unidad si el interruptor se establece en MANUAL.

1

Para ejecutar la calibración, vaya a [Technical] > [Lens] > [Lens Calibration] en el menú de la cámara.

Durante la calibración, el objetivo con zoom se mueve automáticamente y se mide.

2
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Almacenamiento/restablecimiento de la posición de giro/inclinación, la posición del
zoom y el ajuste de enfoque con la Aplicación Web

Puede almacenar la posición de giro/inclinación, la posición del zoom y el ajuste de enfoque y recuperarlos cuando sea
necesario a través de la Aplicación Web (función de posición preajustada).

Para obtener más información acerca de los elementos que se pueden almacenar/restablecer, consulte “Elementos
guardados de posición preajustada”.

Nota

No se puede guardar una posición predefinida si el porcentaje de Clear Image Zoom es superior a 1×.

Si se cambia el ajuste [Pan-Tilt] > [P/T Direction] > [Ceiling] en el menú web, se eliminan todas las posiciones preajustadas.

Establezca el modo de asistencia PTZ en [Pos.] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

1

Determine la posición que desee guardar a través de las operaciones de giro/inclinación y zoom.2

Pulse el botón [+] en el panel de control de posición preajustada.

La imagen con la posición almacenada se muestra en el panel de control de posición preajustada.

Sugerencia

Si el panel de control de posición preajustada no se muestra, pulse el botón  (abrir) para mostrarlo.

Las posiciones se guardan de manera secuencial a partir de [Preset1].

Si hay preajustes sin utilizar dentro de una secuencia de ellos, las posiciones se almacenarán comenzando por aquellos
sin utilizar. Por ejemplo, si las posiciones preajustadas se almacenan en [Preset1] y [Preset3], pero no en [Preset2], las

3
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Para cancelar la operación de restauración de la posición preajustada
Pulse el botón  (Cancelar restauración) que aparece en el panel de control de posición predefinida durante la
operación de restauración de posición predefinida para cancelar la operación de restauración. Utilice la palanca de
mando y el control deslizante [Zoom] para ajustar el encuadre.

siguientes posiciones preajustadas se almacenarán en [Preset2] y luego en [Preset4].

Es posible almacenar hasta 100 posiciones preajustadas.

Puede cambiar de nombre cada posición preajustada. Para obtener más detalles, consulte “Cambio de nombre de
posiciones preajustadas mediante la Aplicación Web”.

Restablezca una posición guardada.

Pulse dos veces en la imagen en miniatura de la posición que desee restablecer en el panel de control de posición
preajustada para restablecer la posición correspondiente.

Sugerencia

También puede restablecer una posición pulsando la imagen y el botón  (Menú de posición preajustada) que aparece y
seleccionando [Recall].

La velocidad de transición a una posición guardada viene determinada por el ajuste [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] >
[Pan-Tilt Speed for Common] del menú web cuando se almacenó la posición. Es posible modificar la velocidad de
transición después de guardar. Para obtener más detalles, consulte “Cambio de la velocidad de transición (giro-
inclinación/zoom/enfoque) al restaurar una posición preajustada”.

Es posible ajustar el grado de cambio de la posición de giro/inclinación al pasar a una posición preajustada mediante la
velocidad de transición y el ajuste [Ramp Curve]. Para obtener más detalles, consulte “Cambio de la velocidad de
transición (giro-inclinación/zoom/enfoque) al restaurar una posición preajustada” y “Ajuste de la aceleración del
giro/inclinación”.

Si se recupera un preajuste diferente durante la reproducción predeterminada, la operación del primer preajuste
recuperado se detiene y comienza la operación del inicio predeterminado recuperado posteriormente.

Nota

Si la temperatura del entorno ha cambiado significativamente entre el momento en que se guardó una posición preajustada
y el momento en que se reproduce, puede producirse una desviación en el encuadre.

Mientras se restaura una posición preajustada, no se puede realizar ninguna otra operación que no sea restaurar o
cancelar la posición preajustada.

4
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Tema relacionado

Elementos guardados de posición preajustada

Cambio de nombre de las posiciones preajustadas mediante la Aplicación Web

Cambio de la velocidad de transición (giro-inclinación/zoom/enfoque) al restaurar una posición preajustada

Ajuste de la aceleración del giro/inclinación
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Cambio de nombre de las posiciones preajustadas mediante la Aplicación Web

Puede cambiar de nombre a las posiciones preajustadas almacenadas.
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Establezca el modo de asistencia PTZ en [Pos.] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

1

Pulse la posición preajustada cuyo nombre desee cambiar.

El botón  (Menú Preset Position) aparece en el lado superior derecho de la imagen.

2

Pulse el botón  (Menú Preset Position) y seleccione [Rename] en el menú mostrado.3

Introduzca un nuevo nombre para el preajuste.4
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Sustitución de una posición preajustada almacenada por una posición nueva
mediante la Aplicación Web

Puede sustituir una posición preajustada almacenada por una posición nueva.
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Establezca el modo de asistencia PTZ en [Pos.] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

1

Determine la posición que desee guardar a través de las operaciones de giro/inclinación y zoom.2

Pulse en la imagen de la posición que desee sustituir en el panel de control de posición preajustada.

El botón  (Menú Preset Position) aparece en el lado superior derecho de la imagen.

3

Pulse el botón  (Menú Preset Position) y seleccione [Replace] en el menú mostrado.

La nueva posición sustituye al ajuste actual.

4
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Eliminación de una posición preajustada almacenada mediante la Aplicación Web

Puede eliminar las posiciones preajustadas almacenadas.
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Establezca el modo de asistencia PTZ en [Pos.] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

1

Pulse en la imagen de la posición que desee eliminar en el panel de control de posición preajustada.

El botón  (Menú Preset Position) aparece en el lado superior derecho de la imagen.

2

Pulse el botón  (Menú Preset Position) y seleccione [Delete] en el menú mostrado.

Se elimina la posición guardada.

3
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Sincronización de las operaciones de giro/inclinación y zoom/enfoque al restaurar
una posición preajustada

Puede sincronizar las operaciones de giro/inclinación y zoom al restaurar una posición preajustada para obtener un
encuadre más suave.

Sugerencia

Puede especificar de antemano los ajustes utilizados para registrar una posición preajustada. Establezca [Pan-Tilt] > [P/T Preset]
> [Default] > [Zoom Sync] en [On] en el menú web.

Cuando [Pan-Tilt] > [P/T Preset] > [Speed Select] está ajustado en [Common], todas las posiciones preajustadas se
restablecerán a la velocidad fijada mediante [Pan-Tilt] > [P/T Preset] > [Common Speed].

Una vez finalizado el movimiento del zoom, la cámara se desplaza a la posición de enfoque almacenada.

Una vez finalizado el movimiento del zoom, [AF Transition Speed] vuelve a su configuración original.

Establezca el modo de asistencia PTZ en [Pos.] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

1

Pulse en la imagen de la posición preajustada cuya velocidad de transición desee modificar.

El botón  (Menú Preset Position) aparece en el lado superior derecho de la imagen.

2

Pulse el botón  (Menú Preset Position) y seleccione [Edit…] en el menú mostrado.

Aparece la pantalla de configuración de la posición preajustada seleccionada.

3

Deslice el interruptor [Zoom Sync] hacia la derecha para activar la función y pulse el botón [OK].

La próxima vez que se restablezca una posición almacenada, la cámara se moverá a la velocidad configurada.

4
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Cambio de la velocidad de transición (giro-inclinación/zoom/enfoque) al restaurar una
posición preajustada

Puede cambiar la velocidad de transición (operaciones de giro/inclinación, zoom y enfoque) al restaurar una posición
preajustada almacenada.

Sugerencia

Cuando [Pan-Tilt] > [P/T Preset] > [Speed Select] está ajustado en [Common], se restablecen todas las posiciones a la velocidad
ajustada con [Pan-Tilt] > [P/T Preset] > [Common Speed].

Una vez finalizado el movimiento del zoom, la cámara se desplaza a la posición de enfoque almacenada.

Una vez finalizado el movimiento del zoom, [AF Transition Speed] vuelve a su configuración original.

Establezca [Pan-Tilt] > [P/T Preset] > [Speed Select] en [Separate] en el menú web.1

Establezca el modo de asistencia PTZ en [Pos.] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

2

Pulse en la imagen de la posición preajustada cuya velocidad de transición desee modificar.

El botón  (Menú Preset Position) aparece en el lado superior derecho de la imagen.

3

Pulse el botón  (Menú Preset Position) y seleccione [Edit…] en el menú mostrado.

Aparece la pantalla de configuración de la posición preajustada seleccionada.

4

Ajuste las velocidades de transición (giro-inclinación/zoom/focus) que desee modificar mediante los
controles deslizantes o introduzca directamente los valores y pulse el botón [OK].

La próxima vez que se restablezca una posición almacenada, la cámara se moverá a la velocidad configurada.

5
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Almacenamiento/restablecimiento de la posición de giro/inclinación y del zoom
mediante el control remoto infrarrojo suministrado

Puede almacenar la posición de giro/inclinación y del zoom y recuperarlas cuando sea necesario mediante el control
remoto infrarrojo suministrado.

Tema relacionado
Cambio de la velocidad de transición (giro-inclinación/zoom/enfoque) al restaurar una posición preajustada

Ajuste la posición de giro/inclinación y del zoom de la cámara.1

Establezca el modo de asistencia PTZ en [Pos.] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas en la Aplicación Web.

2

Mantenga pulsado el botón PRESET y pulse uno de los botones del 1 al 3.

La posición se guarda.

3

Restablezca una posición guardada.

Pulse uno de los botones de 1 a 3 para restablecer esa posición preajustada.

Sugerencia

La velocidad de transición al restaurar una posición preajustada viene determinada por el valor guardado de [Pan-Tilt] >
[P/T Preset] > [Pan-Tilt Speed] en el menú web. Es posible modificar la velocidad de transición después de guardar un
valor. Para obtener más detalles, consulte “Cambio de la velocidad de transición (giro-inclinación/zoom/enfoque) al
restaurar una posición preajustada”.

4
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Grabación de operaciones de encuadre de la cámara mediante la Aplicación Web

Puede grabar las operaciones de encuadre con la cámara mediante la Aplicación Web.

Ajuste la posición inicial de funcionamiento de la cámara.1

Establezca el modo de asistencia PTZ en [Trace] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

2

Pulse el botón [+] en el panel de control de posición preajustada.

Se añade una imagen en miniatura y la cámara pasa al estado de grabación en espera.

Sugerencia

3
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Sugerencia

El tiempo de grabación restante se muestra en la parte superior del panel de imagen de la cámara durante la grabación.

Nota

Las operaciones de encuadre grabadas se eliminarán si cambia a montaje en techo

El cambio de frecuencia del sistema puede borrar las operaciones de encuadre grabadas.

La operación del zoom no se graba cuando se conecta un controlador del objetivo.

La duración máxima de grabación de un solo encuadre es de 3 minutos. La grabación se detendrá automáticamente cuando la
duración de la grabación alcance los 3 minutos.

La grabación de una operación de encuadre no puede iniciarse si la relación de Clear Image Zoom es superior a 1×.

Si la cámara se maneja desde otro dispositivo mientras se graba una operación de encuadre, las operaciones desde el otro
dispositivo también se grabarán. Para obtener más detalles sobre las operaciones de grabación con un controlador remoto de
otro fabricante, póngase en contacto con el fabricante correspondiente.

Los ajustes de enfoque y calidad de imagen no se graban con esta función.

Puede pulsar el botón  (cerrar) de la imagen en miniatura para salir del estado de grabación en espera y volver al
funcionamiento normal.

Inicie la operación de encuadre utilizando la palanca de mando y el control deslizante [Zoom].

La grabación comienza en el momento en que se inicia la operación de encuadre.

4

Pulse el botón  (detener grabación) de la imagen en miniatura para detener la grabación.5
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Las operaciones de giro/inclinación/zoom grabadas al grabar un encuadre no pueden reproducirse exactamente durante la
reproducción del encuadre.

Si, después de grabar una operación de encuadre, ajusta el límite de rango de giro/inclinación mediante [Pan-Tilt] > [P/T Range
Limit] el menú web, el límite de rango de giro/inclinación no se aplicará durante la reproducción del encuadre. Si desea utilizar
una operación de encuadre y la función de límite de giro/inclinación a la vez, ajuste el límite de rango de giro/inclinación antes de
grabar la operación de encuadre.

Las operaciones de encuadre grabadas no pueden reproducirse cuando se selecciona la salida de vídeo RAW.

Las operaciones de encuadre grabadas no pueden reproducirse cuando la señal de vídeo no se emite desde el conector de
salida SDI.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Reproducción de operaciones de encuadre de la cámara mediante la Aplicación Web

Puede reproducir la operación de encuadre grabada por la cámara mediante la Aplicación Web.

Establezca el modo de asistencia PTZ en [Trace] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

1

Seleccione una imagen en miniatura con la operación de encuadre que desee reproducir.

El botón  (preparar) aparece en la imagen en miniatura.

2

Pulse el botón  (preparar).

La cámara se desplaza a la posición de inicio de la operación de encuadre y pasa al estado de reproducción en
espera.

3

Pulse el botón  (reproducir) en la imagen en miniatura.4
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Sugerencia

Se inicia la reproducción del encuadre.
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En el estado de reproducción en espera y durante la reproducción, puede cancelar la reproducción y volver al funcionamiento
normal realizando cualquiera de las siguientes operaciones.

Pulse el botón  (detener) en la imagen en miniatura o en el panel de control de la posición preajustada.
Utilice la palanca de mando.
Utilice el control deslizante [Zoom].

El tiempo de reproducción transcurrido se muestra en la parte superior del panel de imagen de la cámara durante la
reproducción.

Nota

Puede producirse un comportamiento inesperado si el ajuste del zoom para borrar imágenes difiere entre la grabación y la
reproducción de operaciones de encuadre.

La reproducción de la operación del zoom no es compatible cuando se conecta un controlador del objetivo. El funcionamiento del
zoom detendrá la reproducción de las operaciones de encuadre.

Durante la reproducción de la operación de encuadre, cambiar el límite del rango de giro/inclinación mediante [Pan-Tilt] > [P/T
Range Limit] el menú web no tiene ningún efecto. Establezca el límite del rango de giro/inclinación antes de grabar una
operación de encuadre.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Eliminación de operaciones de encuadre grabadas por la cámara mediante la
Aplicación Web

Puede eliminar las operaciones de encuadre grabadas por la cámara mediante la Aplicación Web.

5-041-957-43(1) Copyright 2022 Sony Corporation

Establezca el modo de asistencia PTZ en [Trace] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

1

Seleccione una imagen en miniatura con la operación de encuadre que desee eliminar.

El botón  (menú Trace) aparece en la imagen en miniatura.

2

Pulse el botón  (menú Trace).

Aparece el menú.

3

Seleccione [Delete] en el menú que aparece.

Se elimina la operación de encuadre seleccionada.

4
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Grabación de las operaciones de encuadre de la cámara con el control remoto
infrarrojo suministrado

Puede grabar operaciones de encuadre con el control remoto infrarrojo suministrado.

Para obtener más información acerca de la reproducción de una operación de encuadre, consulte “Reproducción de las
operaciones de encuadre de la cámara con el control remoto infrarrojo suministrado”.

Nota

La duración máxima de grabación de un solo encuadre es de 3 minutos. La grabación se detendrá automáticamente cuando la
duración de la grabación alcance los 3 minutos.

Si la cámara se maneja desde otro dispositivo mientras se graba una operación de encuadre, la operación desde el otro
dispositivo también se grabará como parte de la operación de encuadre.

Si se ajusta la calidad de la imagen mientras se graba un encuadre, ese cambio no se graba.

Tema relacionado

Reproducción de las operaciones de encuadre de la cámara con el control remoto infrarrojo suministrado

5-041-957-43(1) Copyright 2022 Sony Corporation

Acceda a la pantalla de operación en directo de la Aplicación Web.1

Establezca el modo de asistencia PTZ en [Trace] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

2

Ajuste la posición inicial de funcionamiento de la cámara con el control remoto infrarrojo.3

Mantenga pulsado el botón PRESET y pulse uno de los botones del POSITION1 al 3.

La cámara pasa al estado de grabación en espera.

4

Realice la operación de encuadre que desee grabar.5

Para finalizar la grabación, mantenga pulsado el botón PRESET y pulse el botón POSITION seleccionado en
el paso 4.

6
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Interchangeable Lens Digital Camera
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Reproducción de las operaciones de encuadre de la cámara con el control remoto
infrarrojo suministrado

Puede reproducir una operación de encuadre con el control remoto infrarrojo suministrado.

Nota

Al operar el movimiento de giro/inclinación/zoom de la cámara se detendrá la reproducción.

Tema relacionado

Grabación de las operaciones de encuadre de la cámara con el control remoto infrarrojo suministrado

5-041-957-43(1) Copyright 2022 Sony Corporation

Acceda a la pantalla de operación en directo de la Aplicación Web.1

Establezca el modo de asistencia PTZ en [Trace] en la lista desplegable, en la parte superior del panel de
control de posiciones preajustadas.

2

Seleccione y pulse uno de los botones de POSITION1 a 3 para el que se haya registrado una operación de
encuadre.

El movimiento de giro/inclinación/zoom de la cámara se desplaza a la posición inicial de reproducción.

3

Después de que la cámara se desplace a la posición inicial de reproducción, pulse de nuevo el mismo
botón POSITION.

Se inicia la reproducción.

4
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Pantalla de ajuste del enfoque

El enfoque se ajusta mediante los siguientes elementos de la pantalla de operación en directo.

5-041-957-43(1) Copyright 2022 Sony Corporation

Panel de imagen de la cámara
Para ajustar el enfoque, toque la imagen de la cámara. Para deshabilitar el funcionamiento táctil en la Aplicación
Web, desactive el interruptor [Touch Focus] en la pestaña  (Focus) en el panel de control de la cámara.

1.

Panel de control de la cámara – pestaña  (Focus)2.

Panel de control de la GUI3.
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Ajuste manual mediante la Aplicación Web

Puede ajustar el enfoque manualmente en los siguientes casos, por ejemplo.

Sujetos parcialmente oscurecidos por gotas de agua
Sujetos con poco contraste con el fondo
Sujetos más alejados que otros más cercanos

Nota

El enfoque manual no puede controlarse desde la aplicación web mientras se está utilizando el zoom.

Sugerencia

También puede utilizar el enfoque automático cuando el ajuste manual es el principal método de funcionamiento. Para obtener
más detalles, consulte “Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación Web”.

Tema relacionado

Comprobación de los interruptores del objetivo

Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación Web
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Si el objetivo dispone de interruptor de selección de enfoque, sitúe el interruptor en la posición “AF/MF” o
“AF”.

Nota

Si se ajusta el interruptor en la posición “Full MF” o “MF”, el enfoque del objetivo no se puede realizar con la unidad.
Consulte “Para un objetivo con un interruptor de modo de enfoque” en “Comprobación de los interruptores del objetivo”.

1

Deslice el interruptor [Auto Focus] hacia la izquierda en el panel de control de la cámara para desactivar el
enfoque automático.

El modo de enfoque manual se activa.

 (MF)

2

Efectúe el ajuste con el control deslizante situado en la parte inferior de la pestaña  (Focus).3
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Ajuste manual mediante el control remoto infrarrojo suministrado

Puede ajustar manualmente el enfoque mediante el control remoto infrarrojo suministrado.

Sugerencia

También puede utilizar el enfoque automático cuando el ajuste manual es el principal método de funcionamiento. Para obtener
más detalles, consulte “Enfoque manual durante el enfoque automático mediante el control remoto infrarrojo proporcionado”.

Tema relacionado

Enfoque manual durante el enfoque automático mediante el control remoto infrarrojo proporcionado
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Pulse el botón MF del control remoto infrarrojo.1

Puede ajustar manualmente el enfoque a través de los botones F (lejos) y N (cerca).

Para enfocar a un sujeto que está lejos, pulse el botón F.
Para enfocar a un sujeto que está cerca, pulse el botón N.

2
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Enfoque mediante la especificación de una posición de enfoque (Spot Focus)

En el modo de enfoque manual, puede especificar la posición en la que quiere ajustar el enfoque en el panel de imagen
de la cámara.

Nota

La función Spot Focus no se puede utilizar si el objetivo está ajustado en enfoque manual.

Sugerencia

En modo Spot Focus, puede pulsar un botón asignable asignado con [Push AF/MF] para detener temporalmente Spot Focus y
poder enfocar automáticamente mientras el botón está pulsado. El enfoque volverá al enfoque manual cuando suelte el botón.
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Establezca [Shooting] > [Focus] > [Touch Function in MF] en [Spot Focus] en el menú web o en el menú de
la cámara.

1

Deslice el interruptor [Touch Focus] de la pestaña  (Focus) hacia la derecha para activarlo.2

Deslice el interruptor [Auto Focus] de la pestaña  (Focus) hacia la izquierda para desactivarlo.3

Especifique la posición del enfoque.

El marcador de Spot Focus aparece y la imagen se ajusta para estar enfocada en esa posición.

Ejemplo de cómo especificar la posición mediante el funcionamiento táctil

4
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Uso del enfoque automático de forma temporal (Push Auto Focus (AF))

En el modo de enfoque manual, puede ajustar el enfoque temporalmente mediante el enfoque automático si pulsa el
botón [Push AF/MF] para enfocar automáticamente mientras se presiona el botón.
Esto es útil cuando desea mover el enfoque lentamente de un sujeto a otro durante el enfoque manual.

Nota

El enfoque automático mediante una pulsación no se puede utilizar si el objetivo está ajustado en enfoque manual.

Sugerencia

Se admite la misma operación utilizando un botón asignable asignado con [Push AF/MF].
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Establezca [Shooting] > [Focus] > [Push AF Mode] en [AF] en el menú de la cámara.1

Deslice el interruptor [Auto Focus] de la pestaña  (Focus) hacia la izquierda para desactivarlo.2

Pulse el botón [Push AF/MF].

El enfoque automático está activo mientras se presiona el botón.

El enfoque automático mediante una pulsación se liberará y el enfoque volverá a ser manual cuando suelte el
botón.

3
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Uso de Enfoque automático de una sola toma (Push Auto Focus (AF-S))

Puede pulsar el botón [Push AF/MF] cuando está en modo de enfoque manual para enfocar automáticamente a alta
velocidad.
Esta función resulta cómoda si enfoca sobre un sujeto antes de filmar.

Nota

El enfoque automático mediante una pulsación no se puede utilizar si el objetivo está ajustado en enfoque manual.

El marco del área de enfoque no está oculto cuando se usa el botón [Display].

Establezca [Shooting] > [Focus] > [Push AF Mode] en [Single-shot AF(AF-S)] en el menú web o en el menú
de la cámara.

1

Especifique la posición para la que desea ajustar el enfoque mediante [Shooting] > [Focus] > [Focus Area
(AF-S)] en el menú de la cámara.

Sugerencia

Puede cambiar la posición pulsando un botón asignable asignado con [Focus Setting] para mostrar un marco naranja
alrededor del área de enfoque y seleccionando una posición con el funcionamiento táctil.

2

Deslice el interruptor [Auto Focus] de la pestaña  (Focus) hacia la izquierda para desactivarlo.3

Pulse el botón [Push AF/MF].

Si suelta el botón antes de que termine de enfocar, el enfoque automático mediante una pulsación se detendrá.

Durante el enfoque automático mediante una pulsación, el estado de enfoque se muestra mediante el indicador de
enfoque.
On: el enfoque está fijo en la posición de enfoque.
Parpadeo: fuera de enfoque. Dado que la unidad no enfocará automáticamente, cambie los ajustes de
composición y enfoque para conseguir el enfoque.
El enfoque volverá al enfoque manual cuando suelte el botón.

4
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Durante el funcionamiento de [Focus Area (AF-S)], no es posible ajustar la posición del marco. Durante el funcionamiento del
enfoque automático, el funcionamiento de AF también da prioridad a la parte central.

Sugerencia

Se admite la misma operación utilizando un botón asignable asignado con [Push AF/MF].

También puede asignar [Push AF Mode] a un botón asignable.

También puede asignar [Focus Area (AF-S)] a un botón asignable.

Puede mostrar/ocultar el marco del área de enfoque usando [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] en el menú
de la cámara.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste automático mediante la Aplicación Web

La unidad utiliza AF de detección de fase para el enfoque de alta velocidad y AF de contraste para el enfoque de alta
precisión.
La combinación de estos dos métodos AF proporciona un enfoque automático con alta velocidad y alta precisión.

Nota

Se necesita un objetivo compatible con enfoque automático.

Es posible que no se obtenga precisión según las condiciones de disparo.

El enfoque no se puede ajustar de manera automática en un objetivo de montura A.

Sugerencia

Durante el modo de enfoque automático, puede ajustar el enfoque mediante el control deslizante Focus del panel de control de la
cámara. Para obtener más detalles, consulte “Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación
Web”.

Tema relacionado

Comprobación de los interruptores del objetivo

Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación Web

5-041-957-43(1) Copyright 2022 Sony Corporation

Si el objetivo dispone de interruptor de selección de enfoque, sitúe el interruptor en la posición “AF/MF” o
“AF”.

Nota

Si se ajusta el interruptor en la posición “Full MF” o “MF”, el enfoque del objetivo no se puede realizar con la unidad.
Consulte “Para un objetivo con un interruptor de modo de enfoque” en “Comprobación de los interruptores del objetivo”.

1

Deslice el interruptor [Auto Focus] hacia la derecha en el panel de control de la cámara para activarlo.

El modo de enfoque automático se activa.

 (AF)

2
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Ajuste automático a través del control remoto infrarrojo suministrado

Puede ajustar automáticamente el enfoque mediante el control remoto infrarrojo suministrado.

Nota

También puede utilizar el enfoque automático cuando el ajuste manual es el principal método de funcionamiento. Para obtener
más detalles, consulte “Enfoque manual durante el enfoque automático mediante el control remoto infrarrojo proporcionado”.

Tema relacionado
Enfoque manual durante el enfoque automático mediante el control remoto infrarrojo proporcionado
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Pulse el botón AF del control remoto infrarrojo.

El enfoque sobre un sujeto se realiza automáticamente.

1
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Especificación de la posición/área de enfoque automático (Focus Area)

Puede establecer el área de destino para el enfoque automático y ajustar el enfoque para dicha área.

Pulse el botón [Menu] en el panel de control de la GUI para abrir el menú de la cámara.1

Especifique el área de destino para el enfoque automático con [Shooting] > [Focus] > [Focus Area] en el
menú de la cámara.

[Wide]:
Busca un sujeto en un ángulo amplio de la imagen al enfocar. No se muestra un marco.

[Zone]:
Busca automáticamente una posición de enfoque dentro de la zona especificada.
Tras la selección, especifique la posición con los botones de flecha en el panel de control de la GUI.

Puede volver a la posición central manteniendo presionado el botón [Set].
[Flexible Spot]:
Enfoca una posición especificada en la imagen.

2
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Nota

El marco del área de enfoque no está oculto cuando se usa el botón [Display] en el panel de imagen de la cámara.

Durante la operación Clear Image Zoom, el área de enfoque se ajusta en [Wide] (fijo).

Sugerencia

Puede mostrar/ocultar el marco del área de enfoque usando [Monitoring] > [Display On/Off] > [Focus Area Indicator] en el menú
de la cámara.

5-041-957-43(1) Copyright 2022 Sony Corporation

Tras la selección, especifique la posición con los botones de flecha en el panel de control de la GUI.

Puede volver a la posición central manteniendo presionado el botón [Set].
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Cambio del área de enfoque rápidamente (Focus Setting)

También puede cambiar la posición y el tamaño del área de enfoque automático rápidamente durante la grabación
asignando [Focus Setting] a un botón asignable.

Para obtener más información acerca de los botones asignables, consulte “Botones asignables”.

La operación varía según el ajuste del área del enfoque.

Cuando [Shooting] > [Focus] > [Focus Area] se establece en [Flexible Spot] o [Zone] en el
menú de la cámara

Puede cambiar la posición del área de enfoque pulsando un botón asignable asignado con [Focus Setting] y
realizando el ajuste con los botones de flecha del panel de control de la GUI. Puede volver a la posición central del
área del enfoque a la vez que ajusta la posición presionando el botón [Set].
Puede cambiar el tamaño del área de enfoque manteniendo pulsado un botón asignable asignado con [Focus
Setting]. Después de cambiar el tamaño, puede cambiar la posición del área del enfoque pulsando el botón [Set]. Al
finalizar, pulse un botón asignable asignado con [Focus Setting] para volver a la pantalla original.

Cuando [Shooting] > [Focus] > [Focus Area] se establece en [Wide] en el menú de la cámara

Solo puede cambiar el tamaño del área de enfoque manteniendo pulsado un botón asignable asignado con [Focus
Setting]. La posición también puede cambiarse modificando primero el tipo a [Flexible Spot] o [Zone].

Sugerencia

Cuando [Shooting] > [Focus] > [Push AF Mode] se define en [Single-shot AF(AF-S)] en el menú de la cámara y el interruptor
[Auto Focus] está en la posición de apagado (modo de enfoque manual), puede cambiar la posición del área de enfoque [Focus
Area (AF-S)].

El marco del área de enfoque se muestra de color naranja cuando la modificación de la posición del área de enfoque es posible.

Tema relacionado

Botones asignables

5-041-957-43(1) Copyright 2022 Sony Corporation
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Desplazamiento del marco del área de enfoque mediante el funcionamiento táctil
(área de enfoque táctil)

Puede cambiar la posición del área de enfoque pulsando un botón asignable asignado con [Focus Setting] para cambiar
la visualización del área de enfoque a naranja y, a continuación, mover el marco del área de enfoque con el
funcionamiento táctil del panel de control de la cámara.
Pulse la pantalla para mover el área de enfoque, con el área de enfoque centrada en la posición pulsada. Arrastre la
pantalla para mover el área de enfoque a la posición indicada con el dedo.

Sugerencia

Puede activar/desactivar el área de enfoque táctil en la pantalla de filmación mediante un botón asignable asignado con [Focus
Setting].

Pulse cualquier posición.

La posición pulsada se convierte en el centro del área de enfoque.

1

Arrastre para mover el área de enfoque, indicando la posición con el dedo.2
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Nota

Si pulsa una posición o arrastra el área de enfoque hasta una posición que supere el rango de ajuste, el área de enfoque se
ajustará al límite superior/inferior/izquierdo/derecho del rango de ajuste.

Esta función no está disponible en las siguientes circunstancias.

Cuando el interruptor [Touch Focus] se apaga en el bloque de control de la cámara
Cuando el marco del área de enfoque aparece de color gris o no aparece

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste del funcionamiento del enfoque automático (velocidad de transición AF,
sensibilidad de desplazamiento del sujeto AF)

Puede ajustar el funcionamiento del enfoque automático si modifica la velocidad de transición y la sensibilidad de
desplazamiento del sujeto.

Ajuste de la velocidad de transición AF

Puede establecer la velocidad de la unidad de enfoque para cuando el sujeto cambia usando el botón [AF Transition
Speed] en el panel de control de la cámara.

Seleccione la velocidad entre el rango [Speed 1] (lenta) y [Speed 7] (rápida) en incrementos de 1. Pulse el botón < para
disminuir el valor (más despacio) o el botón > para aumentarlo (más rápido).
Cuando se configura a baja velocidad, el enfoque se mueve lentamente cuando el sujeto que se enfoca se mueve, lo
que permite tomar imágenes con una expresión impresionante.
Cuando se configura a alta velocidad, el enfoque alterna entre sujetos rápidamente. En el ejemplo siguiente, el enfoque
cambia rápidamente desde el edificio del fondo a la persona que camina en el primer plano. El sujeto que entra en el
encuadre se enfoca al instante, lo que convierte este ajuste en ideal para la grabación documental que requiere un
enfoque rápido.

Sensibilidad de desplazamiento del sujeto AF

Puede establecer la sensibilidad para cambiar entre sujetos con el botón [AF Subj. Shift Sens.] en el panel de control de
la cámara.
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Seleccione la sensibilidad entre el intervalo [Sens 1] (Locked On) y [Sens 5] (Responsive) en incrementos de 1. Pulse el
botón < para disminuir el valor (cambio lento) o el botón > para aumentarlo (cambio rápido).
Cuando se establece en una sensibilidad baja, el enfoque no cambia fácilmente incluso cuando otro sujeto se mueve
delante del sujeto enfocado.

Cuando se establece en una sensibilidad alta, el enfoque cambia para dar prioridad al sujeto que se mueve al frente.

Sugerencia

Si asigna [AF Speed/Sens.] a un botón asignable, las barras de nivel para el ajuste de los valores se muestran en el panel de
imagen de la cámara en el siguiente orden cada vez que se presiona el botón, lo que le permite cambiar los ajustes de velocidad
de transición AF y de sensibilidad de desplazamiento del sujeto AF.
Velocidad de transición AF → Sensibilidad de desplazamiento del sujeto AF → Sin visualización…

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación Web

Después de cambiar y ajustar el enfoque manualmente, puede cambiar de control de enfoque a enfoque automático
para el ajuste fino del enfoque.

Nota

En el estado de ayuda de AF, cambiar el enfoque resulta difícil, sea cual sea el ajuste de [Shooting] > [Focus] > [AF Subj. Shift
Sens.] en el menú de la cámara.

El estado AF Assist se cancela en los siguientes casos:

Cuando el sujeto enfocado mediante el control deslizante [Focus] ya no es visible
Al cambiar al enfoque manual
Cuando se inicia AF de seguimiento en tiempo real

Sugerencia

El estado AF Assist se puede cancelar rápidamente con un botón asignable asignado con [Push AF/MF].

AF de seguimiento en tiempo real se detiene cuando se opera el control deslizante [Focus].

Establezca [Shooting] > [Focus] > [AF Assist] en [On] en el menú de la cámara.1

Establezca [Shooting] > [Focus] > [AF Assist Control] en [On] en el menú web.2

Deslice el interruptor [Auto Focus] hacia la derecha en el panel de control de la cámara para activarlo.

El modo de enfoque automático se activa.

3

Ajuste el enfoque mediante el control deslizante [Focus] del panel de control de la cámara.

[Near]: enfoque a un sujeto que está cerca.
[Far]: enfoque a un sujeto que está lejos.

En el estado AF Assist, el sujeto que se encuentre a la distancia establecida con el control deslizante [Focus], se
enfocará automáticamente.

4
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En el modo Face/Eye Only AF, el enfoque automático enfoca la cara más cercana a la posición de enfoque del control deslizante
[Focus].

5-041-957-43(1) Copyright 2022 Sony Corporation
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Enfoque manual durante el enfoque automático mediante el control remoto infrarrojo
proporcionado

Cuando la opción [Shooting] > [Focus] > [AF Assist] se encuentra en [On] en el menú de la cámara, puede utilizar los
botones F (lejos) y N (cerca) del control remoto infrarrojo proporcionado incluso durante el enfoque automático para
ajustar el enfoque sobre un sujeto.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Uso temporal del enfoque manual durante el enfoque automático (Push Manual
Focus)

Pulse el botón [Push AF/MF] cuando está en modo de enfoque automático para enfocar manualmente mientras se
presiona el botón. El enfoque volverá al enfoque automático cuando suelte el botón.
Esto le permite detener temporalmente el enfoque automático y enfocar manualmente cuando algo que no es el sujeto
de la filmación se cruza delante de este.

Sugerencia

Se admite la misma operación utilizando un botón asignable asignado con [Push AF/MF].

5-041-957-43(1) Copyright 2022 Sony Corporation
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Seguimiento usando detección de caras y ojos (Face/Eye Detection AF)

La unidad puede detectar las caras y los ojos de la gente como objetivo para seguir y ajustar el enfoque en las caras y
los ojos dentro del área de enfoque.
Cuando se detecta una cara, aparece un marco gris de detección de caras/ojos. Cuando es posible establecer el
enfoque automático, el marco se vuelve de color blanco y el seguimiento se inicia. Cuando se detectan ojos y se ajusta
el enfoque, el marco de detección de caras/ojos aparece en los ojos. Cuando se detectan varios individuos, se
determina el individuo principal automáticamente.
Esta función solo está disponible cuando el modo del enfoque está el modo AF o durante el enfoque automático
mediante una pulsación.

Sugerencia

Cuando el área de enfoque está configurada en [Zone] o [Flexible Spot] y las caras o los ojos se superponen dentro del área de
enfoque especificada, los marcos de detección de caras/ojos cambian a blanco y la unidad enfoca esas caras/ojos
automáticamente.

Cuando se utiliza el enfoque automático mediante una pulsación (AF-S), los marcos de detección de caras/ojos de las caras/ojos
enfocados cambian a verde.

Ajuste con el botón [Face/Eye Detection AF] en el panel de control de la cámara

Pulse el botón [Face/Eye Detection AF] para definir la operación de AF de detección de caras/ojos.

[Face/Eye Only AF]: la cámara detecta las caras/ojos de los sujetos (personas) y solo enfoca y sigue las caras/ojos. Si
no se detecta ninguna cara ni ojo, el AF se detiene temporalmente y se muestra el icono  (enfoque automático
pausado del modo Face/Eye Only AF). Este modo resulta eficaz cuando desea enfocar y seguir automáticamente
únicamente las caras/ojos.
[Face/Eye Priority AF]: la cámara detecta las caras/ojos de los sujetos (personas) y prioriza el enfoque/seguimiento en
las caras/ojos. Cuando no se detecta ninguna cara ni ojo, el enfoque está en modo AF (ajuste predeterminado).
[AF]: la función de AF de detección de caras/ojos está desactivada.

Nota

Durante el funcionamiento del enfoque automático mediante una pulsación, se activa [Face/Eye Priority AF], aunque se haya
seleccionado [Face/Eye Only AF].

Cuando el interruptor [Auto Focus] se ha establecido en la posición OFF, se desactiva el AF de detección de caras/ojos (salvo
durante el funcionamiento del enfoque automático mediante una pulsación).
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Si apaga la videocámara mientras [Face/Eye Only AF] está seleccionado, el modo cambia automáticamente a [Face/Eye Priority
AF] cuando vuelva a encender la cámara.

Sugerencia

Puede establecer la función de AF de detección de caras/ojos mediante [Shooting] > [Focus] > [Face/Eye Detection AF], en el
menú de la cámara.

Para ocultar marcos de detección de caras/ojos
Puede mostrar/ocultar los marcos de detección de caras/ojos usando [Monitoring] > [Display On/Off] > [Face/Eye
Detection Frame] en el menú de la cámara.

Nota

Se muestran marcos verdes de detección de caras/ojos para las caras y los ojos que están enfocados usando el enfoque
automático mediante una pulsación (AF-S), y no se ocultan con el botón [Display] o cuando [Face/Eye Detection Frame] se
establece en [Off].

Para cambiar el funcionamiento del AF de detección de caras/ojos con un botón asignable
Asigne [Face/Eye Detection AF] a un botón asignable. Puede cambiar el funcionamiento del AF de detección de
caras/ojos cada vez que pulse el botón, en el siguiente orden: [Face/Eye Priority AF], [Face/Eye Only AF] y [AF].

Ajuste mediante el menú directo

También se puede ajustar el funcionamiento del AF de detección de caras/ojos mediante el menú directo.

Para obtener más información acerca del menú directo, consulte “Funcionamiento del menú directo”.

Tema relacionado
Funcionamiento del menú directo

5-041-957-43(1) Copyright 2022 Sony Corporation
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Seguimiento de un sujeto especificado (Realtime Tracking AF)

Puede mantener el enfoque en un sujeto especificando el sujeto mediante un toque o seleccionado un marco de
detección de cara en el panel de control de la cámara.
Cuando se selecciona un sujeto, se muestra un marco de seguimiento blanco y comienza el seguimiento.

Sugerencia

El seguimiento tiene lugar en toda el área de la imagen, sin importar el ajuste de área de enfoque.

Cuando [Shooting] > [Focus] > [Touch Function in MF] se establece en [Tracking AF] en el menú web o en el menú de la cámara,
se admite el AF de seguimiento en tiempo real aunque el modo de enfoque sea modo MF.

Ocurren las siguientes acciones para el objetivo de seguimiento, dependiendo del ajuste del modo de funcionamiento de
AF de detección de caras/ojos.

[Face/Eye Only AF] o [Face/Eye Priority AF]: enfoque y seguimiento del sujeto especificado.
Si el objetivo del seguimiento es una persona y se detecta una cara/ojo, la cámara enfoca esa cara/ojo.
Cuando se detecta una cara/ojo objetivo de seguimiento, se guarda la cara objetivo de seguimiento. Una vez guardada,
se muestra  (icono de cara de seguimiento guardada).

Nota

Si el AF de seguimiento se inicia durante el enfoque manual, la cara objetivo de seguimiento no se guarda.

[AF]: se utiliza para enfocar y rastrear un sujeto específico. No se realiza la detección de cara/ojo, aunque el objetivo de
seguimiento sea una persona.

Nota

La función de AF de seguimiento en tiempo real no se puede utilizar si el objetivo está ajustado en enfoque manual.

Inicio de AF de seguimiento en tiempo real

Cuando se especifica un sujeto específico como objetivo de seguimiento, se inicia el seguimiento de ese objetivo.

Para especificar una operación táctil
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Deslice el interruptor [Touch Focus] de la pestaña  (Focus) del panel de control de la cámara hacia la derecha para
activarlo y, a continuación, toque el sujeto objetivo que desea seguir en uno de los siguientes estados.

Durante el enfoque manual o el enfoque manual mediante una pulsación y cuando [Shooting] > [Focus] > [Touch
Function in MF] se establece en [Tracking AF] en el menú web o en el menú de la cámara
Durante el enfoque automático o el enfoque automático mediante una pulsación (AF)

Para especificar mediante la selección del marco de detección de cara
Mueva el cursor de selección de caras (destacado en naranja) al sujeto que desea seguir usando los botones de flecha
del panel de control de la GUI y pulse el botón [Set].

A: Marcos de detección de cara (gris)
B: Marco de seguimiento
C: Cursor de selección de cara (naranja)

Nota

Durante el enfoque manual, no es posible iniciar el seguimiento mediante la selección del marco de detección de cara.

Sugerencia

También puede cambiar el objetivo que desea seguir durante el AF de seguimiento en tiempo real.

Detención de AF de seguimiento en tiempo real

Pulse el botón  (detención de AF de seguimiento en tiempo real).

Sugerencia

El AF se seguimiento en tiempo real se detendrá en los siguientes casos:

Cuando el interruptor [Auto Focus] o el control AUTO/MANUAL del objetivo esté cambiado
Cuando se cambia el modo de enfoque
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Cuando se ejecuta la ayuda de AF
Cuando se cambia el ajuste de área de enfoque o la acción de AF de detección de cara/ojo
Cuando se pulsa un botón asignable con [Push AF/MF] asignado
Cuando el objetivo de seguimiento no está dentro de la pantalla de filmación o cuando el sujeto está fuera del enfoque durante
unos segundos

Cuando se guarda una cara de seguimiento (cuando se muestra  (icono de cara de seguimiento guardada)), AF de
seguimiento en tiempo real se reanudará cuando la cara de seguimiento guardada entre en el área de la imagen. Para borrar la
cara de seguimiento, detenga el AF de seguimiento en tiempo real según se describe más arriba.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Pantalla de ajuste del brillo

Puede ajustar el brillo mediante la regulación del diafragma, la ganancia, la velocidad del obturador y el nivel de luz con
los filtros ND en los siguientes paneles de control de la pantalla de operación en directo de la Aplicación Web. Asimismo,
es posible ajustar el brillo automáticamente.

Nota

La ganancia no se puede ajustar cuando [Shooting Mode] está ajustada en [Cine EI Quick] o [Cine EI]. Asimismo, el brillo no
puede ajustarse automáticamente con la velocidad del obturador cuando se ajusta en [Cine EI Quick] o [Cine EI]. Se puede
ajustar automáticamente el brillo con el disfragma o el filtro ND.

Sugerencia

Panel de control de la cámara – pestaña  (Main)1.

Panel de configuración básica de la cámara
Muestra el estado de configuración de las funciones básicas necesarias para los botones de filmación. Pulse un
botón para visualizar la pantalla de configuración correspondiente a cada una de las funciones en el panel de ajuste
de la configuración básica de la cámara siguiente.

2.

Panel de ajuste de la configuración básica de la cámara
Muestra el panel de ajuste para el elemento de configuración seleccionado en el panel de configuración básica de la
cámara.

3.
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El modo Cine EI permite la filmación con una sensibilidad base sin utilizar la ganancia para maximizar el rendimiento del sensor
de imagen. El brillo se ajusta utilizando la iluminación y el filtro ND para ajustar la cantidad de luz que llega al sensor de imagen.
Para obtener más información acerca de Exposure Index (EI), consulte “Cambio de la distribución de las áreas oscuras e
iluminadas en la imagen grabada”.

Tema relacionado

Cambio de la distribución de las áreas oscuras e iluminadas en la imagen grabada

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste de la sensibilidad base

Puede ajustar la sensibilidad base antes de comenzar a ajustar el brillo.

Cuando [Shooting Mode] está definido en [Custom]

Pulse el botón [ISO/Gain/] del panel de configuración básica de la cámara y establezca [Base Sensitivity] en el panel de
ajuste de ISO/ganancia en [High] o [Low].
Seleccione [Low] en condiciones de iluminación normales y [High] en condiciones de poca luz.
Pantalla cuando la opción [AGC] está desactivada

Pantalla cuando la opción [AGC] está activada

Cuando [Shooting Mode] está definido en [Flexible ISO] o [Cine EI]

Pulse el botón [Base ISO/Exposure Index] del panel de configuración básica de la cámara y establezca [Base ISO] en el
panel de ajuste de Base ISO/Exposure Index en [ISO 12800] o [ISO 800].
Seleccione [ISO 800] en condiciones de iluminación normales y [ISO 12800] en condiciones de poca luz.

Sugerencia
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También puede establecer estos ajustes en la pestaña  (Main) del panel de control de la cámara.

También se puede definir a través de [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] o [Base ISO] en el menú de la cámara.

También puede asignar [Base ISO/Sensitivity] a un botón asignable.

En el modo de filmación [Cine EI Quick], la sensibilidad base se ajusta automáticamente de acuerdo con el ajuste del índice de
exposición.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Establecimiento del nivel deseado para el ajuste de brillo automático

El nivel deseado para el ajuste de brillo automático se establece con el control deslizante [AE Level] del panel de control
de la cámara.

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse la pestaña  (Main) en el panel de control de la cámara.

Si el control deslizante [AE Level] no se muestra, seleccione uno de los dos botones de selección de funciones del
control deslizante y seleccione el control deslizante [AE Level] en la lista.

Aparece el control deslizante [AE Level].

1

Ajuste el nivel deseado con el control deslizante.

Mueva la perilla del control deslizante hacia la izquierda para oscurecer la imagen. Mueva la perilla del control
deslizante hacia la derecha para aclarar la imagen.

Sugerencia

También se puede definir a través de [Shooting] > [Auto Exposure] > [Level] en el menú de la cámara.

2
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Ajuste automático del diafragma

Puede ajustar el brillo automáticamente según el sujeto. Se requiere un objetivo compatible.

Nota

El diafragma no se puede ajustar de manera automática en un objetivo de montura A.

Sugerencia

También puede asignar [Auto Iris] a un botón asignable.

5-041-957-43(1) Copyright 2022 Sony Corporation

Si se acopla un objetivo con interruptor Auto Iris, coloque el interruptor en AUTO.1

Pulse el botón [Iris] del panel de configuración básica de la cámara.

El marco del botón [Iris] se pone de color naranja.

Aparece el panel de ajuste de Iris.

2

Deslice el interruptor [Auto] hacia la derecha para activarlo.

El diafragma cambia al modo de ajuste automático. El valor del diafragma ajustado automáticamente se muestra a
la derecha del interruptor.

3
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Ajuste manual del diafragma

Puede ajustar el brillo manualmente.

Para ajustar temporalmente el diafragma de manera automática
También puede pulsar el botón [Push Auto] del panel de ajuste Iris para que el diafragma se ajuste automáticamente
mientras pulse el botón.

Si se acopla un objetivo con interruptor Auto Iris, coloque el interruptor en AUTO.

Nota

Cuando el interruptor Auto Iris del objetivo se ajusta en MANUAL, las funciones [Auto Iris] y [Push Auto Iris] de la unidad no
tendrán ningún efecto. Los ajustes manuales de diafragma en la unidad tampoco tendrán ningún efecto.

1

Pulse el botón [Iris] del panel de configuración básica de la cámara.

El marco del botón [Iris] se pone de color naranja.

Aparece el panel de ajuste de Iris.

2

Deslice el interruptor [Auto] hacia la izquierda para desactivarlo.

El diafragma cambia al modo de ajuste manual.

3

Ajuste el diafragma con el control deslizante [Iris] o los botones de ajuste [Iris].

Sugerencia

El control deslizante y los ajustes del botón de ajuste están vinculados.

También puede asignar el diafragma al control deslizante en la pestaña  (Main) del panel de control de la cámara.

4
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Sugerencia

Pulse un botón asignable asignado con la función [Push Auto Iris] para ajustar automáticamente el diafragma mientras pulse el
botón.
El diafragma volverá al modo manual cuando suelte el botón.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste automático de la ganancia

Puede ajustar el brillo automáticamente con el ajuste de ganancia cuando la opción [Shooting Mode] está establecida en
[Custom] o [Flexible ISO].

5-041-957-43(1) Copyright 2022 Sony Corporation

Establezca [Project] > [Shooting Mode] en [Custom] en el menú web o en el menú de la cámara.1

Pulse el botón [ISO/Gain] del panel de configuración básica de la cámara.

El marco del botón [ISO/Gain] se pone de color naranja.

Aparece el panel de ajuste de ISO/Gain.

2

Deslice el interruptor [AGC] hacia la derecha para activarlo.

La ganancia cambia al modo de ajuste automático. El valor de la ganancia ajustado automáticamente se muestra a
la derecha del interruptor.

Sugerencia

También puede realizar la misma acción configurando [Shooting] > [Auto Exposure] > [AGC] en [On] en el menú de la
cámara.

También puede asignar [AGC] a un botón asignable.

3
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Ajuste manual de la ganancia

Puede ajustar el brillo manualmente con el ajuste de ganancia cuando la opción [Shooting Mode] está establecida en
[Custom] o [Flexible ISO].
Puede controlar la ganancia cuando desee ajustar la exposición con un ajuste de diafragma fijo, o bien cuando desee
evitar que la ganancia aumente debido al AGC.

Para ajustar la ganancia manualmente de manera temporal
Puede ajustar temporalmente la ganancia si asigna la opción [ISO/Gain] a un botón de selección de funciones del
control deslizante en la pestaña  (Main) del panel de control de la cámara y utiliza el control deslizante.
Esto es útil cuando desea ajustar la exposición en un nivel sin cambiar la profundidad de campo.
El resultado del ajuste vuelve al valor predefinido que se ha configurado con [ISO/Gain<L>] después de realizar alguna
de las siguientes operaciones.

Establezca [Project] > [Shooting Mode] en [Custom] en el menú web o en el menú de la cámara.1

Pulse el botón [ISO/Gain] del panel de configuración básica de la cámara.

El marco del botón [ISO/Gain] se pone de color naranja.

Aparece el panel de ajuste de ISO/Gain.

2

Deslice el interruptor [AGC] hacia la izquierda para desactivarlo.

La ganancia cambia al modo de ajuste manual.

3

Ajuste la ganancia con el control deslizante [ISO/Gain] o los botones de ajuste [ISO/Gain].

Sugerencia

El control deslizante y los ajustes del botón de ajuste están vinculados.
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Cambio de los elementos de ajuste de ISO/Gain
Cambio de la sensibilidad base
Ajuste del interruptor AGC en la posición ON
Cambio de la fuente de alimentación de la unidad a espera

Para ajustar la ganancia automáticamente de manera temporal con un botón asignable
Pulse un botón asignable asignado con la función [Push AGC] para ajustar automáticamente la ganancia mientras pulse
el botón.
La ganancia volverá al modo manual cuando suelte el botón.
El resultado del ajuste vuelve al valor predefinido que se ha configurado con [ISO/Gain<L>] después de realizar alguna
de las siguientes operaciones.

Cambio de los elementos de ajuste de ISO/Gain
Cambio de la sensibilidad base
Ajuste del interruptor AGC en la posición ON
Cambio de la fuente de alimentación de la unidad a espera

Nota

Esta función no se puede ejecutar cuando [Shooting] > [Iris] > [Bokeh Control] está ajustado en [On] en el menú de la cámara.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste automático del obturador

Puede ajustar el obturador automáticamente en respuesta al brillo de la imagen.

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse el botón [Shutter] del panel de configuración básica de la cámara.

El marco del botón [Shutter] se pone de color naranja.

Aparece el panel de ajuste de Shutter.

1

Pulse el botón [Shutter Type] y seleccione [Auto] en la lista.

Sugerencia

También puede realizar la misma acción configurando [Shooting] > [Auto Exposure] > [Auto Shutter] en [On] en el menú de
la cámara.

También puede asignar [Auto Shutter] a un botón asignable.

2
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Ajuste manual del obturador

Puede ajustar el obturador manualmente.

Pulse el botón [Shutter] del panel de configuración básica de la cámara.

El marco del botón [Shutter] se pone de color naranja.

Aparece el panel de ajuste de Shutter.

1

Pulse el botón [Shutter Type] y seleccione [Speed] en la lista.2

Ajuste el obturador con el control deslizante [Speed] o los botones de ajuste [Speed].

Para ajustar el tiempo de exposición para que coincida con el intervalo de fotogramas, seleccione [Off] en el paso
2. También puede establecer un valor fijo con [ECS] (frecuencia) o ajustarlo automáticamente con [Auto].
Ejemplo: ajuste con [ECS] (frecuencia)

Sugerencia

El control deslizante y los ajustes del botón de ajuste están vinculados.

Para utilizar [Angle] en lugar de [Speed] o [Off], establezca [Shooting] > [Shutter] > [Mode] en [Angle] en el menú de la
cámara.

3
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Acerca del filtro ND

En condiciones donde la luz es demasiado fuerte, puede ajustar el brillo adecuado si cambia el filtro ND.
Cuando se filma un sujeto con mucha luz, un cierre excesivo del diafragma puede causar borrosidad por difracción, lo
que hace que la imagen empiece a desenfocarse (un fenómeno habitual en las cámaras). Puede suprimir este efecto
para obtener mejores resultados en la filmación con el filtro ND.
La unidad dispone de los siguientes modos de filtro ND.
Modo predeterminado

Consulte “Ajuste en el modo predeterminado”.

Modo variable (ajuste automático)

Consulte “Ajuste automático en el modo variable”.

Modo variable (ajuste manual)

Consulte “Ajuste manual en el modo variable”.

Tema relacionado

Ajuste en el modo predeterminado

Ajuste automático en el modo variable

Ajuste manual en el modo variable

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste en el modo predeterminado

Es posible seleccionar tres valores de transmitancia del filtro ND de antemano y cambiar rápidamente entre ellos al
filmar.

Sugerencia

Cuando se pulsa un botón asignable con la opción [ND Filter Position] asignada, el filtro ND cambia en la secuencia [Clear] →
[Preset1] → [Preset2] → [Preset3] → [Clear].
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Establezca [Shooting] > [ND Filter] > [Mode] en [Preset] en el menú de la cámara.1

Pulse el botón [ND Filter] del panel de configuración básica de la cámara.

El marco del botón [ND Filter] se pone de color naranja.

Aparece el panel de ajuste de ND Filter.

2

Pulse el botón [ND Filter] y seleccione una de las siguientes opciones en la lista.

[Clear]: sin filtro ND.
[Preset1]: transmitancia definida mediante [Shooting] > [ND Filter] > [Preset1] en el menú de la cámara.
[Preset2]: transmitancia definida mediante [Shooting] > [ND Filter] > [Preset2] en el menú de la cámara.
[Preset3]: transmitancia definida mediante [Shooting] > [ND Filter] > [Preset3] en el menú de la cámara.

Cuando se selecciona una de las opciones entre [Preset1] y [Preset3] para el filtro ND, el valor de transmitancia se
muestra junto al nombre del filtro ND.

3
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Ajuste automático en el modo variable

Puede activar el ajuste de exposición automática con el filtro ND.

Nota

Cuando el filtro ND se cambia a o desde [Clear] durante la filmación, el marco del filtro ND se muestra en la imagen y se emite el
sonido de funcionamiento.

Sugerencia

También puede asignar [Auto ND Filter] a un botón asignable y pulsar el botón para cambiar entre [Auto] y [Manual].
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Establezca [Shooting] > [ND Filter] > [Mode] en [Variable] en el menú de la cámara.1

Pulse el botón [ND Filter] del panel de configuración básica de la cámara.

El marco del botón [ND Filter] se pone de color naranja.

Aparece el panel de ajuste de ND Filter.

2

Pulse el botón [ND Filter] y seleccione [Auto] en la lista.

El valor de transmitancia del filtro ND ajustado automáticamente se muestra junto al botón [ND Filter].

3
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Ajuste manual en el modo variable

Puede realizar el ajuste de exposición manual con el filtro ND.

Para ajustar automáticamente de forma temporal
Puede asignar la función [Push Auto ND] a un botón asignable y activar el filtro ND automático de forma temporal
mientras pulsa el botón. Al soltar el botón, se vuelve a desactivar la función de filtro ND automático.
Defina el filtro ND en [Manual].

Nota

Cuando el filtro ND se cambia a o desde [Clear] durante la filmación, el marco del filtro ND se muestra en la imagen y se emite el
sonido de funcionamiento.

Establezca [Shooting] > [ND Filter] > [Mode] en [Variable] en el menú de la cámara.1

Pulse el botón [ND Filter] del panel de configuración básica de la cámara.

El marco del botón [ND Filter] se pone de color naranja.

Aparece el panel de ajuste de ND Filter.

2

Pulse el botón [ND Filter] y seleccione [Manual] en la lista.3

Ajuste la transmitancia del filtro ND con el control deslizante [ND Filter] o con los botones de ajustes de
[ND Filter].

Sugerencia

El control deslizante y los ajustes del botón de ajuste están vinculados.

También puede ajustar el filtro ND en la pestaña  (Main) del panel de control de la cámara.

4
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Sugerencia

También puede asignar [ND Filter Position] a un botón asignable y pulsar el botón para cambiar entre [Manual] y [Clear].

También puede pulsar el botón [Push Auto] del panel de ajuste ND Filter para activar el filtro ND mientras se pulse el botón.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Pantalla de ajuste del balance de blancos

Puede ajustar el balance de blancos a través de la pantalla de operación en directo de la Aplicación Web para obtener
un balance de blancos que proporcione un aspecto más natural a la imagen.

5-041-957-43(1) Copyright 2022 Sony Corporation

Panel de configuración básica de la cámara1.

Panel de ajuste de la configuración básica de la cámara
Muestra el panel de ajuste para el elemento de configuración seleccionado en el panel de configuración básica de la
cámara.

2.
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Ajuste automático del balance de blancos

Puede obtener un balance de blancos bien ajustado en todo momento con ATW (balance de blancos de corrección
automática).
Si la opción ATW está activada, el balance de blancos se ajusta automáticamente cuando la temperatura de color de la
fuente de luz cambia.

Nota

La opción ATW no se puede utilizar si [Shooting Mode] está definido en [Cine EI] o [Cine EI Quick].

Tal vez no sea posible ajustar el color adecuado con ATW, según las condiciones de iluminación y del sujeto.
Ejemplos:

Cuando un único color domina el sujeto, como por ejemplo el cielo, el mar, la tierra o las flores.
Cuando la temperatura del color es extremadamente alta o extremadamente baja.

Si la velocidad de corrección automática de ATW es lenta o no se puede conseguir el efecto adecuado, pulse el botón [WB SET]
para ejecutar el balance automático de blancos.

Sugerencia

En el modo ATW, puede seleccionar la velocidad de respuesta entre cinco pasos (1, 2, 3, 4, 5) mediante [Shooting] > [White
Setting] > [ATW Speed] en el menú de la cámara. Cuanto más bajo sea el número, mayor será la velocidad de respuesta.

Puede congelar el ajuste del balance de blancos actual si asigna la función [ATW Hold] a un botón asignable y pulsa el botón
asignable para pausar temporalmente la opción ATW mientras está en el modo ATW.

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse el botón [White Balance] del panel de configuración básica de la cámara.

El marco del botón [White Balance] se pone de color naranja.

Aparece el panel de ajuste de White Balance.

1

Pulse el botón [White Mode] y seleccione [ATW] en la lista.2
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Ajuste manual del balance de blancos

Puede ajustar el balance de blancos manualmente.

Pulse el botón [White Balance] del panel de configuración básica de la cámara.

El marco del botón [White Balance] se pone de color naranja.

Aparece el panel de ajuste de White Balance.

1

Pulse el botón [White Mode] y seleccione una de las siguientes opciones en la lista.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Ajuste el balance de blancos con los controles deslizantes o los botones de ajuste.

Sugerencia

El control deslizante y los ajustes del botón de ajuste están vinculados.

La diferencia entre [Memory A(T/T)] y [Memory A(R/B)] es que el eje de ajuste es distinto, pero los resultados del ajuste
están vinculados.

Para [Memory A(T/T)]
Este modo ajusta el balance de blancos guardado en la memoria A; para ello, ajusta la temperatura de color (Temp)
y Tint.

3
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Es posible definir la temperatura de color en incrementos de 20 K en el rango entre 2000 K y 5600 K. Los valores
superiores a 5600 K pueden establecerse en intervalos equivalentes a la cantidad de cambio de color (mired) de
5580 K a 5600 K.
Si pulsa el botón [Reset] en la parte derecha de [Temp] o [Tint], el ajuste correspondiente se restablecerá a su valor
predeterminado.
Para [Memory A(R/B)]
Este modo ajusta el balance de blancos guardado en la memoria A; para ello, ajusta R Gain y B Gain.
Si pulsa el botón [Reset], el ajuste de ganancia correspondiente se restablecerá a su valor predeterminado.
Para [Preset]
Este modo ajusta la temperatura del color a un valor predeterminado.
Puede establecer el valor en incrementos de 100 K.
En el modo predeterminado, también puede asignar [Preset White Select] a un botón asignable y pulsar el botón
para cambiar a un valor predeterminado previamente configurado.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Utilización del balance automático de blancos

En el modo de la memoria A, el balance de blancos que está guardado se ajusta automáticamente.

Pulse el botón [White Balance] del panel de configuración básica de la cámara.

El marco del botón [White Balance] se pone de color naranja.

Aparece el panel de ajuste de White Balance.

1

Pulse el botón [White Mode] y seleccione [Memory A(T/T)] o [Memory A(R/B)] en la lista.

[Memory A(T/T)]

[Memory A(R/B)]

2

Coloque un papel blanco (u otro objeto) en un lugar con la misma fuente de iluminación y condiciones que
el sujeto y, a continuación, utilice el zoom para acercarse al papel y así mostrar blanco en la pantalla.

3

Ajuste el brillo.

Ajuste el diafragma con el procedimiento descrito en “Ajuste manual del diafragma”.

4

Pulse el botón [WB SET] del panel de ajuste del balance de blancos.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Nota

Si el ajuste no se realiza correctamente, aparecerá un mensaje de error en la pantalla durante unos tres segundos. Si el mensaje
de error continúa después de varios intentos repetidos de ajuste del balance de blancos, póngase en contacto con su servicio de
asistencia técnica de Sony.

Sugerencia

También puede ejecutarlo en el modo ATW. Puede utilizarlo si desea ajustar rápidamente el balance de blancos durante la
operación de ATW. Tras el ajuste, el modo vuelve a la operación de ATW normal.

Tema relacionado

Ajuste manual del diafragma
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Si el balance automático de blancos se ejecuta en el modo de memoria, el resultado del ajuste automático se
guarda en la memoria A.
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Pantalla de configuración de audio

Puede configurar el nivel de audio que grabará la unidad en la pantalla de operación en directo de la Aplicación Web.
Configure los interruptores del bloque de conectores de la unidad y configure el audio por medio del menú de la cámara
o del menú web.
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Panel de control de la cámara – pestaña  (Audio)1.
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Selección del dispositivo de entrada de audio

Ajuste los siguientes interruptores de acuerdo con el dispositivo conectado al conector AUDIO IN.

Nota

En los modos Interval Rec y Slow & Quick Motion no se graba audio.
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Si se conecta un micrófono, defina el interruptor SETUP 2 en el bloque de conectores de la parte posterior
de la unidad.

CH-1 y CH-2 tienen ajustes comunes.

1

Ajuste Descripción

OFF
(predeterminado)

Seleccione esta opción si utiliza un micrófono dinámico o un micrófono con batería.
Desactiva la fuente de alimentación fantasma de +48 V y establece la entrada LINE o MIC
como la fuente de audio CH-1 y CH-2.

ON

Seleccione esta opción si utiliza un micrófono compatible con una fuente de alimentación
fantasma de +48 V. Activa la fuente de alimentación fantasma de +48 V y establece el
micrófono compatible con la fuente de alimentación fantasma como la fuente de audio CH-
1 y CH-2.

Defina el tipo de dispositivo conectado en [Audio] > [Audio Input] > [AUDIO IN Select] en el menú de la
cámara.

2

Seleccione la entrada de audio en [Audio] > [Audio Input] > [CH1 Input Select] como [CH4 Input Select] en
el menú web o en el menú de la cámara.

3
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Ajuste automático del nivel de grabación de audio

Defina el canal para el que desee ajustar automáticamente el nivel de grabación de audio mediante la opción [Auto] de
la página [Audio] del menú web o bien defina [Audio] > [Audio Input] > [CH1 Level Control] en [CH4 Level Control] en el
menú de la cámara.
Los canales especificados para el ajuste automático están indicados mediante un icono  (Auto) junto a los canales
correspondientes en la pestaña  (Audio) de la pantalla de operación en directo.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste manual del nivel de grabación de audio

Puede ajustar manualmente el nivel de grabación de audio.
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Defina el canal para el que desee ajustar manualmente el nivel de grabación de audio mediante la opción
[Manual] de la página [Audio] del menú web o bien defina [Audio] > [Audio Input] > [CH1 Level Control] en
[CH4 Level Control] en el menú de la cámara.

1

Pulse la pestaña  (Audio) en el panel de control de la cámara.2

En la pantalla [Audio] del panel de control de la cámara, defina el nivel de grabación de audio mediante el
control deslizante o con los botones de ajustes para el canal cuyo nivel de grabación de audio desee
establecer manualmente.

Nota

Los canales para los que se muestra el icono  (Auto) se ajustan automáticamente. Los cambios en los valores por
medio de los controles deslizantes o los botones no se aplican al audio grabado.

Sugerencia

El control deslizante y los ajustes del botón de ajuste de cada fila están vinculados.

Puede comprobar el nivel de entrada de audio en tiempo real en el medidor del nivel de audio, en la pantalla de filmación.

3
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Funcionamiento del menú directo

Puede verificar el estado y la configuración de la unidad superpuestos en la imagen de la cámara y seleccionar y
cambiar la configuración mediante los botones de control de la GUI del control remoto infrarrojo.
Estos son los elementos que pueden configurarse.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Valor [ND Filter]
[Auto Iris]
Valor [Iris]
[AGC]
Valor [Gain]
Valor [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Valor [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] y [Frame Rate]

Sugerencia

También puede realizar la misma función con un botón asignable y el panel de control de la GUI de la Aplicación Web.

Pulse un botón asignable asignado con [Direct Menu] en el control remoto infrarrojo.

El botón [Direct Menu] está asignado a un botón asignable 1 según el ajuste predeterminado de fábrica.
Solo los elementos en la pantalla que se pueden configurar con el menú directo se pueden seleccionar con el
cursor naranja.

1

Mueva el cursor hasta el elemento que desee definir mediante los botones de flecha del panel de control de
GUI y pulse el botón [Set].

Se muestra un menú o el elemento sobre un fondo blanco.

2

Seleccione un ajuste mediante los botones de flecha y pulse el botón [Set].

El menú o el fondo blanco desaparece y se muestra el nuevo ajuste con un cursor naranja.
Pulse un botón asignable al que se ha asignado [Direct Menu] de nuevo o espere 3 segundos sin realizar ninguna
acción para cerrar el menú directo.

3
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Botones asignables

Existen diez botones asignables en la Aplicación Web a los que puede asignar diversas funciones.
Los botones asignables se muestran en la pantalla de operación en directo y en la pantalla de operación de
reproducción.

Nota

La lista de botones asignables no se muestra cuando se configuran los ajustes en el panel de funcionamiento básico de la
cámara de la pantalla de operación en directo. Para finalizar la operación, pulse el botón [X] situado en el parte superior derecha
del panel de ajuste.

Las siguientes funciones se asignan a los botones de manera predeterminada de fábrica.
Botón 1: [Direct Menu]
Botón 2: [Focus Setting]
Botón 3: [Rec Review]

Los botones del 1 al 3 son equivalentes a los botones con el mismo número del control remoto infrarrojo
suministrado.

Botón 4: [Push Auto ND]
Botón 5: [Crop Select]
Botón 6: [Marker]
Botón 7: [Video Signal Monitor]
Botón 8: [Clip Flag OK]
Botón 9: [Color Bars]
Botón Focus Hold: [Focus Hold]

El botón Focus Hold es equivalente al botón Focus Hold en un objetivo de montura E.

Para cambiar la función de un botón
Utilice [Project] > [Assignable Button] en el menú de la cámara.
Cuando cambie una asignación, la visualización de la lista de botones asignables cambiará.
Para obtener más detalles sobre las funciones asignables, consulte “Assignable Button” en “Menú de la cámara y
ajustes detallados”.

Tema relacionado

Assignable Button
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Movimiento a cámara lenta y rápida

Cuando el formato de grabación se ajusta en los siguientes valores, puede especificar valores diferentes para la
velocidad de fotogramas de grabación y la velocidad de fotogramas de reproducción.
La siguiente tabla muestra las velocidades de fotogramas que se pueden configurar.

Frecuencia del sistema: 59.94/50/29.97/25/23.98; modo de escaneado de la cámara: FF

Frecuencia del sistema: 59.94/50/29.97/25/23.98; modo de escaneado de la cámara: S35

Frecuencia del sistema: 24; modo de escaneado de la cámara: FF

Nota

La función Slow & Quick Motion no se puede ajustar durante la grabación, la reproducción ni durante la visualización de la
pantalla de miniaturas.

La grabación automática no es compatible con el modo Slow & Quick Motion.

Las funciones del diafragma y obturador automático se inhabilitan en el modo Slow & Quick Motion.

Auto Focus tiene las siguientes limitaciones en el modo Slow & Quick Motion.

Limitaciones debidas al modelo del objetivo, la frecuencia del sistema y la velocidad de fotogramas de filmación

Códec Formato de vídeo Velocidades de fotogramas que se pueden configurar

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Códec Formato de vídeo Velocidades de fotogramas que se pueden configurar

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Códec Formato de vídeo Velocidades de fotogramas que se pueden configurar

XAVC-I 4096×2160P 1–60
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La función de Auto Focus se desactiva temporalmente si el diafragma está configurado en F18 o superior.

Para obtener más información sobre el uso de la salida RAW, consulte “Grabación de vídeo RAW”.

Tema relacionado

Grabación de vídeo RAW

5-041-957-43(1) Copyright 2022 Sony Corporation

Objetivo Sony Frecuencia del sistema Disponibilidad de AF

Distinto de SEL16F28 – Compatible con 7 fps o superior

SEL16F28

59.94/29.97/23.98 Compatible con 30, 60, 120, 240 fps

50,00/25,00 Compatible con 25, 50, 100, 200 fps

24,00 No compatible

231



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Grabación de vídeo de manera intermitente (Interval Rec)

La función Interval Rec le permite capturar vídeos de forma intermitente en la memoria interna de la unidad. Esta función
es una manera efectiva de filmar sujetos que se mueven lentamente.
Al iniciar la grabación, la unidad graba automáticamente un número especificado de fotogramas (Number of Frames) en
un intervalo de tiempo especificado (Interval Time).

A: Intervalo de filmación (Interval Time)
B: número de fotogramas en una toma (Number of Frames)

Nota

Solo se puede utilizar una función de grabación especial al mismo tiempo, como la grabación Interval Rec.

Si se activa otro modo de grabación especial mientras se está utilizando Interval Rec, se desactivará automáticamente Interval
Rec.

El modo Interval Rec se desactiva automáticamente después de cambiar los ajustes del sistema, como el formato de vídeo.

No se pueden cambiar los ajustes de Interval Rec durante la grabación o la reproducción, ni cuando se muestre la pantalla de
imágenes en miniatura.

Limitaciones durante la grabación
No se graba el audio.
No es posible revisar la grabación (Rec Review).

Si la unidad se apaga durante la grabación
Cuando la fuente de alimentación de la unidad está ajustada en estado de espera, se accede al soporte durante
varios segundos para grabar las imágenes almacenadas en la memoria hasta ese momento y, a continuación, la
unidad cambia automáticamente al estado de espera.
Si se ha desconectado el cable de alimentación de CC, se ha apagado la alimentación desde el adaptador de CA o
se ha desconectado el suministro de alimentación PoE++, es posible que se pierdan las tomas realizadas hasta ese
punto (10 segundos como máximo). Tenga cuidado.

Ajuste del número de fotogramas y del intervalo entre la filmación
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Establezca [Project] > [Interval Rec] > [Setting] en [On] en el menú web y establezca [Number of Frames] y [Interval
Time].
La unidad sale del modo Interval Rec cuando se apaga, pero los ajustes de [Number of Frames] e [Interval Time] se
mantienen. No es necesario volver a ajustarlos la próxima vez que filme en el modo Interval Rec.

Sugerencia

También se puede definir a través de [Project] > [Interval Rec] en el menú de la cámara.

Iniciar la filmación

Pulse el botón START/STOP de grabación para comenzar a grabar. “Int●Rec” e “Int●Stby” aparecen de manera
alternativa.

Detener la filmación

Detenga la grabación.
Cuando la filmación finalice, los datos de vídeo almacenados en la memoria hasta ese punto se graban en el soporte.
Para salir del modo Interval Rec, realice una de las siguientes acciones.

Cambie la fuente de alimentación de la unidad a espera.
En el modo de espera de grabación, establezca [Project] > [Interval Rec] > [Setting] en [Off].

Asimismo, el modo Interval Rec se desactivará automáticamente cuando se reinicie la unidad.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Grabación de imágenes en memoria intermedia (Picture Cache Rec)

La función Picture Cache Rec le permite capturar vídeo de forma retroactiva cuando empieza a grabar manteniendo una
memoria intermedia interna de imágenes de una duración específica durante la filmación.

Ajuste del tamaño de la memoria intermedia

Establezca [Project] > [Picture Cache Rec] > [Setting] a [On] en el menú web y ajuste el tamaño de la memoria
intermedia con [Cache Size].

Nota

Picture Cache Rec no se puede utilizar en combinación con Interval Rec, la grabación simultánea en 2 ranuras o la grabación de
proxy. Cuando Picture Cache Rec está en On, estos otros modos de grabación especiales se ajustarán en Off de forma forzosa.

El modo Picture Cache Rec no se puede seleccionar mientras se graba o cuando Rec Review está en proceso.

Cuando Picture Cache Rec está en On, el código de tiempo se grabará en el modo [Free Run] aunque esté ajustado en [Regen]
o [Rec Run].

Es posible que el ajuste de [Output Format] no se pueda configurar en el modo Picture Cache Rec. Si esto sucede, ajuste
temporalmente Picture Cache Rec en Off y, a continuación, cambie el ajuste.

Sugerencia

El tiempo en la memoria intermedia puede ser inferior, dependiendo del formato de grabación. Compruebe la hora mostrada en
[Project] > [Picture Cache Rec] > [Cache Rec Time] en el menú web.

También se puede definir a través de [Project] > [Picture Cache Rec] en el menú de la cámara.

También puede activar (On) o desactivar (Off) [Picture Cache Rec] mediante un botón asignable.

Inicio de Picture Cache Rec

Cuando [Picture Cache Rec] está en On, aparece “●Cache” (● se ilumina en verde).
Cuando pulsa el botón START/STOP de grabación, la grabación comienza y el vídeo se graba en las tarjetas de
memoria a partir del vídeo almacenado en la memoria intermedia.

Nota

El cambio del formato de grabación o el aspecto básico borra el vídeo de la memoria intermedia almacenado hasta ese punto y
comienza a almacenar vídeo nuevo. En consecuencia, la grabación de memoria intermedia de imágenes no es posible antes de
cambiar el formato, aunque empiece a grabar inmediatamente después de cambiar el formato.

Ajuste [Cache Size] Tiempo en la memoria intermedia (aproximado)

[Short] 5 segundos

[Medium] 10 segundos

[Long] 20 segundos

[Max] Valor máximo para cada formato de grabación
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Si Picture Cache Rec se activa/desactiva inmediatamente después de insertar una tarjeta de memoria, los datos de la memoria
intermedia pueden no grabarse en la tarjeta.

El vídeo se almacena en la memoria intermedia cuando la función Picture Cache Rec está en On. No se almacena en la
memoria media el vídeo antes de que la función se ajuste en On.

El vídeo no se almacena en la memoria intermedia durante el acceso a una tarjeta de memoria; lo mismo ocurre durante la
reproducción, Rec Review o la visualización de miniaturas en la pantalla. Durante ese intervalo, la grabación de memoria
intermedia de imágenes de vídeo no es posible.

Cancelación de Picture Cache Rec

Defina [Project] > [Picture Cache Rec] > [Setting] en [Off] en el menú web o pulse un botón asignable asignado con la
función [Picture Cache Rec].

5-041-957-43(1) Copyright 2022 Sony Corporation
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Grabación en la tarjetas de memoria A y B simultáneamente (2-slot Simul Rec)

Puede grabar simultáneamente en las tarjetas de memoria A y B ajustando [Project] > [Simul Rec] > [Setting] en [On] en
el menú web o en el menú de la cámara.

Grabación independiente en la tarjeta de memoria A y B

Puede iniciar y detener la grabación en cada tarjeta de memoria de forma independiente con el botón START/STOP de
grabación o con el botón [2nd Rec START/STOP] en la pestaña  (Others).
Según el ajuste predeterminado de fábrica, ambos botones se han configurado para iniciar y detener la grabación
simultánea en ambas tarjetas A y B.
Cuando los botones se establezcan para controlar la grabación de diferentes tarjetas de memoria, el control de
inicio/parada de la grabación [SDI/HDMI Rec Control] seguirá el estado de grabación de la ranura A.

Cambio del ajuste

Ajuste lo siguiente con [Project] > [Simul Rec] > [Rec Button Set] en el menú de la cámara.

5-041-957-43(1) Copyright 2022 Sony Corporation

Ajuste [Rec
Button Set] Botones y tarjetas de memoria

Rec Button:<Slot
A> <Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Inicia y detiene la grabación simultánea en las tarjetas de memoria A y B con cualquiera de los
botones.

Rec Button:<Slot
A>
2nd Rec Button:
<Slot B>

El botón START/STOP inicia y detiene la grabación en la tarjeta de memoria A, y el botón [2nd
Rec START/STOP] de la pestaña  (Others) inicia y detiene la grabación en la tarjeta de
memoria B.

Rec Button:<Slot
B>
2nd Rec Button:
<Slot A>

El botón START/STOP inicia y detiene la grabación en la tarjeta de memoria B, y el botón [2nd
Rec START/STOP] de la pestaña  (Others) inicia y detiene la grabación en la tarjeta de
memoria A.
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Monitor de señal de vídeo

Puede establecer el tipo de señal de vídeo que se mostrará en el panel de imagen de la cámara en forma de onda,
vectorscopio o histograma mediante [Monitoring] > [Video Signal Monitor] > [Setting] en el menú de la cámara.
La línea naranja indica los valores establecidos de [Level Marker 1] y [Level Marker 2].
También puede asignar la función [Video Signal Monitor] a un botón asignable.

Monitorización de visualización del objetivo
En los modos de filmación Log, la configuración de la gama de colores o la información de configuración del LUT de
monitor se muestra en la parte superior derecha del monitor de señal de vídeo para indicar el objetivo del monitor.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Marcas de clip

Puede añadir una marca de clip [OK] a un clip presionando un botón asignable asignado con la función [Clip Flag OK] y
seleccionando [Add OK].
Puede eliminar una marca de clip [OK] presionando el botón dos veces y seleccionando [Delete Clip Flag].

Sugerencia

También pueda añadir una marca de clip usando [Thumbnail] > [Set Clip Flag] en el menú de la cámara.

La pantalla de miniaturas se puede mostrar con los clips ordenados por tipo de marcador (pantalla de miniaturas de clip
filtradas). Para obtener más información, consulte “Operaciones en clips grabados” en “Pantalla de imágenes en miniatura”.

Tema relacionado

Operaciones en clips grabados
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Breathing Compensation

Puede ajustar si desea realizar la Breathing Compensation del objetivo mediante [Technical] > [Lens] > [Breathing
Compensation] en el menú de la cámara.
Esta función corrige el fenómeno en el que se producen cambios en el ángulo de visión a medida que va variando la
posición del enfoque.
Al ejecutar Breathing Compensation, se recorta electrónicamente una parte de la imagen para mantener un ángulo
constante de visión para que el fenómeno de Breathing no aparezca.

Nota

Al activar Breathing Compensation, es posible que el ángulo de visión y la calidad de la imagen cambien ligeramente.

En función del objetivo, puede que no sea posible corregir el cambio del ángulo de visión al activar Breathing Compensation.

La compensación no es posible cuando se coloca un objetivo que no admite Breathing Compensation.

Esta función está ajustada en Off (fija) en las siguientes circunstancias.

Cuando [Technical] > [Lens] > [Distortion Comp.] se establece en [Off] en el menú de la cámara
Cuando [Shooting] > [S&Q Motion] > [Setting] se establece en [On] en el menú web o en el menú de la cámara
Cuando [Project] > [Rec Format] > [Codec] se establece en [RAW] o [RAW & XAVC-I] en el menú web o en el menú de la
cámara

5-041-957-43(1) Copyright 2022 Sony Corporation
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Descripción general de la grabación de proxy

Esta función le permite grabar simultáneamente datos proxy de baja resolución al mismo tiempo que graba vídeo con
datos originales de alta resolución.

Para obtener información detallada sobre las tarjetas de memoria compatibles, formatear las tarjetas de memoria y
verificar la capacidad restante, consulte “Tarjetas de memoria compatibles” en “Preparación de tarjetas de memoria”.

Acerca del archivo grabado
La extensión del nombre del archivo es “.mp4”.
El código de tiempo también se graba simultáneamente.

Destino del almacenamiento del archivo grabado
El archivo grabado se almacenará en el siguiente directorio:

Acerca del nombre del archivo
El nombre de archivo consiste en el nombre del clip grabado en la tarjeta de memoria y un sufijo “S03”.
Para conocer los nombres de los clips, vaya a [TC/Media] > [Clip Name Format] en el menú de la cámara.

Tema relacionado

Tarjetas de memoria compatibles

5-041-957-43(1) Copyright 2022 Sony Corporation

Soporte de grabación Ruta de acceso a la carpeta

SDXC /PRIVATE/XDROOT/Sub

CFexpress Tipo A /XDROOT/Sub
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Grabación de un proxy

Puede empezar a grabar cuando la grabación de proxy esté activada.

Para detener la filmación
Detenga la grabación.

Para establecer el canal de audio para la grabación de proxy
Defina el canal de audio para la grabación de datos de proxy mediante [Project] > [Proxy Rec] > [Audio Channel] en el
menú de la cámara.
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Establezca [Project] > [Proxy Rec] > [Setting] en [On] en el menú web o en el menú de la cámara.1

Introduzca una tarjeta de memoria en una ranura para tarjetas CFexpress Tipo A/SD.

Inserte las tarjetas CFexpress con la etiqueta mirando hacia arriba.
Inserte las tarjetas SD con la etiqueta mirando hacia abajo.

Nota

Proxy Rec no se puede establecer en On al mismo tiempo que S&Q Motion o Interval Rec. Cuando Proxy Rec se establece
en On, estos otros modos de grabación se establecen de forma forzada en Off.

2

Pulse el botón START/STOP de grabación.

La grabación de proxy comenzará.

Nota

Si la unidad está apagada o si se extrae la tarjeta de memoria mientras se está accediendo a esta, no se podrá garantizar
la integridad de los datos de la tarjeta.
Es posible que se pierdan todos los datos grabados en la tarjeta de memoria. Asegúrese de que el indicador de acceso a la
tarjeta de memoria esté siempre apagado antes de apagar la unidad o extraer la tarjeta de memoria.

Asegúrese de que la tarjeta de memoria no se salga al introducirla o extraerla.

3
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Descripción general del aspecto

Cuando la unidad está en el modo Custom, puede añadir ajustes al negro, la matriz y otros parámetros para crear un
“aspecto” basado en el aspecto básico.

También puede seleccionar rápidamente otro aspecto guardando combinaciones diferentes de ajustes en archivos de
escena.
La unidad viene con un total de siete aspectos predeterminados.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Selección del aspecto

En este tema se describe cómo seleccionar un aspecto.

Compruebe que [Project] > [Base Setting] > [Shooting Mode] esté establecido en [Custom] en el menú web
o en el menú de la cámara.

Sugerencia

En el modo [Custom] se muestran los botones [ISO/Gain] y [Scene File] en el panel de configuración básica de la cámara.

1

Pulse el botón [Scene File] del panel de configuración básica de la cámara.

El marco del botón [Scene File] se pone de color naranja.

Aparece el panel de ajuste de Scene File.

2

Pulse el botón [Scene File] en el panel de ajuste y seleccione en la lista un archivo de escena con el
aspecto deseado.

Los siguientes preajustes vienen configurados de fábrica:

Sugerencia

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Archivo de escena 1 [S-Cinetone] [HLG Live]

Archivo de escena 2 [Standard] [HLG Natural]

Archivo de escena 3 [Still] (Sin registrar)

Archivo de escena 4 [ITU709] (Sin registrar)

Archivo de escena 5 [709tone] (Sin registrar)

Archivos de escena del 6 al 16 (Sin registrar) (Sin registrar)
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También puede seleccionar un aspecto con [Paint/Look] > [Scene File] > [Recall] en el menú de la cámara. También puede
cargar un preajuste con [Scene File] > [Preset Recall].

Nota

El ajuste preestablecido del archivo de escena 5 se establece en [709tone] con la versión de software 2.0 o posterior. Se
muestra cuando [Maintenance]> [Reset] > [Factory Default] en el menú web.

244



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Importación del aspecto básico deseado

Puede importar un archivo 3D LUT, creado en un ordenador o en otro dispositivo, como aspecto básico. Se pueden
importar hasta 16 archivos.
Formato de archivo: archivo CUBE (*.cube) para una 3D LUT de 17 o 33 cuadrículas creada con Catalyst Browse, RAW
Viewer o DaVinci Resolve* (de Blackmagic Design Pty. Ltd.).

Gama de colores de entrada/Gamma: [S-Gamut3.Cine/S-Log3] o [S-Gamut3/S-Log3]

Para ajustar en caso de subexposición

Verificado con Resolve V9.0, V10.0 y V11.0.*

Guarde el archivo 3D LUT en el dispositivo que ejecuta la Aplicación Web.1

Abra [Paint/Look] > [Base Look] en el menú web.

Aparecerá una lista de aspectos básicos registrados.

2

Pulse el botón [Import] de la fila en la que desea importar el archivo.

Aparecerá el cuadro de diálogo de la selección del archivo.

3

Seleccione el archivo 3D LUT preparado.

El archivo 3D LUT importado pasará a ser el aspecto básico de la unidad.

4

Seleccione el archivo 3D LUT importado con [Paint/Look] > [Base Look] > [Select] en el menú de la cámara.5

Configure [Paint/Look] > [Base Look] > [Input] y [Output] del menú de la cámara para que coincida con los
atributos del archivo 3D LUT importado.

6
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Si existe tendencia a la subexposición cuando se selecciona la exposición automática durante el uso del aspecto básico
importado, ajústelo con [Paint/Look] > [Base Look] > [AE Level Offset] en el menú web.

Nota

La imagen no se ve afectada simplemente por importar un archivo 3D LUT. Cargue el archivo 3D LUT importado con [Paint/Look]
> [Base Look] > [Select] en el menú de la cámara.

Si la opción [Input] no se configura correctamente, no se obtendrá el aspecto adecuado.

Los ajustes de los elementos de menú [Input], [Output] y [AE Level Offset] se aplican al aspecto básico seleccionado mediante
[Select]. Si se importan varios archivos 3D LUT, seleccione [Select] para cada archivo 3D LUT y configure [Input], [Output] y [AE
Level Offset] de forma individual para cada archivo.

La configuración de [Input], [Output] y [AE Level Offset] se guarda para cada archivo 3D LUT.

Las opciones de selección de Base Look/LUT para los archivos 3D LUT importados son las mismas en los modos
[SDR(BT.709)], [HDR(HLG)] y modos de filmación Log, pero la gama de colores y la conversión gamma no se realizan de
acuerdo con estos modos.

Los archivos 3D LUT no se eliminan cuando se ejecuta [Maintenance] > [Reset] > [All Reset (except for Network Settings)] del
menú web.

Un  (error de archivo adjunto LUT 3D) que se muestra delante de la pantalla [Base Look Name] indica que los archivos LUT
3D no se pueden adjuntar a clips grabados en los modos de filmación Log. Vuelva a importar el archivo LUT 3D.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Personalización del aspecto

Puede personalizar el aspecto en función del aspecto básico mediante los controles deslizantes [Master Black], [R
Black] y [B Black] en el panel de ajuste de Scene File, el panel de configuración básica de la cámara, y [Paint/Look] >
[Matrix] y otros elementos de configuración en el menú de la cámara.
Conecte la unidad a una televisión o a un monitor y ajuste la calidad de la imagen mientras observa la pantalla de la
televisión o del monitor.

1: Botones de ajuste/control deslizante de [R Black]
2: Botones de ajuste/control deslizante de [B Black]
3: Botones de ajuste/control deslizante de [Master Black]

Nota

Al importar un archivo 3D LUT y aplicarlo a la imagen, no se obtendrá el aspecto deseado definido en el archivo 3D LUT si se
cambia la opción [Paint/Look] > [Matrix] y otros ajustes de aspecto que no sean los ajustes del menú de cámara.

Puede restablecer todos los ajustes personalizados con [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] en el
menú de la cámara.
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Guardar un aspecto

Puede guardar el aspecto actual como archivo de escena en la memoria interna con [Paint/Look] > [Scene File] > [Store]
en el menú de la cámara.
Puede recuperar el aspecto anterior rápidamente mediante el panel de ajuste de Scene File o a través de las
operaciones de menú.

Nota

Si selecciona otro aspecto sin guardar el aspecto actual, se descartará el aspecto actual.

Sugerencia

Puede sobrescribir los archivos de escena predeterminados. Para restaurar un archivo de escena predeterminado, cargue el
aspecto que desee restaurar mediante [Paint/Look] > [Scene File] > [Preset Recall] en el menú de la cámara y guarde el archivo
de escena con [Scene File] > [Store].

Para eliminar un aspecto guardado
Puede eliminar un archivo de escena guardado en la memoria interna con [Paint/Look] > [Scene File] > [Delete] en el
menú de la cámara.

Sugerencia

Una vez eliminado, dejará de mostrarse en el panel de ajustes de Scene File o el menú directo.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Eliminación de un aspecto básico

Puede eliminar los archivos 3D LUT importados con [Paint/Look] > [Base Look] > [Delete] en el menú de la cámara.
Puede eliminar todos los archivos 3D LUT importados con [Paint/Look] > [Base Look] > [Delete All] en el menú de la
cámara.

Nota

Antes de eliminarlo, compruebe que el aspecto básico no esté siendo utilizado en ningún archivo de escena. Si elimina un
aspecto básico que está siendo utilizado, el aspecto de los archivos de escena correspondientes será incorrecto.

Los archivos 3D LUT importados no se eliminan cuando se ejecuta [Maintenance] > [Reset] > [All Reset (except for Network
Settings)] del menú web.

Los aspectos básicos eliminados ya no podrán utilizarse como LUT en los modos de filmación Log.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Filmación con ajuste del aspecto en posproducción

Si utiliza la unidad en los modos de filmación Log*1 y graba gradaciones uniformes de las áreas oscuras a las luminosas,
puede realizar ajustes finos, como restaurar localmente las gradaciones de las áreas oscuras y las luminosas, en la
posproducción.
Sin embargo, cuando vea las imágenes grabadas en un monitor convencional, el contraste total será bajo y resultará
difícil ajustar el enfoque y la exposición.
Puede aplicar una LUT al destino del monitor en la unidad para facilitar diversos ajustes durante la filmación. También
puede aplicar la LUT utilizada al filmar automáticamente durante la reproducción para comprobar rápidamente el
resultado final.
Las LUT se aplican en los siguientes sistemas. Sin embargo, solo se puede aplicar una LUT.

Salida SDI
Transmisión y salida HDMI
Clip proxy grabado en soportes de grabación
Clip en alta resolución (principal) grabado en soportes de grabación

5-041-957-43(1) Copyright 2022 Sony Corporation

Término genérico para los modos Flexible ISO/Cine EI/Cine EI Quick*1
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Aplicación de una LUT a la transmisión y a la salida de HDMI

Puede aplicar una LUT a la transmisión y a la salida de HDMI.

Nota

La imagen del panel de imagen de la cámara de la Aplicación Web también se incluye en la imagen de transmisión.

Sugerencia

También se puede definir a través de [Shooting] > [LUT On/Off] > [HDMI/Stream] en el menú de la cámara.

La salida de SDI puede definirse de la misma manera.

En el caso de los vídeos en medios grabados, puede definirlo en [Shooting] > [LUT On/Off] > [Internal Rec] y [Proxy] en el menú
de la cámara.

Un  (error de archivo adjunto LUT 3D) que se muestra delante de la pantalla [Base Look/LUT] indica que los archivos LUT 3D
no se pueden adjuntar a clips grabados en los modos de filmación Log. Vuelva a importar el archivo LUT 3D.
Este icono también se muestra cuando el archivo adjunto falla debido a la congestión de procesamiento temporal.

Compruebe que [Project] > [Base Setting] > [Shooting Mode] esté establecido en [Flexible ISO], [Cine EI] o
[Cine EI Quick] en el menú web o en el menú de la cámara.

Sugerencia

En los modos de filmación Log, los botones [Base ISO/Exposure Index] y [Base Look/LUT] en el panel de configuración
básica de la cámara.

1

Pulse el botón [Base Look/LUT] del panel de configuración básica de la cámara.

El marco del botón [Base Look/LUT] se pone de color naranja.

Aparece el panel de ajuste de Base Look/LUT.

2

Seleccione [HDMI/Stream] > [MLUT].3

251



5-041-957-43(1) Copyright 2022 Sony Corporation

252



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Cambio de una LUT

Puede modificar el LUT que se aplicará.

Sugerencia

La unidad proporciona [s709], [709(800%)] y [S-Log3] como LUT predeterminadas.

También puede importar y aplicar un archivo 3D LUT. Para obtener más detalles, consulte “Importación del aspecto básico
deseado” y “Eliminación de un aspecto básico.”

También se puede definir a través de [Paint/Look] > [Base Look] > [Select] en el menú de la cámara.

Tema relacionado
Importación del aspecto básico deseado

Eliminación de un aspecto básico

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse el botón [Base Look/LUT] del panel de configuración básica de la cámara.

El marco del botón [Base Look/LUT] se pone de color naranja.

Aparece el panel de ajuste de Base Look/LUT.

1

Pulse el botón [Base Look/LUT] y seleccione el aspecto básico que desee aplicar.2
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Cambio de la distribución de las áreas oscuras e iluminadas en la imagen grabada

En los modos de filmación Cine EI y Cine EI Quick, puede cambiar la distribución de las áreas oscuras e iluminadas, por
ejemplo, si desea priorizar el tono de las áreas oscuras sobre las áreas iluminadas, cambiando Exposure Index a un
valor distinto de la sensibilidad base.

Pulse el botón [Base Look/LUT] del panel de configuración básica de la cámara.

El marco del botón [Base Look/LUT] se pone de color naranja.

Aparece el panel de ajuste de Base Look/LUT.

1

Seleccione [HDMI/Stream] > [MLUT].

Se aplica una LUT a la transmisión y a la salida de HDMI.

2

Pulse el botón [Base ISO/Exposure Index] del panel de configuración básica de la cámara.

El marco del botón [Base ISO/Exposure Index] se pone de color naranja.

Aparece el panel de ajuste de Base ISO/Exposure Index.

3

Ajuste el índice de exposición según la distribución deseada de áreas oscuras e iluminadas con el control
deslizante [Exposure Index] o los botones de ajuste [Exposure Index].

Para [Cine EI]

Para [Cine EI Quick]
La sensibilidad base se ajusta automáticamente de acuerdo con el índice de exposición especificado.

4
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Sugerencia

También se puede definir a través de [Shooting] > [ISO/Gain/EI] > [Exposure Index] en el menú de la cámara.

La salida de SDI puede utilizarse de la misma manera.

El segundo valor numérico del ajuste indica cuántos pasos de información sobre el brillo se asignan a las áreas luminosas (brillo
superior a gris 18%). Las áreas con un brillo superior quedarán sobreexpuestas.
Ejemplo: en “400EI/5.0E”, se asignan 5,0 pasos en la parte luminosa.

Esto también le puede servir de guía para comprobar el tono de las zonas oscuras y luminosas durante la filmación. No olvide
volver a la posición EI original después de comprobar la exposición. Además, en el modo Cine EI Quick, tenga cuidado de no
afectar negativamente la sensibilidad de la base.

5-041-957-43(1) Copyright 2022 Sony Corporation

Ajuste los filtros ND o de iluminación para que la salida de la imagen de la cámara de [HDMI/Stream] tenga
la exposición adecuada.

5
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Grabación de vídeo RAW

Puede grabar la señal de vídeo RAW emitida desde el conector SDI OUT de la videocámara en una grabadora externa
compatible.
A continuación, se muestran los formatos de salida RAW compatibles.

Frecuencia del sistema [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Conecte una grabadora RAW externa al conector SDI OUT de la unidad.1

Establezca [Project] > [Base Setting] > [Shooting Mode] en [Cine EI], [Cine EI Quick] o [Flexible ISO] en el
menú web o en el menú de la cámara.

2

Establezca el ángulo de visión solamente FF con [Project] > [Rec Format] > [Imager Scan Mode] en el menú
web o en el menú de la cámara.

3

Establezca [Project] > [Rec Format] > [Codec] en [RAW] en el menú web o en el menú de la cámara.

Si selecciona [RAW & XAVC-I], se grabará simultáneamente vídeo en la grabadora RAW externa y vídeo en las
tarjetas de memoria de la unidad.

4

Establezca la resolución con [Project] > [Rec Format] > [RAW Output Format] en el menú web o en el menú
de la cámara.

5

Compruebe que la grabadora externa esté encendida y, a continuación, pulse el botón START/STOP de
grabación en la pantalla de operación en directo.

El estado de grabación del vídeo RAW se indica mediante un icono en el panel de imagen de la cámara.

6
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Nota

Cuando se inicia la grabación en una grabadora externa, sin usar el botón START/STOP de grabación de la pantalla de
operación en directo, es posible que los clips no se graben correctamente.

5-041-957-43(1) Copyright 2022 Sony Corporation

Nota

La señal de control de grabación se emite desde el conector SDI OUT de la unidad, pero no es posible obtener el estado
de la grabadora externa. Por lo tanto, es posible que la unidad indique que se está grabando vídeo RAW cuando en
realidad la grabadora externa no está grabando. Compruebe el indicador en la grabadora externa para obtener el estado
de funcionamiento correcto.
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Grabación de vídeo RAW en modo Slow & Quick Motion

Puede grabar vídeos RAW en modo Slow & Quick Motion.

Para obtener más información sobre las velocidades de fotogramas admitidas en la filmación, consulte “Movimiento
a cámara lenta y rápida”.

Tema relacionado
Movimiento a cámara lenta y rápida
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Activación/desactivación de la función de control del bokeh

Puede ajustar fácilmente el grado de bokeh vinculando ND Filter y Gain al funcionamiento del iris.

Activación/desactivación de la función de control del bokeh

Esta función solamente se puede activar al ajustar la exposición manualmente. Defina el filtro ND a modo variable y el
iris, la ganancia, el obturador y el filtro ND en el ajuste manual.
Puede activar y desactivar la función de control del bokeh mediante [Shooting] > [Iris] > [Bokeh Control] en el menú de la
cámara.
Cuando la función de control del bokeh está ajustada en On, se muestra un icono  (B) en los indicadores de filtro ND
y ganancia.

Nota

Esta función solamente está habilitada en objetivos de montura E que se pueden comunicar con la unidad.

El efecto máximo de esta función puede obtenerse mediante un objetivo de montura E de Sony.

La función de control del bokeh cambia a Off cuando se produce alguna de las siguientes operaciones.

Cuando la unidad está apagada
Cuando se ajusta el diafragma, la ganancia, el obturador o el filtro ND en Auto
Al cambiar el modo de filmación
Cuando el filtro ND está ajustado en Clear o el modo predeterminado
Al extraer el objetivo
Cuando se reinicia la unidad, por ejemplo, tras cambiar la frecuencia

Sugerencia

También puede asignar la función [Bokeh Control] a un botón asignable y ajustar la función de control del bokeh en On u Off con
el botón.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste del grado de bokeh

Ajuste la configuración en los pasos del 2 al 4 según sea necesario.

Nota

Es posible que el aspecto varíe en función de la velocidad de funcionamiento, del objetivo, de los ajustes de captura y del sujeto,
y también es posible que cambie el brillo. Es altamente recomendable realizar una prueba de la cámara antes de empezar a
filmar.

Es posible que el brillo cambie cuando la dirección de funcionamiento del iris cambie, como al abrir el iris después de cerrarlo o
al cerrar el iris después de abrirlo. En este caso, establezca un ajuste ligeramente superior al requerido de antemano y, a
continuación, bájelo ligeramente, compruebe el brillo y comience a filmar. Por ejemplo, si desea abrir el iris a una apertura F8 y
desenfocar el fondo, primero cierre la apertura más allá de F8, vuelva a F8, compruebe el brillo y comience a filmar.

Realice las operaciones de control del bokeh lentamente. Si necesita acelerar el funcionamiento, intente ajustar gradualmente
mientras comprueba los cambios en la imagen.

Sugerencia

Cuando la función de control del bokeh está ajustada en On, el filtro ND y la ganancia funcionan a la vez para compensar los
cambios en la exposición provocados por el ajuste del iris, lo cual le permitirá cambiar el grado de bokeh.

El control del bokeh se vincula en primer lugar al filtro ND como respuesta al accionamiento del iris. Si ND Filter no se puede
seguir cambiando, se vincula Gain.

En modo MF, es recomendable abrir en primer lugar el iris y, a continuación, ajustar el enfoque.

Si utiliza el filtro ND automático en lugar de la función de control del bokeh, el grado del filtro ND seguirá el cambio producido en
el brillo del sujeto.

Visualización durante la operación de vinculación de la ganancia
Cuando la función de control del bokeh está ajustada en On, es posible que la ganancia cambie a medida que se ajusta
el iris.

Ajuste la función de control del bokeh en On.1

Abra por completo el diafragma.2

Defina el filtro ND en 1/128.3

Establezca la ganancia en 0 dB y utilice la iluminación para conseguir la exposición correcta.4

Ajuste el enfoque.5

Ajuste el diafragma.

El grado de bokeh cambiará.

6
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Cuando el vínculo de la ganancia está activo y la ganancia cambia, se muestra un mensaje en la parte superior de la
pantalla y parpadea el icono  (B) en el indicador de ganancia.
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Descripción general del proceso para guardar y cargar datos de configuración

Puede guardar los ajustes de la unidad como datos de configuración mediante la Aplicación Web. De esta manera,
podrá cargar rápidamente el conjunto de ajustes de menú más adecuado para cada situación.
Con esta unidad, puede guardar prácticamente todos los ajustes relacionados con las funciones de la cámara, a
excepción de lo que se indica en la siguiente nota, como un archivo ALL (un archivo con todos los ajustes).

Nota

La configuración de la función de red y la información de autenticación no se guarda. Para obtener más detalles sobre los
elementos guardados, consulte “Lista de elementos del menú.”

Tema relacionado

Lista de elementos del menú
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Guardar un archivo ALL

En este tema se describe cómo guardar un archivo ALL.

5-041-957-43(1) Copyright 2022 Sony Corporation

Abra [Project] > [All File] en el menú web.1

Pulse el botón [Save All File] > [Save].

El navegador web descargará un archivo denominado all-file.ALL momentáneamente.

2

Especifique una ubicación y un nombre para el archivo all-file.ALL descargado y guárdelo.

Para obtener más información acerca de las operaciones con archivos, consulte las instrucciones de
funcionamiento del dispositivo.

3
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Cargar un archivo ALL

En este tema se describe cómo cargar un archivo ALL.

Nota

La unidad se reiniciará automáticamente después de cargar los datos de configuración. Una vez reiniciada, vuelva a cargar la
página en el navegador web.

5-041-957-43(1) Copyright 2022 Sony Corporation

Abra [Project] > [All File] en el menú web.1

Pulse el botón [Load All File] > [Load].

Se mostrará el cuadro de diálogo abierto en el dispositivo que ejecuta la Aplicación Web.

2

Abra el cartel que desee cargar.

Para obtener más información acerca de las operaciones con archivos, consulte las instrucciones de
funcionamiento del dispositivo.

3

Cuando aparezca la pantalla de confirmación del nombre del archivo cargado, pulse el botón [OK].4

Cuando aparezca la pantalla de resultados de ejecución, pulse el botón [OK].5

Espere a que la unidad se reinicie y conecte de nuevo la Aplicación Web.6
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Acerca de la transferencia de archivos

Puede cargar un archivo proxy o un archivo original que se haya grabado en la unidad en un servidor de Internet o en un
servidor de una red local.

Nota

Cuando la fuente de alimentación está ajustada en estado de reposo, las transferencias de archivos se ponen en espera aunque
la unidad esté conectada.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Registro de un destino de transferencia de archivo

Puede registrar un destino de transferencia de archivo antes de iniciar una transferencia de archivo.

Seleccione [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (o [Server Settings2],
[Server Settings3]) en el menú web.

Sugerencia

El nombre de la opción de selección cambiará según el valor de [Display Name] que se configura en el siguiente paso.

1

Defina los siguientes elementos para [Network] > [FTP Server 1] como [FTP Server 3] en el menú web.

[Display Name]
Introduzca el nombre del servidor que se mostrará en la lista de tareas de transferencia al seleccionar un servidor
de destino de transferencia.
[Service]
Muestra el tipo de servidor.
[FTP]: servidor FTP
[Host Name]
Introduzca la dirección o el nombre de host del servidor.
[Port]
Introduzca el nombre del servidor para conectarse.
[User Name]
Introduzca el nombre del usuario.
[Password]
Introduzca la contraseña.
[Passive Mode]
Active y desactive el modo pasivo.
[Destination Directory]
Introduzca el nombre del directorio en el servidor de destino.

Nota

Si se introducen caracteres en el directorio de destino no válidos en el [Destination Directory], los archivos se transferirán al
directorio de inicio del usuario. Los caracteres no válidos variarán dependiendo del servidor.

[Using Secure Protocol]
Ajuste si desea llevar a cabo una transferencia de FTP segura.
[Root Certificate]
Cargue/borre un certificado.
[Load]: cargar un certificado de CA. Permite cargar certificados de formato PEM.
[Clear]: borrar el certificado de CA.
[None]: no cargar ni borrar ningún certificado.

Nota

Ajuste el reloj de la unidad a la hora correcta antes de cargar un certificado CA.

Al grabar en XAVC-I 4096×2160P/3840×2160P 59.94/50P, no se puede seleccionar [Load].

2
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[Root Certificate Status]: Muestra el estado de carga del certificado.
[Reset]: Restablece los ajustes predeterminados de Server Settings.
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Carga de un archivo proxy en una tarjeta de memoria desde la pantalla de imágenes
en miniatura

Puede subir los archivos proxy en una tarjeta de memoria individualmente desde la pantalla de imágenes en miniatura.

Nota

Se pueden registrar hasta 200 trabajos de transferencia.
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Pulse el botón [Thumbnail] de la pantalla de funcionamiento en directo de la Aplicación Web.

La pantalla cambia de la imagen de cámara a la pantalla de imágenes en miniatura.

1

Seleccione [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] en el menú de la cámara.

Para transferir todos los archivos proxy de manera simultánea, seleccione [Transfer Clip (Proxy)] > [All Clips].
Los clips se pueden transferir desde la pantalla de imágenes en miniatura o la pantalla de imágenes en miniatura
de clips filtrados.

2

Seleccione el clip que desea transferir con el botón [Set] y, a continuación, pulse el botón [Menu].

Aparece una pantalla de confirmación de transferencia.

3

Seleccione [Execute].

El archivo proxy correspondiente al clip seleccionado se registra como trabajo de transferencia y comienza la
carga.
Cuando el trabajo de transferencia se registra correctamente, aparece la pantalla de resultados de la transferencia.

4

Pulse el botón [OK].5
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Carga de un archivo original en una tarjeta de memoria desde la pantalla de imágenes
en miniatura

Puede cargar un archivo original en una tarjeta de memoria desde la pantalla de imágenes en miniatura.

Nota

Se pueden registrar hasta 200 trabajos de transferencia.

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse el botón [Thumbnail] de la pantalla de funcionamiento en directo de la Aplicación Web.

La pantalla cambia de la imagen de cámara a la pantalla de imágenes en miniatura.

1

Seleccione [Thumbnail] > [Transfer Clip] > [Select Clip] en el menú de la cámara.

Para transferir todos los archivos originales de manera simultánea, seleccione [Transfer Clip] > [All Clips].
Los clips se pueden transferir desde la pantalla de imágenes en miniatura o la pantalla de imágenes en miniatura
de clips filtrados.

2

Seleccione el clip que desea transferir con el botón [Set] y, a continuación, pulse el botón [Menu].

Aparece una pantalla de confirmación de transferencia.

3

Seleccione [Execute].

El archivo original del clip seleccionado se registra como trabajo de transferencia y comienza la carga.
Cuando el trabajo de transferencia se registra correctamente, aparece la pantalla de resultados de la transferencia.

4

Pulse el botón [OK].5

269



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Comprobación del estado de transferencia de archivos

Puede verificar el estado de la transferencia de archivos seleccionando [Network] > [File Transfer] > [View Job List] en el
menú de la cámara.

Nota

Se pueden registrar hasta 200 trabajos de transferencia.

Las tareas de transferencia se retienen cuando la unidad se apaga o se pone en reposo, pero es posible que se pierdan hasta 10
minutos de información de progreso reciente si se desconecta la batería de otra manera.

Si se produce un error durante la transferencia de archivos, no se reanudará la transferencia de un clip con el mismo nombre que
un clip transferido dependiendo de la configuración y el estado del servidor de destino de la transferencia. En este caso,
compruebe la configuración y el estado del servidor de destino de la transferencia.

Sugerencia

Si [Network] > [File Transfer] > [Auto Upload (Proxy)] se define como [On] en el menú de la cámara y existe una conexión de red,
los archivos proxy se suben automáticamente al servidor especificado con [Default Upload Server] cuando termina la grabación.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Carga mediante FTP segura

Puede cargar archivos cifrados mediante FTPS en el modo Explicit (FTPES) para conectarse con el servidor de archivos
de destino.
Para una transferencia de FTP segura, ajuste [Using Secure Protocol] en [On] en el servidor de archivos de destino y
cargue un certificado.

Para obtener más detalles acerca de la configuración, consulte “Registro de un destino de transferencia de archivo”.

Tema relacionado

Registro de un destino de transferencia de archivo
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Acerca de la transmisión

La unidad puede transmitir de manera simultánea el vídeo y el audio que se emite a través del conector HDMI.

Nota

Para usar la transmisión como vídeo principal, defina [Monitoring] > [Output Display] > [SDI] en [On] y [HDMI/Stream] en [Off] en
el menú web y supervise el estado de la cámara en un monitor SDI.

Si un monitor conectado al conector HDMI no es compatible con el formato de salida de HDMI configurado en el menú
[Monitoring] del menú web o el menú de la cámara, la imagen de la cámara no se mostrará en la Aplicación Web. El vídeo de
transmisión tampoco se emitirá.

La resolución de la transmisión no puede definirse en un valor superior al de la resolución de la señal de salida de HDMI.

Cuando varios usuarios visualizan la imagen, esta puede mostrarse distorsionada, según la configuración del códec.

La unidad admite los siguientes métodos de transmisión. Los códecs de vídeo disponibles para seleccionarse se
muestran entre paréntesis.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Configure los ajustes de formato de transmisión, los ajustes de códec de vídeo y los ajustes de códec de audio, en ese
orden.

●: habilitado, –: deshabilitado

Sugerencia

La imagen del panel de imagen de la cámara de la Aplicación Web también es un sistema de transmisión.

Formato de transmisión
Configuración del códec

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Aplicación Web – – ● –

RTMP se puede seleccionar cuando [Stream] > [Audio Stream] se establece en [On] en el menú de la cámara.*1

Cuando la frecuencia del sistema es 59.94 o 50 y el formato de salida HDMI es 3840×2160 o superior, la salida de video 2 no está disponible.*2
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Configuración del formato de transmisión

Establezca el formato de transmisión con [Stream] > [Stream] > [Stream Setting] > [Setting] en el menú web.

Cuando [Setting] está definido en [RTSP]

En la transmisión RTSP, hasta 5 usuarios pueden visualizar simultáneamente la imagen de una única cámara.
Puede configurar hasta 2 modos de códec de vídeo.
[Port Number]
Permite definir el número de puerto que se usará para la transmisión RTSP. El valor predeterminado es 554.
Al modificar el ajuste, el servidor RTSP se reiniciará.
[Time Out]
Especifica el tiempo de espera del comando Keep-Alive para la transmisión RTSP. El tiempo de espera puede ser un
valor de entre 0 y 600 segundos. El valor predeterminado es 60 segundos.
Cuando se establece en 0 segundos, no se agota el tiempo de espera del comando Keep-Alive.
[Authentication]
Permite definir si se requiere autenticación.
[Video Port Number 1], [Video Port Number 2]
Permite especificar el número de puerto de comunicaciones de datos de imágenes que se usará para la transmisión de
unidifusión de RTSP. El valor predeterminado de fábrica para Video Port Number 1 es 51000. El valor predeterminado
de fábrica para Video Port Number 2 es 53000. Introduzca un número par entre 1024 y 65534. El número que se defina
aquí y el siguiente número impar que se obtiene al sumar 1 serán los dos números de puertos que se utilizarán para el
control y la comunicación de datos de imágenes.
[Video Port Number 1] y [Video Port Number 2] corresponden a [Stream] > [Video Stream] > [Video Stream 1] y [Video
Stream 2].
[Audio Port Number]
Permite especificar el número de puerto de comunicaciones de datos de audio que se usará para la transmisión de
unidifusión de RTSP. El valor predeterminado es 57000. Introduzca un número par entre 1024 y 65534. El número que
se defina aquí y el siguiente número impar que se obtiene al sumar 1 serán los dos números de puertos que se utilizarán
para el control y la comunicación de datos de audio.

Cuando [Setting] está definido en [RTMP]

El modo de códec de vídeo que solo se puede utilizar para RTMP es H.264. Para utilizar RTMP, [Stream] > [Audio
Stream] deben estar configurados en [On] en el menú web.
[Server URL]
Establece la dirección URL de destino de carga. Especifique una cadena de caracteres que comience con “rtmp://” o
“rtmps://”.
[Stream Key]
Introduzca la clave de transmisión obtenida del sitio que está usando. A pulsar el botón [Clear], se borrará la entrada.

Nota

Tenga cuidado al manipular la clave de transmisión. Si un tercero conoce la clave de transmisión, existe el riesgo de suplantar la
transmisión.

[Root Certificate]
Importa el certificado raíz necesario para la transmisión mediante el protocolo RTMPS. Para importar el certificado raíz,
pulse el botón [Load] y seleccione un certificado raíz. Pulse el botón [OK] en el cuadro de diálogo de selección de
archivos para importar el archivo seleccionado a la unidad. Si hay un certificado raíz importado en la unidad, se
actualizará el certificado raíz. Para eliminar un certificado raíz importado, pulse el botón [Delete] en la pantalla de
configuración. El estado del certificado raíz se muestra en [Root Certificate Status].
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Nota

Importe el certificado raíz requerido por el servicio de transmisión.

Cuando [Setting] está definido en [SRT-Caller] o [SRT-Listener]

El modo del códec de vídeo es H.264 solo.
[Destination]
Se muestra cuando el modo de transmisión está ajustado en [SRT-Caller]. Permite definir la URL del destino de
conexión.
[Port Number]
Se muestra cuando el modo de transmisión está ajustado en [SRT-Listener]. Define el número de puerto en el que se
lleva a cabo la escucha. El valor predeterminado es 4201.
[Latency]
Define el valor de latencia entre 20 ms y 8000 ms. El valor predeterminado es 120.
[TTL]
Define el valor de TTL entre 1 y 255. El valor predeterminado es 64.
[Encryption]
Selecciona el método de cifrado. Seleccione Off, AES128 o AES256. El valor predeterminado es Off.
[Passphrase]
Define la frase de contraseña que se ha usado para el cifrado. Al pulsar el botón [Clear], se restablecerá la frase de
contraseña configurada.
[ARC]
Para habilitar la función de control de velocidad adaptativa, debe definirse en On.
Cuando la función de control de velocidad adaptativa se habilita, es posible que se reduzcan las interrupciones de la
imagen causadas por la congestión de la línea de comunicación.

Cuando [Setting] está definido en [NDI|HX]

La unidad es compatible con la versión 2 de NDI|HX de NewTek.
Para usar NDI|HX, debe adquirirse una clave de licencia.
Adquisición de una clave de licencia
Se debe adquirir en la siguiente URL de NewTek.
https://www.newtek.com/ndihx/products/upgrade/

Nota

Descargue la versión más reciente del controlador NDI|HX e instálela en un producto NewTek.

Para obtener detalles sobre el funcionamiento y el registro de NDI|HX, consulte las instrucciones de funcionamiento del producto
de NewTek.

[License]
Muestra la información de licencia de una licencia habilitada.
[Source Name]
Muestra el nombre de la fuente.
[Group]
Para habilitar la función de agrupación de NDI, debe definirse en On.
[Group Name]: define el nombre de grupo de NDI. Se pueden configurar varios ajustes separados por una coma.
[Discovery Server 1], [Discovery Server 2]
Permite definir el servidor de detección 1 de NDI y el servidor de detección 2 de NDI.
[Reliable UDP Mode]
Para habilitar el modo Reliable UDP, debe definirse en On.
[Multicast Mode]
Para habilitar el modo Multicast, debe definirse en On.
[Multicast Prefix]: define el prefijo que debe usarse para la transmisión de multidifusión.
[Multicast Netmask]: define la máscara de red que determina el rango de dirección de multidifusión.
[Multicast TTL]: define el valor de TTL para la transmisión de multidifusión en un rango de 1 a 256. El valor
predeterminado es 3.
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[Multi-TCP Mode]
Para habilitar el modo Multi-TCP, debe definirse en On.
[Unicast UDP Mode]
Para habilitar el modo Unicast UDP, debe definirse en On.

Acerca de los servicios y el software de terceros.
Es posible que se apliquen distintos términos de uso.

El aprovisionamiento de servicios y las actualizaciones de software podrían interrumpirse o finalizarse sin previo
aviso.
La descripción de los servicios y el software está sujeta a cambios sin previo aviso.
Es posible que se exija el registro y la suscripción por separado.

Sony no se responsabiliza de ninguna reclamación por parte de usuarios o terceros debido al uso de servicios y
software de otras empresas.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Configuración del códec de vídeo para la transmisión

Defina el códec de vídeo mediante [Stream] > [Video Stream] en el menú web.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Puede definir hasta tres modos de códec de imagen. Configure los siguientes ajustes por separado para cada modo de
imagen.
[Video Stream 3] se utiliza para la pantalla del panel de imagen de la cámara de la Aplicación Web.

Nota

Cuando [Stream] > [Stream Setting] > [Setting] se establece en [RTMP], [SRT-Caller] o [SRT-Listener], algunos de los ajustes
de[Video Stream 1], [Video Stream 2] y [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) tienen
valores predefinidos.

[Codec 1], [Codec 2], [Codec 3]
Seleccione [H.264], [H.265] o [Off]. Tenga en cuenta que [Codec 1] no puede definirse como [Off]. Además, [Codec 3] se
define como [JPEG] (fijo).

Nota

Se puede detectar lo siguiente según la combinación de varios ajustes, como el tamaño de la imagen, la velocidad de
fotogramas y la velocidad de bits de [Codec 1], [Codec 2] y [Codec 3].

Aumento de la latencia del vídeo.
Salto de fotogramas durante la reproducción del vídeo.
Audio intermitente.
Respuesta lenta de la cámara a varios comandos.
Respuesta lenta de la cámara a operaciones desde un controlador remoto.
Lenta emisión de la imagen de pantalla y funcionamiento de la configuración.

Si detecta alguno de estos problemas, reduzca los valores del tamaño de la imagen, la velocidad de fotogramas y los parámetros
de la velocidad de bits o cambie los valores de otros parámetros de configuración para resolverlo.

Cuando [Stream] > [Stream Setting] > [Setting]se establece en [RTMP], [SRT-Caller] o [SRT-Listener], [Codec 1] se establece en
[H.264] (fijo). [Codec 2] se define como [Off] (fijo).

Cuando el tamaño de la imagen o la frecuencia del sistema de la salida de HDMI cambia, [Codec 2] se define como [Off].

[Size 1], [Size 2], [Size 3]
Permite seleccionar el tamaño de la imagen que se transmitirá desde la cámara.
Las opciones de tamaño de imagen disponibles variarán según el tamaño de la imagen de la salida de HDMI.

Nota

Cuando se modifica el tamaño de la imagen o la frecuencia del sistema de la salida HDMI, se seleccionará el tamaño máximo de
la imagen.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Permite definir la velocidad de fotogramas de la imagen.
Las unidades “fps” indican el número de fotogramas que se transmiten por segundo.
Las opciones de velocidad de fotogramas disponibles variarán según el tamaño de la imagen de la salida de HDMI.
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Nota

Cuando se modifica el tamaño de la imagen o la frecuencia del sistema de la salida HDMI, se seleccionará la velocidad máxima
de fotogramas.

[I-Picture Mode 1], [I-Picture Mode 2]
Define el método para especificar el intervalo de inserción de I-Picture para H.264 y H.265 en [Time] o [Frame].
No se puede definir para [Codec 3].
[Time]: define el intervalo de inserción de I-Picture como un periodo de tiempo.
[Frame]: define el intervalo de inserción de I-Picture como un número de fotogramas.
[I-Picture Interval 1], [I-Picture Interval 2]
Permite definir el intervalo de inserción de I-Picture en unidades de segundos. Permite definir un valor en el intervalo de
1 a 5. El valor predeterminado es 1 segundo.
No se puede definir para [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Establece el intervalo de inserción de I-Picture para H.264 y H.265 como un número de fotogramas en un rango de 15 a
300. El valor predeterminado es de 300 fotogramas.
No se puede definir para [Codec 3].
[Profile 1], [Profile 2]
Permite definir el perfil de códec de imagen H.264 o H.265.
[H.264]: seleccione el perfil [high], [main] o [baseline].
[H.265]: seleccione el perfil [main] o [main10]. Cuando hay dos códecs de vídeo habilitados, solo la opción de selección
del perfil [main] está disponible.
La eficacia de la compresión de la imagen va de menos a más en el siguiente orden: [high], [main] y [baseline].
Seleccione un perfil admitido por su sistema.
Cuando [H.265] se define como [main10], el funcionamiento se encuentra en [main10] si la salida de HDMI es YCrCb, o
en [main] si la salida de HDMI es RGB.
No se puede definir para [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Seleccione [CBR] o [VBR].
Para mantener una velocidad de bits constante, seleccione [CBR]. Para mantener la calidad de la imagen, seleccione
[VBR].
No se puede definir para [Codec 3].

Nota

La velocidad de fotogramas y de bits que se transmiten realmente puede ser distinta de los valores definidos, dependiendo del
tamaño de la imagen, la escena de filmación, el entorno de red y otros factores.

Cuando [Stream] > [Stream Setting] > [Setting]se establece en [RTMP], [SRT-Caller] o [SRT-Listener], [Bit Rate Compression
Mode 1] se establece en [CBR] (fijo).

[Bit Rate 1], [Bit Rate 2]
Permite definir el valor objetivo de la velocidad de bits cuando [Bit Rate Compression Mode] está definido como [CBR].
Definir una velocidad de bits alta le permite transmitir vídeos de alta calidad de imagen.
No se puede definir para [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Define la calidad de imagen entre 1 y 10. La máxima calidad de la imagen es la que ofrece el valor 10. El valor
predeterminado es 6.
Para [Quality 1] y [Quality 2], puede definir la calidad de H.264 estableciendo [Bit Rate Compression Mode] en [VBR] y
[Codec] en [H.264]. Puede definir la calidad de imagen H.265 estableciendo [Bit Rate Compression Mode] en [VBR] y
[Codec] en [H.265].
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Configuración del códec de audio para la transmisión

Defina el códec de audio mediante [Stream] > [Audio Stream] en el menú web.
[Setting]
Para habilitar la transmisión de audio, debe definirse en On.

Nota

Para seleccionar RTMP, establezca siempre de antemano en On .

[Codec]
Selecciona el tipo de códec que se utilizará para la transmisión de audio.
[AAC (256kbps)]: seleccione esta opción para priorizar la calidad del sonido.
[AAC (128kbps)]: seleccione esta opción para priorizar la capacidad de los datos.
Este ajuste no afecta al clip grabado por la unidad o la señal de audio incrustada en la señal HDMI/SDI.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Iniciar/detener transmisión

Para [RTSP], [SRT-Listener] y [NDI|HX]

La unidad espera una solicitud de entrega de transmisión.
Inicie una aplicación de cliente para visualizar la transmisión y acceda a la URL que se muestra en la siguiente tabla.
Introduzca los valores de usuario y contraseña configurados en la unidad.

<camera_address>: dirección IP de la unidad
<Port>: puerto de agente de escucha configurado mediante [Port Number]

Nota

La reproducción en todas las aplicaciones o dispositivos no está garantizada.

Para [RTMP] y [SRT-Caller]

Pulse el botón [Stream now] de la pestaña  (Stream) de la pantalla de funcionamiento en directo para iniciar la
transmisión. El botón cambiará a [Stop stream] y el icono [Stream] se muestra en la parte superior del panel de imagen
de la cámara.
Pulse el botón [Stop stream] durante la transmisión para detenerla. El botón cambiará de nuevo a [Stream now] y el
icono [Stream] de la parte superior del panel de imagen de la cámara desaparece.

Nota

La reproducción en todas las aplicaciones o dispositivos no está garantizada.

5-041-957-43(1) Copyright 2022 Sony Corporation

Formato de
transmisión URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX
Consulte las instrucciones de funcionamiento del dispositivo de cliente compatible de
NDI|HX.
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Pantalla de imágenes en miniatura

Cuando pulsa el botón [Thumbnail] en la pantalla de operación de reproducción o el botón THUMBNAIL del control
remoto infrarrojo, los clips grabados en la tarjeta de memoria se muestran en el panel de imagen de la cámara. Esto se
denomina pantalla de imágenes en miniatura.
Puede seleccionar un clip en la pantalla de imágenes en miniatura e iniciar la reproducción de dicho clip.
Si pulsa el botón [Thumbnail] mientras está visualizando la pantalla de imágenes en miniatura, se cerrará la pantalla de
imágenes en miniatura y volverá a la imagen de la filmación.

Nota

Solo los clips grabados con el formato de grabación seleccionado actualmente se mostrarán en la pantalla de imágenes en
miniatura. Si un clip grabado esperado no se muestra, compruebe el formato de grabación. Tenga en cuenta esto antes de
formatear (inicializar) soportes.

Diseño de la pantalla

Se muestra la miniatura de un clip seleccionado con un fondo naranja.
La información del clip seleccionado se muestra en la parte inferior de la pantalla.
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Tarjeta de memoria seleccionada
Si la tarjeta de memoria está protegida contra escritura, aparece un icono de un candado.

1.

Número del clip/número total de clips2.

Miniaturas (imágenes índice)
Muestra la imagen índice de un clip. Cuando se graba un clip, su primer fotograma se ajusta automáticamente como
imagen índice.
La información del clip/fotograma se muestra debajo de la imagen en miniatura. Puede cambiar la información que
se muestra con [Thumbnail] > [Customize View] > [Thumbnail Caption] en el menú de la cámara.

3.

Nombre del clip
Muestra el nombre del clip seleccionado.

4.

Formato de grabación
Muestra el formato de archivo del clip seleccionado.

5.

Información del modo de grabación especial
Muestra el modo de grabación solo si el clip se grabó con un modo especial de grabación.
En clips con Slow & Quick Motion, la velocidad de fotogramas se muestra a la derecha.

6.

Duración del clip7.

Fecha de creación8.
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Reproducción de clips grabados

Puede reproducir clips grabados cuando la unidad esté en modo de espera (Stby).
En este tema se describe cómo reproducir clips grabados mediante el panel de control de GUI.

Inserte la tarjeta de memoria que desea reproducir.1

Pulse el botón [Thumbnail].

Aparecerán los iconos en miniatura de los clips.

2

Utilice los botones de flechas del panel de control de GUI para mover el cursor a la miniatura del clip que
desea reproducir.

3
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Nota

Pueden existir roturas momentáneas de imagen o visualizarse imágenes fijas en el cambio de un clip a otro. Durante este
periodo no podrá utilizar la unidad.

Nota

Los clips no pueden seleccionarse mediante el funcionamiento táctil.

Pulse el botón [Set] del bloque de control de GUI.

La reproducción comienza desde el principio del clip seleccionado.

4

Utilice el panel de control de reproducción según sea necesario.

Sugerencia

También puede controlar el funcionamiento mediante el panel de control de GUI.

Reproducir: pulse el botón [Set].
Pausa de reproducción: pulse el botón [Set] durante la reproducción. Pulse de nuevo para volver a la reproducción
normal.
Saltar al inicio del clip/saltar al siguiente clip: pulse el botón izquierdo/derecho.
Rebobinado/avance rápido: mantenga pulsados los botones izquierda/derecha. La reproducción volverá a la velocidad
normal cuando se suelte el botón.
Detener reproducción: pulse el botón [Cancel/Back].

5

Botón Función

Botón  (reproducir/pausar) Reproduce un clip. Durante la reproducción, pausa el clip.

Botón  (avance rápido), botón 
(rebobinado rápido)

Reproduce un clip a alta velocidad. Cuando se pulsa este botón, la
velocidad de reproducción cambia en tres pasos.

Botón  (anterior), botón 
(siguiente)

Salta al inicio del clip o al clip anterior/siguiente.

Botón  (detener) Detiene la reproducción y cambia a la pantalla de filmación.
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Cuando selecciona un clip en la pantalla de imágenes en miniatura y comienza la reproducción, pueden existir distorsiones
momentáneas de imagen al principio del clip. Para ver el inicio del clip sin distorsiones, pause la reproducción, pulse el botón

 (anterior) para volver al inicio del clip e inicie de nuevo la reproducción.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Operaciones en clips grabados

En la pantalla de imágenes en miniatura, puede utilizar los clips o comprobar sus propiedades a través del menú
[Thumbnail] del menú de cámara.
Pulse el botón [Menu] de la pantalla de operación de reproducción para mostrar el menú de la cámara en el panel de
imagen de la cámara.
Puede llevar a cabo las siguientes operaciones a través del menú [Thumbnail] del menú de cámara.
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Sugerencia

También puede pulsar el botón [Menu] de la pantalla de funcionamiento en directo para mostrar el menú de la cámara.

Operaciones del menú [Thumbnail] del menú de cámara
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Seleccione la función que desee activar mediante los botones de flecha del panel de control de GUI y pulse el botón
[Set].
Pulse el botón [Cancel/Back] para volver a la pantalla anterior.

Nota

Algunos elementos no pueden seleccionarse, dependiendo del estado, cuando se visualiza el menú.

Elementos de menú para operaciones en clips

El menú [Thumbnail] del menú de cámara tiene los siguientes elementos de menú relacionados con las operaciones en
clips.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Para obtener más información sobre cada elemento de menú, consulte “Menú [Thumbnail]”.

Para mostrar la pantalla de propiedades del clip
Seleccione [Thumbnail] > [Display Clip Properties] en el menú de la cámara para mostrar la pantalla de propiedades del
clip.
Pulse el botón  (anterior) o  (siguiente) para saltar al clip anterior o al clip siguiente, respectivamente.

Para añadir marcas de clip
Puede añadir marcas de clip (marcas OK, NG o KP) en los clips para filtrar la visualización de estos según las marcas
de clip.
Seleccione la imagen en miniatura del clip al que desea añadir una marca de clip y, a continuación, seleccione la marca
de clip mediante [Thumbnail] > [Set Clip Flag] en el menú de la cámara.

Sugerencia

También puede utilizar un botón asignable asignado con la función de marcas de clip para añadir marcas de clip.

Para mostrar la pantalla de imágenes en miniatura de clips filtrados
Seleccione [Thumbnail] > [Filter Clips] en el menú de la cámara y, después, seleccione un tipo de marca de clip para
mostrar solo aquellos clips que tengan la marca especificada.
Para mostrar todos los clips, seleccione [All].
También puede pulsar el botón [Display] para organizar la pantalla de vistas en miniatura por marca.

Para eliminar clips
Puede eliminar clips de tarjetas de memoria.
Seleccione [Thumbnail] > [Delete Clip] > [Select Clip] o [All Clips] en el menú de la cámara.
[Select Clip]: elimina el clip seleccionado. Compatible con la selección de varios clips.

Ajuste Marca de clip añadida

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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[All Clips]: elimina todos los clips mostrados.

Para cambiar la información que se muestra en la pantalla de imágenes en miniatura
Puede cambiar la información de fotogramas/clips que se muestra debajo de la imagen en miniatura.
Seleccione [Thumbnail] > [Customize View] > [Thumbnail Caption] en el menú de la cámara y seleccione la información
que desea que se muestre.
[Date Time]: muestra la fecha y la hora de creación del clip y de su última modificación.
[Time Code]: muestra el código de tiempo.
[Duration]: muestra la duración del clip.
[Sequential Number]: muestra el número secuencial de cada imagen en miniatura.
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Configuración del menú de cámara

Cuando se pulsa el botón [Menu] del panel de control de GUI o el botón MENU del control remoto infrarrojo, el menú de
cámara para configurar los ajustes necesarios para filmar y reproducir se muestran en el panel de imagen de la cámara.

El menú incluye los siguientes menús.

Configuración del menú

Menú [User]
Contiene elementos del menú configurados por el usuario.
Puede editarse en [Edit User Menu].
Menú [Edit User]
Contiene elementos del menú para editar el menú [User].
Menú [Shooting]
Contiene ajustes relacionados con la filmación.
Menú [Project]
Contiene ajustes básicos del proyecto.
Menú [Paint/Look]
Contiene ajustes relacionados con la calidad de la imagen.
Menú [Pan-Tilt]
Contiene ajustes relacionados con las funciones de giro/inclinación.
Menú [TC/Media]
Contiene ajustes relacionados con códigos de tiempo y soportes de grabación.
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Menú [Monitoring]
Contiene ajustes relacionados con la salida de vídeo y la visualización de pantalla.
Menú [Audio]
Contiene ajustes relacionados con el audio.
Menú [Thumbnail]
Contiene ajustes relacionados con la pantalla de imágenes en miniatura.
Menú [Technical]
Contiene ajustes para elementos técnicos.
Menú [Network]
Contiene ajustes relacionados con las redes.
Menú [Maintenance]
Contiene ajustes de dispositivos, como el reloj y el idioma.

Configuración y jerarquía del menú de cámara

Nivel 1 Nivel 2

User
(Ajustes de fábrica)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Nivel 1 Nivel 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Nivel 1 Nivel 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Nivel 1 Nivel 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Funcionamiento del menú de la cámara

Cuando se pulsa el botón [Menu] del panel de control de GUI o el botón MENU del control remoto infrarrojo, el menú de
cámara para configurar los ajustes necesarios para filmar y reproducir se muestran en el panel de imagen de la cámara.
El menú se controla a través de los botones del panel de control de la GUI.

Botón [Menu]: púlselo para mostrar el menú de la cámara. Púlselo de nuevo mientras se muestra el menú de la cámara
completo para ocultarlo.
Botones de flecha: púlselos para mover el cursor hacia arriba, hacia abajo, hacia la derecha y hacia la izquierda en el
menú de la cámara y seleccionar elementos o ajustes.
Botón [Set]: púlselo para aplicar el elemento seleccionado.
Botón [Cancel/Back]: púlselo para volver al menú anterior. Los cambios sin finalizar se cancelan.

Nota

Algunos elementos no pueden seleccionarse, dependiendo del estado, cuando se visualiza el menú.

Elementos del menú de configuración

Mueva el cursor hasta el elemento que desee definir mediante los botones de flecha del panel de control de GUI y pulse
el botón [Set] para aplicar la configuración.

El área de selección de elementos del menú muestra hasta ocho líneas. Si las opciones disponibles para un
elemento no se pueden mostrar al mismo tiempo, desplácese por la pantalla moviendo el cursor hacia arriba/abajo.
En el caso de los subelementos con una amplia gama de opciones (por ejemplo, de −99 a +99), el área de
configuración no se visualiza. El ajuste actual se resalta para indicar que el valor se puede cambiar.
Si selecciona [Execute] para una función, la función correspondiente se ejecutará.
Si selecciona un elemento que requiere confirmación antes de su ejecución, el menú se ocultará temporalmente y se
mostrará un mensaje de confirmación. Compruebe el mensaje y a continuación selecciones si desea ejecutar o
cancelar la función.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Introducción de una cadena de caracteres

Cuando selecciona un elemento, como por ejemplo un nombre de archivo, que requiere la introducción de caracteres,
aparecerá la pantalla para introducir caracteres.

5-041-957-43(1) Copyright 2022 Sony Corporation

Pulse los botones de flecha del panel de control de GUI para seleccionar el tipo de carácter y aplicar el
ajuste.

[ABC]: caracteres alfabéticos en mayúsculas
[abc]: caracteres alfabéticos en minúsculas
[123]: caracteres numéricos
[!#$]: caracteres especiales

1

Seleccione un carácter y pulse el botón [Set] para aplicar la configuración.

El cursor pasa al campo siguiente.
[Space]: introduce un carácter de espacio en la posición del cursor.
[←] [→]: mueve la posición del cursor.
[BS]: elimina el carácter a la izquierda del cursor (retroceso).

2

Seleccione un carácter y pulse el botón [Done] para aplicar la configuración.

La cadena de caracteres se confirma y la pantalla de introducción de caracteres desaparece.

3
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User

En esta sección se describe la función y los ajustes de cada elemento de menú.

Nota

Puede agregar y eliminar elementos de menú en el menú [User] utilizando el menú [Edit User]. Se pueden configurar hasta 20
elementos.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Descripción

Base Setting Elemento Project > Base Setting

Focus Elemento Shooting > Focus

S&Q Motion Elemento Shooting > S&Q Motion

LUT On/Off Elemento Shooting > LUT On/Off

Simul Rec Elemento Project > Simul Rec

Proxy Rec Elemento Project > Proxy Rec

Interval Rec Elemento Project > Interval Rec

Picture Cache Rec Elemento Project > Picture Cache Rec

Assignable Button Elemento Project > Assignable Button

Scene File Elemento Project > Scene File

Base Look Elemento Paint/Look > Base Look

P/T Acceleration Elemento Pan-Tilt > P/T Acceleration

Clip Name Format Elemento TC/Media > Clip Name Format

Format Media Elemento TC/Media > Format Media

Video Signal Monitor Elemento Monitoring > Video Signal Monitor

Marker Elemento Monitoring > Marker

Zoom Elemento Technical > Zoom

Lens Elemento Technical > Lens

Edit User Menu Muestra el menú Edit User.
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Edit User

El menú [Edit User] se muestra en el nivel superior cuando se selecciona [Edit User Menu] en el menú [User].
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Add Item
Adición de un elemento al
menú [User]

– –
Agrega un elemento de menú de nivel 2
al menú [User].

Customize Reset
Restablecimiento de los
elementos en el menú [User]

– –
Restaura los elementos del menú
registrados en el menú [User] de manera
predeterminada de fábrica.

Elemento de menú de nivel 2
seleccionado durante la
edición

Delete –
Elimina el elemento de menú de nivel 2
registrado del menú [User].

Move –
Reordena los elementos de menú
registrados dentro del menú [User].

Edit Sub Item –
Edita (registra/elimina) el subelemento
de menú de nivel 3 registrado en el
menú [User].
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ISO/Gain/EI

Configura los ajustes de ganancia.

Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Mode ISO/dB dB
Selecciona el modo de
ajuste de ganancia.

ISO/Gain<L>

Para obtener más detalles acerca de
los ajustes, consulte “Ajustes
ISO/Gain y valores predeterminados”.

–
Ajusta el valor
predeterminado de
ganancia <L>.

Exposure
Index<L>

Cuando Base ISO está definido en ISO
800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Cuando Base ISO está definido en ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Cuando Base ISO se
define como ISO 800:
800EI / 6.0E
Cuando Base ISO se
define como ISO 12800:
12800EI / 6.0E

Define el valor de
Exposure Index<L>.

Shockless
Gain

On / Off Off
Activa y desactiva la
función de ganancia sin
vibraciones.

Base
Sensitivity

High / Low Low Ajusta la sensibilidad base
del modo Custom.
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Tema relacionado

Ajustes y valores predeterminados de ISO/Gain
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Base ISO ISO 12800 / ISO 800 ISO 800
Ajusta la sensibilidad ISO
base para el modo Cine
EI/Flexible ISO.
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ND Filter

Ajuste los valores predeterminados del filtro ND.
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Mode Preset / Variable Variable
Permite seleccionar el modo de filtro
ND.

Preset1
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/4
Ajusta el valor predeterminado 1 del
filtro ND.

Preset2
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/16
Ajusta el valor predeterminado 2 del
filtro ND.

Preset3
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/64
Ajusta el valor predeterminado 3 del
filtro ND.
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Shutter

Ajusta el funcionamiento del obturador electrónico.
Se utiliza para filmar con claridad sujetos que se mueven rápidamente.

Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

Mode Speed / Angle Speed

Selecciona el modo para definir la
velocidad del obturador en
segundos (Speed) o como un
ángulo de este (Angle).

Shutter
Speed
On/Off

On / Off Off

Establece si el tiempo de
exposición cuando se selecciona
el modo Speed sigue el valor de
[Shutter Speed] o se establece
para exposición completa.

Shutter
Speed

De 64F a 1/8000
Los ajustes disponibles dependen de la
frecuencia de fotogramas del formato de
vídeo seleccionado.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F
/ 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125
/ 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F
/ 3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 /
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P: 1/24

Ajusta la velocidad del obturador
cuando Speed está seleccionado.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 360.0° / 300.0° / 270.0° / 240.0° /
216.0° / 210.0° / 180.0° / 172.8° / 150.0° /
144.0° / 120.0° / 90.0° / 86.4° / 72.0° / 45.0°
/ 30.0° / 22.5° / 11.25° / 5.6°

180.0°
Ajusta el ángulo del obturador
cuando Angle está seleccionado.
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Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

ECS On/Off On / Off Off
Activa y desactiva la función
Extended Clear Scan.

ECS
Frequency

23.99 a 8000
Los ajustes disponibles dependen de la
frecuencia del sistema del formato de
grabación seleccionado.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Ajusta la frecuencia ECS cuando
Mode está ajustado en ECS.
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Iris

Configura los ajustes de diafragma.
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Bokeh
Control

On / Off Off
Permite activar/desactivar la función de
control del bokeh.
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Auto Exposure

Configura los ajustes de la exposición automática.

Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75
/ +1.5 / +1.25 / +1.0 / +0.75 / +0.5 /
+0.25 / ±0 / −0.25 / −0.5 / −0.75 / −1.0 /
−1.25 / −1.5 / −1.75 / −2.0 / −2.25 / −2.5
/ −2.75 / −3.0

±0
Establece el nivel de brillo para la
exposición detectada
automáticamente.

Mode Backlight / Standard / Spotlight Standard

Establece el modo de funcionamiento
del ajuste de exposición automática.
Backlight: modo de retroiluminación
(modo para reducir el oscurecimiento
de un sujeto cuando dicho sujeto está
retroiluminado)
Standard: modo estándar
Spotlight: modo de luz direccional
(modo para reducir la sobreexposición
de blancos cuando el sujeto recibe
una iluminación direccional)

Speed De −99 a +99 ±0
Establece la velocidad de ajuste del
ajuste de exposición automática.

AGC On / Off Off
Activa y desactiva la función AGC
(Control automático de ganancia).

AGC Limit

Para obtener más detalles acerca de
los ajustes, consulte “Ajustes AGC
Limit y valores predeterminados”.

–
Ajusta la ganancia máxima de la
función AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Establece el valor F-stop de los iris si
la operación AGC empieza cuando la
función AGC está ajustada en On.

Auto
Shutter

On / Off Off
Activa y desactiva la función de
control del obturador automático.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Ajusta la velocidad más rápida del
obturador en la función de obturador
automático.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Establece el valor F-stop de los iris si
se inicia la operación de obturación
automática.
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Ajustes y valores predeterminados de AGC Limit
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Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

Clip High
light

On / Off Off

Activa y desactiva la función que
ignora las zonas más iluminadas para
proporcionar una respuesta menor a
la luminosidad alta.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Ajusta el rango del medidor de luz
para ajustar automáticamente la
exposición de acuerdo con la
luminosidad del sujeto. (No disponible
cuando se ajusta la exposición
manualmente)

Detect
Window
Indication

On / Off Off
Activa/desactiva la indicación del
rango del medidor de luz.

Custom
Width

De 40 a 999 500 Establece el ancho del rango del
medidor de luz.

Custom
Height

De 70 a 999 500
Establece la altura del rango del
medidor de luz.

Custom H
Position

De −479 a +479 ±0
Ajusta la posición horizontal del rango
del medidor de luz.

Custom V
Position

De −464 a +464 ±0
Ajusta la posición vertical del rango
del medidor de luz.
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White

Configura los ajustes del balance de blancos.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Preset
White

De 2000K a
15000K

3200K Ajusta el valor predeterminado del balance de blancos.

Color Temp
<A>

De 2000K a
15000K

3200K

Establece la temperatura de color del balance de blancos
que está guardada en la memoria A.

Nota

Dado que Color Temp se recorta a 2000K y 15000K
durante la operación R Gain/B Gain, es posible que no se
pueda mostrar el valor correcto de Color Temp para el
valor R Gain/B Gain.

Tint<A> De −99 a +99 ±0

Establece el valor de matiz del balance de blancos
guardado en la memoria blanca A.

Nota

Dado que Tint se recorta a ±99 durante la operación R
Gain/B Gain, es posible que no se pueda mostrar el valor
correcto de matiz para el valor R Gain/B Gain.

R Gain <A> De −99.0 a +99.0 ±0.0
Ajusta la ganancia R del balance de blancos que está
guardada en la memoria A.

B Gain <A> De −99.0 a +99.0 ±0.0
Ajusta la ganancia B del balance de blancos que está
guardada en la memoria A.
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White Setting

Ajusta los ajustes del balance de blancos.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Shockless
White

Off / 1 / 2 / 3 2

Ajusta la velocidad de respuesta del balance de
blancos cuando se cambia el modo de balance de
blancos.
Off: cambia instantáneamente.
De 1 a 3: cambia más lentamente cuanto mayor es el
número.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Ajusta la velocidad de respuesta en el modo ATW.
La máxima velocidad de respuesta es el 1, la mínima
es 5.
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Offset White

Configura los ajustes de desviación del balance de blancos.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Offset White
<A>

On / Off Off
Selecciona si se debe (On) o no se debe (Off) añadir
un valor de desviación al balance de blancos
especificado en la memoria A.

Offset Color
Temp<A> De −99 a +99 ±0

Ajusta la desviación de la temperatura de color que
se añadirá al balance de blancos en la memoria A
cuando [Offset White <A>] está ajustado en On.

Offset Tint<A> De −99 a +99 ±0
Ajusta la desviación del valor de Tint que se añadirá
al balance de blancos en la memoria A cuando
[Offset White <A>] está ajustado en On.

Offset
White<ATW>

On / Off On
Selecciona si se debe (On) o no se debe (Off) añadir
un valor de desviación al balance de blancos ATW.

Offset Color
Temp<ATW> De −99 a +99 ±0

Ajusta la desviación de la temperatura de color que
se añadirá al balance de blancos ATW cuando [Offset
White<ATW>] está ajustado en On.

Offset
Tint<ATW>

De −99 a +99 ±0
Ajusta la desviación del valor de Tint que se añadirá
al balance de blancos ATW cuando [Offset
White<ATW>] está ajustado en On.
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Focus

Configura los ajustes de enfoque.

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 / 5
/ 6 / 7(Fast)

5
Establece la velocidad del enfoque para cuando el sujeto
cambia durante el enfoque automático.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3
/ 4 / 5(Responsive)

5(Responsive)
Establece la sensibilidad para cambiar el enfoque del
sujeto durante el enfoque automático.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Establece el área de destino para la función Auto Focus
y Push Auto Focus (AF).

Consulte “Ajuste automático del enfoque (Auto
Focus)” y “Especificación de la posición/área de
enfoque automático (Focus Area)”.

Wide: busca un sujeto en un ángulo amplio de la imagen
al enfocar.
Zone: busca automáticamente un punto de enfoque
dentro de la zona especificada.
Flexible Spot: enfoca una posición especificada en la
imagen.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Establece el área de destino para la función Push Auto
Focus (AF-S).

Face/Eye
Detection
AF

Face/Eye Only AF /
Face/Eye Priority
AF / Off

Face/Eye Priority AF

Activa y desactiva el AF de detección de caras.

Consulte “Seguimiento usando detección de caras y
ojos (Face/Eye Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Ajusta el modo Push Auto Focus.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Establece la operación cuando se toca la imagen de la
cámara en la pantalla de operación en vivo de la
aplicación web en modo MF.

AF Assist On / Off On

Cuando está ajustado en On, le permite anular
temporalmente el enfoque automático para ajustar el
enfoque manualmente.

Consulte “Ajuste del objetivo de enfoque
manualmente (AF Assist) mediante la Aplicación
Web” y “Enfoque manual durante el enfoque
automático mediante el control remoto infrarrojo
proporcionado”.
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Tema relacionado
Especificación de la posición/área de enfoque automático (Focus Area)

Seguimiento usando detección de caras y ojos (Face/Eye Detection AF)

Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación Web

Enfoque manual durante el enfoque automático mediante el control remoto infrarrojo proporcionado

5-041-957-43(1) Copyright 2022 Sony Corporation
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S&Q Motion

Permite definir los ajustes del modo Slow & Quick Motion (consulte “Movimiento a cámara lenta y rápida”).

Tema relacionado

Movimiento a cámara lenta y rápida
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Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Setting On / Off Off
Activa y desactiva el modo Slow & Quick
Motion.

Frame
Rate

De 1fps a 60fps / 100fps /
120fps / 150fps / 180fps /
200fps / 240fps

–

Ajusta la velocidad de fotogramas para la
filmación con el modo Slow & Quick Motion.

Nota

Los ajustes disponibles dependen de la
frecuencia del sistema, el códec y el
formato de vídeo seleccionados.
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LUT On/Off

Configura los ajustes de LUT.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

SDI MLUT On / MLUT Off MLUT Off
Selecciona si se va a aplicar la LUT de
monitor al vídeo de las salidas SDI.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Selecciona si se va a aplicar la LUT de
monitor al vídeo de salida de transmisión y
HDMI.

Proxy MLUT On / MLUT Off MLUT Off Selecciona si se va a aplicar la LUT de
monitor al vídeo de grabación proxy.

Internal Rec MLUT On / MLUT Off MLUT Off
Selecciona si se va a aplicar la LUT de
monitor al vídeo de grabación principal.

LUT On/Off
Button Target

SDI / HDMI/Stream / SDI
& HDMI/Stream

HDMI/Stream
Defina la salida de objetivo controlada por
un botón asignable asignado con LUT
On/Off.
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Noise Suppression

Configura los ajustes de supresión de ruido.

Sugerencia

Los ajustes [Setting(Custom)] y [Level(Custom)] se reflejan en el ajuste [Target Display].
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Setting(Custom) On / Off On
Activa y desactiva la función de supresión
de ruido en el modo Custom.

Level(Custom) Low / Mid / High Mid
Ajusta el nivel de supresión de ruido en el
modo Custom.

Setting (Cine
EI/Flex. ISO)

On / Off Off
Activa y desactiva la función de supresión
de ruido en el modo de filmación Log.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Ajusta el nivel de supresión de ruido en el
modo de filmación Log.
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Flicker Reduce

Configura los ajustes de corrección de parpadeo.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Mode Auto / On / Off Off Ajusta el modo de corrección de parpadeo.

Frequency 50Hz / 60Hz 60Hz
Ajusta la frecuencia de la fuente de alimentación que
proporciona la iluminación causante del parpadeo.
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SteadyShot

Configura los ajustes de estabilización de la imagen.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Setting
Active / Standard /
Off

Off

Configura la función de estabilización de la imagen.

Nota

Habilitado cuando se acopla un objetivo compatible.

Si se ajusta en Active o Standard, es posible que se
produzca un comportamiento inesperado durante la
operación de giro/inclinación.
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Base Setting

Configura los ajustes básicos.

Tema relacionado

Configuración del funcionamiento básico
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Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

Shooting
Mode

Custom / Flexible ISO /
Cine EI Quick / Cine EI

Custom

Permite ajustar el modo de filmación.

Consulte “Ajuste del modo de filmación” en
“Configuración del funcionamiento básico”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Ajusta la gama de colores de la
grabación/salida en el modo Custom.
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Rec Format

Configura los ajustes del formato de grabación.

Ajustes [RAW Output Format]

Los valores predeterminados se muestran en negrita.

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94 Selecciona la frecuencia del sistema.

Imager
Scan Mode

FF / S35 FF Selecciona el tamaño de la cámara.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Ajusta el códec de grabación/reproducción
del clip.

Nota

Cuando [Imager Scan Mode] se define
como [S35], [RAW] y [RAW & XAVC-I] no
se pueden seleccionar.

RAW Output
Format

Los ajustes disponibles varían
según el ajuste de [Frequency].

Consulte “Ajustes de [RAW
Output Format]” a
continuación.

–

Define el tamaño de la imagen RAW para
emitirla en una grabadora RAW externa.

Nota

Cuando [Codec] está ajustado en [RAW &
XAVC-I], el ajuste [Video Format] cambia
en la vinculación con el ajuste [RAW
Output Format].

Video
Format

Los ajustes disponibles varían
según los ajustes de
[Frequency], [Imager Scan
Mode] y [Codec].

Consulte “Ajustes de [Video
Format]” a continuación.

–
Ajusta el tamaño de imagen y la velocidad
de bits.

Frequency Imager Scan Mode Codec Ajuste

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Las condiciones en las que [RAW Output Format] no puede establecerse se han omitido.

Ajustes [Video Format]

Los valores predeterminados se muestran en negrita.

5-041-957-43(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Ajuste

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Establece los ajustes del modo de filmación Log (consulte “Ajuste del modo de filmación” en “Configuración del
funcionamiento básico”).

Tema relacionado

Configuración del funcionamiento básico
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Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Establece la gama de colores para los modos
de disparo de registro ([Flexible ISO], [Cine
EI Quick], [Cine EI]).

Embed LUT
File

On / Off On
Activa o desactiva la grabación de metadatos
de archivos LUT 3D (archivo CUBE).
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Simul Rec

Permite definir los ajustes de modo de grabación en 2 ranuras simultáneamente (consulte “Grabación en la tarjetas de
memoria A y B simultáneamente (2-slot Simul Rec)”).
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Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

Setting On / Off Off
Activa/desactiva el modo de
grabación simultánea en 2
ranuras.

Rec
Button Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:
<Slot A> 2nd Rec Button:<Slot B> / Rec
Button:<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A> <Slot
B> 2nd Rec Button:<Slot
A> <Slot B>

Asigna los botones de
grabación utilizados para
controlar cada soporte de
grabación.
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Proxy Rec

Ajusta el modo de grabación de proxy (consulte “Grabación de proxy”).
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Setting On / Off Off
Activa y desactiva el modo de grabación de
proxy.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Selecciona el canal de audio en el que se
grabarán los datos de proxy.
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Interval Rec

Ajusta el modo de grabación de intervalos (consulte “Grabación de vídeo de manera intermitente (Interval Rec)”).
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Setting On / Off Off

Activa y desactiva el modo de
grabación de intervalo. (Si se
ajusta este modo en On, el resto
de modos especiales se ajustará
en Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

1

Ajusta el intervalo entre
grabaciones en el modo de
grabación Interval Rec (cuando
Interval Rec está ajustado en On).

Number of
Frames

1frame / 2frames / 3frames / 6frames
/ 9frames / 12frames
Los ajustes disponibles dependen de
la frecuencia de fotogramas del
formato de vídeo seleccionado.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Ajusta el número de fotogramas
que se desea grabar por toma en
el modo de grabación Interval Rec
(cuando Interval Rec está ajustado
en On).
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Picture Cache Rec

Permite definir la configuración del modo de grabación de la caché de imágenes (consulte “Grabación de imágenes en
memoria intermedia (Picture Cache Rec)”).

Tema relacionado

Grabación de imágenes en memoria intermedia (Picture Cache Rec)
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Setting On / Off Off
Permite activar/desactivar la función de caché de
imagen.

Cache Size
Short / Medium /
Long / Max Max

Ajusta la hora de acumulación de las imágenes en la
memoria intermedia de imágenes (hora de grabación de
memoria intermedia de imágenes).

Cache Rec
Time

– –
Muestra la hora de acumulación de las imágenes en la
memoria intermedia de imágenes (hora de grabación de
memoria intermedia de imágenes).
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SDI/HDMI Rec Control

Configura los ajustes de control de grabación SDI/HDMI.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Establece el control de inicio/parada de grabación de un
dispositivo externo conectado mediante la señal de salida
SDI/HDMI.
Off: no se usa el control remoto.
SDI/HDMI Remote I/F: control de detención/inicio de
grabación de un dispositivo externo conectado, cuando no
hay ningún soporte insertado en la unidad. No se ha
sincronizado con la precisión de fotogramas para el soporte
de la unidad.
Parallel Rec: control de detención/inicio de grabación de un
dispositivo externo conectado, cuando hay un soporte
insertado en la unidad. Sincronizado con la precisión de
fotogramas para el soporte de la unidad.

Nota

Para el control con la señal de salida HDMI, establezca
[TC/Media] > [HDMI TC Out] > [Setting] en [On] en el menú
de la cámara.
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Assignable Button

Permite definir asignaciones de funciones a botones asignables (del <1> al <9>) y a [Focus Hold Button].
Es posible asignar las siguientes funciones.
[Off]: sin función de asignación.
[Base ISO/Sensitivity]: cambia la sensibilidad base del sensor de imagen.
[AGC]: activa y desactiva la función AGC.
[Push AGC]: habilita la función AGC mientras se mantiene pulsado el botón.
[ND Filter]

En modo variable: ajusta la transmisión del filtro ND. Manténgalo pulsado para cambiar entre Clear/Manual/Auto.
En modo predefinido: manténgalo pulsado para cambiar entre los distintos ajustes predefinidos.

[ND Filter Position]: cambia los filtros ND.
[Auto ND Filter]: activa y desactiva la función de filtro ND.
[Push Auto ND]: habilita la función de filtro ND automático mientras se mantiene pulsado el botón.
[Auto Iris]: activa y desactiva la función del diafragma.
[Push Auto Iris]: activa la función de diafragma automático mientras se mantiene pulsado el botón.
[Bokeh Control]: activa y desactiva la función de control del bokeh.
[Auto Shutter]: activa y desactiva la función del obturador automático.
[AE Level/Mode]: ajusta el nivel de AE. Manténgalo pulsado para cambiar el modo AE.
[Backlight]: cambia entre Backlight y Standard.
[Spotlight]: cambia entre Spotlight y Standard.
[Preset White Select]: cambia el valor del modo predeterminado del balance de blancos.
[ATW]: activa y desactiva la función ATW.
[ATW Hold]: pone en pausa el funcionamiento de la función ATW.
[AF Speed/Sens.]: cambia el ajuste de la velocidad de transición AF y el ajuste de la sensibilidad de desplazamiento del
sujeto AF.
[Focus Setting]: permite definir el área de enfoque.
[Face/Eye Detection AF]: cambia la configuración de AF de detección de caras.
[Push AF Mode]: cambia la configuración del modo Push AF.
[Push AF/MF]: en el modo de enfoque MF, activa AF mientras se presiona el botón. En el modo de enfoque AF, activa
MF mientras se presiona el botón.
[Focus Hold]: en el modo de enfoque AF, el enfoque se fija mientras se presiona el botón.
[S&Q Motion]: activa y desactiva el modo Slow & Quick Motion. Permite establecer la velocidad de fotogramas de
filmación si se mantiene pulsado.
[LUT On/Off]: activa y desactiva la función LUT. El objetivo de cambio se define en [Shooting] > [LUT On/Off] > [LUT
On/Off Button Target].
[SteadyShot]: cambia entre Active, Standard y Off.
[Crop Select]: cambia Imager Scan Mode. Permite cambiar dentro del rango sin modificar el formato de grabación.
[Rec]: iniciar/detener grabación.
[Picture Cache Rec]: activa y desactiva el modo de grabación de memoria intermedia.
[Rec Review]: activa y desactiva la función de revisión de la grabación.
[Clip Flag OK]: ejecuta Add OK. Pulse dos veces para ejecutar Delete Clip Flag.
[Clip Flag NG]: ejecuta Add NG. Pulse dos veces para ejecutar Delete Clip Flag.
[Clip Flag Keep]: ejecuta Add KEEP. Pulse dos veces para ejecutar Delete Clip Flag.
[Slot Select]: cambia entre las ranuras de memoria (A) y (B).
[Color Bars]: activa y desactiva las barras de colores.
[DURATION/TC/U-BIT]: cambia entre Time Code, Users Bit y Duration.
[Display]: activa y desactiva los indicadores de la pantalla.
[Lens Info]: cambia el indicador de profundidad de campo.
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[Video Signal Monitor]: cambia el monitor de señal de vídeo (como un monitor de forma de onda).
[Marker]: activa y desactiva la función de marcador.
[Thumbnail]: muestra/sale de la pantalla de imágenes en miniatura.
[Auto Upload (Proxy)]: activa y desactiva la transferencia automática de los archivos proxy.
[Direct Menu]: muestra/sale del menú directo.
[User Menu]: muestra/sale del menú User.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Scene File

Configura los ajustes relacionados con los archivos de escena (consulte “Filmación con el aspecto deseado”).
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Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Recall – –

Carga un archivo de escena
restaurado en la memoria interna y
aplica los ajustes a la configuración
actual de la calidad de imagen.

Store – –
Guarda el estado actual de la calidad
de imagen como archivo de escena en
la memoria interna.

Delete – –
Elimina un archivo de escena
almacenado en la memoria interna.

Preset
Recall

Cuando Shooting Mode está ajustado
en Custom y Target Display está
ajustado en SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / 709tone
Cuando Shooting Mode está ajustado
en Custom y Target Display está
ajustado en HDR(HLG): HLG Live /
HLG Natural

–

Aplica los ajustes predeterminados de
la calidad de imagen (no regrabables)
a la configuración actual de la calidad
de imagen.
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Base Look

Configura los ajustes relacionados con el aspecto básico.
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Select

Cuando Shooting Mode está ajustado
en Custom y Target Display está
ajustado en SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / 709tone / De
User1 a User16
Cuando Shooting Mode está ajustado
en Custom y Target Display está
ajustado en HDR(HLG): HLG Live /
HLG Natural / De User1 a User16
Cuando Shooting Mode está ajustado
en los modos de filmación Log: s709 /
709(800) / S-Log3 / De User1 a User16

Cuando Shooting Mode está
ajustado en Custom y Target
Display está ajustado en
SDR(BT.709): S-Cinetone
Cuando Shooting Mode está
ajustado en Custom y Target
Display está ajustado en
HDR(HLG): HLG Live
Cuando Shooting Mode está
ajustado en los modos de
filmación Log: s709

Selecciona un aspecto
básico.

Delete – –
Elimina el aspecto básico
seleccionado.

Delete All – –
Elimina todos los
aspectos básicos.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3

Establece la gama de
entrada para el aspecto
básico seleccionado
mediante [Select].

Output BT.709 / HLG BT.709

Establece la gama de
color de salida para el
aspecto básico
seleccionado mediante
[Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Establece el valor de
referencia de la
exposición para el
aspecto básico
seleccionado mediante
[Select].
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Reset Paint Settings

Restablece los ajustes del menú [Paint/Look], excepto el aspecto básico.
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Reset without
Base Look

Execute / Cancel –
Restablece los ajustes del menú
[Paint/Look], excepto el aspecto básico.
Execute: Ejecutar la función.
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Black

Configura los ajustes de negro.
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Elemento Ajuste de subelementos Valor predeterminado de fábrica Descripción

Master Black De −99.0 a +99.0 ±0.0 Ajusta el nivel de negro maestro.

R Black De −99.0 a +99.0 ±0.0 Ajusta el nivel de negro R.

B Black De −99.0 a +99.0 ±0.0 Ajusta el nivel de negro B.
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Knee

Configura los ajustes de corrección de inflexión.
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Setting

Cuando Target Display se
define como SDR(BT.709):
On / Off / ---
Cuando Target Display se
define como HDR(HLG):
On / Off / ---

Cuando Target Display se
define como
SDR(BT.709): Off
Cuando Target Display se
define como HDR(HLG):
Off

Activa y desactiva la función de corrección
de inflexión.

Nota

Solo está habilitado cuando [Base Look]
> [Select] se ha ajustado como
[Standard], [ITU709], [709tone], [HLG
Live] o [HLG Natural].

Auto
Knee

Cuando Target Display se
define como SDR(BT.709):
On / Off / ---
Cuando Target Display se
define como HDR(HLG):
On / Off / ---

Cuando Target Display se
define como
SDR(BT.709): On
Cuando Target Display se
define como HDR(HLG):
Off

Activa y desactiva la función de inflexión
automática.

Nota

Solo está habilitado cuando [Base Look]
> [Select] se ha ajustado como
[Standard], [ITU709] o [709tone].

Point De 75% a 109% 90% Ajusta el punto de inflexión.

Slope De −99 a +99 ±0 ajusta la pendiente de inflexión.
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Detail

Configura las opciones de ajuste de detalles.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Setting On / Off On Activa y desactiva la función de detalles.

Level De −7 a +7 ±0 Ajusta el nivel de detalle.

Manual
Setting

On / Off / --- Off
Activa y desactiva la función de ajuste manual de
detalles.

H/V Ratio De −2 a +2 ±0

Ajusta el balance entre el detalle horizontal (H) y el
vertical (V) para el ajuste manual de detalles.

Nota

Este elemento varía según la versión del software.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3

Ajusta el balance entre el detalle de negros (B) para las
áreas de baja luminosidad y el detalle de blancos (W)
para las áreas de alta luminosidad para el ajuste manual
de detalles.

Limit De 0 a 7 7
Establece el límite de detalle para el ajuste manual de
detalles.

Crispening De 0 a 7 0
Establece el nivel de nitidez para el ajuste manual de
detalles.

High Light
Detail

De 0 a 4 0
Establece el límite de detalle de las áreas de alta
luminosidad para el ajuste manual de detalles.

En la versión 1.00 del software, el elemento de menú es [V/H Balance]. En la versión 1.10 o posteriores del software, el elemento de menú es
[H/V Ratio]. El intervalo de ajuste no cambia entre −2 a 0 a +2, pero el efecto en la calidad de la imagen es diferente.
Versión de software 1.00: cuanto más alto sea el valor establecido, más alto será el detalle horizontal (H).
Versión de software 1.10 o posteriores: cuanto más alto sea el valor establecido, más alto será el detalle vertical (V).
Tras actualizar el software de la versión 1.00 a la 1.10 o posteriores, [All File], [Scene File] y otros ajustes se heredan, pero con la polaridad
invertida (la calidad de imagen se mantiene).
Si ha registrado el elemento de menú [V/H Balance] en el menú [User], será sustituido por el elemento de menú [H/V Ratio] en el menú [User]
automáticamente tras actualizar el software.

*1
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Matrix

Configura los ajustes de corrección de matrices.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

User Matrix On / Off Off
Activa y desactiva la función de corrección
matricial del usuario.

User Matrix
Level

De −99 a +99 ±0
Ajusta la saturación de color de toda la
imagen.

User Matrix
Phase

De −99 a +99 ±0
Ajusta el tono de color (fase) de toda la
imagen.

User Matrix R-
G

De −99 a +99 ±0
Ajusta una matriz del usuario R-G definida
por el usuario.

User Matrix R-
B

De −99 a +99 ±0
Ajusta una matriz del usuario R-B definida
por el usuario.

User Matrix G-
R

De −99 a +99 ±0
Ajusta una matriz del usuario G-R definida
por el usuario.

User Matrix G-
B

De −99 a +99 ±0
Ajusta una matriz del usuario G-B definida
por el usuario.

User Matrix B-
R

De −99 a +99 ±0
Ajusta una matriz del usuario B-R definida
por el usuario.

User Matrix B-
G

De −99 a +99 ±0
Ajusta una matriz del usuario B-G definida
por el usuario.
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Multi Matrix

Configura los ajustes de corrección de matrices múltiples.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Setting On / Off Off
Activa y desactiva la función de
corrección de matrices múltiples.

Reset Execute / Cancel –
Restablece el tono y la saturación de
cada color de eje a los valores
predeterminados.

Axis
B / B+ / MG− / MG / MG+ / R / R+ /
YL− / YL / YL+ / G− / G / G+ / CY /
CY+ / B−

B Selecciona el eje.

Hue De −99 a +99 ±0
Ajusta el matiz del color utilizado para la
corrección de matrices múltiples.

Saturation De −99 a +99 ±0
Ajusta la saturación del color utilizado
para la corrección de matrices múltiples.
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P/T Acceleration

Configura los ajustes relacionados con la aceleración de operaciones de giro/inclinación.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Ramp
Curve

De 1 a 9 8
Permite seleccionar la aceleración/deceleración de las
operaciones de giro/inclinación. Cuanto mayor sea el valor,
mayor será la aceleración.
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Timecode

Configura los ajustes de código de tiempo.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Mode
Preset / Regen /
Clock

Preset

Ajusta el modo de ejecución del código de tiempo.
Preset: empieza a funcionar a partir de un valor
preestablecido.
Regen: empieza a funcionar a partir del código de
tiempo del final del clip anterior.
Clock: utiliza el reloj interno como código de tiempo.

Run Rec Run / Free Run Rec Run
Rec Run: Funciona solo durante la grabación.
Free Run: Funciona siempre, independientemente
del funcionamiento de la grabación.

Setting – –
Ajusta el código de tiempo en un valor arbitrario.
Set: Ajustar el valor.

Reset Execute / Cancel –
Restablece el valor del código de tiempo a
00:00:00:00.
Execute: Ejecutar la función.

TC
Format

DF / NDF DF
Ajusta el formato del código de tiempo.
DF: omisión de fotograma
NDF: no omisión de fotograma
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TC Display

Configura los ajustes de visualización de datos de tiempo.
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Display
Select

Timecode / Users Bit /
Duration

Timecode
Cambia la visualización de datos de
tiempo.

338



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Users Bit

Configura los ajustes relacionados con los bits de usuario.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Mode Fix / Time Fix

Ajusta el modo de bit de usuario.
Fix: utiliza un valor fijo arbitrario en bits de
usuario.
Time: utiliza la hora actual en hora, minuto y
segundo en bits de usuario.

Setting – – Ajusta los bits de usuario en un valor arbitrario.
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HDMI TC Out

Configura los ajustes relacionados con la salida de código de tiempo cuando se utiliza HDMI.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Setting On / Off Off
Ajusta si enviar la salida del código de tiempo a
dispositivos con otros objetivos, mediante HDMI.
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Clip Name Format

Configura los ajustes relacionados con el nombre y la eliminación de los clips.
Cuando [Auto Naming] se define como [Cam ID + Reel#], los cuatro primeros caracteres de los nombres del clip se
determinan para cada soporte de grabación. Cuando se inserta un nuevo soporte de grabación, o cuando el último clip
del soporte de grabación no coincide con los ajustes de [Camera ID] o [Reel Number], el nombre del clip parpadea para
notificárselo.
Cuando [Auto Naming] se define como [Title], puede utilizar una cadena de caracteres arbitraria como la primera parte
de los nombres del clip.

Elemento Ajuste de
subelementos

Valor
predeterminado

de fábrica
Descripción

Auto
Naming

Cam ID + Reel# / Title

Selecciona el formato de nombre del clip.
Cam ID + Reel#: ID de cámara + número de rollo +
número de toma + fecha + cadena aleatoria
Title: cadena arbitraria especificada por [Title Prefix] +
número de clip

Camera ID De la A a la Z A

Establece el ID de la cámara utilizado al generar los
nombres de los clips.

Nota

Configurable solo cuando [Auto Naming] se ha
ajustado en [Cam ID + Reel#].

Reel
Number

De 001 a 999 001

Establece el número de rollo utilizado al generar los
nombres de los clips.

Nota

Configurable solo cuando [Auto Naming] se ha
ajustado en [Cam ID + Reel#].

Camera
Position

C / L / R C

Establece el primer carácter del número de toma
utilizado al generar nombres de clips.

Nota

Configurable solo cuando [Auto Naming] se ha
ajustado en [Cam ID + Reel#].
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Para ajustar [Title Prefix]

Tema relacionado
Introducción de una cadena de caracteres

Elemento Ajuste de
subelementos

Valor
predeterminado

de fábrica
Descripción

Title Prefix

nnn_(nnn son los tres
últimos dígitos del
número de serie)
(se muestra un
máximo de 7 dígitos)

nnn

Establece la parte del título (de 4 a 46 caracteres) del
nombre del clip.
Abre una pantalla de introducción de cadenas de
caracteres.

Para obtener información acerca de la configuración
de títulos y la pantalla de introducción de
caracteres, consulte los apartados “Para establecer
el título” a continuación e “Introducción de una
cadena de caracteres”.

Nota

Configurable solo cuando [Auto Naming] se ha
ajustado en [Title].

Number
Set

De 0001 a 9999 0001

Establece el sufijo formado por un número de 4 dígitos
del nombre del clip.

Nota

Configurable solo cuando [Auto Naming] se ha
ajustado en [Title].

Seleccione el carácter que desea insertar en la posición del cursor en el área [Title Prefix] desde el área de
selección de caracteres con los botones de flecha del panel de control de GUI. El carácter se destacará.
Después, pulse el botón [Set] del panel de control de GUI.

Se inserta el carácter seleccionado y el cursor se mueve hacia la derecha.

1

Repita el paso 1 para establecer el título.

Utilice [BS] según se requiera.

2

Tras establecer el título, pulse el botón [Done] para cerrar la pantalla de introducción de caracteres.

Para obtener información sobre el funcionamiento de la pantalla de entrada de caracteres, consulte
“Introducción de una cadena de caracteres”.

Es posible seleccionar los siguientes caracteres.
!#$%()+,-.;=@[ ]^_~ espacio
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Actualiza el archivo de gestión en las tarjetas de memoria (consulte “Restablecimiento de tarjetas de memoria”).

Tema relacionado

Restablecimiento de tarjetas de memoria

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Media(A) Execute / Cancel –
Actualiza el archivo de gestión en la tarjeta de
memoria en la ranura A.
Execute: Ejecutar la función.

Media(B) Execute / Cancel –
Actualiza el archivo de gestión en la tarjeta de
memoria en la ranura B.
Execute: Ejecutar la función.
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Format Media

Permite formatear (inicializar) las tarjetas de memoria (consulte “Formateo (inicialización) de tarjetas de memoria”).

Tema relacionado

Formateo (inicialización) de tarjetas de memoria

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Media(A)
Full Format / Quick Format /
Cancel

–
Formatea la tarjeta de memoria de la
ranura A.

Media(B)
Full Format / Quick Format /
Cancel

–
Formatea la tarjeta de memoria de la
ranura B.
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Media Life

Muestra la vida útil restante de las tarjetas de memoria.

Nota

Requiere tarjetas de memoria compatibles con la visualización de vida útil restante de archivos multimedia.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Media(A) – –
Muestra la vida útil restante de la tarjeta de
memoria en la ranura A.

Media(B) – –
Muestra la vida útil restante de la tarjeta de
memoria en la ranura B.

346



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

Configura los ajustes del formato de salida.

Tema relacionado

Limitaciones y formatos de salida

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

SDI Para obtener más detalles acerca de los ajustes,
consulte “Limitaciones y formatos de salida”.

– Ajusta la resolución de
salida de SDI y HDMI.HDMI –
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Display On/Off

Configura los ajustes de los elementos de la pantalla.
Para mostrar un elemento de pantalla, seleccione On. Para ocultar un elemento de pantalla, seleccione Off.

Elemento Ajuste de subelementos Valor predeterminado de fábrica

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On

348



5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado de fábrica

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Define los ajustes del monitor de señal de vídeo.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Setting
Off / Waveform / Vector /
Histogram

Off
Permite definir el tipo de monitor de señal
de vídeo.

Level Marker
1

De 0% a 109% 70%
Permite definir el nivel de iluminación del
marcador de nivel 1.

Level Marker
2

De 0% a 109% 100%
Permite definir el nivel de iluminación del
marcador de nivel 2.
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Marker

Configura los ajustes de visualización de marcadores.

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Setting On / Off On
Activa y desactiva la visualización de todos
los marcadores.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White
Selecciona el color de la señal de los
marcadores.

Center
Marker

1 / 2 / 3 / 4 / Off Off Selecciona el marcador central.

Safety Zone On / Off Off
Activa y desactiva el marcador de la zona
de seguridad.

Safety Area 80% / 90% / 92.5% / 95% 90%
Selecciona el tamaño del marcador de la
zona de seguridad (como un porcentaje del
tamaño total de la pantalla).

Aspect
Marker

Line / Mask / Off Off Selecciona el tipo de marcador de aspecto.

Aspect Mask De 0 a 15 12
Ajusta el nivel de la señal de vídeo fuera del
marcador.

Aspect
Safety Zone

On / Off Off
Activa y desactiva el marcador de la zona
de seguridad de aspecto.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Selecciona el tamaño del marcador de la
zona de seguridad de aspecto (como un
porcentaje del tamaño total de la pantalla).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 /
16:9 / 17:9 / 1.66:1 / 1.85:1 /
2.35:1 / 2.39:1 / Custom

2.39:1
Ajusta el modo cuando se muestra el
marcador de aspecto.

Custom
Aspect Ratio

Introduzca un valor arbitrario. 01.00:01.00

Configura la relación de aspecto en un valor
arbitrario.

Nota

Se muestra cuando [Aspect Select] está
definido en [Custom].

Guide
Frame On / Off Off

Activa y desactiva la visualización del
fotograma de la imagen.
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Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

100%
Marker

On / Off Off Activa y desactiva el marcador de 100%.

User Box On / Off Off
Activa y desactiva la visualización del
marcador de casilla del usuario.

User Box
Width De 3 a 479 240

Ajusta la amplitud del marcador de casilla
de usuario (distancia del centro a los
bordes derecho e izquierdo).

User Box
Height

De 3 a 269 135
Ajusta la altura del marcador de casilla de
usuario (distancia del centro a los bordes
superior e inferior).

User Box H
Position

De −476 a +476 0
Establece la posición horizontal del centro
del marcador de la casilla de usuario.

User Box V
Position

De −266 a +266 0
Establece la posición vertical del centro del
marcador de la casilla de usuario.
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Audio Input

Configura los ajustes de entrada de audio.

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

AUDIO IN
Select

MIC / LINE MIC
Selecciona el tipo de dispositivo conectado al
conector AUDIO IN.

Phantom
Power +48V

On / Off Off
Muestra el estado de la fuente de alimentación
fantasma +48 V.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Muestra la fuente de entrada para la grabación en el
canal 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2
Cambia la fuente de entrada para la grabación en el
canal 2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1
Cambia la fuente de entrada para la grabación en el
canal 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2
Cambia la fuente de entrada para la grabación en el
canal 4.

AUDIO IN
CH1 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Ajusta el nivel de la grabación de referencia para la
entrada del micrófono XLR desde AUDIO IN CH1.

AUDIO IN
CH2 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Ajusta el nivel de la grabación de referencia para la
entrada del micrófono XLR desde AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Selecciona el nivel de entrada de referencia cuando
[AUDIO IN Select] está definido en LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB / EBUL

−20dB Selecciona el nivel de grabación de la señal del tono
de referencia de 1 kHz.

CH1 Wind
Filter

On / Off Off
Habilita/inhabilita el filtro de reducción de ruido del
viento para la grabación del canal 1.

CH2 Wind
Filter

On / Off Off
Habilita/inhabilita el filtro de reducción de ruido del
viento para la grabación del canal 2.

CH3 Wind
Filter

On / Off Off
Habilita/inhabilita el filtro de reducción de ruido del
viento para la grabación del canal 3.

CH4 Wind
Filter

On / Off Off Habilita/inhabilita el filtro de reducción de ruido del
viento para la grabación del canal 4.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

CH1 Level
Control

Auto / Manual Auto
Permite seleccionar el ajuste de nivel de entrada de
audio automático o el ajuste manual para el canal de
grabación 1.

CH2 Level
Control

Auto / Manual Auto
Permite seleccionar el ajuste de nivel de entrada de
audio automático o el ajuste manual para el canal de
grabación 2.

CH3 Level
Control

Auto / Manual Auto
Permite seleccionar el ajuste de nivel de entrada de
audio automático o el ajuste manual para el canal de
grabación 3.

CH4 Level
Control

Auto / Manual Auto
Permite seleccionar el ajuste de nivel de entrada de
audio automático o el ajuste manual para el canal de
grabación 4.

CH1 Input
Level

De 0 a 99 49
Ajusta el nivel de entrada para el canal de grabación
1.

CH2 Input
Level

De 0 a 99 49
Ajusta el nivel de entrada para el canal de grabación
2.

CH3 Input
Level

De 0 a 99 49
Ajusta el nivel de entrada para el canal de grabación
3.

CH4 Input
Level

De 0 a 99 49
Ajusta el nivel de entrada para el canal de grabación
4.

Master Input
Level

De 0 a 99 99 Permite ajustar el nivel de entrada de audio principal.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Selecciona la característica del limitador para
señales de entrada grandes cuando está ajustado el
nivel de entrada de audio manualmente.

CH1&2 AGC
Mode

Mono / Stereo Stereo

Establece el modo de ajuste de nivel automático
para la grabación en el canal 1 y en el canal 2.
Cuando se define en Stereo, AGC se vincula entre
los canales.

CH3&4 AGC
Mode

Mono / Stereo Stereo

Establece el modo de ajuste de nivel automático
para la grabación en el canal 3 y en el canal 4.
Cuando se define en Stereo, AGC se vincula entre
los canales.

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB Selecciona la característica AGC.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

1kHz Tone
on Color
Bars

On / Off Off

Activa y desactiva la señal de tono de referencia de 1
kHz cuando se muestran las barras de colores.

Nota

Cuando se ajusta en [On], la señal de tono de
referencia de 1 kHz se establece para grabar en el
canal 3 y en el canal 4, aunque [CH3 Input Select] y
[CH4 Input Select] estén ajustados en [Off].
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Audio Output

Configura los ajustes de salida de audio.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Ajusta la combinación de canales de audio
para la salida HDMI/transmisión.
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Display Clip Properties

Muestra la pantalla de propiedades de visualización de clips.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Display Clip
Properties

– –
Muestra la pantalla de propiedades de
visualización de clips.
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Set Clip Flag

Configura los ajustes de marca de clip.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado de fábrica Descripción

Add OK – – Agrega una marca OK.

Add NG – – Agrega una marca NG.

Add KEEP – – Agrega una marca KEEP.

Delete Clip Flag – – Elimina todas las marcas.
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Lock/Unlock Clip

Configura los ajustes de protección de clips.
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Select Clip – –
Selecciona y bloque/desbloquea un
clip.

Lock All Clips – – Bloquea todos los clips.

Unlock All
Clips

– – Desbloquea todos los clips.
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Delete Clip

Elimina clips.
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Elemento Ajuste de subelementos Valor predeterminado de fábrica Descripción

Select Clip – – Elimina el clip seleccionado.

All Clips – – Elimina todos los clips.

360



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip

Transfiere los clips.
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Select
Clip

– – Transfiere los clips seleccionados.

All Clips – –

Transfiere todos los clips.

Nota

Se pueden registrar hasta 200 trabajos de
transferencia.
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Transfer Clip (Proxy)

Transfiere los clips de proxy.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Select
Clip

– –
Transfiere los clips de proxy correspondientes a
los clips seleccionados.

All Clips – –

Transfiere los clips de proxy correspondientes a
todos los clips.

Nota

Se pueden registrar hasta 200 trabajos de
transferencia.
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Filter Clips

Configura los ajustes de los clips que se van a visualizar.
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

OK – – Muestra todos los clips con la marca OK.

NG – – Muestra todos los clips con la marca NG.

KEEP – – Solo se muestran los clips con la marca KEEP.

None – – Muestra solo los clips que no tienen marca.

All – –
Muestra todos los clips, independientemente de
si hay marcas.
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Customize View

Cambia la pantalla de imágenes en miniatura.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

Thumbnail
Caption

Date Time / Time Code /
Duration / Sequential Number

Time Code
Cambia la información mostrada
debajo de las imágenes en miniatura.
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Color Bars

Configura los ajustes de las barras de colores.
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Setting On / Off Off
Activa y desactiva las barras de
colores.

Type
ARIB / 100% / 75% /
SMPTE

ARIB Selecciona el tipo de barra de color.
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Genlock

Permite configurar la visualización del estado de Genlock (consulte “Sincronización de la fase de la señal de vídeo
(Genlock))”.

Tema relacionado

Sincronización de la fase de la señal de vídeo (Genlock)
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Reference
Internal / External(HD) /
External(SD)

–
Muestra el tipo de señal de referencia
de Genlock.
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Tally

Permite definir los ajustes de la luz indicadora de registro/grabación (“Conexión de una señal de registro”).

Tema relacionado

Conexión de una señal de registro
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Tally Lamp
Brightness

High / Low / Off High
Permite definir el brillo de la luz indicadora de
registro/grabación.

G Tally Lamp Enable / Disable Enable
Permite activar/desactivar la luz indicadora de
registro G.

Tally Control External / Internal Internal

Permite seleccionar el objetivo para aceptar la
información de control de la luz indicadora de
registro/grabación.
External: control de registro desde fuera de la
cámara.
Internal: control a través del funcionamiento de la
grabación de la cámara.
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Rec Review

Permite definir los ajustes de revisión de grabaciones (consulte “Revisión de la grabación (Rec Review)”).

Tema relacionado

Revisión de la grabación (Rec Review)
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Setting 3s / 10s / Clip 3s
Permite definir la hora de reproducción de los clips
recién grabados para revisar la grabación.
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Zoom

Permite configurar los ajustes del zoom (“Ajuste del zoom”).
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Zoom
Type

Optical Zoom Only / On(Clear Image
Zoom)

Optical Zoom Only
Establece el tipo de
zoom.
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Lens

Configura los ajustes relacionados con los objetivos.

Tema relacionado
Breathing Compensation
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Lens Calibration Execute / Cancel –

Ejecuta la función que corrige las diferencias en la
posición de zoom debido a las diferencias de
objetivos individuales al utilizar un objetivo con
zoom motorizado.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Ajusta el sentido de funcionamiento del anillo del
zoom.

Nota

Solo está habilitado cuando se utiliza un objetivo
de montura E compatible con el cambio de
dirección del anillo de zoom.

Shading
Compensation Auto / Off Auto Ajusta la compensación de sombreado automático.

Chroma
Aberration
Comp.

Auto / Off Auto
Ajusta la compensación de la aberración cromática
automática.

Distortion Comp. Auto / Off Auto Ajusta la compensación de distorsión automática.

Breathing
Compensation

Auto / Off Off
Ajusta la Breathing Compensation del objetivo.

Consulte “Breathing Compensation”.

Distance Display Meter / Feet Meter
Establece las unidades de visualización para la
información del objetivo y la posición de enfoque.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length
Establece el formato de visualización para la
posición del zoom.
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APR

Ejecuta APR.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

APR Execute / Cancel –

Ejecuta APR (restauración automática de píxeles) para
ajustar automáticamente el sensor de imagen.
Execute: Ejecutar la función.

Nota

Coloque siempre la tapa del objetivo antes de ejecutar
APR.
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Wired LAN

Establece la configuración relacionada con las conexiones LAN con cable.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

HTTP Port – 80 Muestra el puerto de acceso HTTP.

Detail
Settings

– –
Muestra las propiedades de la conexión LAN
cableada.

DHCP
On / Off

On
Muestra si DHCP está activado (On) o desactivado
(Off).

IP Address – Muestra la dirección IP de la unidad cuando [DHCP]
se define como [Off].

Subnet Mask –
Muestra la máscara de subred de la videocámara
cuando [DHCP] está ajustado en [Off].

Gateway –
Muestra la puerta de enlace predeterminada
cuando [DHCP] está ajustado en [Off].

DNS Auto
On / Off

On
Muestra el ajuste de adquisición automática de
DNS.
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File Transfer

Permite definir los ajustes relacionados con la transferencia de archivos (consulte “Acerca de la transferencia de
archivos”).

Tema relacionado

Acerca de la transferencia de archivos
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Auto Upload
(Proxy)

On / Off Off
Permite activar y desactivar la carga automática del
archivo proxy.

Default
Upload
Server

Server Settings1 a
3 > Display Name

–

Selecciona el servidor de carga para los archivos. El
servidor seleccionado aquí se convierte en el destino de
carga automática para los archivos de proxy y el destino
de carga para los archivos desde la pantalla de imágenes
en miniatura.
Muestra los ajustes de [Display Name] configurados en
[Server Settings1 a 3].

Clear
Completed
Jobs

Execute / Cancel –
Borra de la lista los trabajos de transferencia finalizados.
Execute: Ejecutar la función.

Clear All
Jobs

Execute / Cancel –
Borra de la lista todos los trabajos de transferencia.
Execute: Ejecutar la función.

View Job
List

– – Muestra la lista de trabajos de transferencia.
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Language

Ajusta el idioma de visualización.
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Elemento Ajuste de subelementos Valor predeterminado de fábrica Descripción

Select – –
Ajusta el idioma de visualización.
Set: Ajustar el valor.
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Clock Set

Configura los ajustes del reloj interno.

Nota

Cuando cambie este ajuste desde el menú de la cámara, apague la fuente de alimentación de la unidad y reiníciela. Puede
ocurrir un comportamiento inesperado si se inicia el estado de espera con el control remoto infrarrojo o la Aplicación Web.
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Time
Zone

De UTC − 12:00 a UTC +
14:00

–
Ajusta la diferencia horaria desde UTC en
intervalos de 30 minutos.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Selecciona el formato de visualización de la
fecha.
YYMMDD: año, mes, día
MMDDYY: mes, día, año
DDMMYY: día, mes, año

12H/24H 12H / 24H 24H
Ajusta el formato de visualización del reloj.
12H: modo de 12 horas
24H: modo de 24 horas

Date – –
Ajusta la fecha actual.
Set: Ajustar el valor.

Time – –
Ajusta la hora actual.
Set: Ajustar el valor.
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Hours Meter

Muestra el tiempo de ejecución acumulado.
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Hours(System) – –
Muestra el número de horas acumuladas de
uso (no se puede restablecer).

Hours(Reset) – –
Muestra el número de horas acumuladas de
uso (se puede restablecer).

Reset Execute / Cancel –
Restablece el tiempo de ejecución acumulado
en 0.
Execute: Ejecutar la función.
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Ajustes y valores predeterminados de ISO/Gain

El rango de ajustes y valores predeterminados de [ISO/Gain<L>] varía en función de la configuración de [Mode], [Base
Look] > [Select] y [Base Sensitivity].
Los valores predeterminados de las tablas se muestran en negrita.

Cuando [Mode] está definido en [ISO]

Cuando [Base Look] > [Select] se define como [S-Cinetone], [Standard], [ITU709], [709tone] o [Still]

Cuando [Base Look] > [Select] se define como [HLG Live] o [HLG Natural]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [Low]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Cuando [Base Look] > [Select] se define como [User1] a [User16]

Cuando [Mode] está definido en [dB]

Puede configurarse un valor en el rango entre −3dB y +30dB en incrementos de 1dB.
El valor predeterminado es 0dB.
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Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [Low]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [Low]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ajustes y valores predeterminados de AGC Limit

El rango de ajustes y valores predeterminados del menú [AGC Limit] varía en función de la configuración de [Mode],
[Base Look] > [Select] y [Base Sensitivity].
Los valores predeterminados de las tablas se muestran en negrita.

Cuando [Mode] está definido en [ISO]

Cuando [Base Look] > [Select] se define como [S-Cinetone], [Standard], [ITU709], [709tone] o [Still]

Cuando [Base Look] > [Select] se define como [HLG Live] o [HLG Natural]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [Low]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Cuando [Base Look] > [Select] se define como [User1] a [User16]

Cuando [Mode] está definido en [dB]

Seleccione 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
El valor predeterminado es 15dB.
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Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [Low]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [Low]

Cuando [ISO/Gain/EI] > [Base Sensitivity] se define
como [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ajustes de calidad de imagen guardados para cada modo de filmación

El estado actual de los elementos de configuración relacionados con la calidad de la imagen se guarda para cada uno
de los siguientes modos de filmación. Cuando se cambia el modo de filmación, los ajustes correspondientes que se
guardan se aplican al modo de filmación de objetivo.

Visualización del objetivo en modo Custom SDR(BT.709)
Visualización del objetivo en modo Custom HDR(HLG)
Filmación Log (Cine EI, Cine EI Quick, Flexible ISO)

En las siguientes tablas se muestran los elementos de configuración relacionados con la calidad de la imagen que se
guardan para cada modo de filmación.
“Sí” indica que el ajuste se guarda y “No” indica que el ajuste no se guarda. Cuando “Sí” abarca varias columnas, indica
una configuración común.

Elemento

Modo de filmación

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menú
Shooting

ISO/Gain/EI

ISO/Gain Sí1) Sí No

Exposure Index No No Sí Sí

Base Sensitivity Sí No

Base ISO No Sí4) No3) Sí4)

White

Preset White Sí Sí

Distinto de lo
anterior

Sí

White Setting Sí

Offset White Sí No

LUT On/Off No Sí

Noise
Suppression

Setting(Custom) Sí Sí No

Level(Custom) Sí Sí No

Setting (Cine
EI/Flex. ISO)

No Sí

Level (Cine EI/Flex.
ISO)

No Sí
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Elemento

Modo de filmación

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menú
Paint/Look

Base Look

Select Sí Sí Sí

Input2) Sí

Output2) Sí

AE Level Offset2) Sí

Black Sí Sí No

Knee

Auto Knee Sí No No

Distinto de lo
anterior

Sí Sí No

Detail Sí Sí No

Matrix Sí Sí No

Multi Matrix Sí Sí No

Se guardan ajustes de sensibilidad ISO separados para los modos Custom SDR(BT.709) y HDR(HLG).1)

Los ajustes se guardan para cada Base Look y no dependen del modo de filmación.2)

La sensibilidad ISO base cambia en función del índice de exposición.3)

Valor de ajuste común en los modos de filmación Flexible ISO y Cine EI.4)
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Configuración del menú web

Pulse la pestaña de cambio a la pantalla de operación [Settings] para mostrar la pantalla de ajustes.
Utilice la pantalla de ajustes para configurar los distintos elementos de configuración de la unidad, incluidos los ajustes
iniciales, los ajustes de red y los ajustes de filmación/reproducción a través del menú web.

El menú incluye los siguientes menús.

Configuración y jerarquía del menú

Nivel 1 Descripción del nivel 1 Nivel 2

Shooting Contiene ajustes relacionados con la filmación. Focus
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Nivel 1 Descripción del nivel 1 Nivel 2

Project Contiene ajustes básicos del proyecto.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Contiene ajustes relacionados con la calidad de la imagen. Base Look

Pan-Tilt Contiene ajustes relacionados con las funciones de giro/inclinación.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Contiene ajustes relacionados con la salida de vídeo y la visualización de
pantalla.

Output Format

Output Display

Audio Contiene ajustes relacionados con el audio. Audio

Technical Contiene ajustes para elementos técnicos.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Contiene ajustes relacionados con las redes.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Nota

[Accessibility] solo se incluye en las versiones para Estados Unidos.
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Nivel 1 Descripción del nivel 1 Nivel 2

Stream Contiene ajustes relacionados con la transmisión.

Stream

Video Stream

Audio Stream

Maintenance Contiene ajustes de dispositivos, como el reloj y el idioma.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Operaciones del menú web

Pulse la pestaña de cambio de pantalla de operación [Settings] para mostrar la pantalla de configuración y definir los
distintos elementos de configuración de la unidad, incluidos los ajustes iniciales, los ajustes de red y los ajustes de
filmación/reproducción a través del menú web.
Configure los ajustes del menú web en una tablet mediante el funcionamiento táctil o en un ordenador con un ratón.
Pulse el menú de los elementos que desee configurar para mostrar los elementos de configuración y los ajustes
correspondientes del menú.

Método de configuración

Selección de valor

Menú (nivel 1)1.

Menú (nivel 2)2.

Ajustes3.
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Pulse el botón de opción de un elemento. El botón de opción del elemento seleccionado se mostrará en naranja.

Activación o desactivación de elementos

Pulse el interruptor para activar o desactivar el elemento. El interruptor se pondrá de color naranja cuando se active el
elemento y de color blanco cuando se desactive.

Selección de un valor de la lista

Pulse el botón desplegable y seleccione un elemento de la lista que aparecerá.

Selección de un valor numérico

Pulse < o > para modificar el valor numérico. Si el valor numérico está subrayado, también puede introducir
directamente el valor que desee.

Introducción de número/carácter

Configuración en pantalla separada
Pulse el botón para llevar a cabo operaciones de configuración en una pantalla externa.

Mensaje de orientación

Se muestra información que ayuda al usuario a configurar algunos ajustes y mensajes de atención.

Guardado de un ajuste

Cuando termine de configurar un ajuste, pulse el botón [OK] para guardar el ajuste.
Pulse el botón [Cancel] para descartar los cambios de un ajuste y revertir al valor anterior.
Pulse el botón [Reload] para actualizar la pantalla.

Nota

Si pulsa el botón [Reload] antes de guardar un ajuste, los cambios que se hayan introducido se descartarán.

Si se mueve a una página distinta antes de guardar un ajuste, los cambios que se hayan introducido se descartarán.
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Focus

Configura los ajustes de enfoque.

Tema relacionado

Ajuste del objetivo de enfoque manualmente (AF Assist) mediante la Aplicación Web

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Ajusta el modo Push Auto Focus.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Define la operación cuando la pantalla de imagen de
cámara se toca en modo MF.

AF Assist
Control

On / Off On

Cuando se define como [On], se puede usar el control
deslizante de la Aplicación Web durante el enfoque
automático para ajustar la posición del enfoque.

Para obtener más detalles, consulte “Ajuste del
objetivo de enfoque manualmente (AF Assist)
mediante la Aplicación Web”.

Nota

Este elemento está habilitado solo cuando [AF Assist]
se define como [On] en el menú de la cámara.
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Base Setting

Configura los ajustes básicos.

Tema relacionado

Configuración del funcionamiento básico
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Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI Custom

Permite ajustar el modo de filmación.

Consulte “Modo de filmación” en
“Configuración del funcionamiento
básico”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Ajusta la gama de colores de la
grabación/salida en el modo Custom.
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Rec Format

Configura los ajustes del formato de grabación.

Ajustes [RAW Output Format]

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94

Selecciona la frecuencia del sistema.

Nota

Si la frecuencia se modifica, la cámara se
reinicia. Una vez reiniciada, vuelva a
cargar la página en el navegador web.

Imager
Scan Mode

FF / S35 FF Selecciona el tamaño de la cámara.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Ajusta el códec de grabación/reproducción
del clip.

Nota

Cuando [Imager Scan Mode] se define
como [S35], [RAW] y [RAW & XAVC-I] no
se pueden seleccionar.

RAW Output
Format

Los ajustes disponibles varían
según el ajuste de [Frequency].

Consulte “Ajustes de [RAW
Output Format]” a
continuación.

–

Define el tamaño de la imagen RAW para
emitirla en una grabadora RAW externa.

Nota

Cuando [Codec] está ajustado en [RAW &
XAVC-I], el ajuste [Video Format] cambia
en la vinculación con el ajuste [RAW
Output Format].

Video
Format

Los ajustes disponibles varían
según los ajustes de
[Frequency], [Imager Scan
Mode] y [Codec].

Consulte “Ajustes de [Video
Format]” a continuación.

– Ajusta el tamaño de imagen.
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Los valores predeterminados se muestran en negrita.
Las condiciones en las que [RAW Output Format] no puede establecerse se han omitido.

Ajustes [Video Format]

Los valores predeterminados se muestran en negrita.
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Frequency Imager Scan Mode Codec Ajuste

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Ajuste

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Permite definir los ajustes de modo de grabación en 2 ranuras simultáneamente (consulte “Grabación en la tarjetas de
memoria A y B simultáneamente (2-slot Simul Rec)”).

Tema relacionado
Grabación en la tarjetas de memoria A y B simultáneamente (2-slot Simul Rec)

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Setting On / Off Off
Activa y desactiva la función de grabación
simultánea y ajusta el soporte de destino de
grabación.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Muestra la asignación del botón de grabación para
cada medio de grabación.
Establezca [Project] > [Simul Rec] > [Rec Button
Set] en el menú de la cámara.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Ajusta el modo de grabación de proxy (consulte “Grabación de proxy”).
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Setting On / Off Off
Activa y desactiva el modo de grabación de
proxy.
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Interval Rec

Ajusta el modo de grabación de intervalos (consulte “Grabación de vídeo de manera intermitente (Interval Rec)”).

Tema relacionado

Grabación de vídeo de manera intermitente (Interval Rec)
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Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Setting On / Off Off

Activa y desactiva el modo de
grabación de intervalo. (Si se
ajusta este modo en On, el resto
de modos especiales se ajustará
en Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

1

Ajusta el intervalo entre
grabaciones en el modo de
grabación Interval Rec (cuando
Interval Rec está ajustado en On).

Number of
Frames

1frame / 2frames / 3frames / 6frames
/ 9frames / 12frames
Los ajustes disponibles dependen de
la frecuencia de fotogramas del
formato de vídeo seleccionado.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Ajusta el número de fotogramas
que se desea grabar por toma en
el modo de grabación Interval Rec
(cuando Interval Rec está ajustado
en On).
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Picture Cache Rec

Permite definir la configuración del modo de grabación de la caché de imágenes (consulte “Grabación de imágenes en
memoria intermedia (Picture Cache Rec)”).

Tema relacionado

Grabación de imágenes en memoria intermedia (Picture Cache Rec)
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Setting On / Off Off
Permite activar/desactivar la función de caché de
imagen.

Cache Size
Short / Medium /
Long / Max Max

Ajusta la hora de acumulación de las imágenes en la
memoria intermedia de imágenes (hora de grabación de
memoria intermedia de imágenes).

Cache Rec
Time

– –
Muestra la hora de acumulación de las imágenes en la
memoria intermedia de imágenes (hora de grabación de
memoria intermedia de imágenes).
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All File

Lleva a cabo las operaciones de archivos ALL (consulte “Guardar y cargar datos de configuración”).
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Load All
File

– –

Permite cargar un archivo ALL en la unidad desde el
dispositivo en el que se ejecuta la Aplicación Web.

Nota

Cuando un archivo ALL se carga en la unidad, esta se
reinicia. Una vez reiniciada, vuelva a cargar la página
en el navegador web.

Save All
File

– –
Guarde los ajustes de la unidad en el dispositivo en el
que se ejecuta la Aplicación Web como archivo ALL.
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Base Look

Puede cargar un aspecto básico en la unidad.
Se muestra una lista de los aspectos básicos disponibles en la pantalla. El aspecto básico aplicado actualmente se
indica mediante una marca ● a la izquierda del número de aspecto base.

[No.]: número del aspecto base
[Base Look Name]: nombre del aspecto base
[Input]: señal de entrada del aspecto básico
[Output]: señal de salida del aspecto básico
[AE Level Offset]: valor de desviación de exposición de aspecto básico

Para añadir un aspecto básico
Pulse el botón [Import] para importar un nuevo aspecto básico. Siga las instrucciones que aparecen en pantalla.
Tras la importación, defina los valores adecuados para [Input], [Output] y [AE Level Offset]. Para obtener más detalles,
consulte “Importación del aspecto básico deseado”.

Tema relacionado
Importación del aspecto básico deseado
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P/T Speed

Permite definir los ajustes relacionados con la velocidad de giro/inclinación.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Speed
Step

Normal /
Extended

Extended

Define el número de pasos de velocidad de la sección de
movimiento de giro/inclinación.
Normal: la velocidad se puede especificar en un rango de
24 pasos. Utilice esta configuración para la compatibilidad
con cámaras remotas Sony existentes.
Extended: la velocidad se puede especificar en un rango
de 50 pasos.

Speed
Mode

Normal / Slow Normal

Define el modo de velocidad de la sección de movimiento
de giro/inclinación.
Solo está habilitado cuando [Speed Step] se ha ajustado
en [Normal].
Normal: funciona en el rango de velocidad normal (de
mínimo a máximo (60 grados/segundo)).
Slow: funciona en el rango de velocidad baja (de mínimo a
máximo (40 grados/segundo)).
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P/T Acceleration

Permite definir los ajustes relacionados con la velocidad de giro/inclinación.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Acceleration De 1 a 9 8
Permite seleccionar la aceleración/deceleración de las
operaciones de giro/inclinación. Cuanto mayor sea el
valor, mayor será la aceleración.
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P/T Range Limit

Permite definir los valores de límite del rango de operación de giro/inclinación.
Defina los límites de operación de giro/inclinación en la siguiente pantalla.

Nota

Cuando la unidad se activa o se ejecuta el restablecimiento de giro/inclinación, este ajuste de límite de rango se ignora. Esta
función no puede utilizarse para evitar obstáculos cerca de la unidad.

Coloque el interruptor [Setting] en la posición ON.

Se activará la función de límite de rango de operación de giro/inclinación.

1

Compruebe la imagen mediante los controles de giro/inclinación de la cámara.2

Para definir las posiciones a las que definir el límite, pulse [Left], [Right], [Up], [Down] > [Set Current Value]
en dichas posiciones.

[Left]: lado izquierdo de la cámara
[Right]: lado derecho de la cámara
[Up]: lado superior de la cámara

3
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Nota

Las posiciones de cámara que sobrepasen las posiciones de límite no podrán guardarse como preajuste.

Si el ajuste [Pan-Tilt] > [P/T Direction] > [Ceiling] se modifica, los ajustes de las posiciones de límite configuradas volverán a los
valores predeterminados de fábrica.

El ajuste no puede modificarse durante la reproducción, durante la muestra de iconos en miniatura, cuando ocurre un error de
giro/inclinación, cuando no se inicializa el giro/inclinación y cuando se bloquea el giro/inclinación.

5-041-957-43(1) Copyright 2022 Sony Corporation

[Down]: lado inferior de la cámara

Las posiciones de límite se definen y muestran como valores numéricos (ángulo).
Para cancelar un límite, pulse el botón [Reset] en cada posición.

Pulse el botón [OK].

La operación de giro/inclinación está restringida y debe mantenerse dentro de las posiciones de límite
configuradas.

4
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P/T Direction

Permite definir los ajustes relacionados con la dirección de giro/inclinación.

Nota

Cuando se aplica un ajuste [Ceiling] modificado, se eliminan todas las posiciones predefinidas, ya que se invertirían las
coordenadas de giro/inclinación.

El rango de la unidad de giro/inclinación cambia según se muestra en el diagrama siguiente, en función del ajuste
[Ceiling].

A: cuando [Ceiling] está definido en [Off]
B: cuando [Ceiling] está definido en [On]

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Ceiling On / Off Off

Si la unidad se monta en una mesa, ajústelo en [Off]. Si la
unidad se monta en el techo, ajústelo en [On]. Cuando
[Ceiling] está definido en [On], [Pan Direction] se ajusta
automáticamente en [Opposite].

Pan
Direction

Normal /
Opposite

Normal Permite definir la dirección de la unidad de giro. Cuando se
cambia este ajuste, se invierte la dirección de la unidad.

Tilt
Direction

Normal /
Opposite

Normal
Permite definir la dirección de la unidad de inclinación.
Cuando se cambia este ajuste, se invierte la dirección de la
unidad.

403



5-041-957-43(1) Copyright 2022 Sony Corporation

404



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Preset

Define los valores relacionados con los preajustes de la cámara.

Pan-Tilt
Define la velocidad para los preajustes.

Default
Establece los valores por defecto que se configuran cuando se guarda una posición preajustada.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Define si las velocidades de preajuste se configuran
por separado o con unos valores comunes.

Pan-Tilt Speed
for Common

De 1 a 50 50

Define la velocidad común para los ajustes
preestablecidos.

Nota

Se utiliza una velocidad máxima de 24 si se define
un valor de 25 o más cuando [Pan-Tilt] > [P/T
Speed] > [Speed Step] se define como [Normal].

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Pan-Tilt Speed
for Separate

De 1 a 50 50
Define la velocidad para los ajustes preestablecidos
cuando el método de selección de velocidad
preestablecida está establecida en [Separate].

Zoom Sync On / Off On
Establece si la operación de giro/inclinación y la
operación de zoom se sincronizan al restaurar una
posición preajustada.

Zoom Speed De 0 a 32767 32767 Establece la velocidad del zoom.

Focus Recall On / Off On Establece si se restauran los ajustes de enfoque.

MF Speed De 0 a 32767 32767
Establece la velocidad de enfoque para el enfoque
manual.
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Output Format

Configura los ajustes del formato de salida.

Tema relacionado

Limitaciones y formatos de salida
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Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

SDI Para obtener más detalles acerca de los ajustes,
consulte “Limitaciones y formatos de salida”.

– Ajusta la resolución de
salida de SDI y HDMI.HDMI –
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Output Display

Configura los ajustes relacionados con las señales de salida.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

SDI On / Off Off
Establece si el menú y el estado están integrados en la
señal de salida SDI.

HDMI/Stream On / Off On

Establece si el menú y el estado están integrados en la
señal de salida HDMI.

Nota

Este ajuste también se aplica a la imagen HDMI de
señal de salida, la página de salida de transmisión y la
imagen del panel de imagen de la cámara de la
Aplicación Web.
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Audio Input

Configura los ajustes relacionados con la entrada de audio de CH1 a CH4.

Permite ajustar el nivel de entrada de audio principal. El nivel maestro de entrada de audio se utiliza para todos los
canales, del 1 al 4.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Level
Control

Auto / Manual Auto
Permite seleccionar el ajuste de nivel de entrada
de audio automático o el ajuste manual.

Level De 0 a 99 49 Ajusta el nivel de entrada.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 y CH3: AUDIO IN
CH1
CH2 y CH4: AUDIO IN
CH2

Ajusta la fuente de entrada de audio.

Nota

CH1 se define como [AUDIO IN CH1] (fijo).

Wind Filter On / Off Off
Activa y desactiva el filtro de reducción de ruido
de ventilación.

Elemento Ajuste de subelementos Valor predeterminado de fábrica Descripción

Master De 0 a 99 99 Define el nivel de entrada maestra.
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Audio Output

Configura los ajustes relacionados con la salida de audio.

Nota

Este ajuste también se aplica a la transmisión de salida de audio.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Ajusta la combinación de canales de audio
para la salida HDMI/transmisión.
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Tracking Data Output

Establece los ajustes relacionados con la salida de información de seguimiento (compatible con el protocolo free-d).
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Transfer
Mode

Off / Always / On
Demand

Off
Selecciona el método de salida de información de
seguimiento.

Camera ID De 0 a 255 255 Establece el ID de la unidad.

Destination
Address Dirección IPv4 –

Cuando [Transfer Mode] se establece en [Always],
establece la dirección IP de destino de la información
de seguimiento.

Destination
Port

De 1024 a 65534 40000
Cuando [Transfer Mode] se establece en [Always],
establece el número de puerto de destino de la
información de seguimiento.

Listen Port De 1024 a 65534 40000
Cuando [Transfer Mode] se establece en [On Demand],
establece el número de puerto en la unidad para
escuchar las peticiones de los clientes.
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Tally

Permite definir los ajustes de la luz indicadora de registro/grabación (“Conexión de una señal de registro”).

Tema relacionado

Conexión de una señal de registro

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Tally Lamp
Brightness

High / Low / Off High
Permite definir el brillo de la luz indicadora de
registro/grabación.

G Tally Lamp Enable / Disable Enable
Permite activar/desactivar la luz indicadora de
registro G.

Tally Control External / Internal Internal
Permite seleccionar el objetivo para aceptar la
información de control de la luz indicadora de
registro/grabación.

411



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

IR Remote

Permite definir la configuración relacionada con el control remoto infrarrojo.
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Setting On / Off On
Permite activar/desactivar el funcionamiento del
control remoto infrarrojo.
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RCP/MSU

Configura el ajuste cuando se conecta un RCP/MSU (opcional).
Para obtener más detalles, consulte “Conexión de un RCP/MSU (opcional)”.

Nota

Configura los ajustes del RCP/MSU según sea necesario.

Es necesario un MSU para un sistema multicámara.

Al usar varias unidades MSU, establezca una unidad MSU como la maestra y todas las demás como clientes.
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Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

CNS Mode
Off / Bridge / MCS /
PC Control

Off Define el modo de conexión para el RCP/MSU.

Master IP
Address

Dirección IPv4 0.0.0.0
Define la dirección IP del dispositivo maestro al
crear un sistema multicámara basado en LAN.

Camera No. Camera No. (1 a 96) 1
Define un número de cámara único dentro del
sistema al crear un sistema multicámara basado
en LAN.
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Lens Controller

Establece la configuración de un controlador del objetivo conectado (opcional).
Para obtener más detalles, consulte “Conexión de un controlador del objetivo”.

Nota

Cuando [Setting] se modifica, la unidad se reiniciará. Vuelva a cargar la página en el navegador web.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Setting On / Off Off
Establece si se va a utilizar el controlador del objetivo
(opcional).

Mode De 0 a 15 0

Establece el modo de funcionamiento del controlador del
objetivo (opcional).
Los valores en el rango de 0 a 15 están disponibles, pero los
valores reales que pueden seleccionarse variarán en función
del controlador del objetivo (opcional). Para obtener más
información, consulte las instrucciones de funcionamiento del
controlador del objetivo.

Reverse On / Off Off
Invierte el sentido de giro del controlador del objetivo
(opcional).

Initialize – – Inicializa el controlador del objetivo (opcional).

414



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Camera Name

Permite configurar los ajustes relacionados con el nombre de la cámara (nombre de la unidad).

Hasta ocho (de 0 a 8) de los siguientes caracteres pueden introducirse en Camera Name.
Caracteres alfanuméricos
Símbolos (espacio !#$`*+-./;<=>?@[\]^_`{|})
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Camera
Name

– FR7
Permite definir el nombre de la
cámara.
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User

Permite configurar los ajustes relacionados con el acceso de usuario de la unidad.

Ajustes relacionados con los usuarios del administrador (Administrator) (obligatorio)

Ajustes relacionados con usuarios generales (de User 1 a User 9) (opcional)

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

User Name – admin Permite definir el nombre del usuario.

Current
Password

– –
Cuando se cambia la contraseña, deberá
introducirse la actual.

New Password – –
Campo en el que se introduce la nueva
contraseña.

Re-Type
Password

– –
Campo en el que se introduce la nueva
contraseña de nuevo para verificarla.

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

User Name – – Permite definir el nombre del usuario.

Current
Password

– –
Cuando se cambia la contraseña, deberá
introducirse la actual.

New Password – –
Campo en el que se introduce la nueva
contraseña.

Re-Type
Password

– –
Campo en el que se introduce la nueva
contraseña de nuevo para verificarla.
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Wired LAN

Status
Muestra el estado de la red.

IPv4
Configura los ajustes relacionados con la red IPv4.

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Host Name – – Muestra el nombre del host.

MAC Address – – Muestra la dirección MAC de la unidad.

Ethernet Status – –
Muestra la velocidad de comunicación
actual.

IP Address – – Muestra la dirección IP de la unidad.

Subnet Mask – –
Muestra la máscara de subred de la
unidad.

Gateway – –
Muestra la puerta de enlace IPv4
predeterminada de la unidad.

Primary DNS
Server

– –
Muestra el servidor DNS principal de la
unidad.

Secondary DNS
Server – –

Muestra el servidor DNS secundario de la
unidad.

IPv6 Address 1 – – Muestra la dirección IPv6 1 de la unidad.

IPv6 Address 2 – – Muestra la dirección IPv6 2 de la unidad.

IPv6 Gateway – –
Muestra la puerta de enlace IPv6
predeterminada de la unidad.

Link-local IPv6
Address

– –
Muestra la dirección local de enlace IPv6
de la unidad.

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

DHCP On / Off On Activa y desactiva la función [DHCP].

IP Address – –
Permite definir la dirección IPv4 cuando la función
[DHCP] está en Off.

Subnet
Mask

– –
Define la máscara de subred cuando la función
[DHCP] está en Off.
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IPv6
Configura los ajustes relacionados con la red IPv6.

Common
Permite definir los ajustes comunes de las redes IPv4/IPv6.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Gateway – –
Permite definir la puerta de enlace IPv4
predeterminada cuando la función [DHCP] está en
Off.

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Obtain an IP
Address
Automatically

On / Off On
Activa y desactiva la adquisición de la dirección
IPv6.

IP Address – –
Permite definir la dirección IPv6 cuando la
función [Obtain an IP Address Automatically] está
en Off.

Prefix Length – –
Permite definir el prefijo cuando la función
[Obtain an IP Address Automatically] está en Off.

Gateway – –
Permite definir la puerta de enlace IPv6
predeterminada cuando la función [Obtain an IP
Address Automatically] está en Off.

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

HTTP Port 80, de 1024 a 65534 80 Permite definir el número de puerto HTTP.

DNS Auto On / Off On
Permite definir si se obtendrá la dirección
DNS del servidor DHCP.

Primary DNS
Server

Dirección IPv4/IPv6 –
Permite definir el servidor principal de DNS
cuando [DNS Auto] está en Off.

Secondary DNS
Server

Dirección IPv4/IPv6 –
Permite definir el servidor secundario de DNS
cuando [DNS Auto] está en Off.
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File Transfer

Configura los ajustes relacionados con la transferencia de archivos.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Auto Upload
(Proxy)

On / Off Off
Permite activar y desactivar la carga automática del
archivo proxy.

Default
Upload
Server

Server Settings1 a
3 > Display Name

Server Settings1

Selecciona el servidor de carga para los archivos. El
servidor seleccionado aquí se convierte en el destino de
carga automática para los archivos de proxy y el destino
de carga para los archivos desde la pantalla de imágenes
en miniatura.
Muestra los ajustes de [Display Name] configurados en
[Server Settings1 a 3].
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FTP Server 1 a 3

Configura los ajustes relacionados con la transferencia de FTP.
Los ajustes son comunes para FTP Server 1 a 3.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Display Name – –
Establece el nombre para mostrar que aparece en el
menú de configuración del destino de la
transferencia.

Service – – Muestra el tipo de servidor.

Host Name – – Establece el nombre de host del servidor de destino
de la transferencia.

Port
21, 990, de 1024 a
65534

21
Establece el número de puerto del servidor de
destino de la transferencia.

User Name – –
Establece el nombre del usuario para la
autenticación de la conexión del servidor de destino
de la transferencia.

Password – –
Establece la contraseña de autenticación de la
conexión del servidor de destino de la transferencia.

Passive Mode On / Off Off Permite activar y desactivar el modo pasivo.

Destination
Directory

– –
Permite introducir el nombre del directorio de
destino de la transferencia.

Using Secure
Protocol

On / Off Off
Permite definir si desea usar (On) o no (Off) las
transferencias FTP seguras.

Root
Certificate

– –

Permite cargar el certificado raíz para una
transferencia FTP segura.
Pulse el botón [Load] y seleccione un certificado raíz
de la pantalla que se muestra.
Pulse el botón [Delete] para eliminar el certificado
raíz cargado.

Root
Certificate
Status

– – Muestra el estado de carga del certificado de red.

Reset – –
Restablece los ajustes predeterminados de [Server
Settings].
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SSL

Configura los ajustes relacionados con SSL.

SSL
Activa/desactiva la función SSL.

SSL Server Authentication
Configura los ajustes relacionados con la autenticación del servidor de SSL.

Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Function
Disable / Enable / Enable (Allow HTTP
connection for some clients)

Disable
Activa/desactiva la
función SSL.

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external certificate

–
Define el método de instalación del certificado
del servidor de SSL.

Status – –

Muestra la validez del certificado del servidor
de SSL cuando [Certificate Options] se define
como [Use a self-signed certificate (For test
use)].

Issuer DN – –

Muestra el nombre diferenciado del emisor del
certificado del servidor de SSL cuando
[Certificate Options] se define como [Use a
self-signed certificate (For test use)].

Subject DN – –

Muestra el nombre diferenciado del sujeto del
certificado del servidor de SSL cuando
[Certificate Options] se define como [Use a
self-signed certificate (For test use)].

Available
Period

– –

Muestra el período de validez del certificado
del servidor de SSL cuando [Certificate
Options] se define como [Use a self-signed
certificate (For test use)].

Extended Key
Usage

– –
Muestra el método de uso de clave ampliada
cuando [Certificate Options] se define como
[Use a self-signed certificate (For test use)].
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Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Delete – –

Este botón se muestra cuando [Certificate
Options] está definido en [Use a self-signed
certificate (For test use)].
Elimina el certificado del servidor de SSL
instalado.

Import – –

Instala un certificado de servidor de SSL
externo de una lista cuando [Certificate
Options] se define como [Use an external
certificate].

Private Key
Password

– –

Permite definir la contraseña privada del
certificado del servidor de SSL cuando
[Certificate Options] se define como [Use an
external certificate].

Reset – – Mediante este botón se elimina la contraseña
privada para introducir una nueva.

Self-Signed
Certificate
Generation

– –

Pulse el botón [Generate] para generar un
certificado autofirmado cuando [Certificate
Options] se define como [Use a self-signed
certificate (For test use)].
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Referer Check

Permite configurar los ajustes relacionados con comprobaciones de Referer Check.

Exception List
Permite definir los ajustes relacionados con la lista de excepciones de Referer Check.

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Setting On / Off On
Activa o desactiva la función de Referer
Check.

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

No. De 1 a 10 – Define el número de excepción de la lista.

Host
Name

– – Define el nombre del host de la excepción.

Port
Number – – Define el número de puerto de la excepción.

Set – –
Pulse para registrar la excepción configurada en la lista
de excepciones.

Delete – –
Seleccione una excepción que desee eliminar y pulse el
botón para eliminar la excepción registrada de la lista de
excepciones.
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Brute Force Attack Protection

Permite configurar los ajustes relacionados con la prevención de ataques de fuerza bruta.

Cuando se detecta un atacante, se muestra la información de lista del atacante.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Setting On / Off On
Activa y desactiva la función [Brute Force Attack
Protection].

Count De 3 a 100 8
Define el número de intentos que se considerarán un
ataque.
Se habilita cuando [Setting] se ajusta en On.

Release
Mode

Always / Timer Timer

Permite definir la condición de liberación.
Se habilita cuando [Setting] se ajusta en On.
Always: no eliminar de la lista de atacantes.
Timer: eliminar de la lista de atacantes pasada la hora
de liberación definida con [Release Time].

Release
Time

De 30 a 86400 s 60

Define la hora de liberación.
Se habilita cuando [Setting] se ajusta en On.
Cuando Release Mode se ha definido en [Timer], las
entradas se eliminan de la lista de atacantes pasada la
hora de liberación.
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Stream

Permite definir los ajustes de transmisión (consulte “Acerca de la transmisión”).

Stream Setting
Permite configurar los ajustes relacionados con el protocolo de transmisión.

Nota

Para utilizar RTMP, ajuste de antemano [Stream] > [Audio Stream] > [Setting] en [On].

RTSP
Los siguientes elementos se muestran cuando [Stream Setting] se define como [RTSP].
Permite configurar los ajustes relacionados con la transmisión RTSP.

RTMP
Los siguientes elementos se muestran cuando [Stream Setting] se define como [RTMP].
Configura los ajustes relacionados con la transmisión RTMP.

Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Setting
RTSP / RTMP/ SRT-Caller / SRT-
Listener / NDI|HX / Off

RTSP
Permite seleccionar el protocolo
de transmisión.

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Port Number
554, de 1024 a
65534

554 Permite definir el número de puerto RTSP.

Time Out De 0 a 600 60 Especifica el tiempo de espera del comando
Keep Alive para la transmisión RTSP.

Authentication On / Off On
Activa y desactiva la función de autenticación de
RTSP.

Video Port
Number 1

De 1024 a 65534 51000
Define el número de puerto para enviar el vídeo
1 para la transmisión de unidifusión de RTSP.

Video Port
Number 2

De 1024 a 65534 53000
Define el número de puerto para enviar el vídeo
2 para la transmisión de unidifusión de RTSP.

Audio Port
Number

De 1024 a 65534 57000 Define el número de puerto para enviar el audio
para la transmisión de unidifusión de RTSP.
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SRT
Los siguientes elementos se muestran cuando [Stream Setting] se define como [SRT-Caller] o [SRT-Listener].
Configura los ajustes relacionados con la transmisión SRT.

NDI|HX
Los siguientes elementos se muestran cuando [Stream Setting] se define como [NDI|HX].
Configura los ajustes relacionados con NDI|HX.

Elemento Ajuste de
subelementos

Valor predeterminado
de fábrica Descripción

Server URL – –
Permite definir la URL del destino de la conexión
RTMP o RTMPS.

Stream Key – –
Configura la clave de flujo obtenida del lado del
servidor RTMP.

Root
Certificate

– –

Carga el certificado raíz necesario para la
conexión con el servidor RTMP.
Pulse el botón [Load] y seleccione un certificado
raíz de la pantalla que se muestra.
Pulse el botón [Delete] para eliminar el certificado
raíz cargado.
El estado se muestra en [Root Certificate Status].

Elemento Ajuste de subelementos Valor predeterminado
de fábrica Descripción

Destination – –
Permite definir la URL del destino de conexión
cuando la unidad funciona como emisor de la
llamada.

Port
Number

De 1024 a 65534 4201
Permite definir el número de puerto para que
escuche cuando la unidad funciona como
receptor.

Latency De 20 a 8000 ms 120 Permite definir la latencia.

TTL De 1 a 255 64 Define el valor de TTL.

Encryption Off / AES128 / AES256 Off
Activa o desactiva el cifrado y define el método
de cifrado.

Passphrase
0 o una cadena de entre
10 y 79 caracteres

0

Define la frase de contraseña que se ha usado
para el cifrado.
Pulse Reset para eliminar la frase de
contraseña introducida.

ARC On / Off On
Permite activar y desactivar Adaptive Rate
Control.

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

License – –
Muestra el estado de instalación de la clave de
licencia de NDI.
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Tema relacionado

Acerca de la transmisión
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Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Source Name – – Muestra el nombre de la fuente de NDI.

Group On / Off Off
Permite activar y desactivar la función de
agrupación de NDI.

Group Name – –
Se muestra cuando la función de agrupación de
NDI está en On.
Permite definir el nombre del grupo.

Discovery
Server 1

– – Permite definir el servidor 1 de exploración de
NDI.

Discovery
Server 2

– –
Permite definir el servidor 2 de exploración de
NDI.

Multicast
Mode

On / Off Off
Permite activar y desactivar la transmisión
multidifusión.

Multicast
Prefix

239.255.0.0 239.255.0.0

Se muestra cuando [Multicast Mode] está
definido en On.
Define el prefijo que debe usarse para la
transmisión de multidifusión.

Multicast
Netmask

255.255.0.0 255.255.0.0

Se muestra cuando [Multicast Mode] está
definido en On.
Define la máscara de red que determina el
rango de dirección de multidifusión.

Multicast TTL De 1 a 256 3

Se muestra cuando [Multicast Mode] está
definido en On.
Define el valor de TTL para la transmisión
multidifusión.

Multi-TCP
Mode

On / Off Off Permite activar y desactivar el modo Multi-TCP.

Unicast UDP
Mode

On / Off On
Permite activar y desactivar el modo Unicast
UDP.
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Video Stream

Permite configurar los ajustes relacionados con los códecs de vídeo de transmisión.

Video Stream 1
Permite configurar los ajustes relacionados con el códec de vídeo 1.

Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

Codec 1 H.264 / H.265 H.264
Permite definir el códec de la
imagen 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080
Permite definir el tamaño de la
imagen 1.

Frame Rate 1

Para obtener más información sobre
las velocidades de fotogramas
admitidas, consulte “Configuración
del códec de vídeo para la
transmisión”.

–
Permite definir la velocidad de
fotogramas de la imagen 1.

I-Picture Mode
1

Time / Frame Time

Permite definir el intervalo de
inserción IDR-Frame para la
imagen 1 como un periodo de
tiempo o un número de
fotogramas.

I-Picture
Interval 1

1 / 2 / 3 / 4 / 5 s 1

Se muestra cuando [I-Picture
Mode 1] está definido en Time.
Establece el intervalo de
inserción de IDR-Frame para
H.264 y H.265 como un periodo
de tiempo.

I-Picture Ratio 1 De 15 a 300 fotogramas 30

Se muestra cuando [I-Picture
Mode 1] está definido en Frame.
Establece el intervalo de
inserción de IDR-Frame para
H.264 y H.265 como un número
de fotogramas.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high
Permite definir el perfil H.264 o
H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Permite definir el modo de
compresión de velocidad de bits
de la imagen 1.
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Video Stream 2
Permite configurar los ajustes relacionados con el códec de vídeo 2.

Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

16000

Se muestra cuando [Bit Rate
Compression Mode 1] está
definido en On.
Permite definir el valor objetivo de
la velocidad de bits cuando el
modo de compresión de la
velocidad de bits está definido
como CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Permite definir la calidad H.264 o
H.265.

Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

Codec 2 H.264 / H.265 / Off Off
Permite definir el códec de la
imagen 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080
Permite definir el tamaño de la
imagen 2.

Frame Rate 2

Para obtener más información sobre
las velocidades de fotogramas
admitidas, consulte “Configuración
del códec de vídeo para la
transmisión”.

–

Se muestra cuando [Codec 2] no
está definido en Off.
Permite definir la velocidad de
fotogramas de la imagen 2.

I-Picture Mode
2

Time / Frame Time

Se muestra cuando [Codec 2] no
está definido en Off.
Permite definir el intervalo de
inserción IDR-Frame para la
imagen 2 como un periodo de
tiempo o un número de
fotogramas.

I-Picture
Interval 2

1 / 2 / 3 / 4 / 5 s 1

Se muestra cuando [Codec 2] no
está definido en Off y [I-Picture
Mode 2] está definido en [Time].
Establece el intervalo de
inserción de IDR-Frame para
H.264 y H.265 como un periodo
de tiempo.
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Video Stream 3
Permite configurar los ajustes relacionados con el códec de vídeo 3.

Elemento Ajuste de subelementos
Valor

predeterminado
de fábrica

Descripción

I-Picture Ratio 2 De 15 a 300 fotogramas 30

Se muestra cuando [Codec 2] no
está definido en Off y [I-Picture
Mode 2] está definido en [Frame].
Establece el intervalo de
inserción de IDR-Frame para
H.264 y H.265 como un número
de fotogramas.

Profile 2
H.264: high / main / baseline
H.265: main

–
Permite definir el perfil H.264 o
H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Se muestra cuando [Codec 2] no
está definido en Off.
Permite definir el modo de
compresión de velocidad de bits
de la imagen 2.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

8000

Se muestra cuando [Codec 2] no
está definido en Off y [Bit Rate
Compression Mode 2] está
definido en [On].
Permite definir el valor objetivo de
la velocidad de bits cuando el
modo de compresión de la
velocidad de bits está definido
como CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Se muestra cuando [Codec 2]
está definido en H.264 y [Bit Rate
Compression Mode 2] está
definido en Off.
Permite definir la calidad H.264 o
H.265.

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Codec 3 JPEG JPEG
Permite definir el códec
de la imagen 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Permite definir el tamaño
de la imagen 3.

Frame
Rate 3

Para obtener más información sobre las
velocidades de fotogramas admitidas, consulte
“Configuración del códec de vídeo para la
transmisión”.

–
Permite definir la
velocidad de fotogramas
de la imagen 3.
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Tema relacionado

Configuración del códec de vídeo para la transmisión
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Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Permite definir la
calidad.
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Audio Stream

Permite configurar los ajustes relacionados con el códec de audio de transmisión.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado de
fábrica Descripción

Setting On / Off Off
Activa/desactiva la salida de transmisión
de audio.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)

Se muestra cuando [Setting] está definido
en On.
Configura el códec de audio para la
transmisión.
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Language

Ajusta el idioma de visualización.

Nota

Los idiomas disponibles pueden variar según el país o la región.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos Valor predeterminado de fábrica Descripción

Language – – Ajusta el idioma de visualización.
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Accessibility

Configura los ajustes relacionados con la lectura de audio (texto a discurso oral).

Nota

Esta función solo se incluye en los modelos para Estados Unidos. La función de lectura de pantalla solo puede usarse si el
idioma se define como inglés (en la fecha de lanzamiento).

Habilite la función de lectura de la pantalla del navegador web en el dispositivo que ejecuta la Aplicación Web.

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Screen
Reader

On / Off Off 
Activa/desactiva la función de lectura de
pantalla en el panel de imagen de la cámara de
la Aplicación Web.

Speech
Rate

Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 / Fast4

Normal

Define la velocidad de la función de lectura de
pantalla.
Se lee un fragmento de un pasaje a la
velocidad cofigurada.

Speech
Volume

De 1 a 15 7

Permite definir el volumen de la función de
lectura de la pantalla de la Aplicación Web.
Se lee un fragmento de un pasaje en voz alta
con el volumen configurado.
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Clock Set

Configura los ajustes del reloj interno.
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Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Current Date
& Time

– –
Muestra la hora configurada en la
unidad.

PC Clock – –
Muestra la hora de la tablet o el
ordenador que se utilizan para la
configuración.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd
Permite seleccionar el formato de
visualización de la fecha y la hora.

12 h / 24 h 12 h / 24 h 24 h
Permite definir el formato de hora en 12
horas o 24 horas.

Time Setting
Keep current setting / Synchronize
with PC / Manual setting /
Synchronize with NTP

–
Permite definir el método de
configuración de fecha y hora.

yy-mm-dd
hh:mm:ss

yy: de 19 a 37
mm: de 01 a 12
dd: de 01 a 31
hh: de 00 a 23
mm: de 00 a 59
ss: de 00 a 59 (segundos)

–

Se muestra cuando [Time Setting] está
definido en Manual setting.
Permite ajustar la fecha y la hora
manualmente.

NTP Auto On / Off Off

Se muestra cuando [Time Setting] está
definido en Synchronize with NTP.
Permite definir si se obtendrá la
dirección IP del servidor NTP desde el
servidor DHCP.

NTP Server
Dirección IPv4/IPv6 o nombre de
host

–

Se muestra cuando [Time Setting] está
definido en [Synchronize with NTP] y
[NTP Auto] está definido en Off.
Especifica el servidor NTP utilizado para
la sincronización de tiempo.

Time Zone De UTC − 12:00 a UTC + 14:00 – Selecciona la zona horaria.
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Reset

Inicializa la unidad.

Reboot
Reinicia la unidad.

Reset
Restablece los ajustes predeterminados de la unidad.

Elemento Ajuste de
subelementos

Valor predeterminado de
fábrica Descripción

Reboot Execute –

Reinicia la unidad.
Execute: Ejecutar la función.

Nota

Una vez reiniciada, vuelva a cargar la página en
el navegador web.

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

All Reset (except
for Network
Settings)

Execute –

Restablece los ajustes predeterminados de la
unidad (excepto los ajustes de red).
Execute: Ejecutar la función.

Nota

Los archivos de LUT y los aspectos básicos
importados no se eliminan.

Network Reset Execute –

Restablece los ajustes de red de la unidad.
Execute: Ejecutar la función.

Nota

Tras ejecutar Network Reset, la unidad se
reiniciará. Una vez reiniciada, vuelva a cargar
la página en el navegador web.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Factory Default Execute –

Devuelve los ajustes de la unidad a los ajustes
predeterminados de fábrica.
Execute: Ejecutar la función.

Nota

Tras ejecutar Factory Default, la unidad se
reiniciará. Una vez reiniciada, vuelva a cargar
la página en el navegador web.
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Information

Muestra información de la cámara y el objetivo. También se utiliza para actualizar el software.

Camera
Muestra la información de la cámara y actualiza el software.

Lens
Muestra la información del objetivo y permite actualizar el software.

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Model
Name

– – Muestra el nombre del modelo de la cámara.

Serial
Number

– – Muestra el número de serie de la cámara.

Version
Number

– – Muestra la versión de software de la cámara.

Version Up – –

Pulse el botón [Choose File] y siga las instrucciones en
pantalla para actualizar el software de la cámara.

Nota

La unidad se reiniciará automáticamente tras la
actualización. Una vez reiniciada, vuelva a cargar la
página en el navegador web.

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Model
Name

– – Muestra el nombre de modelo del objetivo.

Serial
Number

– – Muestra el número de serie del objetivo.

Version
Number

– – Muestra la versión de software del objetivo.
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Tema relacionado
Actualización del software del objetivo de montura E

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

Version Up – –

Pulse el botón [Choose File] y siga las instrucciones en
pantalla para actualizar el software del objetivo.

Para obtener más información, consulte
“Actualización del software del objetivo de montura
E”.

Nota

La unidad se reiniciará automáticamente tras la
actualización del objetivo. Una vez reiniciada, vuelva a
cargar la página en el navegador web.
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System Log

Permite definir los ajustes relacionados con el registro del sistema.

El registro adquirido se muestra como se indica a continuación.

Tema relacionado

Actualización del software del objetivo de montura E

5-041-957-43(1) Copyright 2022 Sony Corporation

Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Permite definir el nivel para añadir una entrada
al registro del sistema.

Log Size De 200 a 1024 1024
Permite definir el tamaño de la entrada que se
registrará en el sistema.

Download
as File

– –
Pulse el botón [Download] y guarde el registro
del sistema en una tablet o en un ordenador
desde la pantalla de visualización.
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HTTP Access Log

Configura los ajustes relacionados con el registro de acceso de HTTP.
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Elemento Ajuste de subelementos
Valor

predeterminado de
fábrica

Descripción

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

Permite definir el nivel para añadir una entrada al
registro de acceso HTTP.

Log Size De 200 a 1024 1024
Permite definir el tamaño del registro para
guardarlo en el registro de acceso HTTP.

Download
as File

– –
Pulse el botón [Download] y guarde el registro de
acceso HTTP en una tablet o en un ordenador
desde la pantalla de visualización.
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Service

Permite obtener información del dispositivo acerca de la unidad. Resulta práctico a la hora de ponerse en contacto con
el representante del servicio de asistencia de Sony.
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Elemento Ajuste de
subelementos

Valor
predeterminado de

fábrica
Descripción

I agree to
download device
information.

– –

Marque esta casilla para indicar que está de acuerdo
con obtener información del dispositivo y pulse el botón
[OK].
Pulse el botón [Download] que aparece. El navegador
web descargará un archivo denominado
deviceinformation.dat momentáneamente.

Nota

La unidad se reiniciará automáticamente al finalizar la
descarga. Reinicie manualmente si la unidad no se
reinicia automáticamente. Una vez reiniciada, vuelva a
cargar la página en el navegador web.
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EULA

Muestra el contrato de licencia de usuario final (EULA).

5-041-957-43(1) Copyright 2022 Sony Corporation
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Software

Muestra la licencia de software.

5-041-957-43(1) Copyright 2022 Sony Corporation

445



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Conexión de dispositivos de grabación y monitores externos

Para mostrar imágenes de grabación o reproducción en un monitor externo, seleccione el tipo de salida de vídeo del
monitor externo y utilice un cable adecuado para conectar el monitor.
Puede conectar un dispositivo de grabación externo y grabar la señal de salida de la unidad.
Puede mostrar la misma información que aparece en el panel de imagen de la cámara, como por ejemplo, la información
de estado y los menús, en un monitor externo. Ajuste el tipo de sistema deseado para la imagen de pantalla en On con
[Monitoring] > [Output Display] en el menú web.

Nota

Si un monitor conectado al conector HDMI no es compatible con el formato de salida de HDMI configurado en el menú
[Monitoring] del menú web o el menú de la cámara, la imagen de la cámara no se mostrará en la Aplicación Web. El vídeo de
transmisión tampoco se emitirá.

Puede definir [Output Display] > [SDI] y [HDMI/Stream] en [Off] pero, de esta manera, se impedirá el uso del menú de la cámara
y las funciones de la cámara que dependen de la imagen en pantalla. Además, las notificaciones de error de la unidad solo se
emitirán a través de las luces indicadoras (encendidas o parpadeando) y la imagen de la marca de notificación de la parte
superior derecha de la Aplicación Web. Para ver el estado detallado, defina [Output Display] en [On].

Sugerencia

[Output Display] > [SDI] está definido en [Off] y [HDMI/Stream] está definido en [On] en los valores predeterminados de fábrica.
Para usar la transmisión como vídeo principal, defina [SDI] en [On] y [HDMI/Stream] en [Off] y supervise el estado de la cámara
en un monitor SDI.

Conector SDI OUT (tipo BNC)

Defina el formato de salida en el menú [Monitoring] del menú web o el menú de la cámara.
Utilice un cable coaxial de 75 Ω disponible en el mercado para realizar la conexión.

Nota

Compruebe que la conexión entre la unidad y el dispositivo externo está conectada a tierra antes de encender los dispositivos.

Se recomienda que la unidad y el dispositivo externo se enciendan después de conectar el cable coaxial de
75 Ω.
Si el dispositivo externo se debe conectar a la unidad mientras este está encendido, conecte primero el cable coaxial de
75 Ω al dispositivo externo y, a continuación, conéctelo a la unidad.

Para iniciar una grabación en la unidad y en el dispositivo externo simultáneamente
Con la salida de señal SDI habilitada, ajuste [Project] > [SDI/HDMI Rec Control] > [Setting] a [SDI/HDMI Remote I/F] o
[Parallel Rec] en el menú de la cámara para habilitar la salida de una señal de activación REC hacia el dispositivo
externo conectado en el conector SDI OUT. Esto sincronizará la grabación en el dispositivo externo con la unidad.

Nota

Si el dispositivo externo conectado no es compatible con la señal de activación REC, el dispositivo no se podrá utilizar.

Cuando [Project] > [SDI/HDMI Rec Control] > [Setting] se ajusta en [SDI/HDMI Remote I/F] en el menú de la cámara, solo se
emite la señal de activación REC cuando no hay ningún soporte de grabación insertado en ese momento y se ha pulsado el
botón START/STOP para iniciar o detener la grabación.
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Conector HDMI OUT (conector tipo A)

Defina el ajuste de salida On/Off y el formato de salida en el menú [Monitoring] del menú de la cámara.

Para iniciar una grabación en la unidad y en el dispositivo externo simultáneamente
Con la salida de señal HDMI habilitada, ajuste [TC/Media] > [HDMI TC Out] > [Setting] a [On] y [Project] > [SDI/HDMI
Rec Control] > [Setting] a [SDI/HDMI Remote I/F] o [Parallel Rec] en el menú de la cámara para habilitar la salida de una
señal de activación REC hacia el dispositivo externo conectado en el conector HDMI OUT. Esto sincronizará la
grabación en el dispositivo externo con la unidad.

Nota

Si el dispositivo externo conectado no es compatible con la señal de activación REC, el dispositivo no se podrá utilizar.

Cuando [Project] > [SDI/HDMI Rec Control] > [Setting] se ajusta en [SDI/HDMI Remote I/F] en el menú de la cámara, solo se
emite la señal de activación REC cuando no hay ningún soporte de grabación insertado en ese momento y se ha pulsado el
botón START/STOP para iniciar o detener la grabación.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Conexión con un RCP/MSU

Algunas funciones de la unidad pueden controlarse de manera remota conectando un panel de control remoto (RCP),
como el RCP-3500/3501, o una unidad de configuración maestra (MSU), como la MSU-3500, a la unidad mediante un
cable LAN.
El método de conexión variará según la configuración de los dispositivos relacionados y la aplicación.

Para obtener más información sobre la conexión de uno a uno entre la unidad y un RCP, consulte “Conexión de uno
a uno entre la unidad y un RCP”.
Para obtener más información sobre la conexión de varias cámaras con una MSU o un software de control de la
cámara, consulte “Uso de la unidad en un entorno multicámara con una MSU/software de control remoto de la
cámara”.

Tema relacionado

Conexión de uno a uno entre la unidad y un RCP

Uso de la unidad en un entorno multicámara con una MSU/software de control remoto de la cámara

5-041-957-43(1) Copyright 2022 Sony Corporation
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Conexión de uno a uno entre la unidad y un RCP

Nota

Consulte “Lista de funciones compatibles” y configure la unidad para que cumpla con las condiciones operativas de las funciones
que desea usar; a continuación, habilite la conexión con un RCP mediante el siguiente procedimiento.

Tema relacionado
Lista de funciones compatibles

5-041-957-43(1) Copyright 2022 Sony Corporation

Encienda todos los dispositivos.1

Establezca [Technical] > [RCP/MSU] > [CNS Mode] en [Bridge] en el menú web de la cámara.2

Configure los siguientes ajustes en el RCP.

Para obtener más información acerca de la configuración, consulte las instrucciones de funcionamiento del RCP.

3

Configure el modo de conexión en modo Bridge.1.
Registre la dirección IP de la cámara.2.
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Uso de la unidad en un entorno multicámara con una MSU/software de control remoto
de la cámara

Puede conectar varias cámaras con una MSU o un software de control remoto de la cámara.

Nota

Consulte “Lista de funciones compatibles” y configure la unidad para que cumpla con las condiciones operativas de las funciones
que desea usar; a continuación, habilite la conexión con una MSU o un software de control remoto de la cámara mediante el
siguiente procedimiento.

Tema relacionado

Lista de funciones compatibles
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Encienda todos los dispositivos.1

Configure los ajustes de red del sistema con la MSU o un software de control remoto de la cámara.

Para obtener más información acerca de la configuración, consulte las instrucciones de funcionamiento de la MSU
o el software de control remoto de la cámara.

2

Configure los siguientes ajustes con [Technical] > [RCP/MSU] en el menú web de la cámara.3

Si usa una MSU, establezca [CNS Mode] en [MCS]. Si usa un software de control remoto de la cámara,
establezca [CNS Mode] en [PC Control].

1.

Defina la dirección IP de la MSU maestra o el software de control remoto de la cámara en [Master IP Address].2.
Defina el número de la cámara para el que esta se registrará en [Camera No.].3.
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Lista de funciones compatibles

La siguiente tabla muestra las funciones compatibles y sus condiciones de funcionamiento correspondientes.

Panel de
funcionamiento Funciones de la unidad Condiciones de funcionamiento

IRIS Ajuste manual del diafragma –

AUTO IRIS Activación o desactivación de Auto Iris –

ND
Cambio de la posición predeterminada del filtro
ND (Clear/Preset1 a Preset3)

Esta función se activa cuando [Shooting] >
[ND Filter] > [Mode] se establece en [Preset]
en el menú de la cámara.

MASTER GAIN
Ajuste manual de la ganancia (unidades de
3 dB)

Se activa cuando el modo de filmación se
define como Custom y [Shooting] >
[ISO/Gain/EI] > [Mode] se establece en [dB]
en el menú de la cámara.

WHITE (R/B)
Ajuste manual del balance de blancos (R
Gain/B Gain)

Se muestra cuando [White Mode] se
establece en [Memory A(R/B)] o [Memory
A(T/T)].WHITE (Color

Temp)

Ajuste manual del balance de blancos
(temperatura del color/matiz)

RCP – [Color Temp]: temperatura del color
del balance de blancos
RCP – [Balance]: valor del matiz del balance
de blancos

ATW
Activación o desactivación de la función ATW
(Auto Tracing White Balance)

Se habilita cuando el modo de filmación se
establece en Custom.

BLACK R/B Ajuste del balance de negros
Se habilita cuando el modo de filmación se
establece en Custom.
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Nota

Configure la unidad para que cumpla con las condiciones operativas de las funciones que desea usar; a continuación, habilite la
conexión con un RCP/MSU. Si las condiciones de funcionamiento se ajustan después de habilitar la conexión, puede ocurrir un

Panel de
funcionamiento Funciones de la unidad Condiciones de funcionamiento

MASTER BLACK Ajuste del nivel de negro maestro

Se habilita cuando el modo de filmación se
establece en Custom.
H/V Ratio y Crispening se habilitan cuando
[Paint/Look] > [Detail] > [Manual Setting]
se establece en [On] en el menú de la
cámara.

DETAIL

Activación y desactivación de la función de
detalles
Ajuste del nivel de detalle
Ajuste H/V Ratio
Ajuste Crispening

User Matrix

Activación y desactivación de la función de
corrección matricial del usuario
Ajuste de los valores de corrección matricial
(R-G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Activación y desactivación de la función de
corrección de matrices múltiples
Ajuste del tono y la saturación del color
utilizado para la corrección de matrices
múltiples

Knee

Activación y desactivación de la función de
corrección de inflexión
Activación y desactivación de la función de
inflexión automático
Ajuste del punto de inflexión y de la pendiente
de inflexión

BARS
Activación y desactivación de las barras de
colores

SHUTTER

Activación y desactivación del obturador
automático
Ajuste del valor de la velocidad de
obturación
(no se admite la activación/desactivación del
obturador automático, el ajuste del
obturador angular, el ajuste del obturador
lento ni el ajuste de ECS).

Nota

Los ajustes del obturador RCP pueden no
visualizarse dependiendo del valor de
velocidad de obturación configurado.

Es posible que los ajustes del obturador
del RCP no se muestren correctamente si
el obturador no se puede accionar desde
el RCP.

Cuando el obturador automático está
activado, el obturador automático continuará
funcionando aunque active/desactive el
obturador o cambie el valor de la velocidad de
obturación desde el RCP.
Cuando el obturador está ajustado en [Angle],
no es posible activar/desactivar el obturador ni
cambiar el ajuste de velocidad de obturación
desde el RCP.

452



comportamiento inesperado.
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Acerca del funcionamiento con un controlador remoto RM-IP500 (opcional)

Puede utilizar la unidad mediante un controlador remoto Sony RM-IP500 con una versión de software 2.2 o posterior.
Los dispositivos se comunican a través de VISCA over IP (LAN).
Dependiendo del elemento objetivo que se utilice, es posible que necesite visualizar la pantalla de la unidad. Prepare un
monitor que pueda usarse para consultar la pantalla.
Las siguientes operaciones se admiten desde un controlador remoto RM-IP500.

Selección de la cámara objetivo.
Ajuste del encuadre (inclinación, giro, zoom)
Ajuste del enfoque (excepto el funcionamiento táctil)
Registro y recuperación de posiciones preestablecidas
Funcionamiento del menú de la unidad (excepto el menú web)
Ajuste del brillo
Ajuste del balance de blancos
Ajuste del balance de negros
Ajuste del nivel de entrada de audio
Iniciar/detener grabación
Ejecución de funciones de botones asignables de la unidad

Para obtener más información acerca del funcionamiento de RM-IP500, consulte las instrucciones de funcionamiento de
RM-IP500.

Sugerencia

Al utilizar RM-IP500, utilice la hoja del panel para esta unidad que se suministra con RM-IP500.

RM-IP500 (mediante la hoja de panel de esta unidad)
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Conexión de un controlador remoto RM-IP500

Para obtener más información acerca de la asignación de funciones, consulte las instrucciones de funcionamiento de
RM-IP500.

5-041-957-43(1) Copyright 2022 Sony Corporation

Defina el interruptor 3 SETUP de la unidad en posición ON para habilitar la comunicación de VISCA over IP.

Nota

El ajuste de interruptor se aplica cuando la unidad vuelve a encenderse.

1

Conecte RM-IP500 a la misma red que la unidad.2

Siga el proceso que se describe en las instrucciones de funcionamiento de RM-IP500 para configurar la
conexión de VISCA over IP (LAN) en RM-IP500.

Asigne esta unidad en el menú RM > AUTO IP SETUP > ASSIGN CAM.

3

Asigne las funciones de esta unidad a los botones según se requiera a partir de los siguientes elementos
de menú de RM del RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Acerca de la sincronización con un dispositivo externo

Al filmar empleando varias unidades, es posible sincronizarlas a una señal de referencia o a un código de tiempo
específico a través del conector GENLOCK de las unidades.

Para obtener más detalles acerca de Genlock, consulte “Sincronización de la fase de la señal de vídeo (Genlock)”.
Para obtener más detalles acerca de la sincronización de códigos de tiempo, consulte “Bloqueo del código de tiempo
en otros dispositivos”.

Tema relacionado

Sincronización de la fase de la señal de vídeo (Genlock)

Bloqueo del código de tiempo en otros dispositivos

5-041-957-43(1) Copyright 2022 Sony Corporation
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Sincronización de la fase de la señal de vídeo (Genlock)

Puede proporcionar una señal de referencia al conector de Genlock para habilitar Genlock.
Las señales de referencia de entrada que pueden usarse varían según la frecuencia del sistema del formato de
grabación seleccionado.

Puede comprobar el estado de sincronización externa en [Technical] > [Genlock] > [Reference] en el menú de la cámara.

Nota

Si la señal de referencia es poco estable, no podrá obtenerse Genlock.

El portador secundario no está sincronizado.
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Formato de grabación de frecuencia del sistema Señales de referencia de entrada admitidas

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i 1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Bloqueo del código de tiempo en otros dispositivos

Ajuste la unidad que proporciona el código de tiempo en un modo en el que la salida del código de tiempo siga
funcionando (por ejemplo, Free Run o Clock).

Nota

Compruebe que el código de tiempo de referencia y la señal de vídeo de referencia que se han proporcionado están en una
relación de fase que cumple con el estándar de código de tiempo de SMPTE.

Cuando se utiliza el bloqueo externo, el código de tiempo obtendrá el bloqueo con el código de tiempo externo de forma
instantánea y el valor de este código de tiempo externo aparecerá en el área de visualización de datos de tiempo. Sin embargo,
no comience a grabar inmediatamente. Espere unos segundos antes de comenzar a grabar hasta que el generador de
sincronización se estabilice.

Si la frecuencia de la señal de vídeo de referencia y la frecuencia de fotogramas de la unidad no son iguales, no se podrá
conseguir un bloqueo y la unidad no funcionará correctamente. Si esto ocurre, el código de tiempo no conseguirá un bloqueo
correcto con el código de tiempo externo.

Si la fuente externa del código de tiempo se desconecta, dicho código podría cambiar en un fotograma por hora respecto al
código de tiempo de referencia.

Para liberar el bloqueo externo
Cambie el ajuste [TC/Media] > [Timecode] en el menú de cámara.
La sincronización externa también se libera si se cambia la frecuencia del sistema y cuando comienza a grabar en un
modo de grabación especial (movimiento a cámara lenta y rápida o Interval Rec).

5-041-957-43(1) Copyright 2022 Sony Corporation

Ajuste lo siguiente con [TC/Media] > [Timecode] en el menú de la cámara.

Establezca [Mode] en [Preset].
Establezca [Run] en [Free Run].

1

Pulse un botón asignable correspondiente a la función [DURATION/TC/U-BIT] para mostrar el código de
tiempo en la ventana.

2

Proporcione una señal de vídeo de referencia de SD o HD al conector GENLOCK y el código de tiempo de
referencia al conector TC IN.

El generador de códigos de tiempo de la unidad se bloqueará con el código de tiempo de referencia y “EXT-LK”
aparecerá en la pantalla.
Después de que hayan transcurrido diez segundos desde el bloqueo del código de tiempo, el estado de bloqueo
externo se mantendrá incluso si se desconecta la fuente externa de códigos de tiempo.

3
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Conexión de un micrófono externo o un dispositivo de audio externo

La señal puede recibirse a través de un micrófono externo o un dispositivo de audio externo, e integrar el audio en el
vídeo grabado o de salida de la unidad.

Conecte un micrófono externo o un dispositivo de audio externo mediante un cable XLR.

Cuando el audio se define como [LINE] mediante [Audio] > [Audio Input] > [AUDIO IN Select] en el menú de la
cámara, el conector AUDIO IN funciona como el conector AUDIO IN CH-1 y el conector AUDIO IN CH-2.

1

N.º de pin Función

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Apague la unidad y conecte el cable XLR al conector AUDIO IN.2

Defina el interruptor SETUP 2 para habilitar la fuente de alimentación fantasma según necesite.

Active la fuente de alimentación +48 V (alimentación fantasma) como se describe a continuación.
Interruptor 2
Establece si la fuente de alimentación de +48 V (alimentación fantasma) está encendida/apagada cuando se
conecta el dispositivo de entrada de audio.

3

Ajuste Descripción

OFF
(predeterminado)

Desactiva la fuente de alimentación fantasma de +48 V y establece la entrada LINE o MIC
como la fuente de audio CH-1 y CH-2.
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Nota

Si establece el interruptor en la posición ON y conecta un micrófono que no sea compatible con fuentes de +48 V, es
posible que el dispositivo conectado sufra daños. Compruebe el ajuste antes de conectar el dispositivo.

Ajuste Descripción

ON
Activa la fuente de alimentación fantasma de +48 V y establece el micrófono compatible
con la fuente de alimentación fantasma como la fuente de audio CH-1 y CH-2.

Encienda la unidad y defina el tipo de dispositivo conectado en [Audio] > [Audio Input] > [AUDIO IN Select]
en el menú de la cámara.

4
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Gestión/edición de clips con un ordenador

Es posible gestionar/editar clips mediante un ordenador.

Importación de clips a partir de un lector de tarjetas (opcional)

Conecte un lector de tarjeta CFexpress Tipo A o SD al ordenador y utilice un software que admita el formato de
grabación de la unidad, como Catalyst Browse, para importar los clips.

Uso de un sistema de edición no lineal

En un sistema de edición no lineal, es necesario disponer de software de edición (opcional) que sea compatible con los
formatos grabados por la unidad.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Emisión de una señal de fibra óptica

Puede emitir una señal SDI convertida a señal óptica conectando un módulo SFP+ (opcional) al conector OPTICAL de la
unidad. Utilice un módulo SFP+ que coincida con la banda de señal de cada formato.
Banda de señal

4K (59.94p, 50p): 12G
4K (59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (distinto de 59.94p, 50p): 1.5G

Nota

Utilice un módulo que cumpla con los siguientes estándares.

Estándares SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Estándares SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

La misma señal que la del conector de salida SDI se emite al módulo SFP+.

La unidad no admite entrada de señal de fibra óptica.

Utilice un módulo SFP+ para la salida de señal de fibra óptica. Para obtener más información acerca de los módulos SFP+
verificados, póngase en contacto con su distribuidor o con el servicio de asistencia técnica de Sony.

5-041-957-43(1) Copyright 2022 Sony Corporation

* Nivel de alimentación I (1,0 W)
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Conexión de una señal de registro

En este tema se describe el control de una señal de registro.

Cómo activar la luz indicadora de registro desde un control remoto

Puede activar la luz indicadora de registro a partir de un comando VISCA over IP desde un dispositivo externo, como el
RM-IP500.
Establezca [Technical] > [Tally] > [Tally Control] en [External] en el menú web o en el menú de la cámara.

Activar la luz indicadora de registro desde un dispositivo externo

Puede activar la luz indicadora de registro de la unidad en color rojo o verde desde un dispositivo externo, como el RM-
IP500 o un interruptor. Puede controlar la luz indicadora mediante comandos que se transmiten por la red o a través de
la entrada de una señal de luz indicadora de registro en el conector OPTION de la unidad.
Establezca [Technical] > [Tally] > [Tally Control] en [External] en el menú web o en el menú de la cámara.
Al introducir una señal de registro en el conector OPTION, se produce un cortocircuito en el pin 7 a GND (pines 4 o 5)
que provoca que se active la luz indicadora de registro en verde, o en el pin 8 a GND (pines 4 o 5) que provoca que se
active la luz indicadora de registro en rojo.

Nota

Cuando [Tally Control] se establece en [External], la luz indicadora de registro no indica el estado de grabación de la unidad.

Cuando se introduce una luz indicadora roja y otra verde de manera simultánea, la luz indicadora de la unidad se iluminará en
rojo.

Especificaciones de pin del conector OPTION

N.º de
pin

Dirección de la
señal Especificaciones de señal

1 – Señal RS-232C TX (para el controlador del objetivo)

2 – Señal RS-232C RX (para el controlador del objetivo)

3 OUT

Salida de luz indicadora de registro en verde
Nivel bajo de entrada cuando se enciende la luz indicadora de registro en verde.
Hi-Z (salida de colector abierto) cuando no se enciende la luz indicadora de
registro verde.

4 – GND (tierra)
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Cómo activar la luz indicadora de registro de un dispositivo externo mediante una señal de la
unidad

Puede activar la luz indicadora de registro de un dispositivo externo mediante una señal de la unidad conectando los
pines 3 y 6 del conector OPTION como se indica a continuación.
Ejemplo de conexión de pines 3 y 6 del conector OPTION

Nota

No aplique tensión a los pines 7 y 8.

No conecte un dispositivo externo que pueda provocar tensión al conector OPTION.

Si se produce una tensión inversa o un pico de tensión que supera los límites en los pines 3 o 6, es posible que provoque una
avería, humo, o fuego.

Establezca la señal de salida con [Technical] > [Tally] > [Tally Control] en el menú web o en el menú de la cámara.
[Internal]: estado de funcionamiento de la grabación de la unidad.
[External]: Logical-AND de las señales de registro roja/verde recibidas por la unidad a través de las señales IN o de los
controladores remotos.

5-041-957-43(1) Copyright 2022 Sony Corporation

N.º de
pin

Dirección de la
señal Especificaciones de señal

5 – GND (tierra)

6 OUT

Salida de luz indicadora de registro en rojo
Nivel bajo de entrada cuando se enciende la luz indicadora de registro en rojo.
Hi-Z (salida de colector abierto) cuando no se enciende la luz indicadora de
registro roja.

7 IN
Entrada de control externo de registro en verde
El cortocircuito a la toma de tierra (pines 4 o 5) provoca que la luz indicadora de
registro de la unidad se ilumine en verde.

8 IN
Entrada de control externo de registro en rojo
El cortocircuito a la toma de tierra (pines 4 o 5) provoca que la luz indicadora de
registro de la unidad se ilumine en rojo.
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Emisión de datos de seguimiento (free-d)

La unidad puede emitir información de posición de giro/inclinación/zoom, enfoque y seguimiento del diafragma
sincronizado con una señal de sincronización.
La salida de datos es conforme con el protocolo free-d, un estándar industrial. Puede seleccionar el método de salida,
elegir entre salida constante y salida a petición de los clientes. Seleccione el método de salida según su sistema VR/AR.

Formato de salida de datos

Sugerencia

Encontrará los detalles técnicos en el “Manual de integración para free-d”. Póngase en contacto con un representante comercial
de Sony.

Los datos de seguimiento que emite la unidad comprenden los siguientes datos según el formato especificado en el
Type D0/D1 del protocolo free-d.
Type D0 – poll/command

Compruebe que la unidad esté encendida.1

Establezca el método de salida de datos de seguimiento.

Para salida constante

Para la salida a petición de los clientes

2

Establezca [Technical] > [Tracking Data Output] > [Transfer Mode] en [Always] en el menú web.1.
Establezca el ID de la unidad en [Camera ID].2.
Especifique la dirección IP de destino de salida en [Destination Address].3.
Especifique el número de puerto de destino de salida en [Destination Port].4.
Pulse el botón [OK].5.

Establezca [Technical] > [Tracking Data Output] > [Transfer Mode] en [On Demand] en el menú web.1.
Establezca el ID de la unidad en [Camera ID].2.
Especifique el número de puerto para escuchar las peticiones de los clientes en [Listen Port].3.
Pulse el botón [OK].4.

Símbolo Contenido Descripción

<D0> Message type

<CA> Camera ID

<CD> command

Admite los siguientes comandos:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

Nota

Es posible que los datos de seguimiento se retrasen o que los valores no se actualicen en las siguientes situaciones:

Cuando se emite el vídeo RAW
Cuando S&Q Motion está encendido
Cuando se muestra el menú de la cámara
Cuando se muestra la pantalla de imágenes en miniatura
Cuando se reproducen clips grabados
Cuando se muestra el menú web

5-041-957-43(1) Copyright 2022 Sony Corporation

Símbolo Contenido Descripción

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Ángulo de giro (−170° a +170°)

<TH><TM><TL> Camera Tilt Angle Ángulo de inclinación (−30° a +195°)

<RH><RM><TL> Camera Roll Angle No compatible (siempre 0)

<XH><XM><XL> Camera X-Position No compatible (siempre 0)

<YH><YM><YL> Camera Y-Position No compatible (siempre 0)

<HH><HM><HL> Camera Height No compatible (siempre 0)

<ZH><ZM><ZL> Camera Zoom Longitud focal

<FH><FM><FL> Camera Focus Distancia focal

<SH><SL> Spare/User Defined Posición del diafragma

<CK> Checksum
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Conexión de un controlador del objetivo

Puede utilizar el zoom de un objetivo con zoom manual desde la Aplicación Web, RM-IP500 (opcional) o el control
remoto infrarrojo conectando un controlador del objetivo disponible en el mercado (opcional) que sea compatible con
esta unidad.
Para obtener más información acerca de la conexión de un controlador del objetivo, consulte las instrucciones de
funcionamiento del controlador del objetivo.
Para obtener más detalles acerca del ajuste del zoom mediante un controlador del objetivo, consulte “Ajuste del zoom
mediante un controlador del objetivo”.

Nota

Antes de utilizar un controlador del objetivo, lea atentamente el manual de instrucciones del controlador del objetivo y asegúrese
de que comprende perfectamente su uso. Sony no se hace responsable de las reclamaciones de cualquier tipo derivadas del uso
de un controlador del objetivo.

Clear Image Zoom no está disponible cuando un controlador de objetivo está activado. Se recomienda ajustar la relación de
Clear Image Zoom a 1.0× o desactivar Clear Image Zoom.

Cuando el controlador del objetivo está activado, las operaciones de encuadre de la cámara no se pueden grabar ni reproducir.

Tema relacionado

Ajuste del zoom mediante un controlador del objetivo

5-041-957-43(1) Copyright 2022 Sony Corporation
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Ajuste del zoom mediante un controlador del objetivo

Siga este procedimiento para acoplar un controlador del objetivo (opcional) y ajustar el zoom.

Para comprobar el estado del controlador del objetivo
Pulse el botón  (estado de la cámara) en el área común de la pantalla de la Aplicación Web para mostrar la pantalla
de estado de la cámara.

Conecte un controlador del objetivo al conector OPTION del bloque de conectores de la unidad.

Para obtener más información acerca de la fijación, consulte las instrucciones de funcionamiento del controlador
del objetivo.

1

Configure el controlador del objetivo para su objetivo con zoom.

Para obtener más información, consulte las instrucciones de funcionamiento del controlador del objetivo.

2

Bloquee el giro/inclinación de la unidad y acople el objetivo con zoom.

Para obtener más información, consulte “Acople de un objetivo”.

3

Ajuste el controlador del objetivo para que pueda operar el objetivo con zoom.4

Mantenga el equilibrio del cabezal de la cámara hacia adelante y hacia atrás de manera que la base
deslizante quede en horizontal.

Para obtener más información, consulte las instrucciones de funcionamiento del controlador del objetivo y “Acople
de un objetivo”.

5

Establezca [Technical] > [Lens Controller] > [Setting] en [On] en el menú web y pulse el botón [OK].

La unidad se reiniciará. Espere a que la operación de giro/inclinación se haya completado.

6

Pulse el botón  (Inicializar controlador del objetivo) en la pestaña  (Others) del panel de
control de la cámara, en la pantalla de operación en directo de la Aplicación Web.

El controlador del objetivo se mueve para detectar el rango del zoom. Para obtener más información, consulte las
instrucciones de funcionamiento del controlador del objetivo.
Cuando la indicación  (Error de controlador del objetivo) cambie a  (Controlador del objetivo listo) en la parte
superior izquierda del panel de imagen de la cámara, la preparación ha finalizado.

Nota

Tenga en cuenta el rango de operación del objetivo al inicializar en controlador del objetivo.

7

Ajuste el zoom mediante el control deslizante [Zoom] de la Aplicación Web o los botones de control del
zoom del control remoto infrarrojo.

8
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Puede comprobar el estado del controlador del objetivo en la pantalla.

Nota

Cuando intercambie el objetivo, inicialice el controlador del objetivo.

Clear Image Zoom no está disponible cuando un controlador de objetivo está activado. Se recomienda ajustar la relación de
Clear Image Zoom a 1.0× o desactivar Clear Image Zoom.

5-041-957-43(1) Copyright 2022 Sony Corporation

Estado Descripción

Off Utilice el zoom motorizado en un objetivo de montura E.

Communication
Error

Se ha producido un error de comunicación entre la unidad y el controlador del objetivo.
Compruebe la conexión entre la unidad y el controlador del objetivo, luego consulte las
instrucciones de funcionamiento del controlador del objetivo e inicialice el controlador del objetivo.

Uninitialized Ejecute la inicialización.

Initializing Espere a que finalice la inicialización.

Initialization
Failed

Compruebe la conexión entre la unidad y el controlador del objetivo, luego consulte las
instrucciones de funcionamiento del controlador del objetivo e inicialice el controlador del objetivo.

Working Ajuste el zoom con el controlador del objetivo.

Rotation Error
El rango de movimiento del zoom almacenado y el rango de movimiento del objetivo pueden no
coincidir. Inicialice el controlador del objetivo.

System Error Compruebe la conexión entre la unidad y el controlador del objetivo, consulte las instrucciones de
funcionamiento del controlador del objetivo e inicialice el controlador del objetivo, o apague y
encienda la unidad y el controlador del objetivo.Unknown Error
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Precauciones de uso

Precauciones de transporte y embalaje
Al transportar o embalar la unidad, mantenga las siguientes condiciones y evite someterla a fuertes vibraciones o
golpes.

Retire el objetivo y coloque la tapa del cuerpo.
Después de mover el cabezal de la cámara (A) hacia delante, gire la palanca de bloqueo del cabezal de la cámara
(B) en la dirección de la flecha para bloquear el cabezal de la cámara.

Oriente el cabezal de la cámara de forma que quede orientado hacia delante y bloquéelo con la palanca de bloqueo
de giro/inclinación.

Retire los cables de conexión.

Condensación
Si la unidad se lleva de repente de un lugar frío a uno cálido o si la temperatura ambiente sufre un aumento repentino,
es posible que se acumule humedad en la superficie exterior o interior de la unidad. Este fenómeno se conoce como
condensación. Si se produce condensación, apague la unidad y espere a que se evapore antes de ponerla en marcha.
No utilice la unidad en ese estado, ya que podría dañarla.

Fenómenos del sensor de imagen CMOS de la cámara

Nota

Los siguientes fenómenos que podrían producirse en las imágenes están relacionados con los sensores de imagen. No indican
que exista una avería.

Motas blancas
Aunque los sensores de imágenes se fabrican con tecnologías de alta precisión, es posible que se generen
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pequeñas motas blancas en la pantalla en casos excepcionales producidas por rayos cósmicos, etc.
Están relacionadas con el principio de los sensores de imágenes y no se trata de una avería. Ejecute regularmente
la APR.
Las motas blancas suelen verse especialmente en las siguientes situaciones:

cuando se utiliza la unidad con una temperatura ambiente elevada
cuando se ha elevado la ganancia (sensibilidad)

Parpadeo
Si captura imágenes bajo la luz producida por lámparas fluorescentes, lámparas de sodio, lámparas de vapor de
mercurio o LED, es posible que la pantalla parpadee o que los colores varíen.

Unidades de control de giro/inclinación y del objetivo
Si la sección de movimiento de giro/inclinación y del objetivo no se activa durante un tiempo prolongado, la viscosidad
de la grasa que se aplica en el interior de este podría aumentar, lo que impide que el mecanismo se mueva. Haga
funcionar el mecanismo de movimiento de giro/inclinación y del objetivo de manera regular.

Acerca de los consumibles
El ventilador y la batería integrada recargable son consumibles que deben sustituirse periódicamente.
Si utiliza la unidad a temperatura ambiente, el ciclo de sustitución normal será de 5 años aproximadamente. Sin
embargo, el ciclo de sustitución representa solamente una directriz general y no constituye ninguna garantía de la
vida útil de estos componentes.
Para obtener más información acerca de la sustitución de componentes, póngase en contacto con el distribuidor.

La vida útil del adaptador de CA y del condensador electrolítico es de unos 5 años con las temperaturas de
funcionamiento habituales y un uso normal (8 horas al día, 25 días al mes). Si el uso supera la frecuencia normal
indicada, es posible que la vida útil se vea reducida en consecuencia.

Se recomienda realizar inspecciones periódicas para que la unidad continúe funcionando correctamente y para
prolongar su vida útil. Póngase en contacto con el servicio de asistencia técnica de Sony para obtener más información
sobre las inspecciones.

Acerca de la batería recargable incorporada
La unidad dispone de una batería recargable integrada que almacena la fecha, la hora y otros ajustes incluso cuando
está apagada. La batería recargable incorporada estará cargada a las 24 horas de conectarse la unidad a una toma de
corriente con el adaptador de CA o si se suministra alimentación a través de PoE++, independientemente de que la
unidad esté encendida o apagada. La batería recargable se descargará totalmente en un periodo de alrededor de 2
meses si el adaptador CA no se conecta a la fuente de alimentación. Cargue la batería antes de utilizar la unidad. Sin
embargo, incluso si la batería recargable no está cargada, el funcionamiento de la unidad no se verá afectado siempre
que no necesite registrar la fecha.

Uso y ubicaciones de almacenamiento
Guarde la unidad en un lugar llano y ventilado.
Evite utilizar o guardar la unidad en los siguientes lugares.

Entornos expuestos al agua o la lluvia (incluso bajo techo)
Entornos al aire libre o que superen los 40 °C
Recuerde que, en verano, en climas cálidos, la temperatura en el interior de un vehículo con las ventanas subidas
puede superar fácilmente los 50 °C.
Entornos con una temperatura inferior a los 0 °C.
Entornos húmedos o con polvo. Entornos donde la unidad pueda quedar expuesta a la lluvia.
Entornos que podrían recibir vibraciones o golpes fuertes.
Entornos donde se generan campos magnéticos fuertes, radiación y rayos X.
Cerca de transmisores de radio o televisión que generen campos electromagnéticos potentes.
En contacto directo con la luz sola o cerca de calefactores durante periodos prolongados

Nota sobre los rayos láser

472



Los rayos láser pueden dañar el sensor de imagen CMOS. Si filma una escena que incluya un rayo láser, evite que este
se dirija directamente al sensor de imagen CMOS de la cámara. Específicamente, los rayos láser de alta potencia
procedentes de los dispositivos médicos o de otros dispositivos podrían causar daños debido a los efectos de la luz
reflejada y la luz dispersa.

Cómo evitar interferencias electromagnéticas procedentes de dispositivos de comunicación
portátiles
El uso de teléfonos móviles y otros dispositivos de comunicación cerca de esta unidad puede producir averías e
interferencias con las señales de audio y vídeo. Es recomendable que los dispositivos de comunicación portátiles que se
encuentren cerca de esta unidad estén apagados.

No poner este producto cerca de aparatos médicos
Este producto (incluyendo los accesorios) tiene un imán (o imanes) que puede interferir con marcapasos, válvulas de
derivación programables para el tratamiento de la hidrocefalia, o con otros aparatos médicos. No ponga el producto
cerca de personas que utilicen dichos aparatos médicos. Consulte con su médico antes de utilizar este producto si utiliza
cualquiera de dichos aparatos médicos.

Precauciones de seguridad
SONY NO SE HACE RESPONSABLE POR DAÑOS DE NINGÚN TIPO DEBIDOS A LA OMISIÓN DE LAS
MEDIDAS DE SEGURIDAD ADECUADAS EN DISPOSITIVOS DE TRANSMISIÓN, FUGAS DE DATOS
INEVITABLES DERIVADAS DE LAS ESPECIFICACIONES DE TRANSMISIÓN O PROBLEMAS DE SEGURIDAD
DE CUALQUIER TIPO.
Según el tipo de entorno operativo, es posible que terceras partes no autorizadas puedan acceder a la unidad a
través de la red. Cuando conecte la unidad a la red, confirme siempre que la red está correctamente protegida.
Desde el punto de vista de la seguridad, al utilizar la unidad conectada a la red, se recomienda encarecidamente
acceder a la ventana de control a través de un navegador web y modificar la limitación de acceso de los valores
predeterminados de fábrica. Asimismo, se recomienda establecer una contraseña con una cadena de caracteres
suficientemente larga, que sea difícil de adivinar por los demás, y que deberá guardar de forma segura.
Cuando conecte este producto a una red, conéctelo mediante un sistema con función de protección como, por
ejemplo, un router o un firewall. Si se conecta sin dicha protección, pueden producirse problemas de seguridad.

Fuente de alimentación
La unidad no dispone de un interruptor de alimentación. Para apagar la unidad, compruebe que todas las acciones
hayan finalizado y que la unidad esté en modo de espera. Después, desconecte el adaptador CA. Cuando utilice el
suministro de alimentación PoE++, desconecte el cable LAN.
Siempre que sea posible, utilice una fuente de alimentación de un punto donde resulte sencillo insertar y retirar el
enchufe de alimentación.
Si la toma de corriente se encuentra en un lugar con polvo o suciedad, limpie la zona alrededor de la toma de
corriente regularmente para evitar que se acumulen grandes cantidades de polvo que podrían resultar conductoras.
Desconecte la fuente de alimentación cuando no la utilice.

Precauciones al mover las piezas
Asegúrese de que no penetre ninguna sustancia u objeto externo entre las piezas móviles.
No aplique una carga excesiva al mover las piezas manualmente. Si lo hace, podría provocar una avería.
No interfiera en el funcionamiento de las piezas móviles mientras estén en movimiento. De lo contrario, podría
provocar una lesión o una avería.
Las piezas móviles podrían no funcionar con normalidad si la unidad no se utiliza durante un periodo de tiempo
prolongado. Active con regularidad las funciones de giro/inclinación de la unidad.

Precauciones para la operación continua
La unidad puede recibir alimentación 24 horas al día, 365 días al año (fuente de alimentación en estado de espera).
Realice siempre una prueba de filmación y compruebe que la unidad funciona con normalidad.

No se garantiza la filmación continua durante periodos superiores a 24 horas.
Si captura imágenes durante más de 24 horas, ponga la unidad en fuente de alimentación en estado de espera y
reiníciela.
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Tenga en cuenta que Sony no será responsable de ningún tipo de compensación por el contenido de las imágenes si
no puede filmar debido a cualquier fallo de funcionamiento mientras utiliza esta unidad.
Verifique siempre que esta unidad funciona correctamente antes de utilizarla. SONY NO SE HACE RESPONSABLE
POR DAÑOS DE NINGÚN TIPO, INCLUYENDO ENTRE OTROS LA COMPENSACIÓN O EL REEMBOLSO POR
LA PÉRDIDA DE GANANCIAS PRESENTES O FUTURAS DEBIDO AL FALLO DE ESTA UNIDAD, YA SEA
DURANTE LA VIGENCIA DE LA GARANTÍA O DESPUÉS DEL VENCIMIENTO DE LA GARANTÍA, O POR
CUALQUIER OTRA RAZÓN.
SONY NO SE HACE RESPONSABLE POR RECLAMACIONES DE NINGÚN TIPO REALIZADAS POR USUARIOS
DE ESTA UNIDAD O POR TERCEROS.
SONY NO SE HACE RESPONSABLE DE LA FINALIZACIÓN NI DE LA INTERRUPCIÓN, POR LA
CIRCUNSTANCIA QUE FUERA, DE CUALQUIER SERVICIO RELACIONADO CON ESTA UNIDAD.

Precauciones de la función de grabación
Haga siempre un ensayo de grabación y verifique que se grabó bien. SONY NO SE HACE RESPONSABLE POR
DAÑOS DE NINGÚN TIPO, INCLUYENDO PERO NO LIMITADO A LA COMPENSACIÓN O PAGO POR FALLO EN
HACER CUALQUIER TIPO DE CONTENIDO DE GRABACIÓN POR MEDIO DE ESTA UNIDAD O SU SOPORTE
DE GRABACIÓN O CUALQUIER OTRO SOPORTE O SISTEMA DE ALMACENAMIENTO.
Verifique siempre que esta unidad funciona correctamente antes de utilizarla. SONY NO SE HACE RESPONSABLE
POR DAÑOS DE NINGÚN TIPO, INCLUYENDO ENTRE OTROS LA COMPENSACIÓN O EL REEMBOLSO POR
LA PÉRDIDA DE GANANCIAS PRESENTES O FUTURAS DEBIDO AL FALLO DE ESTA UNIDAD, YA SEA
DURANTE LA VIGENCIA DE LA GARANTÍA O DESPUÉS DEL VENCIMIENTO DE LA GARANTÍA, O POR
CUALQUIER OTRA RAZÓN.
SONY NO SE HACE RESPONSABLE POR RECLAMACIONES DE NINGÚN TIPO REALIZADAS POR USUARIOS
DE ESTA UNIDAD O POR TERCEROS.
SONY NO SE HACE RESPONSABLE POR LA PÉRDIDA, LA REPARACIÓN O LA REPRODUCCIÓN DE
CUALQUIER DATO GRABADO EN EL SISTEMA DE ALMACENAMIENTO INTERNO, SOPORTES DE GRABACIÓN
O CUALQUIER OTRO SOPORTE O SISTEMA DE ALMACENAMIENTO.
SONY NO SE HACE RESPONSABLE DE LA FINALIZACIÓN NI DE LA INTERRUPCIÓN, POR LA
CIRCUNSTANCIA QUE FUERA, DE CUALQUIER SERVICIO RELACIONADO CON ESTA UNIDAD.

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Limitaciones y formatos de salida

En este tema se describen las limitaciones y los formatos de salida.

Nota

La resolución del formato de salida está limitada por la configuración de [Project] > [Rec Format] > [Frequency], [Codec] y [Video
Format] del menú web o el menú de la cámara.

La resolución del formato de salida también está limitada por la combinación con la velocidad de fotogramas a cámara lenta y
rápida. Además de la tabla de formatos de salida del conector SDI OUT/HDMI OUT mostrados a continuación, la salida HDMI
cambia a Full HD o a otra inferior si se cumplen todas las siguientes condiciones.

[Shooting] > [S&Q Motion] > [Setting] se define como [On]
[Shooting] > [S&Q Motion] > [Frame Rate] es superior a 60fps

Cuando se cumplen las condiciones anteriores, las opciones de selección de salida HDMI 4096×2160P y 3840×2160P para
[Monitoring] > [Output Format] > [SDI/HDMI] aparecen atenuadas y no se pueden seleccionar.

La imagen no se emite si se configura una resolución superior a la de la imagen de reproducción.

Formatos de salida del conector SDI OUT/HDMI OUT

Cuando la frecuencia del sistema es 50/59.94 Hz

Ajuste Formato de salida seleccionable

Modo de
grabación/reproducción

Resolución de salida
RAW/

Resolución de
grabación interna

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(predeterminado)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(predeterminado)
1920×1080i
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Cuando la frecuencia del sistema es 25/29.97 Hz

Ajuste Formato de salida seleccionable

Modo de
grabación/reproducción

Resolución de salida
RAW/

Resolución de
grabación interna

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(predeterminado)

1920×1080P
(predeterminado)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(predeterminado)

1920×1080P
(predeterminado)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(predeterminado)

1920×1080P
(predeterminado)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Salida detenida)
720×480P2)

720×576P3)

La pantalla no se puede superponer.1)

Cuando la frecuencia del sistema es 59.942)

Cuando la frecuencia del sistema es 503)
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Cuando la frecuencia del sistema es 23.98 Hz

Ajuste Output Format (resolución de salida)

Modo de
grabación/reproducción

Resolución de salida
RAW/

Resolución de
grabación interna

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i
(predeterminado)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i
(predeterminado)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(predeterminado)

1920×1080i
(predeterminado)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(predeterminado)

1920×1080i
(predeterminado)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Ajuste Output Format (resolución de salida)

Modo de
grabación/reproducción

Resolución de salida
RAW/

Resolución de grabación
interna

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(predeterminado)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
(predeterminado)
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Cuando la frecuencia del sistema es 24 Hz

5-041-957-43(1) Copyright 2022 Sony Corporation

Ajuste Output Format (resolución de salida)

Modo de
grabación/reproducción

Resolución de salida
RAW/

Resolución de grabación
interna

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(predeterminado)

1920×1080P
(predeterminado)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(predeterminado)

1920×1080P
(predeterminado)

1920×1080
1920×1080P
(predeterminado)

1920×1080P
(predeterminado)

Ajuste Output Format (resolución de salida)

Modo de
grabación/reproducción

Resolución de salida
RAW/

Resolución de grabación
interna

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P
(predeterminado)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P
(predeterminado)

4096×2160P
1920×1080P
(predeterminado)
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Resolución de problemas

Fuente de alimentación

Salida de imagen

Síntoma Causa Solución

La unidad no
se enciende.

El adaptador de CA no está firmemente conectado
al conector DC IN.

Inserte el cable de alimentación firmemente
hasta que haga tope.

El cable de alimentación de CA no está firmemente
insertado en el adaptador de CA o la toma de
corriente de CA.

Inserte el cable de alimentación firmemente
hasta que haga tope.

El cable LAN no está firmemente conectado entre
el dispositivo de suministro de alimentación de
PoE++.

Compruebe que el cable se ha insertado y
queda fijo.

El cable LAN está conectado al conector OPTION,
pero no al conector LAN.

Conecte el cable LAN al conector LAN
correctamente.

La unidad está conectada a un dispositivo de
suministro de alimentación que no es compatible
con PoE++ (IEEE802.3bt tipo 4 compatible con
clase 8).

Conecte la unidad a un dispositivo de
suministro de alimentación compatible con
PoE++ (IEEE802.3bt tipo 4 compatible con
clase 8).

El consumo de alimentación total supera el
máximo del dispositivo de suministro de
alimentación de PoE++.

Consulte las instrucciones de funcionamiento
del dispositivo de suministro de alimentación
de PoE++.

Se ha conectado un cable de red con una
calificación de categoría que no es compatible con
el suministro de alimentación de PoE++.

Utilice un cable de red de categoría 5e o
superior conectado al conector LAN.

La cámara, el dispositivo de suministro de
alimentación de PoE++ y los dispositivos
periféricos no están conectados a la toma de tierra.

Conecte cámara, el dispositivo de suministro
de alimentación de PoE++ y los dispositivos
periféricos a la toma de tierra.

Síntoma Causa Solución

No hay salida de imagen.

Los dispositivos conectados no están bien
conectados.

Conecte dichos dispositivos
correctamente.

La configuración inicial no se ha completado.
Complete la configuración inicial
mediante la Aplicación Web.
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Controlador remoto

Control remoto infrarrojo

Síntoma Causa Solución

No hay salida de imagen
del conector HDMI.

Se ha configurado una señal no compatible con el
dispositivo de destino de salida HDMI.

Modifique los ajustes de formato
de salida HDMI o utilice un
dispositivo compatible con la
señal de salida.

Se está utilizando un cable que no es compatible con
el estándar HDMI de salida.

Utilice un cable compatible con
el estándar HDMI de salida
correspondiente.

El conector SDI no emite
ninguna imagen.

Se está utilizando un cable que no es compatible con
el estándar SDI de salida.

Utilice un cable compatible con
el estándar SDI de salida
correspondiente.

El monitor conectado al conector SDI no es
compatible con la señal de salida.

Utilice un monitor compatible con
el estándar SDI de salida.

El formato de grabación está definido como salida
RAW.

Cambie la configuración del
formato de grabación a una
distinta de salida RAW.

La resolución de la salida HDMI está definida en SD. Defina una resolución distinta de
SD para la salida HDMI.

No hay salida de imagen
de la fibra óptica o la
imagen aparece
distorsionada.

El módulo que se está utilizando no cumple con los
estándares SMPTE o SFF, o no cumple con el nivel
de alimentación I (1,0 W).

Consulte “Emisión de una señal
de fibra óptica”.

No hay salida de imagen
o la imagen aparece
distorsionada al usar una
sincronización externa.

No se está recibiendo una señal de sincronización
externa compatible con el formato de señal de vídeo
configurado.

Defina la entrada de una señal
de sincronización externa
compatible con el formato de
señal de vídeo configurado.

Hay ruido en el audio.

La cámara, el dispositivo de suministro de
alimentación de PoE++ y los dispositivos periféricos
no están conectados a la toma de tierra.

Conecte la unidad, el dispositivo
de suministro de alimentación de
PoE++ y los dispositivos
periféricos a la toma de tierra.

La unidad se está utilizando en un entorno con
dispositivos que generan campos magnéticos y
eléctricos fuertes (como antenas de transmisión de
TV o radio, transmisores de radio para aficionados,
motores de aire acondicionado o transformadores de
suministros de alimentación).

Mantenga la unidad alejada de
dispositivos que generan
campos magnéticos y eléctricos
fuertes.

El objetivo, el soporte del objetivo y la unidad de
control están en contacto con la unidad o con un
objeto del entorno y se produce un sonido anómalo.

Coloque el objetivo
correctamente.

Compruebe si hay algún
obstáculo cerca de la
cámara.
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RM-IP500

Aplicación Web

Síntoma Causa Solución

El control remoto infrarrojo no
funciona al pulsarlo.

El control remoto infrarrojo está
inhabilitado.

Establezca [Technical] > [IR Remote] >
[Setting] en [On] en el menú web.

La batería se ha descargado o la
polaridad de la batería es
incorrecta.

Ponga en marcha el control remoto infrarrojo
cerca del sensor de IR de la unidad. Si la luz
LED de alimentación parpadea, sustituya la
batería.

La configuración inicial no se ha
completado.

Complete la configuración inicial mediante la
Aplicación Web.

La velocidad de giro/inclinación
es lenta.

La velocidad de giro/inclinación
del control remoto infrarrojo está
definido en modo normal.

Defina el interruptor 4 SETUP en posición ON
en el bloque de conectores de la unidad.

Se ha definido una cámara
distinta de la que se deseaba
definir como objetivo.

La señal infrarroja ha sido recibida
por otra cámara que la que se
esperaba.

Establezca [Technical] > [IR Remote] >
[Setting] en [Off] en el menú web de la cámara
que no desea controlar.

Síntoma Causa Solución

La cámara no puede controlarse desde
el controlador remoto RM-IP500.

La fuente de alimentación
de la cámara no está
conectada.

Compruebe que el indicador POWER de la
unidad se ilumina en verde o naranja.

La cámara o el controlador
remoto no están
conectados a la red.

Compruebe las conexiones del controlador
remoto y la unidad.

La configuración inicial de
la cámara no se ha
completado.

Complete la configuración inicial mediante la
Aplicación Web.

La comunicación VISCA
over IP no está habilitada.

Defina el interruptor 3 SETUP en posición ON
en el panel del conector de la unidad y
reiníciela.

La dirección IP de la
cámara se ha modificado.

Compruebe la dirección IP de la cámara en
[Network] > [Wired LAN] en el menú web o el
menú de la cámara.

La dirección IP de la cámara se ha
modificado mediante la opción AUTO
IP SETUP del controlador remoto de
RM-IP500.

Han pasado al menos 20
minutos desde que se
inició la cámara.

Reinicie la unidad. La dirección IP puede
modificarse a través de la opción AUTO IP
SETUP en los 20 primeros minutos tras iniciar
la unidad.
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Síntoma Causa Solución

No se puede establecer la conexión
a través de un navegador web.

No se ha conectado un cable
LAN de categoría 5e o
superior.

Conecte un cable LAN de categoría 5e o
superior.

No se ha establecido la
conexión a la red LAN
correctamente o la red
conectada no está
funcionando con normalidad.

Compruebe que el indicador Link LED del
conector LAN está encendido. Si el indicador
Link LED no está encendido, póngase en
contacto con su administrador de red.

La fuente de alimentación de
la cámara no está conectada.

Consulte la sección “Fuente de alimentación”
anterior.

No se ha configurado una
dirección IP válida para la
unidad.

Restablezca la red.

La dirección IP configurada se
está utilizando en otro
dispositivo.

Compruebe que las direcciones IP de los
dispositivos periféricos sean únicas.

La máscara de subred
configurada no coincide con la
subred utilizada.

Restablezca la red.

Se está accediendo a la
unidad en la misma red local a
través de un servidor proxy.

Cambie la configuración para que no se utilice
el servidor proxy.

La puerta de enlace
predeterminada configurada
para la unidad no es correcta.

Restablezca la red.

La URL introducida no es
correcta.

Introduzca la URL correcta e inténtelo de
nuevo.

El puerto HTTP no es
correcto.

Muestre el menú de la cámara en un monitor
externo y compruebe los ajustes de [Network]
> [Wired LAN] > [HTTP Port]. Si se establece
un valor distinto de 80, añada el número de
puerto HTTP al número de host o la dirección
de IP introducida en el navegador web.
Ejemplo: Si el puerto HTTP se define en
8080, introduzca http://<IP Address>:8080

El número de puerto HTTP de
la unidad se está filtrando o
está bloqueado.

Modifique el número de puerto HTTP de la
unidad a un puerto que no se esté filtrando ni
esté bloqueado.

La caché antigua del
navegador web tiene un efecto
adverso.

Elimine la caché del navegador web.
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Síntoma Causa Solución

No se puede establecer la conexión
con la Aplicación Web mediante el
código 2D (código QR).

El dispositivo que se está
utilizando no es compatible
con mDNS.

Utilice un dispositivo compatible con mDNS.
Si utiliza un dispositivo que no es compatible
con mDNS, introduzca la dirección IP
directamente en el navegador web.

La tablet o el ordenador están
conectados a una red distinta
de la red de la cámara.

Conecte la tablet o el ordenador a la misma
red local que la unidad.

No se puede establecer la conexión
con la Aplicación Web
introduciendo manualmente la URL.

El dispositivo que se está
utilizando no es compatible
con mDNS.

Utilice un dispositivo compatible con mDNS.

La tablet o el ordenador están
conectados a una red distinta
de la red de la cámara.

Conecte la tablet o el ordenador a la misma
red local que la unidad.

La pantalla de autenticación se
muestra continuamente.

No se han introducido el
nombre de usuario o la
contraseña correctos.

Introduzca el nombre de usuario y la
contraseña registrados. Si ha olvidado la
información de usuario registrada, consulte
“Interruptor RESET” en “Bloque de
conectores” para inicializar la información del
usuario para la conexión de red.

Es posible que un usuario que
haya iniciado sesión en otro
navegador web haya
cambiado el nombre de
usuario y la contraseña.

Compruebe el nombre de usuario y la
contraseña correctos con el administrador de
la unidad.

La imagen de cámara no se
muestra en la Aplicación Web.

La resolución de la salida
HDMI de la cámara está
definida en 720×480 o
720×576.

Modifique la resolución de la salida HDMI de
la unidad.

Se ha conectado un monitor
HDMI que no es compatible
con la señal de salida HDMI
de la cámara.

Desconecte el monitor HDMI o utilice un
monitor HDMI compatible con los ajustes de
la salida HDMI.

La unidad se ha reiniciado y la
sesión se ha desconectado.

Espere alrededor de un minuto y vuelva a
cargar el navegador web.

La caché antigua del
navegador web tiene un efecto
adverso.

Elimine la caché del navegador web.

La resolución de la imagen de
cámara que se muestra en la
Aplicación Web es baja.

La resolución de la trasmisión
de vídeo 3 que utiliza la
Aplicación Web está definida
como baja.

Aumente el valor con [Stream] > [Video
Stream] > [Size 3] en el menú web.

El menú de la cámara no aparece
al pulsar el botón [Menu].

El menú de la cámara está
configurado de manera que no
se integre en la señal de
salida de HDMI.

Establezca [Monitoring] > [Output Display] >
[HDMI/Stream] en [On] en el menú web.
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Filmación

Cámara

Síntoma Causa Solución

El valor de uno de los ajustes de la
configuración de la pantalla no se
ha actualizado o no se muestra
correctamente.

La pantalla de ajustes de la
Aplicación Web no refleja
automáticamente los ajustes
modificados en otra Aplicación
Web.

Pulse el botón [Reload] situado en la parte
inferior de la pantalla de ajustes de la
Aplicación Web. Los valores de los ajustes de
la pantalla de configuración volverán a
cargarse actualizados.

Los ajustes de los archivos
temporales de Internet se han
visto afectados.

Elimine la caché del navegador web.

No se puede descargar un registro
o archivo de configuración.

La función del archivo de
descarga del navegador web
está inhabilitada.

Habilite la función del archivo de descarga del
navegador web.

La pantalla de ajustes de la
Aplicación Web es accesible, pero
no se pueden llevar a cabo
operaciones en la pantalla de
funcionamiento en directo y la
pantalla de operación de
reproducción.

La pantalla de funcionamiento
de la Aplicación Web está
bloqueada.

Defina el interruptor de bloqueo de
funcionamiento de la parte superior derecha
de la Aplicación Web en la posición 
(Desbloqueo de la operación).

La pantalla de la Aplicación Web
tarda un tiempo en mostrarse.

Hay varios usuarios
visualizando la imagen de
transmisión de la unidad
simultáneamente.

Reduzca el número de usuarios que pueden
acceder a la Aplicación Web de forma
simultánea.

La imagen está distorsionada o
borrosa.

La información del vídeo no se
transmite adecuadamente
porque existe una congestión
en la ruta de comunicación.

Reduzca la velocidad de bits de transmisión,
ajuste el [Video Stream 3] > [Size] a la opción
más pequeña o reduzca la velocidad para
crear un margen en la banda de
comunicaciones.

Se están ejecutando varios
navegadores web en la tablet
y están ocupando memoria.

Cierre los navegadores web que se estén
ejecutando en segundo plano.

Hay demasiadas pestañas del
navegador abiertas, lo que
ralentiza el funcionamiento.

Cierre las pestañas que no esté utilizando.

La acumulación excesiva de
caché del navegador web y
del historial de navegación
ralentiza el funcionamiento.

Elimine la caché del navegador web.

Síntoma Causa Solución

La imagen se muestra distorsionada al
inicio y al final de la operación de
giro/inclinación.

La imagen puede aparecer distorsionada
si la función de estabilización del objetivo
está encendida.

Apague la función de
estabilización del objetivo.

El ángulo de visión ha cambiado sin la
intervención del usuario.

Ha ocurrido el Breathing del objetivo.
Consulte “Breathing
Compensation”.
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Giro/inclinación

Síntoma Causa Solución

Las opciones de enfoque, zoom o
diafragma no funcionan.

Es posible que la configuración de los
interruptores del objetivo sea errónea.

Consulte “Comprobación de
los interruptores del objetivo”.

Síntoma Causa Solución

No se puede
restablecer el giro/la
inclinación.

La palanca de bloqueo de
giro/inclinación está en posición
LOCK.

Mueva la palanca de bloqueo de giro/inclinación a la
posición UNLOCK.

La cámara no se
detiene en la posición
esperada.

El bloque de cámaras está
desequilibrado.

Mueva el bloque de cámaras hacia adelante o hacia
atrás hasta la posición adecuada, tal y como se
describe en “Acople de un objetivo” y, después,
vuelva a encender la unidad.

Se ha conectado un objetivo que no
admite giro/inclinación.

Consulte la información de compatibilidad del
objetivo y conecte un objetivo que admita
giro/inclinación. Después, vuelva a encender la
unidad.

No se puede ejecutar el
restablecimiento de giro/inclinación.

Ejecute un restablecimiento de giro/inclinación tal y
como se describe en “Restablecimiento del
giro/inclinación”.

Se ha aplicado una fuerza inesperada
al cabezal de la cámara, lo que ha
provocado un error de control de
giro/inclinación.

La cámara no vuelve
a la parte frontal
cuando se pulsa el
botón 
(restablecer
giro/inclinación).

Se ha activado el modo de montaje
en techo.

Configure [Pan-Tilt] > [P/T Direction] > [Ceiling] en el
menú web según la instalación actual y, después,
vuelva a encender la unidad. En el montaje en
techo, el bloque de conectores estará en la parte
frontal de la cámara.

La operación de
giro/inclinación está
restringida.

El límite de rango de giro/inclinación
está configurado.

Elimine los ajustes de límite de rango de
giro/inclinación, según se requiera, tal y como se
describe en “P/T Range Limit”.

Se ha aplicado una fuerza inesperada
al cabezal de la cámara, lo que ha
provocado un error de giro/inclinación.

Ejecute un restablecimiento de giro/inclinación tal y
como se describe en “Restablecimiento del
giro/inclinación”.

La operación de
giro/inclinación se ha
llevado a cabo en
dirección contraria.

El modo de montaje en techo es
distinto del estado de montaje actual.

Configure [Pan-Tilt] > [P/T Direction] > [Ceiling] en el
menú web según la instalación actual.

Se han cambiado ajustes
relacionados con la dirección de
giro/inclinación.

Compruebe los ajustes de [Pan-Tilt] > [P/T Direction]
en el menú web.

485



Síntoma Causa Solución

La imagen no se
mueve de manera
fluida al inicio y al
final de la operación
de giro/inclinación.

El ajuste de
aceleración/desaceleración de la
operación de giro/inclinación tiene un
valor demasiado elevado.

Reduzca el valor del ajuste de
aceleración/desaceleración de la operación de
giro/inclinación para que el movimiento del inicio y
del final de la operación de giro/inclinación sea más
fluido mediante [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] en el menú web o en el menú de la
cámara. Tenga en cuenta que esto implicará que el
objetivo tardará más tiempo en alcanzar la velocidad
máxima.

Se ha detenido la
operación de
giro/inclinación.

El bloque de cámaras está
desequilibrado.

Mueva el bloque de cámaras hacia adelante o hacia
atrás hasta la posición adecuada, tal y como se
describe en “Acople de un objetivo” y, después,
vuelva a encender la unidad.

El valor de la curva de rampa
(aceleración/desaceleración) es
demasiado elevado para el objetivo
conectado.

Si se ha conectado un objetivo de gran tamaño,
reduzca el valor del ajuste de [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] en el menú web o en
el menú de la cámara.

Se está usando un objetivo de gran
tamaño.

Póngase en contacto con su representante de
soporte de Sony.

La unidad está
obstruida cuando se
activa la función de
giro/inclinación.

La palanca de sujeción del tornillo de
fijación del pedestal del soporte del
objetivo golpea la cámara.

Gire la palanca de sujeción del tornillo de fijación del
pedestal del soporte del objetivo de manera que
apunte hacia arriba.

La palanca de sujeción del soporte
del objetivo golpea la cámara.

Gire la palanca de sujeción del soporte del objetivo
de manera que apunte hacia arriba.

La palanca de bloqueo del cabezal
golpea la cámara.

Compruebe que la palanca de bloqueo del cabezal
de la cámara está en posición LOCK.

Ocurre un sonido
anómalo durante la
operación de
giro/inclinación.

La cámara está desequilibrada.
Mueva el cabezal de la cámara hacia adelante o
hacia atrás hasta una posición adecuada, de
manera que la base deslizante quede en horizontal.

El valor de la curva de rampa
(aceleración/desaceleración) es
demasiado elevado para el objetivo
conectado.

Si se ha conectado un objetivo de gran tamaño,
reduzca el valor del ajuste de [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] en el menú web o en
el menú de la cámara.

El cabezal de la cámara no está fijado
en su posición y se produce un sonido
de movimiento durante la operación.

Ajuste la palanca de bloqueo del cabezal de la
cámara en posición LOCK.

No se puede guardar
una posición
preajustada.

No se puede guardar un preajuste si
Clear Image Zoom está funcionando.

Vuelva a ajustar la relación de Clear Image Zoom en
1× (estado en el que la relación no se muestra a la
derecha de  (relación de zoom))
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Grabación/reproducción

Síntoma Causa Solución

El encuadre se
desplaza al reproducir
una posición
preajustada.

La temperatura del entorno puede
haber cambiado significativamente
entre el momento en que se guardó
una posición preajustada y el
momento en que se reproduce.

Guarde de nuevo la posición preajustada.

No se realiza la calibración del
objetivo.

Para ejecutar la calibración, vaya a [Technical] >
[Lens] > [Lens Calibration] en el menú de la cámara.

Se ha acoplado un objetivo diferente
al que estaba acoplado cuando se
guardó el preajuste. O la posición del
zoom para el zoom manual es
diferente.

Guarde de nuevo la posición preajustada.

El panel de control
del encuadre de la
Aplicación Web
aparece atenuado y
no puede ejecutarse.

La operación de giro/inclinación no
está disponible mientras se muestra la
pantalla de imágenes en miniatura y
durante la reproducción.

Visualice la pantalla de control de reproducción y
salga de la pantalla de imágenes en miniatura o
detenga la reproducción.

La operación de giro/inclinación no
está disponible cuando la imagen de
la cámara no puede mostrarse en la
Aplicación Web.

Consulte “Aplicación Web” en “Resolución de
problemas”.

La palanca de bloqueo de
giro/inclinación está en posición
LOCK.

Mueva la palanca de bloqueo de giro/inclinación a la
posición UNLOCK.

Se muestra “Execute
Pan-Tilt Reset” bajo el
panel de control de
encuadre de la
Aplicación Web.

Se ha aplicado una fuerza inesperada
al cabezal de la cámara, lo que ha
provocado un error de giro/inclinación.

Ejecute un restablecimiento de giro/inclinación tal y
como se describe en “Restablecimiento del
giro/inclinación”.

Síntoma Causa Solución

La grabación no
comienza al pulsar el
botón START/STOP.

La tarjeta de memoria está llena.
Sustituya la tarjeta de memoria por otra con
espacio suficiente.

Es necesario restablecer la tarjeta de
memoria.

Restablezca la tarjeta de memoria tal y como se
describe en “Restablecimiento de tarjetas de
memoria.”

La luz indicadora de registro/grabación
está configurada como luz indicadora de
registro, por lo que no puede determinar
el estado de grabación.

Configure la luz indicadora de registro/grabación
para que funcione como luz indicadora de
grabación, tal y como se describe en “Conexión
de una señal de registro”.

No se puede grabar
audio.

Hay un micrófono desconectado.
Conecte un micrófono o un dispositivo de audio
al conector AUDIO IN del bloque de conectores.

El valor del ajuste [Master Input Level]
está en el mínimo.

Ajuste [Master Input Level].
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Transferencia de archivos

Transmisión de IP

Síntoma Causa Solución

El sonido grabado
está distorsionado.

El valor del ajuste de nivel de entrada de
audio es demasiado alto.

Ajuste [CH1 Input Level] en [CH4 Input Level] y
[Master Input Level].

Cuando utilice un micrófono en un entorno
ruidoso, como un local de música en directo,
ajuste primero [AUDIO IN CH1 MIC Ref.] y
[AUDIO IN CH2 MIC Ref.].

El sonido grabado
tiene un alto nivel de
ruido.

El valor del ajuste del nivel de entrada de
audio es demasiado bajo.

Ajuste las opciones [Audio Input Level] y [Audio]
> [Audio] > [Audio Input] > [AUDIO IN CH1 MIC
Ref.] o [AUDIO IN CH2 MIC Ref.].

No se pueden
reproducir los clips.

Se está editando el clip.

No se pueden reproducir los clips si ha
modificado los nombres o las carpetas de
archivo o si el clip se está utilizando en un
ordenador. No se trata de un fallo de
funcionamiento.

El clip se ha grabado con una cámara
distinta de la de esta unidad.

Es posible que los clips grabados con una
cámara que no es la de esta unidad no se
reproduzcan o se muestren en un tamaño
incorrecto. No se trata de un fallo de
funcionamiento.

Síntoma Causa Solución

Fallo al cargar
un archivo.

El nombre de usuario y la contraseña
del servidor no son correctos.

Es posible que el nombre de usuario y la contraseña del
servidor no sean correctos. Introduzca los válidos.

Síntoma Causa Solución

La transmisión no está
disponible.

El nombre de usuario o la
contraseña introducida en la
aplicación del cliente para
visualizar la transmisión desde la
unidad son incorrectos.

Si el formato de transmisión de la unidad está
definido en [RTSP], [SRT-Listener] o [NDI|HX], se
debe introducir el nombre de usuario y la
contraseña de la unidad en la aplicación de
cliente. Introduzca el nombre de usuario y la
contraseña correctos.

El protocolo de transmisión no está
definido.

Seleccione el protocolo objetivo mediante [Stream]
> [Stream Setting] en el menú web.

Se han establecido 6 o más
sesiones de RTSP.

Establezca el número de sesiones a 5 o menos.

El número de puerto de UDP no
está definido correctamente.

Seleccione el número de puerto y otros ajustes del
protocolo objetivo mediante [Stream] > [Stream] >
[Stream Setting] en el menú web.

La comunicación UDP está
bloqueada.

Compruebe los ajustes de software de seguridad.
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Conexión con dispositivos externos

Sincronización externa

Síntoma Causa Solución

No se está llevando a cabo
la transmisión del audio.

La transmisión de salida de audio
está definida en [Off].

Establezca [Stream] > [Audio Stream] > [Setting]
en [On] en el menú web.

La transmisión se ha
desconectado.

Los ajustes de códec de
transmisión o los ajustes de
protocolo se han modificado
durante la transmisión.

Defina los ajustes de códec de transmisión o los
ajustes de protocolo antes de comenzar la
transmisión.

El tamaño de imagen de
[Video Stream 1] no puede
definirse en 4096×2160 ni
en 3840×2160.

El tamaño de la imagen es
1920×1080 cuando [Output
Format] está definido en HDMI.

El tamaño de la imagen de transmisión no se
puede definir con un valor más alto que el tamaño
de la imagen HDMI. Modifique el tamaño de la
imagen de HDMI en [Monitoring] > [Output
Format] en el menú web.

La velocidad de
fotogramas de [Video
Stream 1] no puede
definirse en 60 FPS o 50
FPS.

La velocidad de fotogramas de
transmisión está definida en 29.97
o menos.

La velocidad de fotogramas que se utiliza para la
transmisión está limitada por la frecuencia del
sistema. Modifique la frecuencia del sistema en
[Rec Format] > [Frequency] en el menú web.

No se puede acceder a la
transmisión [Video Stream
3].

[Video Stream 3] no es compatible
con RTSP/SRT/NDI.

Utilice [Video Stream 1] o [Video Stream 2].

El valor de RTSP/SRT no
se ha actualizado o no se
muestra correctamente.

El número de puerto que se utiliza
para RTSP o SRT se está filtrando
o está bloqueado.

Modifique el número de puerto RTSP o SRT a un
puerto que no se esté filtrando ni esté bloqueado
por los dispositivos que reciben la transmisión. O
cambie el número de puerto que se utiliza para
RTSP o SRT en la unidad.

La imagen está
distorsionada o borrosa.

La información del vídeo no se
transmite adecuadamente porque
existe una congestión en la ruta de
comunicación.

Reduzca la velocidad de bits de transmisión o
defina el [Video Stream 2] códec ([Codec 2]) a
[Off] para crear un margen en la banda de
comunicación.

El orden de los paquetes de vídeo
ha cambiado dentro del canal de
comunicación.

Utilice el mismo proveedor de servicios de Internet
en el lado de la unidad y del receptor.

No detectado como
dispositivo NDI.

El protocolo de transmisión no está
definido en NDI|HX.

El protocolo de transmisión debe estar definido en
NDI|HX para detectar la unidad como dispositivo
NDI. Establezca [Stream] > [Stream Setting] en
[NDI|HX] en el menú web.

No se puede usar como
dispositivo NDI.

No hay una licencia de NDI|HX
instalada.

Instale una licencia NDI|HX. Puede comprobar si
hay una licencia NDI|HX mediante [Stream] >
[Stream] > [Stream Setting] > [NDI|HX] > [License]
en el menú web.
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Tally

Controlador del objetivo

Síntoma Causa Solución

No se puede
sincronizar a una
fuente externa.

No se está recibiendo una señal de
sincronización externa compatible con el
formato de señal de vídeo configurado.

Defina la entrada de una señal de sincronización
externa compatible con el formato de señal de
vídeo configurado.

La unidad es de doble terminación.
La unidad tiene un terminador integrado de 75 Ω.
Conecte directamente a una fuente de señal (de
uno a uno) o utilice un distribuidor (divisor).

Síntoma Causa Solución

La luz indicadora
de registro no se
enciende.

El brillo de la luz indicadora de registro
está definido en Off.

Establezca el formato de transmisión con [Technical] >
[Tally] > [Tally Lamp Brightness] en el menú web.

La luz indicadora de registro/grabación
está configurada como luz indicadora
de grabación.

Configure la luz indicadora de registro/grabación para
que funcione como luz indicadora de registro, tal y
como se describe en “Conexión de una señal de
registro”.

Se ha conectado un RM-IP500 y la
comunicación VISCA over IP se ha
inhabilitado.

Defina el interruptor 3 SETUP en posición ON en el
bloque de conectores de la unidad.

La conexión del conector OPTION no
es correcta o el pin objetivo no tiene un
circuito corto para GND.

Establezca un circuito corto para el pin 7 o el pin 8 del
conector OPTION en GND, tal y como se describe en
“Conexión de una señal de registro”.

Síntoma Causa Solución

[Communication Error] se
muestra en  (estado de
la cámara).

La cámara no puede
comunicarse con el
controlador del objetivo.

Compruebe la conexión entre la unidad y el controlador del
objetivo, luego apague y encienda la unidad y el controlador
del objetivo.

[Rotation Error] se
muestra en  (estado de
la cámara).

Se ha producido un
error de rotación en el
controlador del objetivo.

El rango de movimiento del zoom almacenado y el rango de
movimiento del objetivo pueden no coincidir. Inicialice el
controlador del objetivo.
Si el problema persiste, póngase en contacto con el
representante del fabricante del controlador del objetivo.

[System Error] se muestra
en  (estado de la
cámara).

Se ha producido un
error del sistema en el
controlador del objetivo.

Compruebe la conexión entre la unidad y el controlador del
objetivo, consulte las instrucciones de funcionamiento del
controlador del objetivo e inicialice el controlador del objetivo,
o apague y encienda la unidad y el controlador del objetivo.
Si el problema persiste, póngase en contacto con el
representante del fabricante del controlador del objetivo.

[Unknown Error] se
muestra en  (estado de
la cámara).

Se ha producido un
error desconocido en el
controlador del objetivo.

Compruebe la conexión entre la unidad y el controlador del
objetivo, consulte las instrucciones de funcionamiento del
controlador del objetivo e inicialice el controlador del objetivo,
o apague y encienda la unidad y el controlador del objetivo.
Si el problema persiste, póngase en contacto con el
representante del fabricante del controlador del objetivo.
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Tema relacionado
Emisión de una señal de fibra óptica

Bloque de conectores

Breathing Compensation

Comprobación de los interruptores del objetivo

Acople de un objetivo

Restablecimiento del giro/inclinación

P/T Range Limit

Restablecimiento de tarjetas de memoria

Conexión de una señal de registro

5-041-957-43(1) Copyright 2022 Sony Corporation
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Advertencias de funcionamiento

Si en la unidad se produce una condición de funcionamiento, precaución o advertencia que requiera confirmación, se
mostrará un mensaje en el panel de imagen de la cámara y empezarán a parpadear las luces indicadoras POWER y
NETWORK del panel frontal, así como el indicador de registro/grabación.

Nota

El parpadeo de la luz indicadora de registro/grabación solo se activa cuando ambos[Technical] > [Tally] > [Tally Control] se
establece en [Internal] y [Tally Lamp Brightness] no se establece en [Off] en el menú web o en el menú de la cámara.

Mensajes de error

Si los indicadores POWER y NETWORK parpadean como se describe a continuación, lleve a cabo las siguientes
acciones.

La unidad dejará de funcionar cuando se muestre lo siguiente.

Mensajes de advertencia

Siga las instrucciones proporcionadas si se muestran los siguientes mensajes.

Indicador
POWER

Indicador
NETWORK Causa y solución

Parpadeo
lento en
naranja

Parpadeo
lento en verde

La unidad no funciona con normalidad. Para obtener más detalles, consulte
[Maintenance] > [System Log] en el menú web. Si el problema continúa incluso tras
haber puesto la unidad en el modo de espera o haberla apagado y encendido,
póngase en contacto con el servicio de asistencia técnica de Sony.

Parpadeo
rápido en
naranja

Parpadeo
rápido en
verde

Se ha producido una avería en la unidad. Póngase en contacto con el
representante del servicio de asistencia de Sony.

Mensaje
mostrado

Lámpara
indicadora/indicador de

grabación
Causa y solución

E + Código
de error

Parpadeo rápido

Indica una anomalía de la unidad. La grabación se detiene, incluso si
aparece ●REC en el panel de imagen de la cámara.
Apague la unidad y compruebe si existe algún problema con los
dispositivos, cables o soportes conectados. Si el error continúa cuando la
unidad se vuelve a encender, póngase en contacto con el servicio de
asistencia técnica de Sony. Es posible que no aparezca una pantalla de
error o un sonido de advertencia dependiendo del estado de la unidad.
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Mensaje
mostrado

Lámpara indicadora/indicador
de grabación Causa y solución

Temperature High Parpadeo
La temperatura interna es elevada.
Apague el camcorder y deje que se enfríe antes de volverlo a
utilizar.

Media
Temperature High

Parpadeo
La temperatura de la tarjeta CFexpress es elevada.
Sustituya la tarjeta o deje que se enfríe antes de volverla a
utilizar.

Voltage Low Parpadeo La tensión de DC IN es baja (nivel 1). Compruebe la fuente
de alimentación.

Insufficient
Voltage

Parpadeo rápido
La tensión de DC IN es demasiado baja (nivel 2). La
grabación se detiene.
Conecte a una fuente de alimentación distinta.

Media Near Full Parpadeo
La capacidad restante de la tarjeta de memoria se está
agotando.
Sustitúyala en cuanto pueda.

Media Full Parpadeo rápido
Los clips no se pueden grabar o copiar porque no queda
capacidad en la tarjeta de memoria.
Sustitúyala inmediatamente.

Clips Near Full Parpadeo
El número de clips adicionales que pueden grabarse en la
tarjeta de memoria está alcanzando valores bajos.
Sustitúyala en cuanto pueda.

Clips Full Parpadeo rápido

Se ha alcanzado el número máximo de clips que pueden
grabarse en la tarjeta de memoria.
No se pueden grabar o copiar más clips. Sustitúyala
inmediatamente.

Last Clip
Recording

Parpadeo

El clip que está grabando actualmente es el último que
puede grabar, ya que ha alanzado el número máximo de
clips.
Prepare una tarjeta de memoria nueva.

Media(A) Life
Near End1) Parpadeo

La tarjeta de memoria está llegando al final de su vida útil.
Sustitúyala en cuanto pueda.

Media(A) Life
End1) Parpadeo rápido

La tarjeta de memoria ha llegado al final de su vida útil.
Sustitúyala inmediatamente.

Media(A) Near
Full1) Parpadeo Al utilizar la función Simul Rec

Media(A) Full1) Parpadeo rápido Al utilizar la función Simul Rec

Media(A) Clips
Near Full1) Parpadeo Al utilizar la función Simul Rec

Media(A) Clips
Full1) Parpadeo rápido Al utilizar la función Simul Rec

Media(A) Last Clip
Rec1) Parpadeo Al utilizar la función Simul Rec
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Mensajes de precaución y de funcionamiento

Es posible que los siguientes mensajes de precaución y funcionamiento aparezcan en el centro de la pantalla. Siga las
instrucciones proporcionadas para resolver el problema.

Mensaje
mostrado

Lámpara indicadora/indicador
de grabación Causa y solución

(Ninguno) Parpadeo

Se ha producido un error desconocido en el controlador del
objetivo.
Compruebe el estado de la cámara en la Aplicación Web.
Para obtener información detallada, consulte el registro del
sistema en la Aplicación Web.

Se muestra “Media (B)” para la tarjeta de la ranura B.1)

Mensaje de pantalla Causa y solución

Backup Battery End
Please Change

La capacidad restante de la batería de reserva es insuficiente.
Conecte la unidad a una fuente de alimentación durante al menos 24
horas para cargar la batería de reserva.

Unknown Media(A)1)

Please Change

Se ha introducido una tarjeta de memoria particionada o una tarjeta de
memoria que contiene más clips de los que puede procesar la unidad.
La tarjeta no se puede utilizar en la unidad y se debe sustituir.

Cannot Use Media(A)1)

Unsupported File System

Se ha introducido una tarjeta que utiliza un sistema de archivos diferente
o que no se ha formateado.
La tarjeta no se puede utilizar en la unidad y se debe sustituir o
formatear mediante la unidad.

Media Error
Media(A) Needs to be Restored1)

Se ha producido un error en la tarjeta de memoria y se debe restaurar.
Restaure la tarjeta de memoria.

Media Error
Cannot Record to Media(A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se puede
utilizar para la grabación.
La reproducción es posible, por tanto, se recomienda copiar y sustituir la
tarjeta de memoria.

Media Error
Cannot Use Media(A)1)

Es posible que la tarjeta de memoria esté dañada y ya no se puede
utilizar para la grabación ni la reproducción.
La tarjeta no se puede utilizar en la unidad y se debe sustituir.

Media(A) Error1)

Recording Halted
Playback Halted

La grabación y la reproducción se han detenido a causa de un error que
se ha producido mientras se utilizaba la tarjeta de memoria.
Si el problema continúa, sustituya la tarjeta de memoria.

Media Reached Rewriting Limit
Change Media(A)1)

La tarjeta de memoria ha llegado al final de su vida útil.
Realice una copia de seguridad y sustituya la tarjeta inmediatamente. Si
continúa utilizando la tarjeta, es posible que no pueda grabar o
reproducir.
Para obtener más información, consulte las instrucciones de
funcionamiento de la tarjeta de memoria.

The specified address is invalid.
La dirección especificada no es válida.
Compruebe que el ajuste sea correcto.

Cannot Use Specified Port Number
El número de puerto especificado no es válido.
Compruebe que el ajuste sea correcto.
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Información de error de transmisión RTMP

La siguiente información de error puede aparecer en la unidad. Realice las siguientes acciones, según sea necesario.

Información de error de transmisión SRT

Mensaje de pantalla Causa y solución

Lens I/F Error(xx:xx)

Se detectó un error de comunicación I/F con el objetivo al conectar un
objetivo con montura E.
Verifique el estado de conexión con el objetivo con montura E.
Si el problema persiste, póngase en contacto con el servicio de
asistencia técnica de Sony con el código de error (cinco caracteres entre
paréntesis).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Se ha alcanzado el número máximo de trabajos de transferencia.
Borre los trabajos no deseados. Es posible que el ajuste de destino de
carga automática para archivos de proxy también sea incorrecto.
Compruebe que el ajuste sea correcto.

Fan Stopped

El ventilador ha dejado de funcionar.
Compruebe que no haya polvo o partículas extrañas.
Si el error continúa después de eliminar el polvo o las partículas
extrañas, póngase en contacto con el servicio de asistencia técnica de
Sony.

Se muestra “Media (B)” para la tarjeta de la ranura B.1)

Código de
error Descripción Solución

RTMP RTMPS

1002
1004

2002
2004

No se puede conectar al
servidor RTMP.

Compruebe que el ajuste de la URL del servidor sea correcto.
Compruebe la conexión de red.

1003 2003
No se puede resolver el nombre
de dominio.

Compruebe que el ajuste de la URL del servidor sea correcto.
Compruebe la conexión del servidor DNS.

–
2005
2008

Error CRL
Compruebe que el ajuste de la URL del servidor sea correcto.
Compruebe que el destino de la conexión es un sitio de
confianza.

2006 Error CA
Compruebe que el ajuste del reloj sea correcto.
Compruebe que el certificado CA sea correcto.

– 2007
No hay certificado CA instalado.
Error de autenticación del
servidor.

Instale un certificado CA.
Compruebe que el destino de la conexión es un sitio de
confianza.

4002
La sesión RTMP se ha
desconectado.

Es posible que la unidad se haya desconectado en el lado del
servidor RTMP.
Compruebe que la configuración coincida con el parámetro de
códec recomendado del servicio.

4003
La calidad de la conexión de red
es baja.

Compruebe la conexión de red.

Otro Otros errores.
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La siguiente información de error puede aparecer en la unidad. Realice las siguientes acciones, según sea necesario.

5-041-957-43(1) Copyright 2022 Sony Corporation

Código de
error Descripción Solución

SRT-Caller

1001 Error inesperado
Es posible que la unidad no esté funcionando
normalmente. Apague y encienda la unidad.

1002
Comunicación desconectada debido a un
cambio en la configuración

La comunicación se desconectó porque se cambió la
configuración.
Restablezca la conexión.

5001 Error inesperado
Es posible que la unidad no esté funcionando
normalmente. Apague y encienda la unidad.

5005 Fallo en la conexión
Compruebe que la configuración de destino de
conexión sea correcta.

5006 Error de cifrado Compruebe que el ajuste de cifrado sea correcto.

5007 Error inesperado Es posible que la unidad no esté funcionando
normalmente. Apague y encienda la unidad.5008 Error inesperado

5009 Fallo de transmisión
La unidad se desconectó durante la comunicación.
Compruebe la conexión de red.

496



Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lista de elementos del menú

En las tablas siguientes se enumeran los elementos del menú de la unidad.

Leyenda
“Menú de la cámara” y “menú web”
●: disponible
▲: algunos elementos disponibles
–: No disponible

“All File” y “Scene File”
Sí: Elemento guardado en un archivo ALL o en un archivo de escena
No: el elemento no se guarda.

“All Reset (except for Network Settings)”
Cuando se ejecuta [Reset]> [Reset] > [All Reset (except for Network Settings)] en el menú web:
Sí: elemento inicializado (ejecuta la configuración de red)
No: no aplicable

“Network Reset”
Cuando se ejecuta [Reset]> [Reset] > [Network Reset] en el menú web:
Sí: elemento inicializado (configuración de red)
No: no aplicable

“Factory Default”
Sí: restablecimiento del elemento a los valores predeterminados de fábrica
No: no aplicable

Shooting

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Sí Sí Sí Sí Sí

ND Filter ● – Sí Sí*1 Sí No Sí

Shutter ● – Sí Sí Sí No Sí

Iris ● – Sí Sí Sí No Sí

Auto Exposure ● – Sí Sí*2 Sí No Sí

White ● – Sí Sí*3 Sí No Sí

White Setting ● – Sí No Sí No Sí

Offset White ● – Sí No Sí No Sí

Focus ● ▲ Sí No Sí No Sí

S&Q Motion ● – Sí No Sí No Sí
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Project

Paint/Look

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Sí No Sí No Sí

Noise
Suppression

● – Sí Sí Sí No Sí

Flicker Reduce ● – Sí No Sí No Sí

SteadyShot ● – Sí No Sí No Sí

[Mode] no aplicable*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] no aplicable*2

[Preset White] no aplicable*3

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Sí No Sí No Sí

Rec Format ● ● Sí No Sí*1 No Sí

Cine
EI/Flex.ISO Set

● – Sí No Sí No Sí

Simul Rec ● ● Sí No Sí No Sí

Proxy Rec ● ▲ Sí No Sí No Sí

Interval Rec ● ● Sí*2 No Sí No Sí

Picture Cache
Rec

● ● Sí*2 No Sí No Sí

SDI/HDMI Rec
Control

● – Sí No Sí No Sí

Assignable
Button

● – Sí No Sí No Sí

All File – ● No No No No No

[Frequency] no aplicable*1

[Setting] no aplicable*2

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – No No No No No

Base Look ● ▲ Sí*1 No Sí*1 No Sí*1

Reset Paint
Settings

● – No No No No No
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Pan-Tilt

TC/Media

Monitoring

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Sí Sí Sí No Sí

Knee ● – Sí Sí Sí No Sí

Detail ● – Sí No Sí No Sí

Matrix ● – Sí Sí Sí No Sí

Multi Matrix ● – Sí*2 Sí*2 Sí No Sí

Datos LUT importados como aspecto base no aplicable*1

[Axis] no aplicable*2

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● No No Sí No No

P/T
Acceleration

● ● No No Sí No No

P/T Range
Limit

– ● No No Sí No No

P/T Direction – ● No No Sí No No

P/T Preset – ● No No Sí No No

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Sí*1 No Sí No Sí

TC Display ● – Sí No Sí No Sí

Users Bit ● – Sí*1 No Sí No Sí

HDMI TC Out ● – Sí No Sí No Sí

Clip Name
Format

● – *2 No Sí No Sí

Update Media ● – No No No No No

Format Media ● – No No No No No

Media Life ● – No No No No No

[Setting] no aplicable*1

[Auto Naming] aplicable, [Camera ID] no aplicable*2
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Audio

Thumbnail

Technical

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output Format ● ● Sí No Sí No Sí

Output Display – ● Sí No Sí No Sí

Display On/Off ● – Sí No Sí No Sí

Video Signal
Monitor

● – Sí No Sí No Sí

Marker ● – Sí No Sí No Sí

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio Input ● ▲ Sí No Sí No Sí

Audio
Output

● ▲ Sí No Sí No Sí

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – No No No No No

Set Clip Flag ● – No No No No No

Lock/Unlock Clip ● – No No No No No

Delete Clip ● – No No No No No

Transfer Clip ● – No No No No No

Transfer Clip
(Proxy)

● – No No No No No

Filter Clips ● – No No No No No

Customize View ● – Sí No Sí No Sí

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color Bars ● – *1 No *1 No Sí

Genlock ● – No No No No No

Tally ● ● Sí No Sí No Sí
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Network

Stream

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Rec
Review

● – Sí No Sí No Sí

Zoom ● – Sí No Sí No Sí

IR Remote – ● No No Sí No Sí

Lens ● – Sí No Sí No Sí

APR ● – No No No No No

[Type] aplicable, [Setting] no aplicable*1

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● No No No No Sí

User – ● No No No Sí Sí

Wired LAN*1 ▲ ● No No No Sí No

File Transfer ● ▲ Sí No Sí Sí Sí

FTP Server 1 – ● No No Sí No Sí

FTP Server 2 – ● No No Sí No Sí

FTP Server 3 – ● No No Sí No Sí

SSL – ● No No No Sí Sí

Referer Check – ● No No No Sí Sí

Brute Force Attack
Protection

– ● No No No Sí Sí

No se puede configurar con el menú de la cámara (solo visualización)*1

Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting – ● No No Sí*1 No Sí*1

Video
Stream

– ● Sí No Sí No Sí

Audio
Stream

– ● Sí No Sí No Sí

[NDI|HX] > [License] no aplicable*1
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Maintenance
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Elemento
(nivel 2)

Menú de la
cámara

Menú
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Sí No Sí No Sí

Accessibility – ● Sí No No No Sí

Clock Set ● ● Sí*1 No Sí*2 No Sí

Reset – ● No No No No No

Hours Meter ● – No No No No No

Information – ● No No No No No

System Log – ● No No No No Sí

HTTP Access
Log

– ● No No No No Sí

Service – ● No No No No No

EULA – ● No No No No No

Software – ● No No No No No

Información de fecha y hora no aplicable*1

Información de [Time Zone], fecha y hora no aplicable*2
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Elementos guardados de posición preajustada

“Sí” indica que el ajuste se guarda en la posición preajustada y “No” indica que el ajuste no se guarda.

Elementos de giro/inclinación

Elementos de zoom

Elementos de enfoque

Mostrar ubicación Elemento Guardar
objetivo

Panel de control de encuadre de la pantalla de operación
en directo

Posición de giro/inclinación Sí

[Pan-Tilt Speed] No

[Pan-Tilt] en el menú web

[P/T Speed] No

[P/T Acceleration] No

[P/T Range Limit] No

[P/T Direction] No

[P/T Preset] > [Pan-Tilt] No

[P/T Preset] > [Default] > [Pan-Tilt
Speed] Sí1)

Los valores de configuración al guardar una posición preajustada se guardan como los valores de esa posición preajustada. Después de
guardar los valores, los valores se pueden cambiar para cada posición preajustada. Para obtener más detalles, consulte “Cambio de la
velocidad de transición (giro-inclinación/zoom/enfoque) de las posiciones preajustadas con la Aplicación Web”.

1)

Mostrar ubicación Elemento Guardar
objetivo

Panel de control de encuadre de la pantalla de operación en
directo

Posición del zoom (distancia
focal)

Sí

[Zoom Speed] No

[Pan-Tilt] > [P/T Preset] > [Default] en el menú web
[Zoom Sync] Sí1)

[Zoom Speed] Sí1)

[Technical] > [Zoom] en el menú de la cámara [Zoom Type] No

Los valores de configuración al guardar una posición preajustada se guardan como los valores de esa posición preajustada. Después de
guardar los valores, los valores se pueden cambiar para cada posición preajustada. Para obtener más detalles, consulte “Cambio de la
velocidad de transición (giro-inclinación/zoom/enfoque) de las posiciones preajustadas con la Aplicación Web”.

1)
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Tema relacionado

Cambio de la velocidad de transición (giro-inclinación/zoom/enfoque) al restaurar una posición preajustada

5-041-957-43(1) Copyright 2022 Sony Corporation

Mostrar ubicación Elemento Guardar
objetivo

Panel de imagen de la cámara de la pantalla
de operación en directo

Objetivo de seguimiento especificado para AF de
seguimiento en tiempo real

No

Coordenadas especificadas para Spot Focus No

Pestaña  (Focus) de la pantalla de
operación en vivo

Interruptor [Touch Focus] No

Interruptor [Auto Focus] Sí

Estado de botón [Focus Hold] No

Estado de botón [Push AF/MF] No

[Face/Eye Detection AF] Sí

[AF Subj. Shift Sens.] Sí

[AF Transition Speed] Sí

Posición de enfoque Sí1)

[Shooting] > [Focus] en el menú web

[Push AF Mode] (incluida la configuración de los
botones asignables)

No

[Touch Function in MF] No

[AF Assist Control] No

[Pan-Tilt] > [P/T Preset] > [Default] en el menú
web

[Focus Recall] Sí2)

[MF Speed] Sí2)

[Shooting] > [Focus] en el menú de la cámara

Configuración de posición y tamaño del área de
enfoque con [Focus Area]

Sí

Configuración de posición del área de enfoque con
[Focus Area (AF-S)]

Sí

No se restaura cuando el interruptor [Auto Focus] se ajusta en la posición de encendido. Se restaura cuando se ajusta en la posición de
apagado.

1)

Los valores de configuración al guardar una posición preajustada se guardan como los valores de esa posición preajustada. Después de
guardar los valores, los valores se pueden cambiar para cada posición preajustada. Para obtener más detalles, consulte “Cambio de la
velocidad de transición (giro-inclinación/zoom/enfoque) al restaurar una posición preajustada”.

2)
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Diagramas de bloques

Audio Input

Audio Output

5-041-957-43(1) Copyright 2022 Sony Corporation
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Actualización del software del objetivo de montura E

Puede actualizar el software de un objetivo de montura E mediante la unidad.
Consulte el sitio web del objetivo para saber qué objetivos pueden actualizarse y cuál es el firmware correspondiente.
El software se actualiza en el menú web.

Nota

No lleve a cabo las siguientes acciones hasta que la actualización se haya completado.

Desconexión de una red
Extracción de un objetivo
Apagado

Si aparece un mensaje en el que se indica que se muestra la actualización fallida, compruebe la descripción que aparece y
vuelva a actualizar.

5-041-957-43(1) Copyright 2022 Sony Corporation

Acople un objetivo de montura E a la unidad.1

Compruebe [Maintenance] > [Information] > [Lens] > [Model Name] y [Version Number] en el menú web.

El número de versión del software del objetivo de montura E aparecerá en el lateral.
Compruebe el número de versión del software y actualice el software de acuerdo con las necesidades.

2

Descargue el archivo de actualización del software del objetivo para Windows (extensión .exe) en el
dispositivo que ejecuta la Aplicación Web.

3

En [Maintenance] > [Information] > [Lens] > [Version Up], pulse el botón [Choose File] y seleccione el
archivo de actualización descargado.

4

Siga las instrucciones que aparecen en pantalla.5
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Colocación de la tapa del botón de liberación del objetivo

Puede evitar que el objetivo se libere de la unidad colocando la tapa del botón de liberación del objetivo que se
proporciona con el soporte de techo CIB-PCM1 (opcional) al botón de liberación del objetivo.

Nota

Esto no evita que el objetivo se extraiga por completo.

Tema relacionado

Acople de un objetivo

5-041-957-43(1) Copyright 2022 Sony Corporation

Coloque el objetivo.

Para obtener más información, consulte “Acople de un objetivo”.

1

Mueva la palanca de bloqueo de giro/inclinación a la posición LOCK para bloquear el giro/inclinación del
cabezal de la cámara.

2

Mueva el bloque de la cámara a una posición que permita colocar la tapa de liberación del objetivo.3

Coloque la tapa de liberación del objetivo de manera que cubra el botón de liberación.4

Asegure la tapa de liberación del objetivo con el tornillo de retención de la tapa.5
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Licencias

Licencia de la cartera de patentes de MPEG-4 AVC

LOS CONSUMIDORES PUEDEN UTILIZAR ESTE PRODUCTO BAJO LA AUTORIZACIÓN DE LA LICENCIA DE LA
CARTERA DE PATENTES DE AVC PARA SU USO PERSONAL O PARA OTROS USOS, POR LOS CUALES NO SE
RECIBE REMUNERACIÓN ALGUNA EN CASO DE
(i) CODIFICAR VÍDEO DE CONFORMIDAD CON EL ESTÁNDAR DE AVC (“VÍDEO AVC”) Y/O
(ii) DESCODIFICAR VÍDEO AVC CODIFICADO POR UN CONSUMIDOR COMO PARTE DE UNA ACTIVIDAD
PERSONAL Y/U OBTENIDO DE UN PROVEEDOR DE VÍDEO CON LICENCIA PARA PROPORCIONAR VÍDEO AVC.
NO SE OTORGA NINGÚN TIPO DE LICENCIA O NO EXISTE NINGUNA LICENCIA IMPLÍCITA PARA NINGÚN OTRO
USO. PUEDE OBTENER INFORMACIÓN ADICIONAL EN MPEG LA, L.L.C. CONSULTE HTTP://WWW.MPEGLA.COM

Obtención del software con la licencia GPL/LGPL

Este producto utiliza un software al que se aplica la licencia GPL/LGPL. Esto le informa de que tiene derecho a acceder,
modificar y redistribuir el código fuente de estos programas de software de acuerdo con las condiciones de la
GPL/LGPL.
El código fuente se proporciona en Internet. Utilice la siguiente URL y siga las instrucciones de descarga.
https://oss.sony.net/Products/Linux/
Le rogamos que no se ponga en contacto con nosotros acerca de los contenidos del código fuente.

Código fuente de μT-Kernel

Este producto utiliza el código fuente de μT-Kernel bajo T-License 2.1 concedida de TRON Forum (www.tron.org).

5-041-957-43(1) Copyright 2022 Sony Corporation
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Especificaciones

General

Peso
Aprox. 4,6 kg (solo el cuerpo)
Aprox. 6,0 kg (incluido el objetivo SELP28135G)

Dimensiones
Consulte “Dimensiones exteriores”.

Requisitos de alimentación
19,5 V de CC
PoE++ (IEEE802.3bt, tipo 4, compatible con clase 8)

Consumo de energía
19,5 V de CC: 80,0 W (máx.)
PoE++: 71,3 W (máx.) 

Temperatura de funcionamiento
De 0 °C a 40 °C

Temperatura de almacenamiento
De −20 °C a +60 °C

Formato de grabación (vídeo)
XAVC Intra
Modo XAVC-I 4K/QFHD: VBR, velocidad de bits de 600 Mbps (máx.), MPEG-4 AVC/H.264
Modo XAVC-I HD: CBG, 223 Mbps (máx.), MPEG-4 AVC/H.264

XAVC Long
Modo XAVC-L QFHD: VBR, velocidad de bits de 150 Mbps (máx.), MPEG-4 H.264/AVC
Modo XAVC-L HD 50: VBR, 50 Mbps (máx.), MPEG-4 H.264/AVC
Modo XAVC-L HD 35: VBR, 35 Mbps (máx.), MPEG-4 H.264/AVC

Formato de grabación (audio)
LPCM de 24 bits, 48 kHz, 4 canales

Velocidad de fotogramas de grabación

XAVC Intra
Modo XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Modo XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modo XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Modo XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modo XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Modo XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Tiempo de grabación/reproducción
XAVC Intra
Modo XAVC-I QFHD: 59.94P, aprox. 30 minutos (con CEA-G160T)
Modo XAVC-I HD: 59.94P, aprox. 78 minutos (con CEA-G160T)

XAVC Long
Modo XAVC-L QFHD: 59.94P, aprox. 115 minutos (con CEA-G160T)
Modo XAVC-L HD 50: 59.94P, aprox. 155 minutos (con CEA-G80T)
Modo XAVC-L HD 35: 59.94P, aprox. 210 minutos (con CEA-G80T)

Nota

El tiempo de grabación/reproducción puede variar debido a las condiciones de uso y a las características de la memoria. Los
tiempos de grabación y reproducción son para una grabación continua como un solo clip. Los tiempos reales pueden ser
inferiores, dependiendo del número de clips grabados.

Sección de movimiento de giro/inclinación

Velocidad mínima de giro: 0,02°/s
Velocidad mínima de inclinación: 0,02°/s
Velocidad máxima de giro: 60°/s
Velocidad máxima de inclinación: 60°/s
Rango de giro: de −170° a +170°
Rango de giro: de −30° a +195°
Calificación de criterio de ruido: NC35 o inferior
Posiciones predefinidas: 100

Sección de la cámara

Dispositivo de generación de imágenes
Encuadre completo 35mm (35,6 × 23,8 mm), sensor Exmor R CMOS

Número de píxeles
Aprox. 12,9 megapíxeles (píxeles totales)
Aprox. 10,3 megapíxeles (píxeles efectivos)

Auto focus
Método de detección: detección de fase / detección de contraste

Filtros ND internos
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
ND linealmente variable: de 1/4ND a 1/128ND

Sensibilidad ISO
ISO 800/12800 (modo Cine EI, fuente de luz D55)

Montura del objetivo
Montura E

Latitud
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Más de 15 paradas

Velocidad del obturador
De 64F a 1/8000 s (23.98P)

Ángulo del obturador
De 5,6° a 360°, de 2 a 64 fotogramas

Movimiento a cámara lenta y rápida
XAVC QFHD: de 1 fps a 120 fps
XAVC HD: de 1 fps a 240 fps
XAVC 4K: de 1 fps a 60 fps
XAVC HD (S35): de 1 fps a 120 fps

Balance de blancos
De 2000 K a 15000 K

Ganancia
De −3 dB a +30 dB (incrementos de 1 dB)

Base look
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Sección de audio

Frecuencia de muestreo
48 kHz

Cuantificación
24 bits

Respuesta en frecuencia
Modo MIC de la entrada XLR: de 20 Hz a 20 kHz (±3 dB o menos)
Modo LINE de la entrada XLR: de 20 Hz a 20 kHz (±3 dB o menos)

Rango dinámico
Modo MIC de la entrada XLR: 80 dB (típico)
Modo LINE de la entrada XLR: 90 dB (típico)

Distorsión
Modo MIC de la entrada XLR: 0,08% o inferior (nivel de entrada de −40 dBu)
Modo LINE de la entrada XLR: 0,08% o inferior (nivel de entrada de +14 dBu)

Sección de entrada/salida

Entradas
DC IN

Compatible con EIAJ, 19,5 V de CC

AUDIO IN

Tipo XLR, 5 contactos, hembra
Conmutable entre LINE / MIC / MIC+48V
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MIC: −30 dBu a −80 dBu de referencia

GENLOCK IN

Conector BNC, 1,0 Vp-p, 75 Ω

TC IN

Conector BNC

Salidas
SDI OUT

Conector BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Conector Type-A

Conector de salida OPTICAL

SFP+ compatible
* La unidad no admite entrada de señal óptica.

Entrada/salida
Conector LAN

RJ-45, 1000BASE-T

Conector OPTION

Conector de entrada/salida de registro RJ-45

Sección de la ranura multimedia

Ranura de la tarjeta CFexpress Tipo A/SD (2)

Elementos suministrados

Adaptador de CA (1)
Cable de alimentación (1)
Control remoto infrarrojo (1)
Tapa del cuerpo (1) (acoplada a la unidad)
Placa de retención del cable HDMI (1)
Antes de utilizar esta unidad (1)
Folleto de la garantía (1)

Dimensiones exteriores

Las dimensiones son valores aproximados.
Unidad: mm

Cuerpo de la cámara
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Soporte de techo
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El diseño y las especificaciones están sujetos a cambios sin previo aviso.
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Guía de Ayuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Marcas comerciales

 es una marca comercial de Sony Group Corporation.
XAVC y  son marcas comerciales registradas de Sony Group Corporation.
Los términos HDMI y HDMI High-Definition Multimedia Interface, y el Logotipo HDMI son marcas comerciales o
marcas registradas de HDMI Licensing Administrator, Inc. en los Estados Unidos y en otros países.
Microsoft y Windows son marcas comerciales o marcas comerciales registradas de Microsoft Corporation en Estados
Unidos o en otros países.
Mac y macOS son marcas comerciales registradas de Apple Inc. en Estados Unidos y en otros países.
El logotipo de “Catalyst Browse” es una marca comercial o marca comercial registrada de Sony Group Corporation.
IOS es una marca comercial o registrada de Cisco en EE. UU. y en otros países, y se utiliza bajo licencia.
iPadOS, Safari y iPad son marcas comerciales de Apple Inc. registradas en Estados Unidos y en otros países.
Android y Google Chrome son marcas comerciales o marcas comerciales registradas de Google LLC.
Wi-Fi es una marca comercial registrada de Wi-Fi Alliance.
El logotipo de SDXC es una marca comercial de SD-3C, LLC.
CFexpress y el logotipo de CFexpress Tipo A son marcas registradas de CompactFlash Association.
NewTek™ y NDI® son marcas comerciales o marcas comerciales registradas de NewTek, Inc.
JavaScript es una marca comercial registrada de Oracle y/o sus entidades afiliadas.
Intel, el logotipo de Intel e Intel Core son marcas comerciales de Intel Corporation o sus entidades subsidiarias.
QR Code es una marca comercial de Denso Wave Inc.
Todos los demás nombres de compañías y de productos son marcas comerciales registradas o marcas comerciales
de sus respectivos propietarios. En este documento, no se utilizan los símbolos ™ o ® para indicar los elementos
con marca registrada.
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